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Safety precautions 

Read this manual for your safety before using the product. 

 Mishandling due to ignoring this indication may cause major injuries or even death. 

 Mishandling due to ignoring this indication may cause personal injury. 
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General cautions 

 

 
Do not touch the safety switch inside this machine. High voltage may occur and electric shock may be caused. 
In addition, gears can rotate, which may result in personal injury. 

 
Do not use any inflammable spray near the machine. 
A fire may be caused since there is an area heating up within the machine. 

 

Disconnect the power plug from the power outlet and contact your dealer if the cover becomes abnormally hot, 
emits smoke, gives off an odor, or makes an abnormal noise. 
Otherwise, a fire may be caused. 

 

Disconnect the power plug from the power outlet and contact your dealer if water or other liquid gets into the 
machine. 
Otherwise, a fire may be caused. 

 

If paper clips or any other foreign objects enter the inside of this machine, disconnect the power plug from the 
power outlet and contact the customer service center or your dealer. 
Otherwise, electric shock, fire or injury may be caused. 

 
Do not disassemble this machine or perform operations other than those specified in the user manual. 
Otherwise, electric shock, fire or injury may be caused. 

 

Disconnect the power plug from the power outlet and contact your dealer if the machine is dropped or the cover 
is damaged. 
Otherwise, electric shock, fire or injury may be caused. 

 

Periodically disconnect the power plug from the power outlet and clean the base of the prongs, and between the 
prongs. 
Leaving the power plug inside the power outlet for a long period of time may result in a fire due to a short circuit 
caused by the buildup of dust at the base of the prongs. 

 

Do not clean up spilled toner using an electric vacuum cleaner. Otherwise, a fire may be caused due to sparks 
from the electrical contacts. 
If toner is spilled on the floor, wipe the toner up carefully using a damp cloth to prevent toner scattering. 

 
Do not insert objects into the air vents. 
Otherwise, electric shock, fire or injury may be caused. 

 
Do not place any containers like cups containing water on the machine. 
Otherwise, electric shock or fire may be caused. 

 
Make sure that no urine from pets on top of this machine wet or enter this machine. 
Otherwise, electric shock or fire may be caused. 

 
Take care when touching the fuser unit. 
Otherwise, burns may be caused. 

 
Do not throw the image drum or toner cartridge into fire. 
Otherwise, burns may be caused due to a dust explosion. 

 
Do not connect the power cord, any other cables or earth wire except as instructed in the user manual. 
Otherwise, a fire may be caused. 

 

The performance cannot be assured if an uninterruptible power supply (UPS) or inverter is used. Do not use an 
uninterruptible power supply or inverter. 
Otherwise, a fire may be caused. 
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Keep away from the paper discharger when the machine is powered on or during printing. 
Otherwise, injury may be caused. 

 

Do not touch a broken display. Otherwise, injury may be caused. If any liquid (liquid crystal) leaking from the 
display gets into the eyes or mouth, wash it off promptly with a large quantity of water. Consult a physician as 
necessary. 

 
Do not disassemble or forcibly open the image drum or toner cartridge. Otherwise, toner may scatter, which 
may be inhaled by people or may stain clothes or hands. 

 
 
NOTE! 
This product is not intended for use in the immediate visual field on the display work place. To avoid disturbing 
reflections on the display work place, this product shall not be placed in the immediate field of vision. 
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Cautions 

 

External sensing function 
This product contains sensors that measure environment temperature and humidity. 

Preface 
• EMERGENCY FIRST AID 
Take care with toner powder: 

 

If swallowed, give small amounts of cold water and seek medical attention. DO NOT attempt to induce 
vomiting. 
If inhaled, move the person to an open area for fresh air. Seek medical attention. 
If it gets into the eyes, flush with large amounts of water for at least 15 minutes keeping eyelids open. Seek 
medical attention. 
Spillages should be treated with cold water and soap to help reduce risk of staining skin or clothing. 
 
• ENVIRONMENTAL INFORMATION 
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Trademarks/Copyrights 

OKI is a registered trademark of Oki Electric Industry Co., Ltd. 
ENERGY STAR and the ENERGY STAR mark are registered trademarks or trademarks owned by the U.S. 
Environmental Protection Agency. 
Microsoft, Microsoft Edge, Windows and Windows Server are registered trademarks or trademarks of 
Microsoft Corporation in the United States and other countries. 
Apple, AirPrint, AirPrint logo, App Store, Bonjour, ColorSync, Mac, macOS, Safari and TrueType are 
trademarks of Apple Inc., registered in the United States and other countries and regions. 

 

iOS is OS name of Apple Inc. IOS is a registered trademark or trademark of Cisco in the United States and 
other countries and is used under license. 

 

The Mopria™ wordmark and the Mopria™ Logo are registered and/or unregistered trademarks of Mopria 
Alliance, Inc. in the United States and other countries. Unauthorized use is strictly prohibited. 

 

IPP Everywhere™ and the IPP Everywhere logo are trademarks of The Printer Working Group. 
Android, Chromebook, ChromeOS, Google Chrome and Google Play are trademarks of Google LLC. 
Linux is the registered trademark of Linus Torvalds in the United States and other countries.  
Adobe and PostScript are either registered trademarks or trademarks of Adobe Inc. in the United States 
and/or other countries. 
Wi-Fi, Wi-Fi Alliance, WPA, WPA2, WPA3, Wi-Fi Direct and Wi-Fi Protected Setup are registered trademarks 
or trademarks of Wi-Fi Alliance in the United States and other countries. 
Arm is registered trademark or trademark of Arm Limited (or its subsidiaries) in the US and/or other 
countries/regions. 
Other product names and brand names are registered trademarks or trademarks of their proprietors.  
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As an ENERGY STAR® Program Participant, the manufacturer has determined that this product meets the 

ENERGY STAR® guidelines for energy efficiency. 

The target country of the ENERGY STAR® program is Japan. 

It is not applicable to other countries. 

 

This product complies with the requirements of the Council Directives 2014/30/EU (EMC), 2014/35/EU 
(LVD), 2014/53/EU (RED), 2009/125/EC (ErP), 2011/65/EU(RoHS) and EU 2023/1542 (Batteries 
Regulation) as amended where applicable, on the approximation of the laws of the member states relating to 
Electromagnetic Compatibility, Low Voltage, Radio Equipment, Energy related Products and Restriction on 
the use of certain Hazardous Substances in electrical and electronic equipment. 

 
The following cables were used to evaluate this product for EMC directive 2014/30/EU compliance, and 
configurations other than this may affect that compliance. 
 
CABLE TYPE LENGTH (METER) CORE SHIELD 

Power 1.8   
USB 5.0   
LAN 10.0   

The simplified EU declaration of conformity 
Oki Electric Industry Co., Ltd. hereby, declares that the radio equipment type "AW-CM382" complies with 
Directive 2014/53/EU. 
The full text of the EU declaration of conformity is available at the following internet address: 
https://www.oki.com/eu/printing/support/declaration-of-conformity 
 
The summary of the statement of compliance 
Oki Electric Industry Co., Ltd. hereby states that this product complies with The Product Security and 
Telecommunications Infrastructure (Security Requirements for Relevant Connectable Products) Regulations 
2023. 
The full text of the statement of compliance is available at the following internet address: 
https://www.oki.com/uk/printing/support/declaration-of-conformity/index.html 
 
This product includes software developed by the OpenSSL project. It is intended for use with the OpenSSL 
toolkit 
(http://www.openssl.org/). 
This product includes software created by Tim Hudson (tjh@cryptsoft.com). 
 

https://www.oki.com/eu/printing/support/declaration-of-conformity
https://www.oki.com/uk/printing/support/declaration-of-conformity/index.html
http://www.openssl.org/
http://cryptsoft.com/


Getting started 

- 14 - 

About this manual 

This section lists a variety of information about this machine. Please read through this manual before using 
the machine. 
 

Manual structure 
 User's Manual (PDF)...Available on our website. You can also download it to read. 
 Online Manual...available on our website. 

About this manual 
 The reproduction of this manual, in whole or in part, without permission is strictly prohibited. 
 The content of this manual may be changed without a prior notice in the future. 
 Efforts have been exerted to make the content of this manual as complete as possible. However, should 

you notice any errors, omissions or other problems, contact the retail store where you made the 
purchase. 

 Notwithstanding the foregoing, we shall not have any liability in regard to any operational effect related to 
the instructions contained in this manual. 

Copyrights 
All rights belong to Oki Electric Industry Co., Ltd. This manual may not be reproduced, transcribed or 
translated without permission. Be sure to obtain the written approval from Oki Electric Industry Co., Ltd. 

© 2025 Oki Electric Industry Co., Ltd. 

 

About the description 
 
This section describes the marks, symbols, abbreviations and illustrations used in this manual. 
This manual uses B433 as an example for illustration purposes unless otherwise specified. 
This manual uses screens of the following operating systems unless otherwise specified. 
 For Windows: Windows 11 
 For macOS: macOS Sequoia 15 

Sometimes, the model name is written as [OKI Printer]. 
Depending on the used OS, model and version, the description in this manual may differ. 

About marks 
This manual uses the following marks. 

Mark Meaning 

 
Indicates cautions and restrictions for the correct operation of this machine. Be sure to read them to 
avoid misoperation. 

 
Indicates useful tips and references on how to use this machine. We recommend you read them. 

 
Indicates reference items. Please read them to learn the detailed information. 
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About symbols 
This section describes the symbols used in this manual and their meanings. 

Symbol Meaning 

« » 
Indicates buttons on the operator panel of this machine. 
Indicates keys on the PC keyboard. 

[ ] 
Indicates menu names, item names, options, etc. that appear on the display. 
Indicates menus, windows and dialog box names that appear on the PC screen. 
They can be clearly distinguished in the description and procedure illustration. 

" " 
Indicates messages and input texts that appear on the display. 
Indicates file names on the PC. 
Indicates item titles of link destinations. 

- 
Indicates the menu path of this machine or the PC. 

 
Indicates that paper shall be loaded in the paper tray in landscape orientation. 

 
Indicates that paper shall be loaded in the paper tray in portrait orientation. 
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Features of this machine 

 Easy maintenance with front access 
You can replace consumables and maintenance parts, and clear a paper jam from the front side. In 
addition, back access has been eliminated. 

 
 Immediate start of printing thanks to short warm-up time 

The warm-up time of this machine has been shortened in comparison with conventional models. 
 
 Massive printing possible with the extension tray 

Up to three extension trays can be installed. 
 

 An increased service life of the machine 
The service life of this machine has been extended in comparison with existing models. 
 

 Reduced installation space 
The top maintenance space is reduced. 

 
 
 
 Easy mobile printing and initialization with the NFC and app 

You can print and initialize this machine by using the specialized application from your NFC-compatible 
smartphone, tablet or other mobile devices. 

 
 Depending on the specific region, this machine may not come with the NFC function. 

 
 Web page 

You can manage this machine by accessing the web page of this machine from the web browser of your 
PC or mobile device like a smartphone or tablet. 

 Managing the machine from the web page(P.200) 

 
 For the difference between B433 and B513, please refer to "Specifications(P.424)". 
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Installation 

Installation environment 
Install this machine in the following environment. 

Ambient temperature: 10°C to 32°C 

Ambient humidity: 20% to 80% RH (relative humidity) 

Max. wet-bulb temperature: 25℃ 

 
 Make sure there is no condensation. Otherwise, malfunction may be caused. 
 If the ambient relative humidity is 30% RH or less, use a humidifier or static prevention mat. 
 The operating noise of this machine may be a concern depending on the installation environment. If the operating 

noise is a concern, it is recommended to install this machine in a remote location or in a separate room. 
 Do not install this machine near combustion appliances that produce combustion emissions. Otherwise, the printing 

may be lighter. 

 
 Do not install it close to high-temperature locations or naked flames. 
 Do not install it in locations where chemical reactions occur (e.g., laboratories). 
 Do not install it close to combustible solutions such as alcohol and thinners. 
 Do not install it within reach of little kids. 
 Do not install it in an unstable location (e.g., unsteady tables and sloping locations). 
 Do not install it in humid or dusty locations, or in locations exposed to direct sunlight. 
 Do not install it in environments with salt air, corrosive gas, NOx or SOx. 
 Do not install it in locations subject to frequent vibration. 
 Do not install it in locations where the air vents of this machine are blocked. 

 

 
 Do not install directly on long-hair rugs or carpets. 
 Do not install in locations with poor air circulation or ventilation like sealed rooms. 
 Ensure adequate ventilation if using it continuously for long hours in a small room. 
 Keep it away from strong magnetic fields and noise sources. 
 Keep it away from monitors and TVs. 
 To move the machine, stand in front of and behind the machine, hold the handle at the bottom of the machine, 

and carry it. 
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Installation space 
Install this machine on a flat desk which is larger than its bottom. 
Keep sufficient space around this machine as shown in the following figure. 
 
 Plan view 

 

 B433 B513 

A When the rear output tray is not used: 10 cm 
When the rear output tray is used: 22 cm or above. Please keep it away from the wall so 
that it does not interfere with the alignment of the paper to be used. 

B When the MP tray is not used: 25 cm 
When the MP tray is used: Check that there is enough space according to the size of paper 
to be used. 

C 10 cm 

D 10 cm 

 
 Depending on the installation environment, the temperature inside this machine may rise and the printing speed 

may slow down. 

 
 Side view 

 

 B433 B513 

E 10cm 10cm 

F 43 cm 47 cm 
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Unpacking 

 
 Be sure to start with the consumables/maintenance parts that come with this machine. If you start with any other 

consumables/maintenance parts than the supplied ones, the service life will not be displayed correctly or you will not 
be able to use the supplied accessories later. 

 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (approx. 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 The packing case and cushioning materials are required to ship this machine. Keep them properly instead of 

discarding them. 

 

1 Open the packing case, and take out the accessories and cushioning materials. 

 

2 Take this machine from the plastic bag. 

 

3 Lift the machine and place it in the installation location. 
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4 Remove the corrugated cardboard sheet on the top of this machine. 

 

5 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

6 Press the starter toner cartridge from the top, and then rotate the blue lever on the right side in 

the direction of the lock mark until it stops. 

 

 

7 Close the top cover (front). 

 

 
 Refer to "Installing optional accessories(P.23)" if you want to use the optional expansion tray unit. 
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Checking the accessories 

Check that you have all of the following. 

 
 See "Unpacking(P.20)" for the unpacking method. 

 
 Be sure to start with the consumables that come with this machine. If you start with any other consumables than the 

supplied ones, the service life will not be displayed correctly or you will not be able to use the supplied accessories 
later. 

 
 Main unit 
 Starter toner cartridge 
 Image drum 

 
 The starter toner cartridge is installed on the image drum. The image drum is attached to the main unit by 

default. 
 Do not remove the starter toner cartridge from the image drum. 
 The number of printable pages of the starter toner cartridge is approximately 2,000 (which is the reference 

value when the standard print data specified by ISO/IEC 19752 is printed on one side of A4 paper in our in-
house test). 

 

 

 Installation Guide 

 

 
 DVD 

 

 
 Power cord 

 
 LAN cables and USB cable are not included. Please prepare them separately according to the connection 

environment. 
 Connecting via a wired LAN(P.37) 
 Connecting via USB(P.62) 



Preparations and connecting this machine to your PC 

- 23 - 

Installing optional accessories 

This section describes how to install optional accessories. If no option is installed, proceed to "Initialization upon 
power-on(P.33)". 
The following optional accessories are available. 

 
 Be sure to turn off the power supply, disconnect the power cord and any other cables, and then install the optional 

accessories. If you install optional accessories while the power supply is on, the main unit and optional accessories 
may break down. 

 Turning the power off(P.73) 

 Wireless LAN module 

 

Install it when you want to connect this machine via a wireless LAN. 
 Installing the wireless LAN module(P.23) 

 

 Expansion tray unit 

 

Install it if you want to increase the amount of paper that can be 
loaded in this machine. 
You can load 580 sheets of paper (with a weight of 64 g/m2). Up to 3 
levels can be expanded. 

 Installing the expansion tray unit(P.25) 
 

 Dedicated caster stand 

 

Install it to make this machine easier to move. After moving, fix it 
with a stopper. 

 Installing the dedicated caster stand(P.27) 
 

 Extended wired LAN module (recommended) 
For details, please visit our website. 
For the mounting method, please refer to "1-2. Installing the extended wired LAN module (For wired 
LAN2)(P.37)". 

 

 
 After installing the expansion tray unit, install the software on your PC and set the optional accessories in the printer 

driver. Refer to "Setting the printer driver(P.67)". 

Installing the wireless LAN module 
Install it when you want to connect this machine via a wireless LAN. After installation, you need to follow the 
procedure to enable the Wireless LAN module on the operator panel. 
This section describes the procedure for installing the wireless LAN module and enabling the wireless LAN 
module on the operator panel. 
You can also use standard wired LAN and wireless LAN on different networks at the same time. 
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1 Press the power button to power off this machine, and then disconnect the power cord. 
 
 If you install it with the power supply turned on, the main unit or the wireless LAN module may be damaged. 
 Turning the power off(P.73) 

2 Open the wireless LAN module cover on the side of this machine. 

 

3 Pull out the connector and insert it into the wireless LAN module. 

 

4 Insert the wireless LAN module along the guide with the label facing the outside, and push it 

toward the main unit to fix. 

 

5 Close the wireless LAN module cover. 

 

6 Plug the power cord to this machine. 
 Initialization upon power-on(P.33) 
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Refer to the next section for the procedure for connecting via a wireless LAN. 
 Connection form via a wireless LAN(P.45) 
 Connecting via an access point (Infrastructure)(P.46) 
 Connecting directly with this machine (Wi-Fi Direct)(P.58) 

Installing the expansion tray unit 

 Injury may be caused.  

The machine may tip over. Be sure to attach the supplied connecting parts. 

Install the expansion tray unit if you want to increase the amount of paper that can be loaded. After 
installation, set the number of trays in the printer driver. 
Up to 3 expansion tray units can be installed. Be sure to attach the supplied connecting parts. 
To install 2 or more expansion trays, install the optional dedicated caster stand and set the anti-tip feet to 
avoid the risk of tipping. 
To install this machine on a table, it is recommended to install one expansion tray. 

 Installing the dedicated caster stand(P.27) 

A flat-head screwdriver is required to install the expansion tray unit. 

 
 The packing case and cushioning materials are required to ship the expansion tray unit. Keep them properly instead 

of discarding them. 
 When an extension tray is used to print from, if the printing position shifts, the printing position is corrected for each 

extension tray. For details, see "Correcting the print position of the tray(P.186)". 

 
This section takes for an example the case where one expansion tray unit is installed in B433. 

1 Check that you have all the parts of the expansion tray unit. 
Expansion tray unit 
Connecting parts (x2) 
Screws (x2) 

 

2 Press the power button to power off the main unit, and disconnect the power cord and any other 

cables. 
 
 Be sure to turn off the power supply, disconnect the power cord and any other cables, and then install the 

expansion tray unit. If you install the expansion tray unit while the power supply is on, this machine and the 
expansion tray unit may break down. 

 If you install it with any cable connected, you may get injured by getting your feet trapped by the cable. 

3 Install the first expansion tray unit. 
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4 Align the right side and front of the main unit and the expansion tray unit, and gently stack them 

so that the holes on the bottom of the main unit and the protrusions of the expansion tray unit 

are aligned. 

 

5 Use a flat-head screwdriver to connect the left and right sides of the main unit and the 

expansion tray unit with the supplied connecting parts. 
 
 At this time, do not push the main unit left, right, back or forth. 

 

 
 When moving the machine or replacing consumables or maintenance parts, or loading paper in the tray, check 

the following points to prevent the printer from tipping over. 
 After stacking the expansion trays, do not push the main unit left, right, back or forth. 
 Do not press on the paper cassette from above when the paper cassette is pulled out. 

 
 Do not press on the main unit from the back when the paper cassette is pulled out. 
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6 Plug the power cord or any removed cables back to the main unit. 
 Initialization upon power-on(P.33) 

7 Press the power button to power on this machine. 

8 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

9 Check that [Information] is selected, and press «OK». 

10 Check that [Tray Count] is selected, and press «OK». 

11 Check that the expansion tray unit you installed appears on the display. 

12 After checking the display, press «CANCEL» to return to the standby screen. 

13 After you have connected you PC and this machine and installed the software, set the 

expansion tray unit in the printer driver. 
 Setting the printer driver(P.67) 

Installing the dedicated caster stand 

 Injury may be caused.  

The machine may tip over. Be sure to attach the supplied connecting parts. 
To install two or more expansion trays, be sure to mount the anti-tip feet. 

It is a stand with casters for moving this machine. 
It also comes with anti-tip feet to avoid the risk of tipping. It is recommended to use it when the expansion tray 
is installed. 
A Phillips screwdriver and a flat-head screwdriver are required to install the caster stand. 

 
 To install two or more expansion trays, be sure to install the dedicated caster stand, the anti-tip feet and the attached 

fixing parts to avoid the risk of tipping. 
 The packing case and cushioning materials are required to ship the dedicated caster stand. Keep them properly 

instead of discarding them. 

 

1 Press the power button to power off the main unit, and disconnect the power cord and any other 

cables. 
 
 If you install it with any cable connected, you may get injured by getting your feet trapped by the cable.  
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2 Check that you have all the parts of the dedicated caster stand. 
(1) Main unit 
(2) Anti-tip foot a (x 1) 
(3) Anti-tip foot b (x 3) 
(4) Positioning pin (x 2) 
(5) Metal fixtures of the caster stand (x 2) 
(6) Screw (x 2) 

 

3 Mount the anti-tip foot a on the front of the dedicated caster stand. 

 

4 Mount the anti-tip foot b (x 3) to both sides and the back of the dedicated caster stand. 

 

5 Check that the anti-tip foot a and the anti-tip foot b (x 3) are inserted in place by turning the 

dedicated caster stand upside down. 
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6 Turn the dedicated caster stand back and mount the positioning pin (x 2). Rotate to fix the 

positioning pin (x 2) with a flat-head screwdriver. 

 

7 Lock the caster (x 2) to prevent the dedicated caster from moving during the installation of the 

main unit and the expansion tray. 

 

8 Align the front of the main unit or expansion tray with the long holes at both ends of the front 

side of the dedicated caster stand, and gently stack them so that the positioning pins of the 

dedicated caster stand fit into the holes on the bottom. 

 

9 Fix the main unit or the expansion tray and the dedicated caster stand with the metal fixtures (x 

2) and the screws (x 2) by using a Phillips-head screwdriver. 
The figure shows an example of fixing the expansion tray and the dedicated caster stand. 
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10 To add an expansion tray unit, align the right side and front of the expansion tray unit attached 

to the dedicated caster stand and the right side and front of the expansion tray unit to be 

installed, and gently stack them so that the holes on the bottom and the protrusions are aligned. 

 

11 Use a flat-head screwdriver to connect the left and right sides of the stacked expansion tray 

units with the supplied connecting parts. 

 

12 To add an expansion tray unit, align the right side and front of the main unit and the expansion 

tray unit, and gently stack them so that the holes on the bottom of the main unit and the 

protrusions of the expansion tray unit are aligned. 

 



Preparations and connecting this machine to your PC 

- 31 - 

13 When an expansion tray is installed, fix the main unit and the expansion tray on both sides with 

the connecting parts supplied with the expansion tray by using a flat-head screwdriver. 

 

14 Before moving this machine, unlock the casters (x 2). 
 
 Press the casters while moving this machine. If you press the main unit, it may fall over. 

 

15 After moving the machine to the destination location, lock the casters (x 2) to avoid accidental 

movement. 

 

 
 When moving the machine or replacing consumables or maintenance parts, or loading paper in the tray, check 

the following points to prevent the printer from tipping over. 
 Press the casters while moving this machine. If you press the main unit, it may fall over. 
 Do not press on the cassette from above when the cassette is pulled out. 

 
 Do not press on this machine from the back with the cassette pulled out. 
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16 Plug the power cord or any removed cables back to this machine. 

17 Press the power button to power on this machine. 

18 If you have not installed an expansion tray unit, you are now done. 
If an expansion tray unit is installed, press the scroll button ▼ on the operator panel to select [Menus], 
and then press «OK». 

19 Check that [Information] is selected, and press «OK». 

20 Check that [Tray Count] is selected, and press «OK». 

21 Check that the expansion tray unit you installed appears on the display. 

22 After checking the display, press «CANCEL» to return to the standby screen. 

23 After you have connected you PC and this machine and installed the software, set the 

expansion tray unit in the printer driver. 
 Setting the printer driver(P.67) 
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Initialization upon power-on 

About the power supply 
Voltage: 110 to 127V AC (Range: 99 to 140V AC) / 220 to 240V AC (Range: 198 to 264V AC) 
Power frequency: 50/60 Hz 

 
 If the power supply is unstable, use a voltage regulator. 
 The maximum power consumption of this machine is 1,140W. Check that there is sufficient voltage capacity. 
 The performance cannot be assured if an uninterruptible power supply (UPS) or inverter is used. Do not use an 

uninterruptible power supply or inverter. 

 Otherwise, a fire may be caused.   

 Be sure to turn off the power supply before attaching or detaching the power cord or earth wire. 
 Be sure to connect the earth wire to the dedicated earth terminal. 

If you cannot get it grounded, contact the store where you purchased the product. 
 Never connect the earth wire to any water pipe, gas pipe, telephone line ground, lightning rod, etc. 
 Be sure to connect the earth wire before connecting the power cord to the power outlet. Also, be sure to unplug the 

power cord from the power outlet before disconnecting the earth wire. 
 Be sure to hold the power plug when connecting or disconnecting the power cord. 
 Be sure to insert the power cord all the way into the power outlet. 
 Do not connect or disconnect the power cord with wet hands. 
 Do not lay the power cord in a place where it may be stepped on, and do not place anything on the power cord. 
 Do not bundle or bind the power cord in use. 
 Do not use a damaged power cord. 
 Avoid octopus wiring. 
 Do not connect this machine and any other electric appliances to the same power outlet. In particular, if this 

machine shares a same power outlet with an air conditioner, copier, shredder, etc., this machine may malfunction 
due to electrical noise. If this machine has to share a power outlet with other appliances, use a commercially 
available noise filter or noise cut transformer. 

 Use the power cord provided with this machine and plug it directly into the power outlet. Do not use a power cord 
for other products with this machine. 

 Do not use any extension cord with this machine. If it is unavoidable, use one with a rating of 15A or higher. 
 If an extension cord is used, this machine may not work properly due to AC voltage drop. 
 Do not turn off the power supply or unplug the power cord while printing. 
 Unplug the power cord if it will be leave unused for a long period of time due to holidays or traveling. 
 Do not use the power cord that comes with this machine for any other products. 
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Connecting the power cord 

1 Plug the power cord into the power connector of this machine. 

 

2 Insert the power plug into the power outlet. 
For details on how to turn the power on and off, refer to "Turning the power on/off(P.73)". 

Initialization upon power-on of the machine 

1 Press and hold the power button for approx. 1 second. 

 

 

2 When the [Language Setup] screen appears on the display, press the scroll button ▼ on the 

operator panel to select the language you want to set, and then press «OK». 

 

3 Follow the on-screen instructions to set the time. 

4 When the setting is complete, "Ready To Print" is displayed. 
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Loading paper in the tray 

This section describes the procedure assuming that A4-sized plain paper is loaded in Tray 1 of B433 (i.e. the 
factory default state). To load paper of a different size or to load paper into B513, please refer to "Loading 
paper(P.74)". 
 

1 Pull out the lower paper cassette until it stops, and then lift it slightly upward to remove it. 

 

2 Hold the blue part of the paper stopper, and pull the paper stopper to the rear side of the paper 

cassette. 

 

3 Hold the blue part of the paper guide, and slide the paper guide to fit the width of the A4 size. 
 
 If the metal plate of the paper cassette is raised, press it down firmly until it clicks into place, and then insert it 

into the printer. If the metal plate is inserted into the main unit while it is raised, malfunction may be caused. 

 

 

 

4 Shuffle the paper well. Align edges of the paper horizontally. 
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5 Load the paper with the printing side down, and press it down from top. 
 
 Do not exceed the ▼ mark on the paper guide when loading paper. 

 

6 Insert the paper cassette into the main unit from slightly above and install it back to its original 

position. 
 
 If you return the paper cassette to the main unit by force, the paper stopper may shift. 

 

7 When the [Tray1 Config] screen is displayed, press «BACK». 
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Connecting via a wired LAN 

You can print by connecting this machine to a PC with a LAN cable. Connect the LAN cable, and set the IP 
address or the like on the operator panel. 
 

1-1. Connecting the LAN cable 

1 Prepare a LAN cable (category 5e or better, twisted pair, straight) and a hub. 

 

2 Press the power button to power off this machine. 
 
 If you are using the extended wired LAN module, please refer to "1-2. Installing the extended wired LAN module 

(For wired LAN2)(P.37)". 

3 Plug one end of the LAN cable into the network interface connector (LAN1) of this machine. 

 

4 Plug the other end of the LAN cable into the hub. 

 

Next, set network information like the IP address on this machine. 
 2. Setting the IP address or the like(P.41) 

1-2. Installing the extended wired LAN module (For wired LAN2) 

 
 Depending on the specific region, the extended wired LAN module may not be installed. 

Install it if you want to connect this machine to two different networks with a wired LAN. After installation, you 
need to enable the wired LAN module on the operator panel. 
 
This section describes the procedure for installing the extended wired LAN module and enabling the extended 
wired LAN module on the operator panel. 
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 It cannot be used together with the wireless LAN module at the same time. 

1 Press the power button to power off this machine, and then disconnect the power cord. 
 
 If you install it with the power supply turned on, the main unit or extended wired LAN module may be damaged. 
 Turning the power off(P.73) 

2 Insert the extended wired LAN module into the USB host port. 

 

3 Attach the power cord to this machine and one end of the LAN cable to the extended wired LAN 

module. 
 Initialization upon power-on(P.33) 

 

4 Plug the other end of the LAN cable into the hub. 

 

5 Press the power button to power on this machine. 

6 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 
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7 Press ▼ several times to select [Admin Setup], and press «OK». 

 

8 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

 

9 Check that [Network Setup] is selected, and press «OK». 

 

10 Check that [General Setup] is selected, and press «OK». 

 

11 Check that [Extended Network] is selected, and press «OK». 

 

12 Press ▼ to select [Wired(LAN2)], and press «OK». 

 

13 When [Are you sure?] is displayed, check that [Yes] is selected, and press «OK». 

 

14 The machine will restart, so wait until the standby screen appears. 
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15 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

16 Press ▼ several times to select [Admin Setup], and press «OK». 

 

17 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

 

18 Check that [Network Setup] is selected, and press «OK». 

 

19 Press ▼ several times to select [Wired(LAN2) Setup], and press «OK». 

 

20 Check that [Wired(LAN2)] is selected, and press «OK». 

 

21 Check that [Enable] is selected, and press «OK». 

 

Next, set network information like the IP address on this machine. 
 2. Setting the IP address or the like(P.41) 
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2. Setting the IP address or the like 
Set values suitable for the current environment on the operator panel. 
This section takes for example a connection to a standard wired LAN (LAN1). 
If you are using an extended wired LAN module, please read "Wired(LAN2) Setup" instead of "Wired(LAN1) 
Setup" and configure the settings. 
The following case is taken for example here. 
 IP address of this machine: 192.168.0.2 
 Subnet mask: 255.255.255.0 
 Gateway address: 192.168.0.1 

 

1 Press the power button to power on this machine. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

 

5 Check that [Network Setup] is selected, and press «OK». 

 

6 Press ▼ to select [Wired(LAN1) Setup], and press «OK». 
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7 Press ▼ to select [IP Address Set], and press «OK». 

 

To set the IP address manually, press ▼ to select [Manual] and then press «OK», and check that [*] is 
displayed to the left of the selected value. 
Go to Step 8. 

 

To obtain an IP address automatically, check that [Auto] is selected and [*] is displayed to the left of the 
selected value, and then press «BACK». 
Go to Step 14. 

 

8 Press «BACK», then press ▼ to select [IPv4 Address] on the [Wired(LAN1) Setup] screen, and 

finally press «OK». 

 

9 Since the first digit of the IP address is selected, press ▲ or ▼ to select the value to be set and 

then press «OK». 
When the cursor moves to the next digit, follow the same procedure to set the value. 

 

10 After all the values have been input, the cursor will return to the first digit. Check that [*] is 

displayed to the left of the set value, and then press «BACK». 
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11 Press ▼ to select [Subnet Mask], and press «OK». 

 

12 Set the subnet mask in the same way as the IP address. After all the digits have been set, the 

cursor will return to the first digit. Check that [*] is displayed to the left of the set value, and then 

press «BACK». 

 

13 Press ▼ to select [Gateway Address], and press «OK». 

 

14 Set the gateway address in the same way as the IP address. After all the digits have been set, 

the cursor will return to the first digit. Check that [*] is displayed to the left of the set value, and 

then press «BACK». 

 

15 Press «CANCEL» to return to the standby screen. 

3. Checking the connection from a PC 
Check the IP address of this machine, and access it from a PC by using the web browser. 
If you are using an extended wired LAN module, please read [Wired(LAN2) Setup] instead of [Wired(LAN1) 
Setup] and configure the settings. 
 

1 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

2 Check that [Configuration] is selected, and press «OK». 

3 Press ▼ several times to select [Network], and then press «OK». 
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4 Check that [Network Information] is selected, and press «OK». 

 

5 Press ▼ to select [Wired(LAN1) Information], and then press «OK». 

 

6 Press ▼ to select [IPv4 Address], and then press «OK». 

 

7 Take a note of the displayed IP address. 

8 Start the web browser in your PC. 

9 Input "https://(the IP address recorded in Step 7)", and press the «Enter» key. 
Connection is successful when the web page of this machine is displayed. 

 

 
 If the web page of this machine is not displayed, the network connection between the PC or other terminals and 

this machine has failed. 
Check if [IP Address Set], [IPv4 Address], [Subnet Mask] and [Gateway Address] of this machine are set 
correctly. 

 By default, when you are opening the machine's web page, use HTTPS instead of HTTP. 
 By default, when you are opening the machine's web page, a warning that it may not be a legitimate server will 

be displayed in your web browser. Set up the certificate appropriately, or temporarily ignore the warning. 
 If you cannot access the machine via HTTPS due to an expired certificate or a corrupted certificate, set [HTTPS 

Redirection (Web)] to [Disable] from the operator panel, access the web page via HTTP, and reset the HTTPS 
settings. 

 This machine does not support TLS 1.1 or lower. If the web browser you are using only supports TLS 1.1 or 
lower, use a web browser that supports TLS 1.2 or higher, or after understanding the security risks, set [HTTPS 
Redirection (Web)] to [Disable] from the operator panel and access the web page via HTTP. 

Then, go to "Installing software on your PC(P.63)". 
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Connection form via a wireless LAN 

There are two types of connection forms between this machine and the PC via a wireless LAN. Select the 
connection form according to your environment, and prepare what is necessary as per the following table for 
the connection. 

 
 Wireless LAN (Infrastructure) and wireless LAN (Wi-Fi Direct) cannot be used simultaneously. 
 Wired LAN1 and wireless LAN can be used at the same time. Please connect wired LAN1 and wireless LAN to 

different subnets since the communication may be unstable if they are connected to the same subnet. 
 Wireless LAN and extended wired LAN cannot be used simultaneously. 
 Do not place an electric appliance (especially microwave oven or digital cordless telephone) that emits weak 

electronic waves near this machine. 
 Wireless LAN connection may be inferior in communication speed compared to wired LAN connection or USB 

connection depending on the environment. When printing large data such as photos, we recommend you to print via 
a wired LAN or USB connection. 

If detailed settings such as security and server are required, set them from the web page of this machine. 
 Managing the machine from the web page(P.200) 

 
Form Infrastructure Wi-Fi Direct 

Connectio
n image 

  

Descriptio
n 

Connect this machine and the wireless terminal (PC, 
tablet, smartphone, etc.) via an access point. 

Without an access point, connect it directly to the 
wireless terminal (e.g. a PC, tablet, smartphone, 
etc.). 

Required 
preparatio
ns 

 Check the following information and take a note. 
 Wireless settings of the printer 
  Auto/Manual setting of the IP address 
  For manual setting: 
    IPv4 Address 
    Subnet Mask 
    Gateway Address 

 Check that your wireless LAN access point 
supports the following environment. 
Standard: IEEE 802.11 a/b/g/n/ac (2.4 Ghz/5 GHz) 
Access mode: Infrastructure mode 

 Check that the wireless LAN access point 
supports WPS-PBC (push button) and WPS-
PIN (PIN code). 

 If WPS (Wi-Fi Protected Setup) is not 
supported, check the SSID and encryption key 
with the User's Manual enclosed with your 
wireless access point. 

 Check that your wireless terminal supports the 
following environment. 
Standard: IEEE 802.11 b/g/n (2.4 Ghz) 
Security: WPA2-PSK (AES) 

 Wi-Fi Direct can only be used in the 2.4GHz 
band. 

 

Connectio
n method 

Connecting via an access point (Infrastructure)(P.46) Connecting directly with this machine (Wi-Fi 
Direct)(P.58) 

 
 SSID is also called the network name, ESSID or ESS-ID. 
 Encryption key is also called the network key, security key, password, or pre-shared key (PSK). 
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Connecting via an access point (Infrastructure) 

 
 Put this machine in an unobstructed view position near the wireless LAN access point. (The recommended distance 

is 30 m or less.) 
 It may be difficult to connect if there is a metal, aluminum sash or reinforced concrete wall between this machine and 

the wireless LAN access point. 
 5GHz band (W52/53) is prohibited to use outdoors due to the Radio Law. Use it indoor only. 

 

1. Enabling the wireless LAN function 

1 Press the power button to power on this machine. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

 

5 Check that [Network Setup] is selected, and press «OK». 

 

6 Check that [General Setup] is selected, and press «OK». 

 



Preparations and connecting this machine to your PC 

- 47 - 

7 Check that [Extended Network] is selected, and press «OK». 

 

8 Press ▼ to select [Wireless], and press «OK». 

 

9 When [Are you sure?] is displayed, check that [Yes] is selected, and press «OK». 

 

10 The machine will restart, so wait until the standby screen appears. 
If [Not connected to wireless access point] is displayed, press «OK». 
When [Set-up wireless?] is displayed, select [No], and then press «OK». 

2. Enabling infrastructure 

1 Press the scroll button ▼ on the operator panel several times to select [Wireless Setting], and 

press «OK». 

 

2 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

3 Press ▼ to select [Wireless(Infrastructure) Setting], and press «OK». 
 
 "Cannot be used simultaneously with Wireless(Wi-Fi Direct)." will be displayed for about 5 seconds. 

4 Press ▲ to select [Enable], and press «OK». 

 

 
 After setting [Wireless(Wi-Fi Direct)] to [Disable], if a screen appears to ask you to check whether or not to 

enable [Wireless(Infrastructure)], press «OK» to set [Wireless(Infrastructure)] to [Enable]. 

To set the IP address of this machine manually, go to "3. Setting the IP address(P.48)". 
To obtain an IP address automatically, go to "4. Connecting with the wireless access point(P.50)". 
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 The factory default setting is [Auto]. 

3. Setting the IP address 
If you want to set the machine's IP address to a fixed value, follow the procedure below. 

 
 For [Auto], the machine's IP address may change dynamically. 

 
 For [IPv4 Address], set a value which is not overlapped to any other networked machines. 
 If you do not use the IPv6 address, set [DHCPv6] to [Disable]. 

The following case is taken for example here. 
 IP address of this machine: 192.168.101.2 
 Subnet mask: 255.255.255.0 
 Gateway address: 192.168.101.1 

 

1 Press the scroll button ▼ on the operator panel several times to select [Wireless Setting], and 

press «OK». 

2 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

3 Press ▼ to select [Wireless(Infrastructure) Setting], and press «OK». 
 
 "Cannot be used simultaneously with Wireless(Wi-Fi Direct)." will be displayed for about 5 seconds. 

4 Press ▲ to select [Enable], and press «OK». 

 

5 Press ▼ to select [Network Setting], and press «OK». 

 

6 Check that [IP Address Set] is selected, and press «OK». 
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7 Press ▼ to select [Manual], and press «OK». 

 

8 Press «BACK», then press ▼ to select [IPv4 Address] on the [Network Setting] screen, and 

finally press «OK». 

 

9 Since the first digit of the IP address is selected, press ▲ or ▼ to select the value to be set and 

then press «OK». 
When the cursor moves to the next digit, follow the same procedure to set the value. 

 

10 After all the values have been input, the cursor will return to the first digit. Check that [*] is 

displayed to the left of the set value, and then press «BACK». 

 

11 Press ▼ to select [Subnet Mask], and press «OK». 

 

12 Set the subnet mask in the same way as the IP address. After all the digits have been set, the 

cursor will return to the first digit. Check that [*] is displayed to the left of the set value, and then 

press «BACK». 
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13 Press ▼ to select [Gateway Address], and press «OK». 

 

14 Set the gateway address in the same way as the IP address. After all the digits have been set, 

the cursor will return to the first digit. Check that [*] is displayed to the left of the set value, and 

then press «BACK». 

 

15 Press «CANCEL» to return to the standby screen. 

4. Connecting with the wireless access point 
There are three ways as follows. 
 4-1. Connecting by selecting a wireless LAN access point(P.50) 
 4-2. Connecting with WPS(P.52) 
 4-3. Manual setup and connection(P.53) 

 
 To connect with wireless LAN by WPA/WPA2-EAP, refer to "Setting IEEE802.1X (Wireless LAN)(P.211)". 

4-1. Connecting by selecting a wireless LAN access point 
When the wireless LAN access point does not support WPS or when WPS connection does not function well, 
connect by specifying the wireless access point to be used from the list of wireless access points detected by 
this machine. In this case, it is required to input the SSID and encryption key. 

1 Check and take a note of the SSID and encryption key on the side of the wireless LAN access 

point or in the User's Manual enclosed with the access point. 
 
 WPA-EAP, WPA2-EAP and WPA3-EAP cannot be set from the operator panel. Set them from the web page of 

this machine. 
 Opening the web page(P.200) 

2 Check that the wireless LAN access point is activated and operating properly. 

3 Press the scroll button ▼ on the operator panel several times to select [Wireless Setting], and 

press «OK». 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

5 Press ▼ to select [Wireless(Infrastructure) Setting], and press «OK». 
 
 "Cannot be used simultaneously with Wireless(Wi-Fi Direct)." will be displayed for about 5 seconds. 
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6 Press ▲ to select [Enable], and press «OK». 

 

7 Press ▼ several times to select [Wireless Network Selection], and then press «OK». 

 

This machine starts searching for wireless LAN access points. 

8 A list of SSIDs of available wireless LAN access points is displayed. Press ▲ or ▼ to select the 

SSID of the wireless LAN access point recorded in Step 1, and press «OK». 

 

If no wireless LAN access point is found, only [Manual Setup] is displayed. In that case, make settings by 
following "4-3. Manual setup and connection(P.53)". 

9 When the encryption key entry screen suitable for the encryption method of the selected 

wireless LAN access point is displayed, input the encryption key recorded in Step 1, and press 

«OK». 
 
 The encryption key varies with the wireless LAN access point and security method. 

 If "WPA Pre-shared key" is displayed 
  Encryption method: WPA/WPA2-PSK, WPA2-PSK, WPA2-PSK/WPA3-SAE or WPA3-SAE 
  Encryption key: Input the WPA Pre-shared key. 

 If "WEP Key" is displayed 
  Encryption method: WEP 
  Encryption key: Input the WEP key. 

 In other cases 
  Encryption method: Disable (Invalid) 
  No need to enter the encryption key. 

10 "Implementing this method?" is displayed, and the SSID and the security of the access point 

selected in Step 8 from the confirmation screen are displayed. If the SSID is the same as the 

one recorded in Step 1, press «OK». 

 

11 When a screen appears indicating that the connection was successful, the connection to the 

wireless LAN access point is completed. 



Preparations and connecting this machine to your PC 

- 52 - 

12 Go to "6. Checking the connection from a PC(P.56)". 

 
 When "Not connected to wireless access point" is displayed, repeat the procedure from Step 4, or try "4-3. Manual 

setup and connection(P.53)". 

4-2. Connecting with WPS 
If the wireless LAN access point supports WPS, you can easily connect to the wireless LAN using the push 
button for easy setup (WPS button). 
 

1 Check the position of push button for easy setup (WPS button) and the time for which the 

button is pressed in the User's Manual enclosed with the wireless LAN access point. 

2 Check that the wireless LAN access point is activated and operating properly. 

3 Press the scroll button ▼ on the operator panel several times to select [Wireless Setting], and 

press «OK». 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

5 Press ▼ to select [Wireless(Infrastructure) Setting], and press «OK». 
 
 "Cannot be used simultaneously with Wireless(Wi-Fi Direct)." will be displayed for about 5 seconds. 

6 Press ▲ to select [Enable], and press «OK». 

 

7 Press ▼ several times to select [Automatic setup (WPS)], and then press «OK». 

 

8 Check that [WPS-PBC] is selected, and press «OK». 

 

9 When "Implementing this method? Pushbutton method" is displayed, check that [Yes] is 

selected, and press «OK». 
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"Running pushbutton method" is displayed, and this machine will start to search for a wireless LAN 
access point. 

 

Press and hold the push button of wireless LAN access point for the period of time confirmed in Step 1 or 
for a few seconds. 

10 When a screen appears indicating that the connection was successful, the connection to the 

wireless LAN access point is completed. 

11 Go to "6. Checking the connection from a PC(P.56)". 

 
 When "Not connected to wireless access point" or "Connection failed." is displayed, repeat the procedure from Step 

1, or try "4-3. Manual setup and connection(P.53)". 

4-3. Manual setup and connection 
Set the wireless LAN access point information (SSID, encryption method, encrypted key) manually, and 
connect to the wireless LAN. 
 

1 Check and take a note of the SSID, encryption method and encryption key in the User's Manual 

enclosed with the wireless LAN access point. 
 
 WPA-EAP and WPA2-EAP cannot be set from the operator panel. Set them from the web page of this machine. 

 Opening the web page(P.200) 

 
 SSID is also called the network name, ESSID or ESS-ID. 
 Encryption key is also called the network key, security key, password, or pre-shared key (PSK). 

2 Check that the wireless LAN access point is activated and operating properly. 

3 Press the scroll button ▼ on the operator panel several times to select [Wireless Setting], and 

press «OK». 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

5 Press ▼ to select [Wireless(Infrastructure) Setting], and press «OK». 
 
 "Cannot be used simultaneously with Wireless(Wi-Fi Direct)." will be displayed for about 5 seconds. 

6 Press ▼ several times to select [Wireless Network Selection], and then press «OK». 

 

Start searching for wireless LAN access points. Please wait. 
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7 A list of SSIDs of available wireless LAN access points is displayed. Press ▼ several times to 

select [Manual Setup] at the end of the list, and then press «OK». 

 

8 Check that [SSID] is selected, and press «OK». 

 

9 Input the SSID recorded in Step 1, and press «OK». 

 

10 Press ▼ to select [Security], and then press «OK». 

 

11 Select the encryption method recorded in Step 1, and press «OK». 

 

12 Press ▼ to select [WPA Pre-shared Key], and press «OK». 
 
 If [WEP] is selected in [Security], the item name is displayed as [WEP key]. 

 

13 Input the encryption key recorded in Step 1, and press «OK». 
 
 The encryption key varies with the wireless LAN access point and security method. 
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14 Press ▼ to select [Execute], and then press «OK». 

 

15 "Implementing this method?" is displayed, and the SSID input in Step 9 and the encryption 

method selected in Step 11 are displayed as security on the confirmation screen. If the SSID is 

the same as the one recorded in Step 1, press «OK». 

 

16 When a screen appears indicating that the connection was successful, the connection to the 

wireless LAN access point is completed. 

17 Go to "6. Checking the connection from a PC(P.56)". 

 
 When "Not connected to wireless access point" is displayed, repeat the procedure from Step 4. 
 If you cannot connect, refer to "Troubleshooting for wireless LAN connection(P.391)". 
 For segment-based communication with a wireless LAN (infrastructure), refer to "5. Choosing a valid default 

gateway(P.55)". 

5. Choosing a valid default gateway 
By default, [Enabling Default Gateway] is set to [Wired(LAN1)]. This machine can use a wired LAN and 
wireless LAN at the same time, but only either of them can be used to connect a terminal outside the segment 
(a different subnet). 
When a wireless LAN (infrastructure) is used to communicate across segments, follow the following procedure 
to change into [Wireless(Infrastructure)]. 
 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

5 Check that [Network Setup] is selected, and press «OK». 
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6 Check that [General Setup] is selected, and press «OK». 

 

7 Press ▼ to select [Enabling Default Gateway], and then press «OK». 

 

8 Press ▼ to select [Wireless(Infrastructure)], and then press «OK». 

 

9 Press «CANCEL» to return to the standby screen. 

6. Checking the connection from a PC 
Check the IP address of the device, and access it from a PC by using the web browser. 
 

1 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

2 Check that [Information] is selected, and press «OK». 

3 Press ▼ several times to select [Network], and then press «OK». 

 

4 Press ▼ to select [Wireless(Infrastructure) Information], and then press «OK». 
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5 Press ▼ several times to select [IPv4 Address] and then press «OK». 

 

6 Take a note of the displayed IP address. 

7 Start the web browser in your PC. 

8 Input "https://(the IP address recorded in Step 6)", and press the «Enter» key. 
Connection is successful when the web page of this machine is displayed. 

 

 
 By default, when you are opening the machine's web page, use HTTPS instead of HTTP. 
 By default, when you are opening the machine's web page, a warning that it may not be a legitimate server will 

be displayed in your web browser. Set up the certificate appropriately, or temporarily ignore the warning. 
 If you cannot access the machine via HTTPS due to an expired certificate or a corrupted certificate, set [HTTPS 

Redirection (Web)] to [Disable] from the operator panel, access the web page via HTTP, and reset the HTTPS 
settings. 

 This machine does not support TLS 1.1 or lower. If the web browser you are using only supports TLS 1.1 or 
lower, use a web browser that supports TLS 1.2 or higher, or after understanding the security risks, set [HTTPS 
Redirection (Web)] to [Disable] from the operator panel and access the web page via HTTP. 

Then, go to "Installing software on your PC(P.63)". 
When using a mobile device, go to "Printing from a mobile device(P.277)". 
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Connecting directly with this machine (Wi-Fi Direct) 

 
 It may be difficult to connect if there is a metal, aluminum sash or reinforced concrete wall between this machine and 

the wireless terminal. 
 Up to 4 mobile devices can be connected simultaneously to this machine Wireless(Wi-Fi Direct). You cannot connect 

5 or more mobile devices simultaneously. 

1. Enabling the wireless LAN function 

1 Press the power button to power on this machine. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

 

5 Check that [Network Setup] is selected, and press «OK». 

 

 
 

6 Check that [General Setup] is selected, and press «OK». 
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7 Check that [Extended Network] is selected, and press «OK». 

 

8 Press ▼ to select [Wireless], and press «OK». 

 

9 When [Are you sure?] is displayed, check that [Yes] is selected, and press «OK». 

 

10 The machine will restart, so wait until the standby screen appears. 

2. Enabling Wi-Fi Direct 

1 Press the scroll button ▼ on the operator panel several times to select [Wireless Setting], and 

press «OK». 

 

2 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

3 Check that [Wireless(Wi-Fi Direct)] is selected, and press «OK». 

 

 
 "Cannot be used simultaneously with wireless(infrastructure)." will be displayed for about 5 seconds. 

4 Press ▲ to select [Enable], and press «OK». 

 

 
 After setting [Wireless(Infrastructure)] to [Disable], if a screen appears to ask you to check whether or not to 
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enable [Wireless(Wi-Fi Direct)], press «OK» to set [Wireless(Wi-Fi Direct)] to [Enable]. 

5 Press «CANCEL» to return to the standby screen. 

3. Connecting with a device 
Input the SSID and password of this machine in the wireless terminal to connect. 
 

1 Press the scroll button ▼ on the operator panel several times to select [Wireless Setting], and 

press «OK». 

 

2 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

3 Check that [Wireless(Wi-Fi Direct) Setting] is selected, and press «OK». 
 
 "Cannot be used simultaneously with wireless(infrastructure)." will be displayed for about 5 seconds. 

4 Press ▲ to select [Enable], and press «OK». 

 

5 Press ▼ several times to select [Manual Setup], and then press «OK». 

 

6 Check that [SSID], [Security] and [Password] of this machine are displayed. 
 
 The screens shown here are examples, and they may differ from the actual display. 

 

7 Input [SSID] and [Password] of this machine confirmed in Step 6 in the wireless terminal to 

connect. 
 
 If the wireless terminal is set to obtain the IP address automatically, you can communicate by connecting to this 

machine via Wi-Fi Direct and allocating the IPv4 address automatically to the wireless terminal. 
 The factory default IP address is [192.168.110.100]. 
 If you cannot connect, see "Troubleshooting for wireless LAN connection(P.391)".  
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Then, go to "Installing software on your PC(P.63)". 
When using a mobile device, go to "Printing from a mobile device(P.277)". 
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Connecting via USB 

You can print by connecting this machine to a PC with a USB cable. 
 

1 Prepare a USB 2.0 cable. 
 
 Not compatible with USB 3.0. 
 The connector shape on the machine side is of type B. 

 

 
 To connect in the USB 2.0 hi-speed mode, use a USB cable compliant with USB 2.0 hi-speed specifications. 

2 Press the power button to power off this machine. 

3 Plug one end of the USB cable into the USB interface connector of this machine. 
 
 Do not insert the USB cable into the network interface connector. Otherwise, malfunction may be caused. 

 

4 Plug the other end of the USB cable into the USB interface connector of the PC. 

 

Then, go to "Installing software on your PC(P.63)". 
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Installing software on your PC 

Printer drivers and related software can be downloaded from our website and then installed on your PC. 
If your PC comes with a DVD drive, you can install the software from the included DVD. 

 
 Software cannot be installed on an OS that is not listed in the operating environment. 
 The screen display may differ from the description depending on the version of Windows or macOS and the specific 

printer driver. 

Operating environment 
 Windows 11 
 Windows 10 
 Windows Server 2025 
 Windows Server 2022 
 Windows Server 2019 
 Windows Server 2016 
 macOS 15 - 12 

 
 For details about printing from ChromeOS, please visit our website. 

Printer driver types 
Both the PCL printer driver and PS printer driver are available. 
For normal printing, please use the PCL printer driver. The PS printer driver is suitable for printing documents 
containing the ESP data or the PostScript font. 

 Screens and functions of the printer driver(P.131) 

 

For Windows 

1 Check that this machine and the PC are connected, and that the power supply is on. 

2 Download the "Software Package for Windows" from our website. 
Or, prepare the included DVD. 

3 Open the downloaded file. 
Or, insert the included DVD into the PC, and click [Run Setup.exe] when the [DVD drive] screen is 
displayed. 

 
 If the [User Account Control] screen is displayed, click [Yes]. 
 If the [DVD drive] screen is not displayed, open DVD from the Explorer. 

4 Choose a language from the pull-down menu of language selection in the [Welcome] screen. 

5 Read the software license agreement, and click [Accept]. 

6 Read the environmental advice, and click [Next]. 
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7 Click either [Network connection] or [USB connection] depending on the connection method 

between the PC and this machine. 

 

8 Select the model name of this machine, and click [Next]. 
 
 If the printer is not displayed with a network connection, input the IP address assigned to the printer by selecting 

[Search Address], and click [Search]. 

 

9 Click [Recommended Install]. 
 
 The following software will be installed. 

 PCL6 printer driver 
 Monitoring Tool 

 Other software is installed from either [Batch Install] or [Individual Install]. 

 

10  Click [Start]. 
 
 If the [Specify Device Information] screen appears, check the settings and click [Execute]. 

 

11 Check that the software installation is complete. 
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12 Click [Exit]. 

 

13 When the [Firmware update] screen is displayed, click [Next] if it is not necessary to update. 
Click [Confirm] if you do not know or an update is required. 

 
 You can update it later. For details, see the support page on our website. 

 

14 If the [Warning] screen appears, click [OK]. 

 

15 Click [Exit]. 

 

Now installation is completed. 
If you install options like the expansion tray unit, change the settings of printer driver. 

 Setting the printer driver(P.67) 
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For macOS 
This section takes for example the installation of macOS PCL printer driver. 
To install the macOS PS printer driver, replace "PCL" with "PS". 
 

1 Check that this machine and the PC are connected, and that the power supply is on. 

2 Download the "Software Package for Mac” from our website. 
Or, prepare the included DVD. 

3 Open the downloaded file. 
Or, insert the included DVD into your PC and copy the file to your desktop. 

4 Double-click on the [OKI] icon on the desktop. 

5 Double-click on [Drivers] - [PCL] - [Installer for macOS]. 

6 Finish the installation by following the on-screen instructions. 

7 Select [System Preferences] from the Apple menu. 

8 Click [Printers & Scanners]. 

 

9 Click [Add Printer, Scanner or Fax]. 
 
 If it is requested to input the administrator name and password, input them by following the on-screen 

instructions. 

10 Click [Default]. 

11 Select this machine from the list. Select [Select Software...] from [Drivers], and then select [OKI 

*** PCL] (where *** is your model name) from the [Printer Software] list. 
 
 If [OKI *** PCL] (where *** is your model name) is not listed in [Drivers], select [Select Software...] from 

[Drivers], and then select [OKI *** PCL] (where *** is your model name) from the [Printer Software] list. 
Connection method Listed name Type 

Network OKI-*** (Last 6 digits of the MAC address) (where *** is your model 
name) 

Bonjour 

USB OKI LTD *** (where *** is your model name) USB 
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 The MAC address can be checked by pressing the scroll buttons on the operator panel to print the network 

information from [Print Information] - [Network]. 
 To change the name, input a new name to be used in [Name]. 

 

12 Click [Add]. 
 
 If the option confirmation screen appears, click [OK]. 

13 Once the machine is added to the [Printers] list, select the machine to display the menu. Make 

sure that "OKI *** PCL" (where *** is your model name) is displayed in [Type]. 
 
 If "OKI *** PCL" (where *** is your model name) is not displayed in [Type], select this machine from [Printers] 

and then click [Delete Printers] to delete it. Then, repeat Steps 8 to 11. 

 

14 Click [Open the Print Queue]. 
 
 When [Upgrade to recommended AirPrint...] is displayed, click [Don't Upgrade]. 

15 Select [Print Test Page] from the [Printers] menu. 

 

Installation is completed when the test page is printed. 
If you install options like the expansion tray unit, change the settings of printer driver. 

 Setting the printer driver(P.67) 

Setting the printer driver 
If an expansion tray unit has been installed, after installing the printer driver, change the settings of the printer 
driver by the following procedure. 

 Installing software on your PC(P.63) 

 
 To perform this procedure, you will have to login to the PC as a user with administrator privileges. 
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For the Windows PCL printer driver 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the [OKI *** PCL6] icon (where *** is your model name) and select [Printer 

Properties]. 

3 Select the [Device Options] tab. 

4 Click [Get Printer Settings]. 

 

5 Click [OK]. 
 

For the Windows PS printer driver 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the [OKI *** PS] icon (where *** is your model name) and select [Printer 

Properties]. 

3 Select the [Device Settings] tab. 

4 Select [Get installed options automatically] in [Installable Options], and click [Setup]. 

 

5 Click [OK]. 
 

For the macOS PCL printer driver 

 
 Depending on the timing when the printer is added, the information for the expansion tray unit may have been set. 

1 Select [System Preferences] from the Apple menu. 

2 Click [Printers & Scanners]. 



Preparations and connecting this machine to your PC 

- 69 - 

3 Select your model, and click [Options and Supplies]. 

4 Select the [Options] tab. 

5 Select the total number of trays from [Available Trays], and click [OK]. 

 

 

For the macOS PS printer driver 

 
 Depending on the timing when the printer is added, the information for the expansion tray unit may have been set. 

1 Select [System Preferences] from the Apple menu. 

2 Click [Printers & Scanners]. 

3 Select your model, and click [Options and Supplies]. 

4 Select the [Options] tab. 

5 Select the total number of trays from [Available Trays], and click [OK]. 
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Parts identification 

This section explains the name and functions of each part of the main unit. 

Front 

  
No. Name Function 

1 Top cover (front) 
(Output tray) 

Open it when replacing toner cartridges. 
Holds the paper ejected with the print side facing down. 

2 Top cover (rear) 
(Output tray) 

Open it when replacing the image drum or maintenance kit. 
Holds the paper ejected with the print side facing down. 

3 Operator panel This is the panel used to operate the main unit. 
It comes with a display, functional buttons, an ATTENTION lamp, 
etc. 

 Parts identification of the operator panel(P.92) 
 

4 Power button Turns on and off the power of the main unit. 

5 Wireless LAN module cover A cover for the housing of the wireless LAN module. 

6 Air vents Allows air to enter and exit from the inside of the main unit. There 
are air vents also on the left side and the rear side of the 
machine. 
Be careful not to block the air vents. 

7 Paper cassette of Tray 1 Holds the paper to print. 

8 NFC mark 

 
 Depending on the specific region, this 

machine may not come with the NFC 
function. 

When using the NFC function, bring your mobile device close 
here. For details about the NFC function, refer to "Printing from a 
mobile device(P.277)". 

9 Multi-purpose tray (MP tray) Holds paper of various sizes. 

10 Paper supporter Pull it out to load paper in the MP tray. 

11 Top cover (rear) open button Press it to open the top cover (rear). 

12 Password label Lists the factory default password. 
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Inside the main unit 

    

No. Name Function 

1 Toner cartridge, image drum The toner cartridge contains toner (powder ink) for printing. 
The image drum is a unit to create an image on the paper by 
using toner, which comes with a toner cartridge. 
Both the toner cartridge and the image drum are consumables. 

2 LED head Writes an image onto the image drum using light. 

3 Fuser unit This unit fixes the toner to the paper. 

4 Transfer roller This unit transfers toner to the paper. 

Back 

 
No. Name Function 

1 Power connector This is where the included power cord is plugged in. 

2 Rear output tray Holds the paper ejected with the print side facing up. 

3 Interface unit There is a connector to connect to a PC. 

4 USB interface connector This is where the USB cable is plugged in when the computer 
and the main unit is connected with a USB cable. 

5 USB Host This is where the USB memory or extended wired LAN module is 
inserted. 

6 Network interface connector (LAN1) This is where the LAN cable is plugged in when the computer and 
the main unit is connected via a network. 

7 Serial number The machine-specific number. 
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Turning the power on/off 

For details about power cord connection, please refer to "Initialization upon power-on(P.33)". 
 

Turning the power on 

1 Press and hold the power button for approx. 1 second. 

 

When this machine gets ready, "Ready To Print" will appear on the display. 
When the power is turned on for the first time, the [Language Setup] screen appears on the display. Set the 
language by following the on-screen instructions. 
 

Turning the power off 

1 Press and hold the power button for approx. 1 second. 

 

2 "Shutting down. Please wait. The power will turn off automatically" appears on the display. 

3 Wait a moment until this machine is powered off automatically. 
 
 Please wait. This may take about 5 minutes to turn off the power. 
 Press and hold the power button for more than 5 seconds to turn off the power by force. Use it only if a problem 

has occurred. For troubles with this machine, please refer to "Troubleshooting for the machine(P.407)". 
 If the power supply is stopped unexpectedly due to a power failure or forcibly turning the power off, the device 

configuration information stored in the machine may become corrupted. 
Turn off the power by following the correct procedure, except in unavoidable circumstances. 
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Loading paper 

Procedure for loading paper 

1. Check the applicable paper. 
 Applicable paper(P.74) 
 Inapplicable paper(P.75) 

2. Load the paper in the tray. 
 Paper applicable to each tray(P.78) 
 Loading paper in Tray 1 (for B433)(P.79) 
 Loading paper in Tray 1 (for B513) or Tray 2/3/4 (Optional)(P.80) 
 Loading paper in the MP tray(P.82) 

3. Set the paper information (e.g. the paper size, media type, media weight) on the 
operator panel. 

 Setting paper information on the operator panel(P.84) 

Applicable paper 
In order to maintain high-quality printing, it is necessary to use paper that fulfills the quality, weight and 
surface finish conditions. Please use electrophotographic paper. 
If you are printing on non-recommended paper, thoroughly test the print quality and paper traction beforehand 
and check that there are no problems before use. 
In addition, to avoid injury by the edge of paper, wear gloves or the like. 
For precautions for printing on various types of paper, please refer to "Paper precautions by type(P.76)". 

Media type Paper size Media weight Other conditions 
Plain paper 
 
 
 

A4 For simplex printing: 
60 - 256 g/m2 
For duplex printing: 
60 - 163 g/m2 
 
 
 
 
 

The paper of the following sizes are not 
applicable to duplex printing. 
 A5, A6, B6, B7, Statement, 8.5" SQ, 

4" x 6", 5" x 7" 
 For custom sizes, paper smaller 

than 182 x 257 mm, or paper larger 
than 216 x 356 mm 

The custom-sized paper must meet the 
requirements for plain paper. 

A5 
A6 
B5 
B6 
B7 
Letter  
Legal 13 
Legal 13.5 
Legal 14 
Executive  
Statement 
8.5" SQ 
Folio 
4" x 6" 
5" x 7" 
Custom 
Width: 86 - 216 mm 
Length: 127 - 1,321 mm 
Long paper 128 g/m2  

Envelope Nagagata#3 Using paper with a 
weight of 85 g/m2 

Media made of craft paper, 
electrophotographic paper or dry PPC 
paper. 
Duplex printing is not available. 

Nagagata#4 
Yougata#0 
Yougata#4 
C5 
C6 
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Media type Paper size Media weight Other conditions 
DL 
COM-9 
COM-10 
Monarch 

Label A4 Total weight: 0.1 - 0.2 
mm 

Labels for electrophotographic printers or 
dry PPCs where the surface paper, 
adhesive, and backing are not degraded 
by heat. 
Media with a structure that prevents the 
front paper from peeling off from the 
backing in the heat fixing process of the 
printer. 
Media with a structure that prevents the 
front paper from peeling off the backing 
when the paper is traveling. 
Media with a combined weight of 0.1 to 
0.2 mm of front paper and backing. 
Media whose surface paper covers the 
entire backing sheet with no adhesive 
sticking out. 
Media with no breaks or creases. 
Duplex printing is not available. 

Letter 

Partially printed 
paper 

Equivalent to plain paper For simplex printing: 
60 - 256 g/m2 
For duplex printing: 
60 - 163 g/m2 

Media whose ink used for partial printing 
is heat resistant and can withstand 
230°C. 

Colored paper Equivalent to plain paper For simplex printing: 
60 - 256 g/m2 
For duplex printing: 
60 - 163 g/m2 

Media whose pigment or ink used to 
color the paper is heat resistant and can 
withstand 230°C. 
Media made of electrophotographic 
paper with the same features as plain 
paper. 

 
 If the paper grain direction does not match the paper feeding direction, paper jams may occur. 
 Printing from the MP tray may cause wrinkles. In this case, feed paper from the paper cassette. 
 The paper wrapper shows the orientation of the surface. Load paper properly so that the surface is the printing 

surface. 
 After unpacking, rewrap the remaining paper in the wrapping paper and reseal it, or place it in a plastic bag and close 

it tightly, and then store it in a low-humidity area. 
 The paper is wrapped in moisture-proof paper to prevent moisture. Please use the paper as early as possible after 

opening its package. 
 Wrap unused paper in the wrapping paper, and keep it away from moisture absorption as much as possible. 
 If it is used beyond the normal room temperature (temperature: 17°C to 25°C; humidity: 40% to 60%), the printing 

quality may be degraded or problems may occur such as paper jams, wrinkles, curls, and warpage. 
 Depending on the installation environment of the machine, printing on paper that contains moisture may cause white 

steam or water droplets to appear around the paper exit area of the machine. This is not abnormal because the heat 
generated when the toner is fixed to the paper evaporates the moisture contained in the paper. 

Inapplicable paper 
Do not use the following types of paper. Doing so may cause paper jams or malfunction. 
 Paper with smooth surface, rough paper, and paper with different front and back roughness 
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 Paper that is too thin or too thick 
 Paper with much paper dust 
 Short grain paper (Do not use for vertical feeding.) 
 Wet (damp) paper 
 Paper with curl, curve or wave due to humidity 
 Paper stuck by static electricity 
 Paper and envelopes that have been textured, embossed or coated (coated paper, glossy paper) 
 Paper specially processed with glue, chemicals, etc. 

 Paper specially processed without heat resistance (230°C) 

 Paper with holes, perforations, notches, holes for binder 
 Paper that has irregularities, crushing, burrs, etc. on the paper cut surface 
 Non-square shaped paper, or paper whose cutting angle is not right 
 Paper or envelopes with wrinkles, warping, corner bending, waving, creases, tears, etc. 
 Paper with staples, clips, ribbons, tapes, clasps, etc. 
 Special paper such as carbon paper, non-carbon paper, thermal paper, and pressure-sensitive paper 
 Thermal transfer printer paper, ink jet paper, wet PPC paper, copying paper, Japanese paper, etc. 
 Envelopes sticked with stamps 
 Envelopes that are too thick 
 Envelope made of plastic 
 Double envelopes with inner bags 
 Envelopes with clasps, buttons or windows 
 Envelopes sticked with double-sided tape or with adhesive on the flap 
 Envelopes with water repellency 

Paper precautions by type 

Plain paper 
 For thick paper, the toner may stick thinly to the whole paper or the printing may be light. 

Partially printed paper 
 When a printing frame is set, design it with careful considerations of the following variations in the printing 

position. 

Output position accuracy: ±2 mm; paper slant: ±1 mm/100 mm (except for duplex printing); image 

expansion and contraction: ±1 mm/100 mm (except for duplex printing, when the paper weight is 64 
g/m2) 

 This machine cannot print over a printed area. 

Envelopes 
 The paper may warp or wrinkle after printing. 
 The toner may stick thinly to the whole paper or the printing may be light. 
 The toner may be easily removed. 
 The printing quality may decline in an area of about 5 mm around the sealing part (of different weights) of 

the envelope. 
 The warps on an envelope may cause poor paper feeding. Use the envelope after correcting warps or 

bulges. 
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 If the glued part at the rear edge of the envelope is bent, it may cause poor paper feeding. Correct the 
bending before use. 

 Duplex printing is not available. 
 Always perform trial printing and check that there are no problems. 

Labels 
 The toner may stick thinly to the whole paper or the printing may be light. 
 The toner may be easily removed. 
 The warps on the front edge of a label may cause poor paper feeding. Use labels after correcting warps 

or bulges. 
 Duplex printing is not available. 
 Always perform trial printing and check that there are no problems. 

Long paper 
 For thick paper, the toner may stick thinly to the whole paper or the printing may be light. 
 If the paper grain direction does not match the paper feeding direction, paper jams may occur. 
 Do not use paper that has been printed once with a thermal transfer printer, inkjet printer, etc. 
 The paper wrapper shows the orientation of the surface. Load paper properly so that the face side is the 

printing side. 
 The paper is wrapped in moisture-proof paper to prevent moisture. Please use the paper as early as 

possible after opening its package. 
 If the paper has a GSM weight other than 128 g/m2, the print quality may deteriorate. Always perform trial 

printing and check that there are no problems. 
 Be sure to set the paper size to a vertical length. The vertical length cannot be set to a value shorter than 

the horizontal length. 
 Some applications may not be available. 
 Even when using under the recommended conditions, the long paper with a length exceeding 356 mm 

may not be able to guarantee the print quality. 

Irregular paper (Custom) 
 Skewing, curling, warping, folded corners (the edge is folded) and paper jams caused by these factors 

may occur. Check the print result of the paper to be used in advance. 
 Register the paper in portrait orientation and load it in portrait orientation in the tray. 
 Some applications may not be available. 
 The quality of printing on the paper with a length exceeding 356 mm will be not guaranteed. 
 If the paper is too long and protrudes from the paper supporter of the MP tray, support the paper with 

your hand. 
 For the paper size that can be fed from each tray and the paper size that can be printed on both sides, 

please refer to "Applicable paper(P.74)". 
 If you cannot print correctly on a large-sized paper, it is suggested to set [Quality] to [Normal] in the PS 

printer driver. 
 Always perform trial printing and check that there are no problems. 

Recycled paper 
 The toner may stick thinly to the whole paper or the printing may be light. 
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 Some recycled paper contains additives that may reduce the printing quality. Be sure to check that it is 
the recycled paper for the electrophotographic printer before using it. 

Paper applicable to each tray 

Tray 1 (for B433) 
Media type Paper size Media weight Applicable number of 

sheets 
Plain paper 
Partially printed paper 
Colored paper 

A4, A5, A6, B5, B6, Letter, Legal 13, Legal 
13.5, Legal 14, Executive, Statement, 8.5" SQ, 
Folio, Custom (width: 100 - 216 mm; length: 
148 - 356 mm) 

60 - 256 g/m2 280 sheets (with a paper 
weight of 64 g/m2) 

 
 When the paper weight 

is 121 g/m2 or above, 
keep the paper stack 
below half the height to 
the ▼ mark on the 
paper guide of the 
paper tray. 
For details, refer to 
Step 5 in "Loading 
paper in Tray 1 (for 
B433)(P.79)". 

Tray 1 (for B513) 
 
 To print on A5-sized paper in landscape, use paper with a weight of 60-104 g/m2. 

In addition, to print, enable [Media Check] in the printer driver. 
 To print on A5-sized paper with a weight of 105 g/m2 or above, please load the paper in portrait. 

Media type Paper size Media weight Applicable number 
of sheets 

Plain paper 
Partially printed paper 
Colored paper 

A4, A5, B5, Letter, Legal 13, Legal 13.5, Legal 14, 
Executive, 8.5" SQ, Folio, Custom (width: 148 - 216 
mm; length: 210 - 356 mm) 

60 - 256 g/m2 580 sheets (with a 
paper weight of 64 
g/m2) 

Tray 2/3/4 (Optional) 
Media type Paper size Media weight Applicable number 

of sheets 
Plain paper 
Partially printed paper 
Colored paper 

A4, A5, B5, Letter, Legal 13, Legal 13.5, Legal 14, 
Executive, 8.5" SQ, Folio, Custom (width: 148 - 216 
mm; length: 210 - 356 mm) 

60 - 256 g/m2 580 sheets (with a 
paper weight of 64 
g/m2) 

Multi-purpose tray (MP tray) 
Media type Paper size Media weight Applicable number 

of sheets 
Plain paper 
Envelope 
Label 
Partially printed paper 
Colored paper 

A4, A5, A6, B5, B6, B7, Letter, Legal 13, Legal 13.5, 
Legal 14, Executive, Statement, 8.5" SQ, Folio, 4" x 
6", 5" x 7", Nagagata#3, Nagagata#4, Yougata#0, 
Yougata#4, Envelope C5, Envelope C6, Envelope 
DL, Envelope COM-9, Envelope COM-10, Envelope 
Monarch, Custom (width: 86 - 216 mm; length: 127 - 
1,321 mm) 

60 - 163 g/m2 110 sheets (with a 
paper weight of 64 
g/m2) 
10 envelopes (with a 
weight of 85 g/m2) 
20 labels (with a 
weight of 130 g/m2) 
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Loading paper in Tray 1 (for B433) 
This section explains the procedure for loading paper of standard sizes. 
Here, the procedure of loading paper in Tray 1 of B433 is taken for example. If you are using B513 or if you 
want to load paper in the optional expansion tray (Tray 2/3/4), please refer to "Loading paper in Tray 1 (for B513) 
or Tray 2/3/4 (Optional)(P.80)". 
For the paper that can be used, please refer to "Applicable paper(P.74)" and "Paper applicable to each tray(P.78)". 
To load paper of irregular sizes, please refer to "Printing on irregular paper (Custom)(P.151)". 

 
 For Tray 1, A5-sized paper can be loaded in either portrait or landscape orientation. 

1 Pull out the lower paper cassette until it stops, and then lift it slightly upward to remove it. 

 

2 Slide the blue part of the paper stopper to fit the length of the paper to be loaded. To load paper 

of A4, Legal (13 inches), Legal (13.5 inches) or Legal (14 inches), pull the paper stopper out to 

the rear side of the paper cassette. 
 
 Do not remove the cork from the metal plate. 

 

3 Slide the blue part of the paper guide to fit the width of the paper to be loaded. 
 
 If the metal plate of the paper cassette is raised, press it down firmly until it clicks into place, and then insert it 

into the printer. If the metal plate is inserted into the main unit while it is raised, malfunction may be caused. 
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4 Shuffle the paper well. Align edges of the paper horizontally. 

 

5 Load the paper with the printing side down, and press it down from top. 
 
 Do not exceed the ▼ mark on the paper guide when loading paper. 
 When the paper weight is 121 g/m2 or above, keep the paper stack below half the height to the ▼ mark on the 

paper guide of the paper tray. 

 

6 Insert the paper cassette into the main unit from slightly above and install it back to its original 

position. 
 
 If you return the paper cassette to the main unit by force, the paper stopper may shift. 

 

7 Proceed to "Setting paper information on the operator panel(P.84)". 

Loading paper in Tray 1 (for B513) or Tray 2/3/4 (Optional) 
This section explains the procedure for loading paper of standard sizes. 
Here, the procedure of loading paper in Tray1 of B513 is taken for example. The same procedure applies to 
loading paper in the optional Tray 2/3/4. 
For the procedure of loading paper in Tray 1 for B433, please refer to "Loading paper in Tray 1 (for B433)(P.79)". 
For the paper that can be used, please refer to "Applicable paper(P.74)" and "Paper applicable to each tray(P.78)". 
To load paper of irregular sizes, please refer to "Printing on irregular paper (Custom)(P.151)". 

 
 For Tray 1, A5-sized paper can be loaded in either portrait or landscape orientation. 
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1 Pull out the lower paper cassette until it stops, and then lift it slightly upward to remove it. 

 

2 Slide the blue part of the paper stopper to fit the length of the paper to be loaded. To load paper 

of A4, Legal (13 inches), Legal (13.5 inches) or Legal (14 inches), pull the rear side of the paper 

cassette backwards with the lock lever pulled outwards. 
 
 Do not remove the cork from the metal plate. 

 

3 Slide the blue part of the paper guide to fit the width of the paper to be loaded. 
 
 If the metal plate of the paper cassette is raised, press it down firmly until it clicks into place, and then insert it 

into the printer. If the metal plate is inserted into the main unit while it is raised, malfunction may be caused. 

 

 

 

4 Shuffle the paper well. Align edges of the paper horizontally. 
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5 Load the paper with the printing side down, and press it down from top. 
 
 Do not exceed the ▼ mark on the paper guide when loading paper. 

 

6 Insert the paper cassette into the main unit from slightly above and install it back to its original 

position. 
 
 If you return the paper cassette to the main unit by force, the paper stopper may shift. 

 

7 Proceed to "Setting paper information on the operator panel(P.84)". 

Loading paper in the MP tray 
This section explains the procedure for loading paper of standard sizes. 
For the paper that can be used, please refer to "Applicable paper(P.74)" and "Paper applicable to each tray(P.78)". 
To load paper of irregular sizes, please refer to "Printing on irregular paper (Custom)(P.151)". 
To load long paper, please refer to "Printing on long paper(P.149)". 

 
 Do not load paper of different sizes, types or weights at the same time. 
 To add paper, remove the existing paper in the MP tray, and then load it back together with the paper to be added. 
 Do not insert anything other than print paper into the MP tray. 
 Do not leave paper in the MP tray for an extended period of time. Dust and dirt will adhere to the paper, and the print 

quality will degrade. 

 
 The paper of A5, B6 and Statement can be loaded in either portrait or landscape orientation. 
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1 Place your finger in the front recess, and pull to open the MP tray towards you. 

 

2 Hold the center of the paper supporter and pull it out towards you. 

 

3 Open the auxiliary supporter. 

 

4 Adjust the manual feeder guide to the width of the paper to be loaded. 

 

5 Shuffle the paper well. Align edges of the paper horizontally. 
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6 Load the paper with the print side facing up. 
 
 Do not exceed the ▼ mark on the paper guide when loading paper. 

 

7 If you always print on paper of the same size and type from the MP tray, go to "Setting paper 

information on the operator panel(P.84)" and set the information of the loaded paper on this machine. 

Setting paper information on the operator panel 
Set the size, type and weight of the paper loaded in each tray in order. 
When envelopes are loaded, please refer to "Printing on envelopes(P.142)". 
When labels are loaded, please refer to "Printing on labels(P.146)". 
When irregular paper (including long paper) is loaded, please refer to "Printing on irregular paper 
(Custom)(P.151)" or "Printing on long paper(P.149)". 

 
 When you pull out the paper cassette of Tray 1/2/3/4 or when you lower the paper placement cover of the multi-

purpose tray (MP tray), select [No] if the setting change screen is displayed. 

The table lists the factory default settings. The paper size setting may differ from region to region. 
 Paper Size Media Type Media Weight 

Tray 1/2/3/4 A4 or Letter Plain paper Medium 
Multi-purpose tray (MP tray) A4 or Letter Plain paper Medium 

 
 If the machine is in the power save mode, press «OK» to restore. 

For Tray 1/2/3/4 
1 Check that "Ready To Print" appears on the display. 

2 Press the scroll button ▼ on the operator panel several times to select [Menus], and press 

«OK». 

3 Press ▼ several times to select [User Setup], and press «OK». 

4 Select [Tray Configuration], and then press «OK». 

5 Select [Tray Setup] you want to set, and then press «OK». 

6 Select [Paper Size], and then press «OK». 

7 Select the size of paper to be loaded in the set paper tray, press «OK», and then press 

«BACK». 

8 Press ▼ to select [Media Type], and press «OK». Press ▲ or ▼ to select the type of the paper 

to be loaded, and then press «OK». Check that [*] is displayed to the left of the selected setting, 

and then press «BACK». 
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9 Press ▼ to select [Media Weight], and then press «OK». Press ▲ or ▼ to select the type of the 

paper to be loaded, and then press «OK». Check that [*] is displayed to the left of the selected 

setting, and then press «BACK». 

10 Press «CANCEL» to return to the standby screen. 
 

For the MP tray 
1 Check that "Ready To Print" appears on the display. 

2 Press the scroll button ▼ on the operator panel several times to select [Menus], and then press 

«OK». 

3 Press ▼ several times to select [User Setup], and press «OK». 

4 Select [Tray Configuration], and then press «OK». 

5 Select [MPTray Config], and then press «OK». 

6 Select [Paper Size], and then press «OK». 

7 Press ▲ or ▼ to select the size of the paper to be loaded, and then press «OK». Check that [*] 

is displayed to the left of the selected setting, and then press «BACK». 

8 Press ▼ to select [Media Type], and press «OK». 

9 Press ▲ or ▼ to select the type of the paper to be loaded, and then press «OK». Check that [*] 

is displayed to the left of the selected setting, and then press «BACK». 

10 Press ▼ to select [Media Weight], and then press «OK». 

11 Press ▲ or ▼ to select the type of the paper to be loaded, and then press «OK». Check that [*] 

is displayed to the left of the selected setting, and then press «BACK». 

12 Press «CANCEL» to return to the standby screen. 
 

About values to be set 
Refer to the following table for settings in the case of plain paper, partially printed paper and colored paper. 

Values to be set on the operator panel 
Media Type Media Weight 

Plain paper 60 - 64 g/m2paper: Light 
65 - 74 g/m2paper: Medium Light 
75 - 87 g/m2paper: Medium 
88 - 104 g/m2paper: Medium Heavy 
105 - 120 g/m2paper: Heavy 
121 - 163 g/m2paper: Ultra Heavy1 
164 - 220 g/m2paper: Ultra Heavy2 
221 - 256 g/m2paper: Ultra Heavy3 
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Storing paper 
Please keep the paper under the following conditions to maintain the quality: 
 A dark and flat place with low humidity 

 Temperature: 20°C 

 Humidity: 50% RH (relative humidity) 
Do not store paper in any of the following places: 
 Places exposed to direct sunlight 
 Places with extreme rises and sudden fluctuations in temperature 
 Places near copiers, air conditioners, heaters, ducts, etc. 
 Near the inner wall affected by the outside air 
 Uneven or curved surfaces 
 Directly on the floor 
 Places where static electricity is generated 

 
 Do not unpack the paper until you use it. 
 After unpacking, rewrap the remaining paper in the wrapping paper and reseal it, or place it in a plastic bag and close 

it tightly, and then store it in a low-humidity area. 
 The paper is wrapped in moisture-proof paper to prevent moisture. Please use the paper as early as possible after 

opening its package. 
 Do not leave the paper exposed to the air for a long period of time. Doing so may cause a printing failure. 
 Depending on the paper in use, operating conditions and storage conditions, the print quality may deteriorate, or the 

paper may be curled or wrinkled. 
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Setting the output bin 

This machine outputs paper to the output tray (Top cover) or rear output tray. The types of paper that can be 
output to each output bin are as follows. 

Output bin Types of paper to output Number of sheets to output 
Output tray (Top 
cover) 

Plain paper, recycled paper, envelopes, Index 
Card, and long paper 

150 (80 g/m2) 

Rear output tray Plain paper, recycled paper, envelope, Index 
Card, labels, and long paper 

100 (80 g/m2) 
10 (Paper longer than A4 size (297 
mm)/Envelopes/Card Stocks) 

 
 Do not open or close the output tray during printing. Doing so may cause a paper jam. 

Output tray (Top cover) 
When printing has completed, the paper is output with the printing side down in the order in which they are 
printed. 

 

 
When the printed paper does not stack well, lift the paper supporter. 
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Rear output tray 
Use the rear output tray to print on envelopes, labels or custom-sized paper. 
The paper is output with the print side facing up in the reverse order to which they are printed. 

 
 Auto Duplex is not available when the rear output tray is used. 

 

1 Open the output tray by putting your fingers in the recess on the back of this machine. 

 

2 Open the paper supporter by holding both ends of the rear output tray. 

 

3 Pull out the auxiliary supporter. 
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Checking the information of this machine 

You can print out and check the information of this machine. You can also check the information from the 
operator panel. 
 

Printing the menu map (configuration) 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ to select [Print Information], and then press «OK». 

 

4 Check that [Configuration] is selected, and then press «OK». 

 

5 Check that [Configuration] is displayed and [Execute] is selected, and then press «OK». 

 

6 The configurations are printed. 
 

How to read the menu map 
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A The optional expansion tray unit will be displayed if it has been installed. 

 
 To print the printer information not listed in [Configuration], please refer to "Menus (Print Information)(P.107)". 

Confirming on the operator panel 
You can check the supplies status and counter information on the operator panel. 
 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

3 Check that [Configuration] is selected, and press «OK». 

4 Select the item that you want to check, and press «OK». 

5 Select the information that you want to check, and press «OK». 

6 After checking the display, press «CANCEL» to return to the standby screen. 
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Parts identification of the operator panel 

 
No. Name Function 

1 Display Display the state of this machine and operation instructions. 
There are two types of standby screens: "Show Remaining Toner" and 
"Show Tray Information". 
The factory default setting is "Show Remaining Toner". 

2 Power button Turn the power on/off. 

3 «HELP» button Display the help screen. To close the screen, press the «HELP» button 
again, or press the «BACK» or «CANCEL» button. 

4 «BACK» button Go back to the previous screen. 

5 «CANCEL» button Cancel the current printing. Go back to the standby screen when the 
menu is displayed. 

6 «OK» button Confirm the highlighted item when a menu is selected. 
Cancel the sleep mode when the machine is in the sleep mode. 
Light on in green in the power save mode, and flashes in green in the 
sleep mode. 

7 Scroll buttons ▲▼  Used to select a menu or scroll the screen display.It can be used to 
input numbers in the numerical input screen. 

8 ATTENTION lamp Indicate the state of this machine. 
Light off in the normal state. 
On: Indicate that a minor error has occurred. 
Flashing: Indicate that a major error has occurred. 

9 ONLINE lamp Light on in green when the machine is online, and lights off when the 
machine goes offline. 
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Inputting text 

You can input alphabetic or numeric characters by using the scroll button ▲ or ▼ on the operator panel. If a 
same button is pressed in succession, the alphanumeric character will switch. To continue inputting with the 
same button, press «OK» after inputting each alphanumeric character. 
The following characters can be input when the corresponding button is pressed. 
For a menu where only digits can be input, it will not switch to alphabetic characters. 

Scroll button Display order 

▲ The order of display is as follows: Lower-case letters → Symbols → Upper-case letters → Digits 
(in ascending order). 
The symbols are displayed in the following order: 
* @ . _ - (space) + ! " $ % & ' ( ) , / : ; < = > ? [ ¥ ] ^ # ` { | } ~ 

▼ The order of display is reverse to that when ▲ is pressed. 

Example 
To input "abc", 
Press ▲ «OK», ▲ ▲ «OK», and ▲ ▲ ▲ «OK». 
 
The functions of the following button are described below. 
«BACK» 
Returns to the home screen when there is no determined character. 
Erases the character being input when there are determined characters but the character being input is not 
determined. 
Erases one of the determined characters when there are determined characters and no character is being 
input. 
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Changing settings 

This section describes how to change menu settings from the operator panel. 
There are several hierarchies before you can see the items to set. Select them from the highest hierarchy in 
order. 
This example shows how to set [B5] as the paper size for Tray 1. 

 
 See "Menu items(P.105)" for a list of menu items. 

 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

 

2 Press the scroll button ▼ on the operator panel several times to select [Menus], and press 

«OK». The display color of the selected item is highlighted. 

 

3 Press ▼ several times to select [User Setup], and press «OK». 

 

4 Since [Tray Configuration] is selected, press «OK». 

 

5 Press ▼ to select [Tray1 Config], and then press «OK». 
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6 Since [Paper Size] is selected, press «OK». 

 

7 Press ▼ several times to select [B5], and then press «OK». 

 

8 Check that [*] is displayed to the left of [B5]. 

 

9 Press «CANCEL» to return to the standby screen. 
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Adjusting the buzzer volume 

The buzzer volume is adjustable in three steps. The buzzer sounds in the following cases: 
 When a paper jam or any other error occurs 
 When the printing is completed 
 When AirPrint, Mopria or IPP Everywhere is used to find a printer 

 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

 

5 Press ▲ or ▼ several times to select [Buzzer Setup], and then press «OK». 

 

6 Press ▲ or ▼ several times to select the item you want to change, and then press «OK». 
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7 Press ▲ or ▼ to select the volume to be set, and then press «OK». Check that [*] is displayed 

to the left of the selected setting. 

 

8 Press «CANCEL» to return to the standby screen. 
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Setting the power save function 

Setting the time that elapses before entering the power save mode 
This machine automatically enters the power save mode (an energy saving mode) if no operation is done for a 
certain period of time. 
The following time options can be set. The factory default setting is 1 minute. 
1 minute, 2 minutes, 3 minutes, 4 minutes, 5 minutes, 10 minutes, 15 minutes, 30 minutes, and 60 minutes 

 
 This machine may not enter the power save mode after the set period of time since the fan is working until this 

machine has cooled down depending on the printing environment or the usage conditions. 
 The service life of the fuser unit in the maintenance kit varies significantly with factors like the total power-on time. 

Setting a longer transition time to Power Save mode will increase the total power-on time, potentially requiring earlier 
fuser replacement. 

 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [User Setup], and press «OK». 

 

4 Press ▼ to select [System Adjust], and then press «OK». 

 

5 Check that [Power Save Time] is selected, and then press «OK». 
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6 Press ▲ or ▼ to select the time to be set, and then press «OK». Check that [*] is displayed to 

the left of the selected setting. 

 

7 Press «CANCEL» to return to the standby screen. 

Setting the time that elapses before entering the sleep mode 
This machine automatically enters the sleep mode (a more energy saving mode) if no operation is done for a 
certain period of time in the power save mode. 
The following time options can be set. The factory default setting is 1 minute. 
1 minute, 2 minutes, 3 minutes, 4 minutes, 5 minutes, 10 minutes, 15 minutes, 30 minutes, and 60 minutes 

 
 When an error has occurred, this machine will not enter the sleep mode. 
 This machine may not enter the sleep mode after the set period of time since the fan is working until this machine 

has cooled down depending on the printing environment or the usage conditions. 

 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [User Setup], and press «OK». 

 

4 Press ▼ to select [System Adjust], and then press «OK». 

 

5 Press ▼ to select [Sleep Time], and then press «OK». 
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6 Press ▲ or ▼ to select the time to be set, and then press «OK». Check that [*] is displayed to 

the left of the selected setting. 

 

7 Press «CANCEL» to return to the standby screen. 

Turning off the power automatically (Auto Power Off) 
This machine comes with a function (Auto Power Off) to turn off the power automatically if it has not been 
used for a certain period of time. 
There are 3 types of settings for Auto Power Off, and the default factory setting is [Auto Config]. 
 [Auto Config]: The power is turned off automatically if the machine has not been used for a certain period 

of time, except in the following cases: 
 When the LAN cable is connected to the network interface connector 
 When the wireless LAN is enabled 

 [Enable]: The power is automatically turned off if this machine has not been used for a certain period of 
time. 

 [Disable]: Disables the Auto Power Off function. The power does not turn off automatically. 

 
 Auto Power Off does not work in the following cases. 

 By default, Auto Power Off does not work with a network connection (wired/wireless). 
 When an error has occurred 

 
Follow the procedure below to change the Auto Power Off setting. 
 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [Admin Setup], and press «OK». 
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4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

 

5 Press ▼ several times to select [Power Setup], and then press «OK». 

 

6 Press ▼ several times to select [Auto Power Off], and then press «OK». 

 

7 When "Changing this setting may increase energy consumption." is displayed, press «OK». 

 

8 Press ▲ or ▼ to select [Auto Config], [Enable] or [Disable], and press «OK». Check that [*] is 

displayed to the left of the selected setting. 

 

9 Press «CANCEL» to return to the standby screen. 

Setting the time that elapses before entering the Auto Power Off mode 
The following time options can be set. The factory default is 15 minutes or 4 hours depending on region. 
 
15 minutes, 1 hour, 2 hours, 3 hours, 4 hours, 8 hours, 12 hours, 18 hours, and 24 hours 
 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 
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2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [User Setup], and press «OK». 

 

4 Press ▼ to select [System Adjust], and then press «OK». 

 

5 Press ▼ several times to select [Auto Power Off Time], and then press «OK». 

 

6 When "Changing this setting may increase energy consumption." is displayed, press «OK». 

 

7 Press ▲ or ▼ to select the time to be set, and then press «OK». Check that [*] is displayed to 

the left of the selected setting. 

 

8 Press «CANCEL» to return to the standby screen. 

Setting actions of the power save mode 
Set actions of the power save mode. 
Mode1: Set it to the power save mode. The power consumption is lower than that in Mode 2. 
Mode2: Set it to the low temperature standby mode. The printing startup is faster than that in Mode 1. 
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1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

 

5 Press ▼ several times to select [Power Setup], and then press «OK». 

 

6 Press ▼ several times to select [Power Save Setting], and then press «OK». 

 

7 Press ▲ or ▼ to select the mode to be set, and then press «OK». Check that [*] is displayed to 

the left of the selected setting. 

 

8 When [Are you sure?] is displayed, check that [Yes] is selected, and press «OK». 
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9 The machine will restart, so wait until the standby screen appears. 

Setting the Sleep After Printing mode 
You can set the machine to enter the sleep mode right after printing. 
 [Enable]: The machine enters the sleep mode right after printing. 
 [Disable]: The machine does not enter the sleep mode right after printing. 

 
 This machine may not enter the sleep mode after the set period of time since the fan is working until this machine 

has cooled down depending on the printing environment or the usage conditions. 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [User Setup], and press «OK». 

 

4 Press ▼ to select [System Adjust], and then press «OK». 

 

5 Press ▼ several times to select [Sleep After Printing], and then press «OK». 

 

6 Press ▲ or ▼ to select [Enable] or [Disable], and press «OK». Check that [*] is displayed to the 

left of the selected setting. 

 

7 Press «CANCEL» to return to the standby screen. 
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Menu items 

You can print to check the menu list. 
 Printing the menu map (configuration)(P.89) 

Language Setup 

Item Factory default 
setting Description 

Language Setup Select Language English Select the language to be displayed on the 
display. 

Menus (Information) 
Item Description 

Tray Count MPTray Display the total print quantity for each tray. 
Tray 2/3/4 is displayed when an optional 
expansion tray is mounted. 

Tray1 
Tray2 
Tray3 
Tray4 

Paper Feed Roller Counter MPTray Display the number of sheets fed from each 
tray. 
After the paper feed roller is replaced, clear it 
from Admin Setup. 
Tray 2/3/4 is displayed when an optional 
expansion tray is mounted. 

Tray1 
Tray2 
Tray3 
Tray4 

A4/Letter Impressions Count Display the number of print pages converted to 
A4/Letter paper. 

Duplex Count Display the number of sheets printed on both 
sides. 

Supplies Life Toner (n.nK) Display the remaining toner amount (%). (n.nK) 
indicates the capacity of the toner cartridge 
installed in this machine. 

Drum Display the remaining service life (%) of the 
image drum. 

Fuser Display the remaining service life (%) of the 
fuser unit. 

Network Network 
Information 

General 
Information 

Extended 
Network 

Display the enabled extended network other 
than the standard wired LAN1. 

Enabling Default 
Gateway 

Display the enabled default gateway. 

Printer Name Display the printer name. 
Short Printer 
Name 

Display the short printer name. 

NIC Program 
Version 

Display the network firmware version. 

Web Remote 
Version 

Display the web page version. 

Wired(LAN1) 
Information 

Wired(LAN1) Display the state (enabled/disabled) of the 
standard wired LAN1. 

IPv4 Address Display the IP address. 
Subnet Mask Display the subnet mask. 
Gateway 
Address 

Display the gateway address when [Enabling 
Default Gateway] is set to [Wired(LAN1)]. 
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Item Description 
MAC Address Display the MAC address. 
IPv6 Address 
(Local) 

Display the IPv6 address (local). 

IPv6 Address 
(Stateless) 

Display the IPv6 address (stateless). 

IPv6 Address 
(Stateful) 

Display the IPv6 address (stateful). 

Wired(LAN2) 
Information 
* It is displayed 
when the 
extended wired 
LAN module is 
installed. 
LAN2 does not 
support some 
specifications. 

Wired(LAN2) Display the state (enabled/disabled) of the 
extended wired LAN2. 

IPv4 Address Display the IP address. 
Subnet Mask Display the subnet mask. 
Gateway 
Address 

Display the gateway address when [Enabling 
Default Gateway] is set to [Wired(LAN2)]. 

MAC Address Display the MAC address. 
IPv6 Address 
(Local) 

Display the IPv6 address (local). 

IPv6 Address 
(Stateless) 

Display the IPv6 address (stateless). 

IPv6 Address 
(Stateful) 

Display the IPv6 address (stateful). 

Wireless(Infrastructure) 
Information 
* It is displayed when the optional 
wireless LAN module is installed. 

Firmware 
Version 

Display the wireless network firmware version. 

Wireless(Infrastr
ucture) 

Display the state (enabled/disabled) of the 
wireless network (infrastructure). 

SSID Display the SSID of the connected wireless 
network access point. 

Security Display the security type of the wireless 
network connection. 

State Display the connection state of the wireless 
network. 

Band Display the frequency bands of the current 
wireless network. 

Channel Display the channel number used by the 
wireless network. 

RSSI Display the signal strength of the wireless 
network. 

IPv4 Address Display the IP address of the wireless network 
I/F. 

Subnet Mask Display the subnet mask. 
Gateway 
Address 

Display the gateway address when [Enabling 
Default Gateway] is set to 
[Wireless(Infrastructure)]. 

MAC Address Display the MAC address of the wireless 
network. 

IPv6 Address 
(Local) 

Display the IPv6 address (local). 

IPv6 Address 
(Stateless) 

Display the IPv6 address (stateless). 

IPv6 Address 
(Stateful) 

Display the IPv6 address (stateful). 

Wireless(Wi-Fi Direct) Information 
* It is displayed when the optional 
wireless LAN module is installed. 
 

Wireless(Wi-Fi 
Direct) 

Display the state (enabled or disabled) of the 
wireless network (Wi-Fi Direct). 

Security Display the security of Wi-Fi Direct. 
SSID Display the SSID of this machine. 
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Item Description 
 Password Display the password. 

Not displayed when [Wireless(Wi-Fi Direct) 
Setting] - [Password Disclose Setting] is set to 
[Don't disclose]. 

Number of 
connected   

Display the number of wireless terminals which 
are currently connected. 

IPv4 Address Display the IP address. 
System 
Information 

Serial Number Display the serial number of the printer. 
Asset Number Display the asset number of the printer. 
Firmware Version Display the version of firmware. 
CU Version Display the firmware version of the Control Unit 

(CU). 
PU Version Display the firmware version of the Print Unit 

(PU). 
Panel Version Display the firmware version of the operator 

panel. 
RAM Display the total capacity of all RAMs installed 

in this machine. 
Flash Memory Display the total capacity of all flash memories 

installed in this machine. 
Date and Time Display the current date and time. 

Menus (Print Information) 
Item Description 

Configuration Print the configurations of the printer. 
Network Print the setup situation of the network. 
File List Print a list of files stored in the printer. 
PS Font List Print the PS font sample. 
PCL Font List Print the PCL font sample. 
ESC/P Font List Print the ESC/P font sample. 
Usage Report Print the collective usage report of the printer. 
Supplies Report Print the information like the remaining service life of consumables. 
Error Log Print the error log. 

Menus (User Setup) 
The asterisk (*) indicates that factory default settings may differ from region to region. 

Item 
Factory 
default 
setting 

Description 

Tray 
Configuration 

MPTray 
Config 

Paper Size A4 Set the size of the paper you want to print 
on from the MP tray. 

X Dimension 210 mm Set the paper width when you have selected 
a custom size for the paper that you want to 
print on from the MP tray. 

Y Dimension 297 mm Set the paper length when you have 
selected a custom size for the paper that 
you want to print on from the MP tray. 

Media Type Plain Set the type of paper that you want to print 
on from the MP tray. 
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Item 
Factory 
default 
setting 

Description 

Media Weight Medium or 
Medium Light 
* 

Set the weight of the paper that you want to 
print on from the MP tray. 

Tray Usage When 
Mismatching 

Set how to use the MP tray. The available 
values are as follows. 
[Normal Tray]: Treat the MP tray as a 
normal tray like Tray 1 or Tray 2/3/4 
(optional). 
[When Mismatching]: Print from the MP tray 
with the correct paper loaded when the 
paper loaded in the specified tray for 
printing is different from the paper size of 
the print data. 
[Do Not Use]: Ignore the MP tray in 
selecting or switching the tray automatically. 

Tray1 Config Paper Size A4 Set the size of the paper you want to print 
on from Tray 1. 
 

X Dimension 210 mm Set the paper width when you have selected 
a custom size for the paper that you want to 
print on from Tray 1. 

Y Dimension 297 mm Set the paper length when you have 
selected a custom size for the paper that 
you want to print on from Tray 1. 

Media Type Plain Set the type of the paper you want to print 
on from Tray 1. 

Media Weight Medium Set the weight of the paper you want to print 
on from Tray 1. 

Tray2 Config Paper Size A4 Set the size of the paper you want to print 
on from Tray 2. 
 

X Dimension 210 mm Set the paper width when you have selected 
a custom size for the paper that you want to 
print on from Tray 2. 

Y Dimension 297 mm Set the paper length when you have 
selected a custom size for the paper that 
you want to print on from Tray 2. 

Media Type Plain  Set the type of the paper you want to print 
on from Tray 2. 

Media Weight Medium Set the weight of the paper you want to print 
on from Tray 2. 

Tray3 Config Paper Size A4 Set the size of the paper you want to print 
on from Tray 3. 

X Dimension 210 mm Set the paper width when you have selected 
a custom size for the paper that you want to 
print on from Tray 3. 

Y Dimension 297 mm Set the paper length when you have 
selected a custom size for the paper that 
you want to print on from Tray 3. 

Media Type Plain Set the type of the paper you want to print 
on from Tray 3. 

Media Weight Medium Set the weight of the paper you want to print 
on from Tray 3. 
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Item 
Factory 
default 
setting 

Description 

Tray4 Config Paper Size A4 Set the size of the paper you want to print 
on from Tray 4. 
 

X Dimension 210 mm Set the paper width when you have selected 
a custom size for the paper that you want to 
print on from Tray 4. 

Y Dimension 297 mm Set the paper length when you have 
selected a custom size for the paper that 
you want to print on from Tray 4. 

Media Type Plain paper Set the type of the paper you want to print 
on from Tray 4. 

Media Weight Medium Set the weight of the paper you want to print 
on from Tray 4. 

Paper Feed Tray Tray1 Specify the paper tray. 
The settings of the printer driver take 
priority. 

Auto Tray Switch On Set whether or not to use the Auto Tray 
Switch function. 
The settings of the printer driver take 
priority. 

Tray Sequence Down Specify the tray sequence for Auto Tray 
Selection/Auto Tray Switch. 

Duplex Last Page Skip Blank 
Page 

Set whether or not to print the last 1-sided 
page when the duplex printing is done on 
odd-numbered pages. 

System 
Adjust 

Power Save Time 1 minute Set the time that will elapse before the 
power save mode is entered. 
Value range: 1 minute, 2 minutes, 3 
minutes, 4 minutes, 5 minutes, 10 minutes, 
15 minutes, 30 minutes, and 60 minutes 

Sleep Time 1 minute Set the time that will elapse before the sleep 
mode is switched from the power save 
mode. 
Value range: 1 minute, 2 minutes, 3 
minutes, 4 minutes, 5 minutes, 10 minutes, 
15 minutes, 30 minutes, and 60 minutes 

Sleep After Printing Enable Set the machine to enter the sleep mode 
immediately after printing. When it is set to 
[Enable], the machine enters the sleep 
mode as soon as possible after printing to 
save energy. Depending on the temperature 
and other conditions inside the machine, the 
machine may not switch over temporarily. 
[Enable]: The machine enters the sleep 
mode right after printing. 
[Disable]: The machine does not enter the 
sleep mode right after printing. 

Auto Power Off Time 15 minutes or 
4 hours* 

Set the time that will elapse before the 
power is turned off automatically after the 
standby mode is entered. 
Value range: 15 minutes, 1 hour, 2 hours, 3 
hours, 4 hours, 8 hours, 12 hours, 18 hours, 
and 24 hours 
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Item 
Factory 
default 
setting 

Description 

Clearable Warning OK button Set the timing to clear the recoverable error 
display. 

Auto Continue Off Set whether or not to automatically restore 
this machine when a memory overflow or 
tray request occurs. 

Manual Timeout 60 seconds Set the waiting time for loading the paper 
when you print with [Feed paper individually] 
checked in the printer driver. 
Value range: Off, 30 seconds, and 60 
seconds 

Timeout Injob 40 seconds Set the time from loss of the data receipt 
(canceled by PostScript) until force-printing. 
Value range: Off, 5 seconds, 10 seconds, 
20 seconds, 30 seconds, 40 seconds, 50 
seconds, 60 seconds, 90 seconds, 120 
seconds, 150 seconds, 180 seconds, 210 
seconds, 240 seconds, 270 seconds, and 
300 seconds 

Timeout Local 0 seconds Set the time to keep each port open after 
printing. (Except for network) 
It can be set from 0 seconds to 300 seconds 
in increments of 5 seconds. 

Timeout Network 90 seconds Set the time to keep the network port open 
after printing. 
It can be set from 0 seconds to 300 seconds 
in increments of 5 seconds. 

Jam Recovery On Set whether to reprint pages not printed due 
to a paper jam after the paper jam is 
cleared. 
When [Off] is selected, the printing process 
including pages missed due to the paper 
jam will be canceled. 

Error Report Off Sets whether to print error reports when an 
internal error occurs. 

Hex Dump Execute Prints the data received from the PC in 
hexadecimal dump. To exit this mode, turn 
off the power. 

Print Adjust Print Position 
Adjust 

MPTray X Adjust 0.00 mm Adjusts the printing position of each tray. 
Tray2/3/4 is displayed when the expansion 
tray is mounted. 
[X Adjust]: Adjust the position of a whole 
print image in the direction that is 
perpendicular to the direction paper runs, 
that is horizontally. 
Value range: ±2.00 mm (in increments of 
0.1mm) 
[Y Adjust]: Adjust the position of a whole 
print image in the direction paper runs, that 
is vertically. 
Value range: ±2.00 mm (in increments of 
0.1mm) 

Y Adjust 0.00 mm 
Duplex X 
Adjust 

0.00 mm 

Duplex Y 
Adjust 

0.00 mm 

Tray1 X Adjust 0.00 mm 
Y Adjust 0.00 mm 
Duplex X 
Adjust 

0.00 mm 

Duplex Y 
Adjust 

0.00 mm 

Tray2 X Adjust 0.00 mm 
Y Adjust 0.00 mm 
Duplex X 
Adjust 

0.00 mm 
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Item 
Factory 
default 
setting 

Description 

Duplex Y 
Adjust 

0.00 mm [Duplex X Adjust]: At the time of back page 
printing of Duplex (when printing the print 
side of paper fed from the duplex unit), 
adjust the position of the whole print image 
in the direction that is perpendicular to the 
direction paper runs, that is horizontally. 
Value range: ±2.00 mm (in increments of 
0.1mm) 
[Duplex Y Adjust]: At the time of back page 
printing of Duplex (when printing the print 
side of paper fed from the duplex unit), 
adjust the position of a whole print image in 
the direction paper runs, that is vertically. 
Value range: ±2.00 mm (in increments of 
0.1mm) 

Tray3 X Adjust 0.00 mm 
Y Adjust 0.00 mm 
Duplex X 
Adjust 

0.00 mm 

Duplex Y 
Adjust 

0.00 mm 

Tray4 X Adjust 0.00 mm 
Y Adjust 0.00 mm 
Duplex X 
Adjust 

0.00 mm 

Duplex Y 
Adjust 

0.00 mm 

Transfer Setting 0 Fine-tune the printing in case of noticeable 
blurs etc. on the printing result. Decrease 
the value if scattered or snowy printing 
occurs in the high-density printing section. 
Increase the value if printing is faint. 
Adjustable within the range of ±2. 

SMR Setting 0 Correct printing variations due to differences 
in temperature and humidity environments, 
printing density/printing frequency. Change 
the value if there is burr in the image. 
Adjustable within the range of ±3. 

BG Setting 0 Correct printing variations due to differences 
in temperature and humidity environments, 
printing density/printing frequency. Change 
the value if the underlay is dark. Adjustable 
within the range of ±3. 

Color Density 0 Set the printing density. 
Darken the printing result by adjusting in + 
direction, or lighten the printing result by 
adjusting in - direction. 
Adjustable within the range of ±3. 

Drum Cleaning Off Set whether or not to empty the drum before 
printing when white streaks appear in the 
horizontal direction. When it is set to [On], 
the service life of the image drum will be 
shortened. 

High Humid Mode Off The paper may curl when the paper is 
ejected at a high humidity. Set this setting to 
[Mode1] or [Mode2] to reduce the curling 
effect. 
The printing time is longer than the case of 
[Off]. 
The service life of the image drum and fuser 
unit will be shortened. 
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Item 
Factory 
default 
setting 

Description 

Narrow Paper Speed Mode1 Set the printing speed when narrow paper is 
used. 
[Mode1]: 
It is the recommend mode for massive 
printing on narrow paper (with a width of 
200 mm or less). 
Switch the speed to a low speed when 
printing on narrow paper. 
[Mode2]: 
It is the recommend mode for printing on a 
small amount of narrow paper. Print on 
narrow paper without reducing the speed. 
When printing on a large amount of narrow 
paper, it is easier to begin the waiting time 
for fixing temperature adjustment. 

Quiet Mode Off When it is set to [On], the printing speed is 
reduced to reduce the noise of the machine. 

Menus (Admin Setup) 
The asterisk (*) indicates that factory default settings may differ from region to region. 

Item 
Factory 
default 
setting 

Description 

Enter 
Password 

 (Please refer 
to the 
password 
label 
attached on 
the inside of 
this 
machine.) 

Input the password required to enter the 
Admin Setup menu. 

Network 
Setup 

General 
Setup 

Extended Network Disable Set up the extended network. 
In addition to the standard wired LAN, set 
[Wireless] when using a wireless LAN, and 
set [Wired(LAN2)] when using the extended 
wired LAN module. 

Enabling Default Gateway Wired (LAN1) Specify the network connection method for 
segment-based communication. 

TCP/IP Enable Enable/Disable the wired LAN. 
NetBIOS over TCP Enable Enable/Disable the NetBIOS over TCP 

protocol. 
Web Enable Specify whether or not to enable the access 

from the web browser. 
It is displayed when the [TCP/IP] protocol is 
set to [Enable]. 

HTTP Enable Specify whether or not to enable access via 
HTTP from a web browser. 
It is displayed when the [TCP/IP] protocol is 
set to [Enable]. 
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Item 
Factory 
default 
setting 

Description 

HTTPS Redirection (Web) Enable Specify whether or not to enable the HTTPS 
Redirection (Web) function. 
It is displayed when the [TCP/IP] protocol is 
set to [Enable]. 

Telnet Disable Specify whether or not to enable access 
using Telnet. 
It is displayed when the [TCP/IP] protocol is 
set to [Enable]. 

FTP Disable Specify whether or not to enable access via 
FTP. 
It is displayed when the [TCP/IP] protocol is 
set to [Enable]. 

IPSec Disable It is displayed only when IPSec is enabled. 
It can be changed to Disable only. 
It is displayed when the [TCP/IP] protocol is 
set to [Enable]. 

SNMP Enable Specify whether or not to enable access 
from SNMP. 
It is displayed when the [TCP/IP] protocol is 
set to [Enable]. 

WSD Print Enable Specify whether or not to enable WSD Print. 
It is displayed when the [TCP/IP] protocol is 
set to [Enable]. 

Network Scale Small Normally, leave it as [Small]. 
Network Factory Defaults Execute Restores the network menu to its factory 

default settings. 
Wired (LAN1) 
Settings 

Wired (LAN1) Enable Enable/Disable the wired LAN1. 
IP Address Set Auto Set whether to obtain the IPv4 address 

automatically or input it manually. 
IPv4 Address 192.168.100.

100 
Input the IPv4 address manually. It is 
displayed when [IP Address Set] is set to 
[Manual]. 

Subnet Mask 255.255.255.
0 

Input the subnet mask. It is displayed when 
[IP Address Set] is set to [Manual]. 

Gateway Address 0.0.0.0 Input the gateway address. It is displayed 
when [IP Address Set] is set to [Manual]. 

DHCPv6 Disable Set whether or not to obtain the IPv6 
address automatically. Set it to [Disable] 
when you do not use the IPv6 address. 

Gigabit Network Disable Enable/Disable connection via 1000Base-T.  
When it is set to [Disable], 1000base-T 
Full/Half duplex connection cannot be 
made. 

HUB Link Setting Auto Set the connection method to the hub. 
Wired(LAN2) 
Settings 

Wired(LAN2) Enable Enable/Disable the extended wired LAN 
(LAN2). 
It cannot be used simultaneously with a 
wireless LAN. 

IP Address Set Auto Set whether to obtain the IPv4 address 
automatically or input it manually. 

IPv4 Address 192,168,102,
100 

Input the IPv4 address manually. It is 
displayed when [IP Address Set] is set to 
[Manual]. 
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Item 
Factory 
default 
setting 

Description 

Subnet Mask 255.255.255.
0 

Input the subnet mask. It is displayed when 
[IP Address Set] is set to [Manual]. 

Gateway Address 0.0.0.0 Input the gateway address. It is displayed 
when [IP Address Set] is set to [Manual]. 

DHCPv6 Disable Set whether or not to obtain the IPv6 
address automatically. 

HUB Link Setting Auto Set the connection method to the hub. 
USB Setup USB Enable Enable/Disable the USB interface. 

Speed 480 Mbps Set the maximum baud rate using a USB 
interface. 

Soft Reset Disable Enable/Disable the Soft Reset command. 
Serial Number Enable Enable/Disable the USB serial number. 

The USB serial number is used to identify 
the USB device connected to the PC. 

Offline Receive Disable When [Enable] is selected, data can be 
received even if the printer is offline. 

USB Memory Interface Enable Enable/Disable the USB memory interface. 
If the setting value is changed, the setting 
will be reflected after the machine is 
restarted. 

Connected Host Normal Set it to [Specific] in case of timeout when 
printing on this machine in sleep mode. 
Power consumption in sleep mode is higher 
than that in [Normal]. 

Print Setup 
 

Personality Auto Select the operating language of the printer. 
Copies 1 Set the number of copies. 

The value set in the printer driver takes 
priority. 

Duplex On Set whether or not to implement duplex 
printing. 
The value set in the printer driver takes 
priority. 

Binding Long Edge Specify the binding method for duplex 
printing. 
The value set in the printer driver takes 
priority. 

Media Check Enable Set whether or not to check the mismatch 
between the paper size of the print data and 
that of the paper tray. 

A4/Letter Override Yes Set the functions of auto switching of the 
printing paper from A4 to Letter when A4 
paper runs out and Letter paper is loaded, 
or from Letter to A4 when Letter paper runs 
out. 

Edge to Edge Off Specify it to expand the print margin. 
The value set in the printer driver takes 
priority. 

Resolution 600 dpi Set the resolution. 
The value set in the printer driver takes 
priority. 

Toner Save Off Set the toner save level. 
Default Orientation Portrait Specify the print orientation. For PostScript, 

this setting is disabled. 
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Item 
Factory 
default 
setting 

Description 

Edit Size Cassette 
Size 

Set the size of the drawing area when the 
size is not specified by the paper size edit 
command from a PC. 

Width 210 mm Set the default paper width for a custom 
paper size. 

Length 297 mm Set the default paper length for a custom 
paper size. 

PS Setup L1 Tray Type 1 Set the tray selection number of level 1 
operator command of PostScript. 

Network Protocol RAW Specify the PS communication protocol for 
network connection. 

USB Protocol RAW Specify the PS communication protocol for 
USB connection. 

PDF Paper Size Current Tray 
Size 

Specify the paper size for direct printing of 
PDF files. 

PDF Scaling Size 99% Set the reduction ratio when [Scaling Size] 
is selected in [Size in PDF file]. 

PDF Print Mode Quality 
priority 

Set whether or not to prioritize print quality 
or print speed when a PDF file is printed. 

PCL Setup Font Source Resident Select the location of the font to be used. 
Font Number I0 Select the number of the font to be used. 

Value range: I0 - I90 when [Resident] is 
set/C1 - C4 when [Resident2] is set 

Font Pitch 10.00 CPI Set the PCL font width. 
Value range: 0.44 - 99.99 CPI (in 
increments of 0.01 CPI) 

Font Height 12.00 points Set the PCL font height. 
Value range: 4.00 - 999.75 points (in 
increments of 0.25 point) 

Symbol Set PC-8 Select the symbol set of PCL. 
A4 Print Width 78 columns Set the number of columns until an auto 

carriage return on A4 paper. 
White Page Skip Off Select whether or not to print blank pages. 
CR Function CR Set the actions of this machine when 

receiving the CR code. 
LF Function LF Set the actions of this machine when 

receiving the LF code. 
Print Margin Normal Set the unprintable area of the paper. 
Pen Width Adjust On Set whether or not to emphasize fine lines 

and make them thicker. 
Tray ID# MPTray 4 Set the value to specify the tray with the 

output specification command of PCL. 
Value range: 1 - 59 

Tray1 1 
Tray2 5 
Tray3 20 
Tray4 21 

SIDM Setup SIDM Manual ID# 2 Sets up Pn specified in MANUAL by 
MANUAL-1 ID No.FX/PPR Emu in CSF 
control command (ESC EM Pn). 

SIDM Manual2 ID# 3 Sets up Pn specified in MANUAL by 
MANUAL-2 ID No.FX/PPR Emu in CSF 
control command (ESC EM Pn). 
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Item 
Factory 
default 
setting 

Description 

SIDM MP Tray ID# 4 Sets up Pn specified TRAYO (MP Tray) by 
MP Tray ID No.FX/PPR Emu in CSF control 
command (ESC EM Pn). 

SIDM Tray 1 ID# 1 Sets up Pn specified TRAY 1 by Tray 1 ID 
No.FX/ PPR Emu in CSF control command 
(ESC EM Pn). 

SIDM Tray2 ID# 5 Sets up Pn specified TRAY 2 by Tray 2 ID 
No.FX/ PPR Emu in CSF control command 
(ESC EM Pn). 
* It is displayed when optional expansion 
trays are mounted. 

SIDM Tray 3 ID# 6 Sets up Pn specified TRAY 3 by Tray 3 ID 
No.FX/ PPR Emu in CSF control command 
(ESC EM Pn). 
* It is displayed when optional expansion 
trays are mounted. 

SIDM Tray 4 ID# 7 Sets up Pn specified TRAY 4 by Tray 4 ID 
No.FX/ PPR Emu in CSF control command 
(ESC EM Pn). 
* It is displayed when optional expansion 
trays are mounted. 

IBM PPR 
Setup 

Character Pitch 10 CPI Specify character pitches in IBM PPR 
emulation. 

Font Condense 12 CPI to 20 
CPI 

Specify 12CPI pitches for Condense Mode. 

Character Set SET-2 Specify a character set. 
Symbol Set IBM-437 Specify a symbol set. 
Letter O Style Disable Specify the style that replaces 9BH with 

letter o and 9DH with a zero. 
Zero Character Normal Set the zero to be slashed or unslashed. 
Line Pitch 6 LPI Specify the line spacing. 
White Page Skip Off Specify whether or not to print blank pages. 
CR Function CR Select a carriage return from [CR] or 

[CR+LF]. 
LF Function LF Select a line feed from [LF] or [LF+CR]. 
Line Length 80 columns Specify the number of characters per line. 
Form Length 11.7 inches 

or 11 inches* 
Specify the length of paper. 

TOF Position 0.0 inch Specify the distance from the top edge of 
paper. 

Left Margin 0.0 inch Specify the distance from the left edge of 
paper so that the print starting point shifts to 
the right horizontally. 

Fit to Letter Disable or 
Enable* 

Set the printing mode that can fit paper to 
the printable area equivalent to 11 inches 
(66 lines). 

Text Height Same Set the height of a character. 
Same: The height stays the same 
regardless of CPI. 
Diff: The height varies according to CPI. 

EPSON FX 
Setup 

Character Pitch 10 CPI Specify the character pitch. 
Character Set SET-2 Specify a character set. 
Symbol Set IBM-437 Specify a symbol set. 
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Item 
Factory 
default 
setting 

Description 

Letter O Style Disable Specify the style that replaces 9BH with 
letter o and 9DH with a zero. 

Zero Character Normal Set the zero to be slashed or unslashed. 
Line Pitch 6 LPI Specify the line spacing. 
White Page Skip OFF Specify whether or not to print blank pages. 
CR Function CR Select a carriage return from [CR] or 

[CR+LF]. 
Line Length 80 columns Specify the number of characters per line. 
Form Length 11.7 inches 

or 11 inches* 
Specify the length of paper. 

TOF Position 0.0 inch Specify the distance from the top edge of 
paper. 

Left Margin 0.0 inch Specify the distance from the left edge of 
paper so that the print starting point shifts to 
the right horizontally. 

Fit To Letter Disable or 
Enable* 

Set the printing mode that can fit paper to 
the printable area equivalent to 11 inches 
(66 lines). 

Text Height Same Set the height of a character. 
Same: The height stays the same 
regardless of CPI. 
Diff: The height varies according to CPI. 

LQ Mode On Specify the EPSON emulation. 
Private Print 
Setup 

Verify job option Disable Specify whether or not to verify the print 
data before printing. 
If enabled, the printer prints after verifying 
that the print data has not been changed. 
The integrity of print data is guaranteed, but 
the time to start printing will be longer. 

Erase job option No overwrite Set the method for erasing the print data. 
You can specify that the data cannot be 
restored by overwriting after it is erased. 
If you overwrite, it will take longer to erase. 
Value range: No overwrite/Zero out once 

Keep job for 2 hours Set the retention period of the print data. 
After the print data is saved, if the print data 
is not printed after the set period, the print 
data is automatically deleted. 
Value range: 15 min, 30 min, 1 hour, 2 
hours, 4 hours, 8 hours, 12 hours, 1 day, 2 
days, 3 days, 4 days, 5 days, 6 days, 7 days 

Job Limitation Enable all 
print formats 

Set whether or not to save restricted print 
data. 
When [Private Print only] is selected, any 
print data other than private print will not be 
accepted. 

Verify job password Off Select whether or not to verify the password 
of print data when access control is 
enabled. 

Job Auto Search On Select whether or not to perform print data 
search at the same time as unlocking the 
panel when access control is enabled. 



Changing settings from the operator panel 

- 118 - 

Item 
Factory 
default 
setting 

Description 

Panel Setup Near Life Status Enable Set whether or not to display a message 
when the image drum or fuser unit is 
approaching the end of service life. 

Near Life LED Enable Set whether or not to light the ATTENTION 
lamp when the image drum, fuser unit or 
toner cartridge is approaching the end of 
service life. 

Paper setup when paper exchange On Set whether or not to display a paper size 
confirmation message when the paper 
cassette is removed or when paper is 
loaded into the MP tray. 
This menu is displayed when [AirPrint] is set 
to [Disable] by disabling [Bonjour] or [IPP]. 

Idle Display Toner Gauge Select the information to be displayed on 
the standby screen. 

Panel Contrast 0 Adjust the display contrast. 
Value range: -10 ~ +10 

Power Save LED Brightness  Bright Set the brightness of the flashing Power 
Save LED when the machine is in the sleep 
mode. 

Buzzer Setup Error Volume Off Set the buzzer volume when an error 
occurs. 

Print Completion Buzzer Volume Off Set the buzzer volume when the printing 
has completed. 

Printer Identification Buzzer Volume Low Set the buzzer volume when you use 
AirPrint, Mopria, or IPP Everywhere to find 
the printer. 

Time Setup Date Format dd/mm/yyyy 
or 
mm/dd/yyyy* 

Set the date in the format of dd/mm/yyyy or 
mm/dd/yyyy. 

Time Zone +0:00 Set the GMT time zone. 
Value range: -12:00 ~ +13:00 (in increments 
of 15 minutes) 

Daylight Saving Off Set the daylight saving (daylight saving 
time). 

Setting method Manual 
Setup 

Select how to set the time. 

SNTP Server (Primary) (Blank) Set the SNTP server used to set the current 
date and time. Up to 64 characters can be 
used. 
It is displayed when [Setting method] is set 
to [Auto Setup]. 

SNTP Server (Secondary) (Blank) 

Time Setup - Change the date and time if necessary. 
It is displayed when [Setting method] is set 
to [Manual Setup]. 

Power Setup Auto Power Off Auto Config Set the operation of Auto Power Off. 
[Auto Config]: Auto Power Off does not work 
for network connections (wired/wireless). 
[Enable]: Auto Power Off works regardless 
of the connection method. 
[Disable]: Auto Power Off does not work. 
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Item 
Factory 
default 
setting 

Description 

Power Save Setting Mode1 Set the switching menu between the power 
save mode and low temperature standby 
mode. 
[Mode1]: Set it to the power save mode. The 
power consumption in the power save mode 
is lower than that in Mode2. 
[Mode2]: Set it to the low temperature 
standby mode. The printing startup in the 
power save mode is faster than that in Mode 
1. 

Tray Setup Unit of Measurement millimeter Set the unit of your custom paper size 
(millimeter/inch). 

Default Paper Size A4 Set the default paper size of the custom 
paper size. 

Others Setup 
 
 
 

Paper Feed 
Roller 
Counter 
Clear 

MP Tray Clear Execute Clear the counter after the paper feed roller 
of the MP tray is replaced. 

Tray1 Clear Execute Clear the counter after the paper feed roller 
of Tray 1 is replaced. 

Tray2 Clear Execute Clear the counter after the paper feed roller 
of Tray 2 is replaced. 

Tray3 Clear Execute Clear the counter after the paper feed roller 
of Tray 3 is replaced. 

Tray4 Clear Execute Clear the counter after the paper feed roller 
of Tray 4 is replaced. 

Flash 
Memory 
Setup 

Initialize All Initialize the specified partition of a flash 
memory. 
The partitions that can be specified are 
[PCL], [PS], [Common] and [All]. 

Job Log 
Setup 

Save Job Log Disable Set whether or not to save a log of print 
data. 

Clear Job Log Execute Clear the log of saved print data. 
It is displayed when [Save Job Log] is 
enabled. 

Access Log Setup Enable or 
Disable* 

Set whether or not to save an access log. 

Security 
Setup 

Access Control Disable Set whether or not to enable access control. 
User Counter Report Execute Print a user counter report. It is displayed 

when access control is set to [Enable] and 
[Save Job Log] is set to [Enable]. 

PJL Enhance Security 
 

Mode1 or 
Off* 

Set the behavior of the machine when it 
receives an unencrypted request that 
contains confidential data over the network. 
[Mode1] accepts and discards any 
unencrypted request that contains 
confidential data. 

Account 
Lockout 
 

Lockout Enable Set whether or not to prohibit new 
authentication for a certain period of time 
when authentication with a password has 
failed consecutively. 
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Item 
Factory 
default 
setting 

Description 

Lockout 
Condition 

5 times Set the conditions for lockout. 
Value range: 1 - 10 times (in increments of 1 
time) 
It is displayed when lockout is set to 
[Enable]. 

Lockout 
Period 

5 minutes Set the period of time for lockout. 
Value range: 1 minute, 5 minutes, 10 
minutes, 15 minutes, 30 minutes, and 60 
minutes 
It is displayed when lockout is set to 
[Enable]. 

Password 
Policy 

Minimum 
Length 

10 or 1* Set the number of characters for the 
password. 

Use 
Uppercase 

On or Off* Set whether the password contains at least 
one upper-case letter. 

Use 
Lowercase 

On or Off* Set whether the password contains at least 
one lower-case letter. 

Use Symbol Off Set whether the password contains at least 
one symbol. 

Use digit Off Set whether the password contains at least 
one digit. 

Font Setup Font Output Mode JIS2004 Set the font output mode. 
Job Cancel 
Setup 

Cancel Button Behavior Short Set the behavior when the «CANCEL» 
button is pressed. 
[Short]: A short press (for 2 seconds or less) 
cancels the printing. 
[Long]: A long press for 2 to 5 seconds 
cancels the printing. 
[Off]: Pressing the «CANCEL» button does 
not cancel the printing. 

Inquiry Display On Set whether or not to display a screen to 
confirm whether or not to cancel the 
printing. 

Focus Position Yes Set whether or not to select [Yes] or [No] as 
the default on the job cancel inquiry screen. 

Display Timeout 180 Set the waiting time in seconds before a 
button is pressed on the job cancel inquiry 
screen. When the waiting time has passed, 
the printing will be continued instead of 
being canceled. 
Value range: 60 - 300 (sec) 

Near Life 
Setup 

Drum Near Life Timing 1000 Set whether or not to display the number of 
copies before the image drum is 
approaching the end of its service life. 
Value range: 500 - 5,000 (in increments of 
500) 

Fuser Near Life Timing 1500 Set whether or not to display the number of 
copies before the fuser unit is approaching 
the end of its service life. 
Value range: 500 - 5,000 (in increments of 
500) 
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Item 
Factory 
default 
setting 

Description 

Erase Privacy Data Execute Erase the following data set in this machine. 
• Admin password, values set in various 
menus 
• Various records 
• Access control registered to this machine, 
user information 

NFC Setup Enable Enable/Disable the NFC function. 

 
 Depending on the specific region, this 

machine may not come with the NFC 
function. 

LAN LED Setup On Set whether or not to light the LED of the 
standard LAN (LAN1) when the machine 
enters the sleep mode. 

Power Off/On Log Record On Set whether or not to record the power 
off/on log of the machine as an error log. 

Power Off/On Log Print Off Set whether or not to include the power 
off/on log of the machine when printing the 
error log. 

Settings Reset Settings Execute Reset the menu settings changed by the 
user to the factory default settings. 

Change Password - Set a new admin password. 
Print 
Information 

Job Log - Print the history of print data. 
It is displayed when [Menus] - [Admin 
Setup] - [Others Setup] - [Job Log Setup] - 
[Save Job Log] is set to [Enable]. 

Menus (AirPrint) 
Item Factory default setting Description 

AirPrint Enable Enable AirPrint. 
If [AirPrint] is set to [Enable], [Bonjour] and [IPP] will also 
be set to [Enable]. 

Menus (Print Statistics) 
The asterisk (*) indicates that factory default settings may differ from region to region. 

Item 
Factory 
default 
setting 

Description 

Enter Password (Please refer 
to the 
password 
label 
attached on 
the inside of 
this 
machine.) 

Input the password required to enter the Print Statistics 
menu. 

Usage Report Enable Enable/Disable the usage report. 
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Item 
Factory 
default 
setting 

Description 

Maintenance Counter Disable Set whether or not to add a Maintenance Report (non-
resettable Counter and non-resettable Consumable 
Replacements) to [Usage Report]. 
[Disable]: Print the resettable Counter and resettable 
Consumable Replacements in [Usage Report]. 
[Enable]: In addition to the resettable Counter and 
resettable Consumable Replacements, the Maintenance 
Report (non-resettable Counter and non-resettable 
Consumable Replacements) is also printed together in 
[Usage Report]. 
It is displayed when [Print Statistics] - [Usage Report] is set 
to [Enable]. 

Reset Main Counter Execute Reset the main counter. 
It is displayed when [Print Statistics] - [Usage Report] is set 
to [Enable]. 

Reset Supplies Counter Execute Reset the replacement counter of consumables. 
The maintenance counter is not reset. 
It is displayed when [Print Statistics] - [Usage Report] is set 
to [Enable] and [Maintenance Counter] is set to [Enable]. 

Account Lockout Lockout Enable Set whether or not to prohibit new authentication for a 
certain period of time when authentication with a password 
for Print Statistics has failed consecutively. 

Lockout Condition 5 times Set the conditions for lockout. 
Value range: 1 - 10 times (in increments of 1 time) 
It is displayed when [Lockout] is set to [Enable]. 

Lockout Period 5 minutes Set the period for lockout. 
Value range: 1 minute, 5 minutes, 10 minutes, 15 minutes, 
30 minutes, and 60 minutes 
It is displayed when [Lockout] is set to [Enable]. 

Password Policy Minimum Length 10 or 1* Set the minimum length of the password. 
Use Uppercase On or Off* Set whether the password contains at least one upper-case 

letter. 
Use Lowercase On or Off* Set whether the password contains at least one lower-case 

letter. 
Use Symbol Off Set whether the password contains at least one symbol. 
Use digit Off Set whether the password contains at least one digit. 

Change Password - Set a new password required to enter the Print Statistics 
menu. 
It is displayed when [Print Statistics] - [Usage Report] is set 
to [Enable]. 

Menus (Calibration) 

Item Factory default 
setting Description 

Fuser Temp Adjust 0 Adjust the fuser unit temperature. 
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Menus (User Account Info) 

Item Factory default 
setting Description 

Change Password - Input a new password. 
It is displayed when [Access Control] is set to [Enable] and 
you log in using local authentication. 

Print 
Item Description 

Print From USB 
Memory 
 

Select Print File Execute Print the selected file. 
Print Setup Paper Feed Tray Set the tray to feed paper. 

Copies Set the number of copies. 
Duplex Set whether or not to print on both sides. 
Binding Set the binding method for duplex printing. 

It is displayed when duplex printing is specified. 
Fit Set whether or not to fit to the paper. 

Shared Print ---Print All--- It is displayed when the shared print data is 
available. 
Print all the shared print data. 

---Delete All--- It is displayed when the shared print data is 
available. 
Delete all the shared print data. 

(View a list of target 
files.) 

It is displayed when the shared print data is 
available. Print the selected file(s). 

Private Print Please select a User Select a user. 
It is displayed when [Access Control] is set to 
[Disable]. 

Enter Password Input the password for the selected user. 
Search all the Private 
Jobs? 

Select whether or not to search for private print 
data for all users or private print data of a 
certain individual (i.e. the logged-in user). 
It is displayed when [Access Control] is set to 
[Disable] and when "admin" is specified in 
[User Name]. 
Or, it is displayed when [Access Control] is set 
to [Enable] and when you log in as a user with 
the role of administrator. 

---Print All--- Print all the private print data. 
It is not displayed when you search for jobs for 
all users. 

---Delete All--- Delete all the private print data. 
(View a list of target 
files.) 

When access control is set to [Disable]: 
When there is private print data, select the 
private print data and print it. 
When access control is set to [Enable]: 
When there is private print data created by the 
logged-in user, select the private print data and 
print it. 
Printing is not possible when you search for 
jobs for all users. Only deleting is possible. 
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Wireless Setting (Wireless(Wi-Fi Direct) Setting) 

Item 
Factory 
default 
setting 

Description 

Enter Password (Please refer 
to the 
password 
label 
attached on 
the inside of 
this 
machine.) 

Input the password required to enter the Admin Setup 
menu. 

Wireless(Wi-Fi Direct) Disable Enable/Disable the Wireless LAN (Wi-Fi Direct). 
It cannot be enabled simultaneously with 
[Wireless(Infrastructure)]. 

Manual Setup Display the SSID and password of this machine for manual 
setup. 

Connection Setting SSID DIRECT-xx-
Printer Name 

Input a new one to change the SSID. 
The DIRECT-xx part cannot be changed. (Here, xx stands 
for 2 alphanumeric characters.) 

Password  Input a new one to change the password. 
IPv4 Address 192.168.110.

100 
Input the IPv4 address. 

Auto Approval 
Setting 

Disable Set whether or not to accept the Wi-Fi Direct connection 
request from a mobile device. 
If [Enable] is set, the connection request is accepted 
automatically. 
If [Disable] is set, a confirmation screen is displayed on the 
operator panel to ask whether or not to accept the 
connection. 

Execute  Execute connection setup. 
Password Disclose Setting Don't 

disclose 
In the [Information] menu, set whether or not to display the 
password. 

Wireless Setting (Wireless(Infrastructure) Setting) 

Item 
Factory 
default 
setting 

Description 

Enter Password (Please refer 
to the 
password 
label 
attached on 
the inside of 
this 
machine.) 

Input the password required to enter the Admin Setup 
menu. 

Wireless(Infrastructure) Disable  Enable/Disable the wireless LAN (infrastructure). 
It cannot be enabled simultaneously with [Wireless(Wi-Fi 
Direct)]. 

Network 
Setup 

IP Address Set Auto Set whether to obtain the IPv4 address automatically or 
input it manually. 

IPv4 Address 192.168.101.
100 

Input the IPv4 address manually. 
It is displayed when [IP Address Set] is set to [Manual]. 
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Item 
Factory 
default 
setting 

Description 

Subnet Mask 255.255.255.
0 

Input the subnet mask. 
It is displayed when [IP Address Set] is set to [Manual]. 

Gateway Address 0.0.0.0 Input the gateway address. 
It is displayed when [IP Address Set] is set to [Manual]. 

DHCPv6 Disable Set whether or not to obtain the IPv6 address 
automatically. Set it to Disable when you do not use the 
IPv6 address. 

Automatic 
setup (WPS) 

WPS-PBC  Execute it when setting is done by pressing the WPS 
button of the wireless LAN access point. 

WPS-PIN  Execute it when the PIN code displayed on this machine is 
registered with the wireless LAN access point. 

Wireless 
Network 
Selection 

xxxxxx 
... 

 Display the list of wireless LAN access points detected by 
this machine. 

Manual 
Setup 

SSID  Input the SSID. 
Security Disable  Set the security of the wireless LAN function. 
WEP Key  Input the WEP key. 
WPA 
Encryption 
Type 

 Display the WPA-PSK encryption type. 
The setting is carried out automatically according to the 
security settings. (They cannot be switched in this menu.) 

WPA Pre-
shared Key 

 Input the pre-shared key. 
It is displayed when [Security] is set to any other value than 
[Disable] or [WEP]. 

Execute  Execute the changes to security settings. 
Wireless reconnection  Reconnect to the wireless LAN (infrastructure). 
   



Changing settings from the operator panel 

- 126 - 

Boot Menu 
 While holding «OK» on the operator panel, press the power button. When [Boot Menu] appears on the 
display, release your finger and press «OK» again. 

 Press the scroll button ▲ or ▼ to input the admin password, and then press «OK». 

 Administrator Password(P.195) 

 
 This menu operation requires a restart. 

Item 
Factory 
default 
setting 

Description 

Enter Password (Please refer 
to the 
password 
label 
attached on 
the inside of 
this 
machine.) 

Input the admin password required to enter the Boot Menu. 

Menu Lockout Off When [On] is set, the Admin Setup and user menu list are 
hidden and thus unavailable. However, only printing 
settings are displayed. 

Panel Lockout Off Disable the buttons on the operator panel. 
[Mode1]: Enable «OK», «CANCEL», «HELP» and 
«BACK»; and disable ▲ and ▼. 
[Mode2]: Disable all the buttons except «OK», «HELP» and 
«BACK». 
[Off]: All the buttons can be used. 

After AC power supply fails Always Off Set whether or not to restore the Ready-To-Print status 
automatically in case of a power failure. 
Depending on the action mode of the machine, if the power 
cord is unplugged or power supply is interrupted (e.g. due 
to a power failure), the machine may not start by force 
unless a specified period of time has elapsed before the 
power cord is reconnected. (5 minutes in Japan, 6 minutes 
in Taiwan, and 8 minutes in other countries or regions 
except Japan and Taiwan) 
[Always On]: This machine is started by force when the 
power failure is recovered without pressing the power 
button. This machine starts simply by connecting the power 
plug to the outlet. 
[Always Off]: This machine does not start when the power 
failure is recovered without pressing the power button. 
[Last State]: This machine remembers the state when the 
power supply is interrupted and restarts with that state after 
the power failure is recovered. This machine automatically 
restores the Ready-to-Print state when the power failure is 
recovered even if the power supply is interrupted due to a 
power failure while the machine is working. If a power 
failure occurs when the power is off, this machine does not 
start even after the power failure is recovered. 
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Printing from a PC 

Both the PCL printer driver and PS printer driver are available. 
 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [OKI *** PCL6] (where *** is your model name) from [Printer]. 

4 Click [More settings]. 

 

5 Select the size of the loaded paper from [Size] in the [Setup] tab. 

 

6 Select the tray to be printed from [Source]. 
 
 If you cannot select Tray 2/3/4, please refer to "Setting the printer driver(P.67)". 

7 Set [Type] and [Weight]. 

8 Set other necessary items. 

9 Click [OK]. 

10 Printing starts. 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [OKI *** PS] (where *** is your model name) from [Printer]. 
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4 Click [More settings]. 

 

5 Select the [Paper/Quality] tab. 

6 Select the tray to be printed from [Paper Source]. 
 
 If you cannot select Tray 2/3/4, please refer to "Setting the printer driver(P.67)". 

7 Click [Advanced]. 

8 Click [Paper Size], and select the size of the loaded paper from the drop-down list. 

9 Click [OK]. 

10 Set other necessary items. 

11 Click [OK]. 

12 Printing starts. 

For the macOS PCL printer driver 
This sections takes for example printing with TextEdit. 
 

1 Open the file to be printed. 

2 Select [Page Setup] from the [File] menu. 

3 Select your model from [Target Printers]. 

4 Select the size of the loaded paper from [Media Size], and click [OK]. 

5 Select [Print] from the [File] menu. 

6 Select [Setup] from [Printer Options]. 

7 Select the tray to be printed from in [Paper Source]. 
 
 If you cannot select Tray 2/3/4, please refer to "Setting the printer driver(P.67)". 

8 Set other necessary items. 

9 Printing starts. 

For the macOS PS printer driver 
This sections takes for example printing with TextEdit. 
 

1 Open the file to be printed. 

2 Select [Page Setup] from the [File] menu. 
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3 Select your model from [Target Printers]. 

4 Select the size of the loaded paper from [Media Size], and click [OK]. 

5 Select [Print] from the [File] menu. 

6 Select [Paper Feed] from [Printer Options]. 

7 Select [All Pages From], and select the tray to be printed from. 
 
 If you cannot select Tray 2/3/4, see "Setting the printer driver(P.67)". 

8 Set other necessary items. 

9 Printing starts. 
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Screens and functions of the printer driver 

For the Windows PCL printer driver 

[Setup] tab 

 
No. Item Description 

1 Driver Setting Save the settings. 

2 Layout image Display a sample image of the print layout. 

3 Size Set the paper size. 

4 Source Set the paper source. 

5 Type Set the media type. 

6 Weight Set the media weight. 

7 Paper Feed Options You can make detailed settings for paper feeding. 

8 Options You can make detailed settings for the layout. 

9 Finishing Mode Set multi-page printing, booklet printing, poster printing, etc. 

10 2-Sided Printing Set the duplex printing. 

11 Orientation Set the printing orientation. 

12 Mono Settings Adjust the brightness during mono printing. 

13 Toner Saving Decrease the print density to reduce the amount of toner to be used. 

14 About Display the version of the printer driver. 

15 Default Restore the settings of each item in the tab to the initial values. 
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[Job Options] tab 

 
No. Item Description 

1 Quality Specify the print resolution. 

2 Scale Set the enlargement/reduction of printing. 

3 Copies Specify the number of copies. 

4 Job Type Set the type of printing. 

5 Print Mode Set whether the print data sent to the printer is in PCL format or as an image. 

6 Advanced Make other printing settings. 

7 Default Restore the settings of each item in the tab to the initial values. 

[Extend] tab 

 
No. Item Description 

1 Watermarks Set it for printing with a text or stamp watermark. 

2 Overlays Set it for printing with an overlapping print format registered in the printer 
beforehand. 

3 Fonts Set the TrueType font and printer font. 

4 User Authentication Set the user authentication. 
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For the Windows PS printer driver 

[Layout] tab 

 
No. Item Description 

1 Orientation Set the printing orientation. 

2 Print on Both Sides Set it for duplex printing. 

3 Page Order Set the order of pages to be printed. 

4 Page format Specify the number of pages to be printed on one sheet of paper and booklet 
printing. 

5 Layout image Display a sample image of the print layout. 

6 Advanced You can make detail settings such as the print quality and paper size. 

[Paper/Quality] tab 

 
No. Item Description 

1 Tray selection Change the paper tray. 

2 Advanced You can make detail settings such as the print quality and paper size. 
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[Job Options] tab 

 
No. Item Description 

1 Quality Specify the print resolution, etc. 

2 Job Type Set the type of print data, the number of copies, etc. When [Shared Print] or 
[Private Print] is set, [Job Type Option] is available. If [Collate] is checked, 
multiple documents will be printed as a batch. 

3 Fit to page Check [Resize document to fit printer page] to print on a different size of paper. 

4 Watermarks Set it for printing with a text or stamp watermark. 

5 Overlays Set it for printing with an overlapping format registered in the printer beforehand. 

6 Advanced Other settings can be made. 

7 User Authentication Set the user authentication. 

8 About Display the version of the printer driver. 

9 Default Restore the settings of each item in the tab to the initial values. 

For the macOS PCL printer driver 

[Layout] 

 
No. Item Description 

1 Pages per Sheet Select the number of pages to be printed on one sheet of paper. 

2 Layout Direction Specify the layout for printing multiple pages on one sheet of paper. 

3 Border Specify the type of borders. 

4 Reverse page orientation Check it to print by reversing the page direction. 

5 Flip horizontally Check it to print by reversing the data horizontally. 



Printing from a PC 

- 135 - 

[Paper Handling] 

 
No. Item Description 

1 Collate pages Check it to print a multi-page document in collation. 

2 Pages to Print Specify the pages to be printed. 

3 Page Order Specify the order of pages to be printed. 

4 Scale to fit paper size Print it by fitting to the paper size. Depending on the settings, printing may not 
work correctly. Check it to print by zooming-in/-out the data according to the 
paper size. 

5 Destination Paper Size Specify the size of the paper to be printed when [Scale to fit paper size] is 
checked. 

6 Scale down only Specify settings for printing in reduction only to fit the size of the paper. 

[Printer Options] - [Setup] 

 
No. Item Description 

1 Paper Set the paper source, paper type, paper weight and so on. 

2 Duplex Specify settings for duplex printing. 

3 About Display the version of the printer driver. 

4 Default Restore the panel settings to the initial values. 
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[Printer Options] - [Job Options] 

 
No. Item Description 

1 Print Quality Specify the printing resolution. 

2 Toner Saving Specify the print density in the toner saving mode. 

3 Advanced Set other printing options. 

4 Default Restore the panel settings to the initial values. 

[Printer Options] - [Image] 

 
No. Item Description 

1 Manual Settings Specify the brightness and contrast. 

2 Default Restore the panel settings to the initial values. 
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[Printer Options] - [User Authentication] 

 
No. Item Description 

1 Use User Authentication Check it to set user authentication for printing. 

2 User Name The user name for user authentication. 

3 Password The password for user authentication. 

4 Authentication type Specify the authentication type to be used. 

 
 [Authentication Type] can be enabled in the [Options] tab of [Options and Supplies] displayed by selecting [System 

Preferences] - [Printers & Scanners] from the Apple menu. 

[Printer Options] - [Encrypt print jobs] 

 
No. Item Description 

1 Encrypt print jobs Check it to encrypt print data before printing. 

2 Printer key for encrypting 
print jobs 

Input the printer key obtained from the web page of this machine. 
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For the macOS PS printer driver 

[Layout] 

 
No. Item Description 

1 Pages per Sheet Select the number of pages to be printed on one sheet of paper. 

2 Layout Direction Specify the layout for printing multiple pages on one sheet of paper. 

3 Border Specify the type of borders. 

4 Reverse page orientation Check it to print by reversing the page direction. 

5 Flip horizontally Check it to print by reversing the data horizontally. 

[Paper Handling] 

 
No. Item Description 

1 Collate pages Check it to print a multi-page document in collation. 

2 Pages to Print Specify the pages to be printed. 

3 Page Order Specify the order of pages to be printed. 

4 Scale to fit paper size Print it by fitting to the paper size. Depending on the settings, printing may not 
work correctly. Check it to print by zooming-in/-out the data according to the 
paper size. 

5 Destination Paper Size Specify the size of the paper to be printed when [Scale to fit paper size] is 
checked. 

6 Scale down only Specify settings for printing in reduction only to fit the size of the paper. 
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[Printer Options] - [Paper Feed] 

 
No. Item Description 

1 All Pages From Specify the tray to feed paper. When [Auto Select] is specified, a tray is selected 
automatically. 

2 First Page From Select it to print only the first page from the specified tray. 

3 Remaining From Select it to print the remaining pages from the specified tray. 

[Printer Options] - [Color Matching] 

 
No. Item Description 

1 ColorSync Specify the ColorSync function. 

2 In printer Use color matching in this machine. 

3 Profile Specify a profile. 

[Printer Options] - [Print Options] 

 
No. Item Description 

1  Quality1, Quality2, Feed, 
Paper 

Specify the print quality, toner save, media type, etc. 
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[Printer Options] - [User Authentication] 

 
No. Item Description 

1 Use User Authentication Check it to set user authentication for printing. 

2 User Name The user name for user authentication. 

3 Password The password for user authentication. 

4 Authentication type Specify the authentication type to be used. 

 
 [Authentication Type] can be enabled in the [Options] tab of [Options and Supplies] displayed by selecting [System 

Preferences] - [Printers & Scanners] from the Apple menu. 

[Printer Options] - [Secure Print] 

 
No. Item Description 

1 Job Type Specify the type of print data. When [Private Print] or [Shared Print] is set, [Job 
Type Option] is available. 

2 Job Type Option Specify the password for printing the job name displayed on the panel. 
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[Printer Options] - [Encrypt print jobs] 

 
No. Item Description 

1 Encrypt print jobs Check it to encrypt print data before printing. 

2 Printer key for encrypting 
print jobs 

Input the printer key obtained from the web page of this machine. 

How to open [Devices and Printers] 
This section explains how to open the printer driver icon folder for each version of Windows. 

For Windows 11/Windows Server 2025 

1 Select [Start] - [Settings] - [Bluetooth & devices] - [Devices] - [More devices and printer 

settings]. 
 

For Windows 10 (Version 1703 or later)/Windows Server 2022/Windows Server 2019 

1 Click [Start] to display the application list. 

2 Select [Windows System Tool] - [Control Panel] - [Devices and Printers]. 

 
For Windows 10/Windows Server 2016 

1 Open the control panel, and select [View devices and printers]. 
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Printing on various types of paper 

Printing on envelopes 
You can print on long paper using the multi-purpose tray (MP tray). 

 
 Tray 1/2/3/4 is not applicable. 

Loading envelopes 
1 Check the paper precautions. 

 Applicable paper(P.74) 
 Inapplicable paper(P.75) 
 Paper precautions by type(P.76) 

2 Load envelopes with the print side facing up by referring to the following instructions. 
Load Nagagata envelopes (Naga#3, Naga#4, and Naga#40) with the flap (opening margin) open. 
Load Yougata envelopes (You#0  and You#4) with the flap (opening margin) folded. 
Load Yougata envelopes (You #0 ) with the flap (opening margin) open. 
For the detailed procedure, please refer to "Loading paper in the MP tray(P.82)". 

 
Envelopes (Naga#3 and Naga#4) 
* Set the flap without breaking it. Envelopes (You#0  and You#4) 

When printing the 
address 

  

When printing the 
sender 

  

3 Check that "Ready To Print" appears on the display. 

4 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

5 Press ▼ several times to select [User Setup], and press «OK». 
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6 Check that [Tray Configuration] is selected, and press «OK». 

 

7 Check that [MPTray Config] is selected, and then press «OK». 

 

8 Check that [Paper Size] is selected, and press «OK». 

 

9 Press ▲ or ▼ several times to select a value that matches the envelopes to be loaded, and 

then press «OK». Check that [*] is displayed to the left of the selected setting. 

 

10 Press «OK». 

11 Press ▲ or ▼ several times to select [Media Weight], and then press «OK». 

12 Press ▲ or ▼ several times to select the paper weight to match the GSM weight of the paper to 

be used for the loaded envelope, and then press «OK». Check that [*] is displayed to the left of 

the selected setting. 
 
 For envelopes made of paper with a GSM weight of 85 g/m2, select [Medium]. 
 Setting paper information on the operator panel(P.84) 

13 Press «CANCEL» to return to the standby screen. 
 

If you are concerned about wrinkles 
After printing, if you are concerned about wrinkles on the envelope, follow the procedure below to change the 
position (blue, small) of the envelope lever on the fuser unit, set the paper weight to [Heavy], and print it again. 
If you are printing on any other paper than envelopes, press the jam release lever (blue, large) to return the 
envelope lever (blue, small) to its original position. 

1 Take out the fuser unit by following Steps 2 - 5 of "Replacing the maintenance kit". 
 Replacing the maintenance kit(P.312) 
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2 By holding the handle, press in the envelope lever (blue, small). 

 

3 Install the removed fuser unit back into the machine by following Steps 6 - 7 of "Replacing the 

maintenance kit". 
 Replacing the maintenance kit(P.312) 

4 By following the procedure in the next section, "Printing from a PC", set the paper weight to 

[Heavy], and start printing. 

5 Once the envelope printing is complete, press the jam release lever (blue, large) next to the 

envelope lever (blue, small) of the fuser unit, and then return the paper envelope lever (blue, 

small) to its original position. 

 

 

Printing from a PC 
For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [Envelope*] from [Size] in the [Setup] tab. 
* Select the type of the envelope loaded. 

5 Select the tray where envelopes are loaded from [Source]. 

6 Specify other settings as necessary, and click [OK]. 
 
 If you want to print while checking each sheet, click [Paper Feed Options] in [Setup] of the printer driver, and 

check [Feed paper individually] (or select [Yes]). To print continuously, uncheck [Feed paper individually] (or 
select [No]). For details, please refer to "Printing one sheet at a time manually(P.156)". 

7 Click [Print] in the [Print] screen. 
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For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Click [Advanced] in the [Layout] tab, and select [Envelope*] from [Paper Size]. 
* Select the type of the envelope loaded. 

5 Click [OK]. 

6 Select the tray where envelopes are loaded from [Paper Source] in the [Paper/Quality] tab. 

7 Specify other settings as necessary, and click [OK]. 
 
 If you want to print while checking each sheet, check [Feeds paper one by one from the MP tray] in [Advanced] 

on the [Layout] tab of the printer driver (or select [Yes]). To print continuously, uncheck [Feeds paper one by 
one from the MP tray] (or select [No]). For details, please refer to "Printing one sheet at a time 
manually(P.156)". 

8 Click [Print] in the [Print] screen. 
 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the envelope size from [Paper Size] and the orientation from [Orientation]. 

4 Select [Multi Purpose Tray] from [Printer Options] - [Setup] - [Paper Source]. 

5 Specify other settings as necessary, and click [Print]. 
 
 If you want to print while checking each sheet, select [Multi Purpose Tray] from [Paper Source] in the printer 

driver, and check [Feeds paper one by one from the MP tray] of [Paper Feed Options] (or select [Yes]). To print 
continuously, uncheck [Feeds paper one by one from the MP tray] (or select [No]). For details, please refer to 
"Printing one sheet at a time manually(P.156)". 

 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the envelope size from [Paper Size] and the orientation from [Orientation]. 

4 Select [Multi-Purpose Tray] from [Printer Options] - [Paper Feed] - [All Pages From]. 

5 Specify other settings as necessary, and click [Print]. 
 
 If you want to print while checking each sheet, select [Multi-Purpose Tray] from [Paper Feed] -[All Pages From] 

in the printer driver, and check [Printer Options] - [Print Options] - [Paper input options] - [Feeds paper one by 
one from the MP tray] (or select [Yes]). To print continuously, uncheck [Feeds paper one by one from the MP 
tray] (or select [No]). For details, please refer to "Printing one sheet at a time manually(P.156)". 

 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 
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Printing on labels 
Labels are printed from the MP tray. 

1 Check the paper precautions. 
 Applicable paper(P.74) 
 Inapplicable paper(P.75) 
 Paper precautions by type(P.76) 

2 Load labels with the print side facing up by referring to the following instructions. 
For the detailed procedure, please refer to "Loading paper in the MP tray(P.82)". 

 

3 Check that "Ready To Print" appears on the display. 

4 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

5 Press ▼ several times to select [User Setup], and press «OK». 

 

6 Check that [Tray Configuration] is selected, and press «OK». 

 

7 Check that [MPTray Config] is selected, and then press «OK». 

 

8 Check that [Paper Size] is selected, and press «OK». 
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9 Press ▲ or ▼ several times to select the size of the labels to be loaded, and then press «OK». 

Check that [*] is displayed to the left of the selected setting, and then press «BACK». 

 

10 Press ▼ to select [Media Type], and press «OK». 

 

11 Press ▲ or ▼ to select [Labels], and press «OK». Check that [*] is displayed to the left of the 

selected setting. 

 

12 Press «CANCEL» to return to the standby screen. 
 

Printing from a PC 
 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [A4] or [Letter] from [Size] in the [Setup] tab. 

5 Select the tray where labels are loaded from [Source] in the [Setup] tab. 

6 Make settings as follows in [Type]. 
If you selected [Labels] on the operator panel when you loaded labels in the machine, select [Printer 
Setting] in [Type]. 
In other cases, select [Labels] in [Type]. 

7 If necessary, click [Paper Feed Options], uncheck [Long Edge Feed] for the tray to feed paper, 

and click [OK]. 
 
 If you want to print while checking each sheet, click [Paper Feed Options] in [Setup] of the printer driver, and 

check [Feed paper individually] (or select [Yes]). To print continuously, uncheck [Feed paper individually] (or 
select [No]). For details, please refer to "Printing one sheet at a time manually(P.156)". 

8 Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 
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For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Click [Advanced] in the [Layout] tab, and select [A4] or [Letter] from [Paper Size]. 

5 Click [OK]. 

6 Select the tray where labels are loaded from [Paper Source] in the [Paper/Quality] tab. 

7 Make settings as follows in [Media]. 
If you selected [Labels] on the operator panel when you loaded labels in the machine, select [Printer 
Setting] in [Media]. 
In other cases, select [Labels] in [Media]. 

8 Specify other settings as necessary, and click [OK]. 
 
 If you want to print while checking each sheet, check [Feeds paper one by one from the MP tray] in [Advanced] 

on the [Layout] tab of the printer driver (or select [Yes]). To print continuously, uncheck [Feeds paper one by 
one from the MP tray] (or select [No]). For details, please refer to "Printing one sheet at a time 
manually(P.156)". 

9 Click [Print] in the [Print] screen. 
 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [A4] or [Letter] from [Paper Size]. 

4 Select [Printer Options] - [Setup]. 

5 Select the tray where labels are loaded from [Paper Source]. 

6 Make settings as follows in [Media Type]. 
If you selected [Labels] on the operator panel when you loaded labels in the machine, select [Printer 
Setting] in [Media Type]. 
In other cases, select [Labels] in [Media Type]. 

7 Specify the media weight and other settings as necessary, and click [Print]. 
 
 If you want to print while checking each sheet, select [Multi Purpose Tray] from [Paper Source] in the printer 

driver, and check [Feeds paper one by one from the MP tray] of [Paper Feed Options] (or select [Yes]). To print 
continuously, uncheck [Feeds paper one by one from the MP tray] (or select [No]). For details, please refer to 
"Printing one sheet at a time manually(P.156)". 

 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [A4] or [Letter] from [Paper Size]. 

4 Select the tray where labels are loaded from [Printer Options] - [Paper Feed] - [All Pages From]. 
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5 Select the [Paper Feed] tab in [Printer Options] - [Print Options]. 

6 Make settings as follows in [Media Type]. 
If you selected [Labels] on the operator panel when you loaded labels in the machine, select [Printer 
Setting] in [Media Type]. 
In other cases, select [Labels] in [Media Type]. 

7 Specify other settings as necessary, and click [Print]. 
 
 If you want to print while checking each sheet, select [Multi-Purpose Tray] from [Paper Feed] - [All Pages From] 

in the printer driver, and check [Printer Options] - [Print Options] - [Paper input options] - [Feeds paper one by 
one from the MP tray] (or select [Yes]). To print continuously, uncheck [Feeds paper one by one from the MP 
tray] (or select [No]). For details, please refer to "Printing one sheet at a time manually(P.156)". 

 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing on long paper 
You can print on long paper using the multi-purpose tray (MP tray). 
Set the size of the long paper to the custom size of the MP tray on the control panel, select a custom size 
(user-defined size) for the size of the long paper in the printer driver, and start printing. 
The size of long paper ranges from 210 mm to 216 mm in width and from 356 mm to 1,321 mm in length. 
 

Setting the paper size before loading paper 
1 Set the X and Y dimensions, media type, and media weight of long paper to the custom size of 

the MP tray on the control panel. 
Refer to "Setting the paper size before loading paper" of "Printing on irregular paper (Custom)(P.151)" for the 
detailed procedure. 

 

Printing from a PC 
For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [User Defined Size] from [Size] in the [Setup] tab, and click [OK]. 
 
 If the size of the loaded paper is 210.0 x 900.0 mm, 215.0 x 900.0 mm, or 215.0 x 1200.0 mm, you can select 

the paper size from [Banner *** x *** mm]. 
Please refer to "Printing on irregular paper (Custom)(P.151)" for how to set an irregular size. 

5 Select [Multi Purpose Tray] in [Source]. 

6 Specify the media weight and other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
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For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Click [Advanced] in the [Layout] tab, select [PostScript Custom Page Size] from [Paper Size], 

input values in [Width] and [Height], and click [OK]. 
To change the size, press [Edit Custom Page Size], input your desired values in [Width] and [Height], and 
click [OK]. 

5 Click [OK]. 

6 Select [Multi Purpose Tray] from [Paper Source] in the [Paper/Quality] tab. 

7 Specify the media weight and other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 
For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Manage Custom Sizes] from [Paper Size]. 

4 Click [+] to add an item to the list of paper size. 

5 Double-click on [Untitled], and input a name for the long paper size. 

6 Select a printer from [Non-Printable Area]. 

7 Input values in [Width] and [Height]. 

8 Click [OK]. 

9 Select a registered paper size from [Paper Size]. 

10 Select [Multi Purpose Tray] from [Printer Options] - [Setup] - [Paper Source]. 

11 Specify the media weight and other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Manage Custom Sizes] from [Paper Size]. 

4 Click [+] to add an item to the list of paper size. 

5 Double-click on [Untitled], and input a name for the long paper size. 

6 Select a printer from [Non-Printable Area]. 

7 Input values in [Width] and [Height]. 

8 Click [OK]. 
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9 Select a registered paper size from [Paper Size]. 

10 Select [Multi-Purpose Tray] from [Printer Options] - [Paper Feed] - [All Pages From]. 

11 Specify the media weight and other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing on irregular paper (Custom) 
When printing on irregular paper (Custom), set the paper size, media type and media weight of the irregular 
size (Custom) on the operator panel. Before printing, register the paper size in the printer driver. 
 

Setting the paper size before loading paper 
1 Check the paper precautions. 

 Applicable paper(P.74) 
 Inapplicable paper(P.75) 
 Paper precautions by type(P.76) 

2 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

3 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

4 Press ▼ several times to select [User Setup], and press «OK». 

 

5 Check that [Tray Configuration] is selected, and press «OK». 

 

6 Press ▼ to select the setting of the tray where the paper is loaded, and then press «OK». 
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7 Check that [Paper Size] is selected, and press «OK». 

 

8 Press ▲ or ▼ several times to select [Custom], and then press «OK». 

 

9 Check that [*] is displayed to the left of [Custom], and then press «BACK». 

 

10 Press ▼ to select [X Dimension], and press «OK». 

 

11 Press ▲ or ▼ to input the paper width, and then press «OK». 

 

12 Check that [*] is displayed to the left of the value, and then press «BACK». 

 

13 Press ▼ to select [Y Dimension], and press «OK». 

 

14 Press ▲ or ▼ to input the paper length, and then press «OK». 
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15 Check that [*] is displayed to the left of the value, and then press «BACK». 

 

16 Press «CANCEL» to return to the standby screen. 

17 Load paper in the tray to be used. When the setting change screen is displayed, press 

«BACK». 
 Loading paper in Tray 1 (for B433)(P.79) 
 Loading paper in the MP tray(P.82) 

 

Printing from a PC 
 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3  Click [More settings]. 

4 Click [Paper Feed Options] in the [Setup] tab. 

5 Click [Custom Size]. 

6 Input a name for the new size in [Name]. 

7 Input values in [Width] and [Length]. 

8 Click [Add] to save any paper size in the list, and click [OK]. 
Up to 32 settings can be saved. 

9 Click [OK] until the [Printing Preferences] screen is closed. 

10 Open the file to be printed. 

11 Select [Print] from the [File] menu. 

12 Click [More settings]. 

13 Select the paper size registered in [Size] on the [Setup] tab. 

14 Specify the media weight and other settings as necessary, and click [OK]. 

15 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Click [Advanced] in the [Layout] tab. 

5 Click [Paper Size], and select [PostScript Custom Page Size] from the pull-down menu. 

6 Click [Edit Custom Page Size]. 
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7 Input values in [Width] and [Height], and click [OK]. 
 
 [Offset Relative to Paper Feed Direction] cannot be set. 

8 Click [OK]. 

9 Specify the media weight and other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 
 

For the macOS PCL printer driver 

 
 When using macOS, you cannot print properly, although you can set the paper size beyond the usable range. Set the 

paper size within the range. 
 macOS may regard the custom-sized paper which is close to a fixed size as the fixed-sized paper. 

1 Open the file to be printed. 

2 Select [Page Setup] from the [File] menu. 

3 Select [Manage Custom Sizes] from [Paper Size]. 

4 Click [+] to add an item to the list of paper size. 

5 Double-click on [Untitled], and input a name for the paper size. 

6 Select a printer from [Non-Printable Area]. 

7 Input values in [Width] and [Height]. 

8 Click [OK] until [Page Setup] is closed. 

9 Select [Print] from the [File] menu. 

10 Select a paper size registered in [Paper Size]. 

11 Specify the media weight and other settings as necessary, and click [Print]. 
 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

 
 When using macOS, you cannot print properly, although you can set the paper size beyond the usable range. Set the 

paper size within the range. 
 macOS may regard the custom-sized paper which is close to a fixed size as the fixed-sized paper. 

1 Open the file to be printed. 

2 Select [Page Setup] from the [File] menu. 

3 Select [Manage Custom Sizes] from [Paper Size]. 

4 Click [+] to add an item to the list of paper size. 

5 Double-click on [Untitled], and input a name for the paper size. 

6 Select a printer from [Non-Printable Area]. 

7 Input values in [Width] and [Height]. 

8 Click [OK] until [Page Setup] is closed. 

9 Select [Print] from the [File] menu. 
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10 Select a paper size registered in [Paper Size]. 

11 Specify the media weight and other settings as necessary, and click [Print]. 
 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 
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Printing methods 

This section describes various printing methods such as zooming-in/-out and booklet printing. 

Printing one sheet at a time manually 
You can print one sheet at a time by loading paper in the MP tray. 
Each time you print each page, the display shows the message "Manual Printing. Set %MEDIA_SIZE% In 
MPTray. Press OK Button". To continue printing, press «OK». 
To cancel the printing, press «CANCEL». 
 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [Multi Purpose Tray] from [Source] in the [Setup] tab. 

5 Click [Paper Feed Options]. 

6 Check [Feed paper individually] in [Multi Purpose Tray Settings], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

9 If a message appears on the display, load paper in the MP tray, and then press «OK». 
If you are printing a multi-page document, the same massage appears each time after one page is 
printed. 

 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [Multi Purpose Tray] from [Paper Source] in the [Paper/Quality] tab. 

5 Click [Advanced]. 

6 Select [Yes] from [Feeds paper one by one from the MP tray] in [Printer Features]. 

7 Click [OK]. 

8 Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 

10 If a message appears on the display, load paper in the MP tray, and then press «OK». 
If you are printing a multi-page document, the same massage appears each time after one page is 
printed. 

 

For the macOS PCL printer driver 

1 Open the file to be printed. 
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2 Select [Print] from the [File] menu. 

3 Select [Multi Purpose Tray] from [Printer Options] - [Setup] - [Paper Source]. 

4 Click [Paper Feed Options]. 

5 Check [Feeds paper one by one from the MP tray], and click [OK]. 

6 Specify other settings as necessary, and click [Print]. 

7 If a message appears on the display, load paper in the MP tray, and then press «OK». 
If you are printing a multi-page document, the same massage appears each time after one page is 
printed. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Multi-Purpose Tray] from [Printer Options] - [Paper Feed] - [All Pages From]. 

4 Select [Printer Options] - [Print Options]. 

5 Select [Paper Feed]. 

6 Check [Feeds paper one by one from the MP tray]. 

7 Specify other settings as necessary, and click [Print]. 

8 If a message appears on the display, load paper in the MP tray, and then press «OK». 
If you are printing a multi-page document, the same massage appears each time after one page is 
printed. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Enlarging/Reducing to fit the specified paper size 
You can print on a different paper size without changing the print data. 

 
 This function is not applicable to some applications. 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the paper size of the print data in [Size] in the [Setup] tab. 

5 Check [Resize document to fit printer page] in [Size]. 

6 Select the size of the paper to be printed on. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 
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For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Check [Resize document to fit printer page] in the [Job Options] tab. 

5 Select the size of the paper to be printed on. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Enable [Scale to fit paper size] in [Paper Handling]. 

4 Select the size of the paper to be printed on in [Destination Paper Size]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Enable [Scale to fit paper size] in [Paper Handling]. 

4 Select the size of the paper to be printed on in [Destination Paper Size]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing by enlargement/reduction 
You can print at the magnification rate you want without changing the print data. 

 
 This function is not available to macOS. 
 This function is not applicable to some applications. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Input the scaling rate for [Scale] on the [Job Options] tab. 
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 When [Print Mode] is set to [PCL], if [Stretch] is checked, different scales can be specified for portrait and 

landscape. 
 Since [Stretch] further enlarges/reduces the state specified in [Scale], [Finishing Mode] (N-UP, Booklet, Poster 

Print), [Offset] and [Margin Setup], the layout may be distorted. If you select [On] for [Keep page layout when 
resizing document] in [Advanced], the layout specified in [Finishing Mode] is maintained and the scale is 
changed. 

 To adjust the enlargement/reduction of printing result in the paper feed direction with [Stretch], select [Auto] for 
[Origin]. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Input the scaling rate for [Scale] of [Job Type] in the [Job Options] tab. 
 
 If [Stretch] is checked, different rates can be specified for portrait and landscape. 
 [Stretch] cannot be used simultaneously with the following settings: 

- [Layout] - [Pages per sheet] is set to 2 or above 
- [Layout] - [Booklet] 
- [Job Options] - [Resize document to fit printer page] 

 To adjust the enlargement/reduction of printing result in the paper feed direction with [Stretch], select [Auto] for 
[Origin]. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

Printing only the cover from another tray 
You can choose to feed the first page and the remaining pages from different trays. 

 
 This function is not available to the Windows PS printer driver or the macOS PCL printer driver. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Click [Paper Feed Options] in the [Setup] tab. 

5 Check [Use different source for first page]. 

6 Select a tray from [Paper Feed], and click [OK]. 
Select the paper type from [Type], and the paper weight from [Weight] as necessary. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 
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For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printer Options] - [Paper Feed]. 

4 Select [First Page From], and select the tray to feed the first page. 

5 Select the tray to feed the remaining pages in [Remaining From]. 

6 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Booklet printing 

 
 Some applications may not be available. 
 This function is not available to macOS. 
 Watermarks cannot be printed correctly when [Booklet] is used. 
 This function is disabled when private jobs are printed from a client PC that shares the network of the device with the 

print server. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [Booklet] in [Finishing Mode] on the [Setup] tab. 

5 Click [Options], and set booklet printing as necessary. 
 [Signature]: Specify the unit of the page to close. 
 [2 pages]: Print two pages on one sheet of paper. 
 [Right to Left]: Print the data to create a right-to-left booklet. 
 [Bind Margin]: Set the margin. 

6 Click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 
 To create an A5 booklet using A4-sized paper, select [A4] from [Size] in the [Setup] tab. 
 If [Booklet] is not available to the Windows PCL printer driver, open [Devices and Printers], right-click on the icon 

[OKI *** PCL6] (where *** is your model name), select [Printer Properties] - the [Advanced] tab - [Print processor] - 
[OKX06BPP] - [RAW], and click [OK]. 
To open [Devices and Printers], please refer to "How to open [Devices and Printers](P.141)". 

 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 
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3 Click [More settings]. 

4 Select [Booklet] in [Page Format] on the [Layout] tab. 

5 Uncheck [Draw Borders] as necessary. 

6 Click [Advanced]. 

7 Click [Booklet Binding Edge] under [Document Options] to set the binding position. 
 
 To make a right-edge binding booklet (i.e. a booklet with the binding on the right edge when the first page is 

facing up), select [On Right Edge]. 
 To create an A5-sized booklet using A4 paper, select [A4] from [Paper Size]. 

8 Click [OK] until the [Printing preferences] screen is closed. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 

 
 If [Page Format] is not displayed in the [Layout] tab, open [Devices and Printers], right-click on the icon of [OKI*** PS] 

(where *** is your model name), and select [Printer Properties] - the [Advanced] tab. Check [Enable advanced 
printing features]. 
To open [Devices and Printers], please refer to "How to open [Devices and Printers](P.141)". 

Printing a poster by dividing a document 
A single document can be divided or enlarged for printing on multiple pages. Finally, you will create a poster 
by combining all pages together. 

 
 This function is not available to an IPP network. 
 This function is not available to the Windows PS printer driver or macOS. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [Poster Print] from [Finishing Mode] of the [Setup] tab. 

5 Click [Options]. 

6 Set the values of [Enlarge], [Add Registration Marks] and [Add Overlap] as necessary, and click 

[OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 
 To create an A1-sized poster using 4 sheets of A4 paper, select [A4] in the paper size, and select [4] in [Enlarge]. 
 If this feature is not available to the Windows PCL printer driver, open [Devices and Printers], right-click on the icon 

[OKI *** PCL6] (where *** is your model name), select [Printer Properties] - the [Advanced] tab - [Print processor] - 
[OKX06BPP] - [RAW], and click [OK]. 
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Printing with text watermarks (Watermarks) 

 
 This function is not available to macOS. 
 Watermarks cannot be printed correctly in booklet printing. 
 If you check [Background] on the [Watermarks] screen of the Windows PS printer driver, the watermark may not be 

printed depending on the application. In this case, uncheck [Background]. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Click [Watermarks] on the [Extend] tab. 
 
 To print the job information such as a user name for printing or a document name as a watermark, check [Print 

job information] and set the job information to be printed. 

5 Click [New]. 

6 Input the text string to be printed as a stamp in [Text] of the [Watermarks] screen. 

7 Set [Font], [Size], etc. as necessary, and click [OK]. 

8 Make sure that the watermark to be printed is selected, and click [OK]. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Click [Watermarks] of the [Job Options] tab. 

5 Click [New]. 

6 Input the text string to be printed as a stamp in [Text] of the [Watermarks] screen. 

7 Set [Font], [Size], etc. as necessary, and click [OK]. 

8 Make sure that the watermark to be printed is selected, and click [OK]. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 

Printing overlaid text or logos (overlay printing) 
You can print a document with an overlapping form file (like a logo or format) registered in this machine 
beforehand. It is called overlay printing. 

 
 This function is not available to macOS. 
 It is not available to the Windows PCL printer driver when [Print Mode] is set to [Image]. 
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Registering a form file 
For the Windows PCL printer driver 

1 From the application, create a form which you want to register with this machine. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select [PCL] in [Print Mode]. 

6 Select the [Extend] tab. 

7 Click [Overlays]. 

8 Select [Register print document as a new form]. 

9 Click [OK]. 

10 Specify other settings as necessary, and click [OK]. 
 
 If [PJL Command Security Enhancement] is set to [Mode 1] for this machine, set [Print Data Encryption] to [On] 

in the printer driver, or set [PJL Command Security Enhancement] to [Off] on this machine. If "Received Data 
Type Restricted" appears, the form may not be registered. 

 Printing with print data encrypted(P.187) 

11 Click [Print] in the [Print] screen. 

12 From [Registration information for printer], input [Form name] and [ID] to register with this 

machine. 
 
 You can also specify the print position of an overlay. 

13 Select the page onto which you want to apply that overlay in [Print on Pages] as the registration 

information to the printer driver. 
To specify a page to apply to, select "Custom", and input the target page in [Custom Pages]. 

14 Click [OK]. 
 

For the Windows PS printer driver 
For the detailed procedure, please refer to "Registering forms (form overlay)(P.258)". 
 

Printing a form file 
For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select [PCL] in [Print Mode]. 

6 Select the [Extend] tab. 

7 Click [Overlays]. 
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8 Select [Overlay Print], and then select the form file to overlay from the drop-down list. 
 
 Click [Edit list] and add it to the list if you want to add a form file registered with the Configuration Tool or if you 

want to overlay multiple forms as a group. 
If you want to add a form file registered with the Configuration Tool, click [Add a registered form...], input the 
form name in [Form Name] and the ID of the form registered with the Configuration Tool in [ID], select the page 
onto which you want to apply that overlay in [Print on Pages], and click [OK]. 

9 Click [OK]. 

10 Specify other settings as necessary, and click [OK]. 

11 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

 
 To perform this procedure, you will have to login to the PC as a user with administrator privileges. 

1  Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the PS printer icon, and select [Printing Preferences]. 

3 Click [Overlays] of the [Job Options] tab. 

4 Select [Use Overlays] from the pull-down menu, and click [New]. 

5 Input the form name registered with the Configuration Tool in [Form Name], and click [Add]. 
 Registering forms (form overlay)(P.258) 

6 In [Overlay Name], input an overlay name. 

7 Select the page onto which you want to apply that overlay in [Print on Pages]. 

8 Click [OK]. 

9 Select the overlay to be used for printing from [Defined Overlays], and click [Add]. 

10 Click [OK]. 

11 Specify other settings as necessary, and click [OK]. 

12 Open the file to be printed. 

13 Select [Print] from the [File] menu. 

14 Click [Print] in the [Print] screen. 

Outputting to a file without printing on paper 
You can export print data to a file and save it without printing on paper. 

 
 To perform this procedure, you will have to login to the PC as a user with administrator privileges. 

 

For Windows 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the icon of your model and select [Printer Properties]. 
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3 Select the [Ports] tab. 

4 Select [FILE:] from the port list, and click [OK]. 

5 Open the file to be printed. 

6 Select [Print] from the [File] menu. 

7 Click [Print]. 

8 Input the file name, and click [OK]. 
Example: C:¥temp¥printdata.prn 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [PDF] on the print screen, and select the file format to be saved as. 

4 Input a name for the file, select a destination for the file, and then click [Save]. 

Printing frequently used documents without using a PC 
By storing frequently used documents in the machine, you can print them directly from the operator panel 
without using a PC. 

 
  This function is not available to the macOS PCL printer driver. 
 If the print data cannot be stored due to insufficient capacity of the memory, a message is displayed indicating that 

the file system is full and the printing will not be performed. 

 

Storing documents 
For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select [Shared Print] from [Job Type]. 

6 Click [Job Type Option]. 

7 Input the print data name in [Job Name]. 
If you check [Input job type option when printing], a prompt asking for the print data name is displayed 
when the print data is sent to this machine. 

8 Click [OK]. 

9 Make other settings as necessary to print. 
The print data is sent to this machine, but not printed yet. 

 



Printing from a PC 

- 166 - 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select [Shared Print] from [Job Type]. 

6 Click [Job Type Option]. 

7 Input the print data name in [Job Name]. 
If you check [Input job type option when printing], a prompt asking for the print data name is displayed 
when the print data is sent to this machine. 

8 Click [OK]. 

9 Make other settings as necessary to print. 
The print data is sent to this machine, but not printed yet. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printer Options] - [Secure Print]. 

4 Select [Shared Print] from [Job Type]. 

5 Specify other settings as necessary, and click [Print]. 
The print data is sent to this machine, but not printed yet. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

Printing the saved document 
1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Print], and then press 

«OK». 

3 Press ▼ to select [Shared Print], and then press «OK». 

4 As a list of shared print data appears, press ▲ or ▼ to select the shared print data you want to 

print, and then press «OK». 
 To print all shared print data, select [Print All] and then press «OK». 
 Select [Delete All] and press «OK» to delete all the shared print data displayed. 

5 Check that [Print] has been selected, and press «OK». 
Select [Delete] and press «OK» to delete the print data. 

6 Input the number of copies, and press «OK». 
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Printing an email attachment 
This machine can print the file attached to the email you have received. Printable file formats are PDF (v1.7), 
JPEG (JFIF 1.02), and TIFF (V6 baseline). 
To use this function, you will have to configure email reception settings on the POP server or SMTP server. 

 Setting e-mail receiving (Web page)(P.215) 

 
 The email body will not be printed. 
 For the number of copies, duplex printing or other settings, the current settings of [Admin Setup] will be applied. 
 Up to 10 files with a maximum size of 8 MB per file can be printed. 
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Printing in economy mode 

This section describes how to save paper and toner during printing. 
 

Printing on both sides of paper 
You can print on both sides of paper. 

 
 Some applications may not be available. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [Long Edge] or [Short Edge] from [2-Sided Printing] on the [Setup] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [Flip on Long Edge] or [Flip on Short Edge] from [Print on Both Sides] in the [Layout] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 
 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Long-Edge Binding] or [Short-Edge Binding] from [Printer Options] - [Setup] - [Duplex]. 

4 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [On] or [On Short-Edge] in [Two-Sided]. 
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4 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing in the toner save mode 
Print the data in the toner save mode. 
The amount of toner to be saved can be set in 3 levels. 
 [Printer Setting]: Follow the machine’s settings. 
 [Off]: Print at normal density without saving toner. 
 [Save Level Low]: Print at a slightly lighter density. 
 [Save Level Middle]: Print at a light density. 
 [Save Level High]: Print at a considerably light density. 

 
 The density of the image printed using this function may vary with the print data. 
 The amount of toner to be saved can also be set from the operator panel of this machine. Set the amount to be 

saved in [Menus] - [Admin Setup] - [Print Setup] - [Toner Save]. However, the setting of the printer driver takes 
priority. 

 The default setting of the printer driver is [Printer Setting]. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Setup] tab. 

5 Select the amount of toner to be saved from [Toner Saving]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select the amount of toner to be saved from [Toner Saving]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 
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3 Select [Printer Options] - [Job Options]. 

4 Select the amount of toner to be saved from [Toner Saving]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printer Options] - [Print Options]. 

4 Select the amount of toner to be saved from [Toner Saving]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

N-in-1 printing 
You can print by zooming in on the data of multiple pages to one side of a single sheet of paper. 

 
 This function prints data at a reduced size, so the center of the paper may not be aligned accurately. 
 Some applications may not be available. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the number of pages to be printed on one sheet in [Finishing Mode] of the [Setup] tab. 

5 Click [Options]. 

6 Set [Page Borders], [Page Layout] and [Bind Margin], and then click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [Pages per sheet] in the [Page Format] of the [Layout] tab. 

5 Select the number of pages to be printed on one sheet from the pull-down menu. 

6 If you do not want to draw a border, uncheck [Draw Borders]. 
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7 Click [Advanced], select the order of page layout from [Document Options] - [Pages per sheet 

layout]. 

8 Click [OK]. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 
 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the number of pages to be printed on one sheet of paper in [Layout] - [Pages per Sheet]. 

4 Set [Border] and [Layout Direction]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the number of pages to be printed on one sheet of paper in [Layout] - [Pages per Sheet]. 

4 Set [Border] and [Layout Direction]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 
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Refining your finishing 

This section describes how to make the print result better when you are printing from your PC. 
 

Printing with the specified print resolution 
You can change the print quality as needed. 
 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select the value you want to set from [Quality]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select the value you want to set from [Quality]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printer Options] - [Job Options]. 

4  Select the value you want to set from [Print Quality]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printer Options] - [Print Options]. 
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4 Select the value you want to set from [Print Quality]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing by correcting fine lines 
When the printer driver is installed, the fine line correcting function is enabled to prevent fine lines from 
becoming faint or inconsistent in thickness. 
Depending on the specific application, the spacing of bar codes may become narrower. In that case, disable 
the function. 

 
 This function is not available to the macOS PCL printer driver. 

 

For the Windows PCL printer driver 
When this function is enabled, ultra fine lines are slightly thicker. 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Select [Adjust ultra fine lines] in [Item], set it to [On] in [Settings], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 
When this function is enabled, the thickness of ultra fine lines is consistent in the specified direction. 
When this function is disabled, ultra fine lines may be slightly thicker. 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Check [Adjust ultra fine lines], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 
 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 
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3 Select [Printer Options] - [Print Options]. 

4 Check [Adjust ultra fine lines]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing by specifying the font to use 

Using printer-specific fonts 
 
 This function is not available to the Windows PCL printer driver when [Print Mode] is set to [Image], nor to a macOS. 
 The printer fonts may not be reproduced as the TrueType font design displayed on screen. 
 This function is not applicable to some applications. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select [PCL] in [Print Mode]. 

6 Select the [Extend] tab. 

7 Click [Fonts]. 

8 Check [Font Substitution] in [TrueType Font Output Type]. 

9 Specify the printer font to be used instead of the TrueType font in [Font Substitution Table]. 

10 Click [OK]. 

11 Specify other settings as necessary, and click [OK]. 

12 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the [OKI *** PS] icon (where *** is your model name) and select [Printer 

Properties]. 

3 Double-click on [Font Substitution Table] in the [Device Setup] tab. 

4 Click the TrueType font, and select the substitution printer font from the list. 

5 Click [OK]. 

6 Open the file to be printed. 

7 Select [Print] from the [File] menu. 

8 Click [More settings]. 
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9 Click [Advanced] in the [Layout] tab. 

10 Select [Substitute with Device Font] from [Graphic] - [TrueType Font]. 

11 Click [OK]. 

12 Specify other settings as necessary, and click [OK]. 

13 Click [Print] in the [Print] screen. 
 

Using PC fonts 
With the TrueType font of the PC, you can print with the same text as the screen display. 

 
 This function is not applicable to macOS. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select [PCL] in [Print Mode]. 

6 Select the [Extend] tab. 

7 Click [Fonts]. 

8 Uncheck [TrueType Font Output Type] - [Font Substitution], select the export format, and click 

[OK]. 
 [Download as Outline Font] 

Create a font image on the printer. 
 [Download as Bitmap Font] 

Create a font image by using the printer driver. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Click [Advanced] in the [Layout] tab. 

5 Select [Download as Softfont] from [Graphic] - [TrueType Font]. 

6 Click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 



Printing from a PC 

- 176 - 

Useful functions 

This section describes useful functions for printing from a PC. 
 

Printing with multiple pages sorted into one complete set (Collate) 
You can print the print data of multiple pages and put them into one complete set. 

 
 Some applications may not be available. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Click [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Input the number of copies in [Copies], and check [Collate]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Click [Print] from the [File] menu. 

3 Click [More settings]. 

4 Input the number of copies in [Copies] of the [Job Options] tab, and check [Collate]. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 
 Turn off the Collate function of the application. 

If the Collate function of the application is turned on, you will print the data without using the memory of this machine. 

 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Input the number of copies in [Copies]. 

4 Select [Paper Handling], and turn on [Collate pages]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 
 Click [Advanced] in [Print Options], and uncheck [The Printer Collate is always used] to print without using the 

memory of this machine. 
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For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Input the number of copies in [Copies]. 

4 Select [Paper Handling], and turn off [Collate pages]. 

5 Select [Printer Options] - [Print Options], and check [Collate]. 

6 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 
 If [Paper Handing] - [Collate pages] is checked, you will print the data without using the memory of this machine. 

Printing from the last page of your document 

 
 This function is not available to the Windows PCL printer driver. 

 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [Back to Front] from [Page Order] on the [Layout] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 
 If [Page Order] is not displayed, open [Devices and Printers], right-click on the icon of [OKI*** PS] (where *** is your 

model name), and select the [Advanced] tab from [Printer Properties]. Check [Enable advanced printing features]. 
To open [Devices and Printers], please refer to "How to open [Devices and Printers](P.141)". 

 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Reverse] in [Paper Handling] - [Page Order]. 

4 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Reverse] in [Paper Handling] - [Page Order]. 
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4 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing by automatically selecting a tray for the specified paper 
The tray (the paper tray (Tray 1/2/3/4), or the MP tray) matching the paper size and type that are set in the 
printer driver will be selected automatically for printing. Trays are selected according to the setting of [Tray 
Sequence]. 

 
 Be sure to set the paper size and paper weight for the paper pay and MP tray on the operator panel. 

 Loading paper(P.74) 

 

When using the MP tray 
By default, the tray usage is set to [When Mismatching] for the MP tray. In this case, the MP tray is not subject 
to Auto Tray Selection. 
To set the MP tray as a target for Auto Tray Selection, use the following settings. 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

3 Press ▼ several times to select [User Setup], and press «OK». 

4 Check that [Tray Configuration] is selected, and press «OK». 

5 Check that [MPTray Config] is selected, and then press «OK». 

6 Press ▲ to select [Tray Usage], and then press «OK». 

7 Press ▲ to select [Normal Tray], and then press «OK». 

8 Press «CANCEL» to return to the standby screen. 
 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select [Auto] from [Source] in the [Setup] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 
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4 Select [Automatically Select] from [Paper Source] in the [Paper/Quality] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 
 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Auto] from [Printer Options] - [Setup] - [Paper Source]. 

4 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Auto Select] from [Printer Options] - [Paper Feed] - [All Pages From]. 

4 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Switching tray automatically at running out of paper 
When the paper loaded in the trays (i.e. the paper tray (Tray1/2/3/4) or the MP Tray) is of the same size, 
weight and type, you can set the machine to continue the printing from another tray when the feeding tray is 
empty. 
First, select Auto Tray Switch from the operator panel. Then, select Auto Tray Switch in the printer driver. 

 
 Configure the same paper settings of the tray to be used for both the machine and the printer driver. 

 Loading paper(P.74) 

 

When using the MP tray 
By default, the tray usage is set to [When Mismatching] for the MP tray. In this case, the MP tray is not subject 
to Auto Tray Switch. 
To set the MP tray as a target for Auto Tray Selection, use the following settings. 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Menus], and press 

«OK». 

3 Press ▼ several times to select [User Setup], and press «OK». 
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4 Check that [Tray Configuration] is selected, and then press «OK». 

5 Check that [MPTray Config] is selected, and then press «OK». 

6 Press ▲ to select [Tray Usage], and then press «OK». 

7 Press ▲ to select [Normal Tray], and then press «OK». 
 
 Trays are switched according to the setting of [Tray Sequence]. 

8 Press «CANCEL» to return to the standby screen. 
 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the tray to feed paper from [Source] in the [Setup] tab. 

5 Click [Paper Feed Options], check [Auto] in [Paper feed options], and click [OK]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the tray to feed paper from [Paper Source] in the [Paper/Quality] tab. 

5 Click [Advanced], and select [Yes] from [Printer Features] - [Tray Switch]. 

6 Click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 
 

For the macOS PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printer Options] - [Setup]. 

4 Select the tray to be printed from [Paper Source]. 

5 Click [Paper Feed Options], and check [Auto tray switch]. 

6 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 
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For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [All Pages Form] in [Printer Options] - [Paper Feed], and select the tray to be printed 

from. 

4 Select [Paper Feed] in [Printer Options] - [Print Options]. 

5 Check [Auto tray switch]. 

6 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Changing the default settings of the printer driver 
You can set those frequently used functions as the default settings of the printer driver. 
 

For Windows 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the icon of your model, and then select [Printing Preferences]. 
 
 Please select the type of the printer driver that you want to use. 

3 Configure the print settings to be used as the default settings of the printer driver. 

4 Click [OK]. 
 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Configure the print settings to be used as the default settings of the printer driver. 

4 Select [Save Current Settings as Preset] from [Presets]. 

5 Input a name for the setting, and click [OK]. 

 
 To use the saved setting, select the set name from [Presets] in the print screen. 

Printing with frequently used settings registered in the printer driver 

 
 This function is not available to the Windows PS printer driver. 

 

Registering frequently used settings 
You can save the settings you configured in the printer driver. 
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For the Windows PCL printer driver 

 
 Up to 14 settings can be saved. 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the icon of your model, and then select [Printing Preferences]. 

3 Set the print options you want to save. 

4 In the [Setup] tab, click [Save] in the [Driver Setting]. 

5 Specify a name for the setting to save, and click [OK]. 

6 Click [OK] to close the [Printing Preferences] screen. 
 

For macOS 

 
 You can change the default settings on the [Page Setup] screen. 
 The operation cannot be guaranteed with settings saved by other printer drivers. Save the setting with a name that 

identifies the model name. 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Set the print options you want to save. 

4 Select [Save Current Settings as Preset...] from [Presets]. 

5 Input a preset name, and click [OK]. 
 

Printing with registered settings 
For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the setting name to be used from [Driver Setting] in the [Setup] tab. 

5 Click [OK]. 

6 Click [Print] in the [Print] screen. 
 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the setting to be used from [Presets]. 

4 Click [Print]. 

 
 When [Edit Preset List] is selected from [Presets] and [Reset Preset Menu to "Default Settings" after Printing], the 

preset you set will always be applied. 



Printing from a PC 

- 183 - 

Printing data from a USB memory 
You can connect a USB memory to this machine, and print the data saved on it. 

 
 We do not guarantee the use of all USB memory products (The USB memory with security function is not supported). 
 Not compatible with USB 3.0. 
 Not compatible with the USB Hub or external USB-HDD. 
 Not compatible with encrypted PDF. 

 
 Compatible with FAT12, FAT16 and FAT32. 
 The compatible file formats are PDF (v1.7), JPEG (JFIF 1.02), TIFF (v6 baseline), and PRN (PS, PCL). 
 Create data in ASCII form. 
 Compatible with a maximum of 32GB USB memory. 
 Among all the files saved in the USB memory with the compatible file format, a maximum of 100 files are displayed in 

the file list. 
 The file list will not be displayed correctly if more than 100 files are stored on the USB memory. 
 Files may not be read correctly from the USB memory with a directory structure of 20 or more layers. 
 Files with a path length of over 240 characters may not be read correctly. 

 Only one file in the USB memory can be printed at a time. 

 

1 Insert the USB memory into the USB host of this machine. 

2 Check that [Select Print File] appears on the display, press the scroll button ▲ or ▼ to select 

the file to be printed, and press «OK». 

3 To set the number of printing sheets and other items, press ▼ to select [Printing Preferences] 

and press «OK». 
Once completing the settings, press «BACK» to return to the screen of the file you want to print. 

4 Press ▲ or ▼ to select [Print], and press «OK». 
The screen returns to the file list screen once the printing is completed. To continue printing, select the 
file from [Select File] and repeat Steps 3 and 4. 
To complete the printing, press «CANCEL» to return to the standby screen. 

5 Remove the USB memory. 
 

Canceling the printing 
To cancel the printing from the USB memory, press «CANCEL» on the operator panel. 
Please refer to "Canceling the printing(P.193)" for details. 

 
 The pages ready for printing in this machine will be printed as they are. 

Printing data stored in this machine 
The print data can be stored in the memory of this machine. Because the work on the PC completes more 
quickly, the PC can perform other tasks while this machine is operating in the background. 

 
 This function is not available to macOS. 
 If the print data cannot be stored due to insufficient capacity of the memory, a message is displayed indicating that 
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the file system is full and the printing will not be performed. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Select [Job Spool], select [On] for [Settings], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Click [Others]. 

6 Check [Job Spool], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

Printing PS errors 
You can print the error content when a PostScript error occurs. 

 
 This function is not available to the Windows PCL printer driver or macOS. 

 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Click [Advanced] in the [Layout] tab. 

5 Click [PostScript Options] - [Send PostScript Error Handler], and select [Yes] from the drop-

down list. 

6 Click [OK] until the print setup screen is closed. 

7 Click [Print] in the [Print] screen. 
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Maximizing the printable area 
You can maximize the printable area by reducing the top, bottom, left and right margins to 2.0 mm for the 
paper to print. 

 
 This function is not available to the Windows PS printer driver or macOS. 
 Print quality is not guaranteed for the area of up to 4.23 mm from the paper edge. 

If the printout is not complete, you may take the following actions to improve such situations. 
 Select [On] for [Advanced] - [Offset] of the [Job Options] tab in the printer driver, and click [Options] to 

correct the print position. 
 Select [Scale] - [Independent Scale] of the [Job Options] tab in the printer driver before printing. 
 Correct the print position on the operator panel. Refer to "Correcting the print position of the tray(P.186)" for 

details. 
 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Select [Margin Setup] in [Item], and set it to [Min] in [Settings]. 

7 Click [OK]. 

8 Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 

Editing margins 
You can expand the margins to 30.0 mm/1.18 inches on the top, bottom, left and right for the paper to be 
printed, and thus change the printable area. 

 
 This function is not available to the Windows PS printer driver or macOS. 

 

For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Select [Margin Setup] in [Item], set it to [Edit individually] in [Settings], and click [Options]. 

7 Input margin values for [Top], [Bottom], [Left] and [Right], and click [OK]. 

8 Click [OK]. 
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9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 

Correcting the print position of the tray 
You can correct the start position vertically and horizontally on the paper for each tray. Set the correction 
volume in increments of 0.1 mm on the operator panel. 
[X Adjust] and [Y Adjust] correct the simplex printing and the back side (the printing side fed from the tray) of 
duplex printing. 
[Duplex X Adjust] and [Duplex Y Adjust] correct the face side (the printing side fed from the duplex unit) of 
duplex printing. 

 
 The thick arrows in the figure indicate the paper feed direction. 
 X indicates the vertical direction of paper travel, and Y indicates the horizontal direction of paper travel. 
 Click [+] in the X direction to expand the margin vertically, and click [+] in the Y direction to expand the margin 

horizontally. 
 Readjustment might be necessary depending on the usage conditions (e.g., temperature, humidity, paper type). 
 This function corrects the position, but it does not improve the writing start position (±2 mm). 
 When you are printing from an expansion tray unit and the start position shifts significantly, please reinstall the 

expansion tray unit. 

 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Menus], and press 

«OK». 

3 Press ▼ several times to select [User Setup], and press «OK». 

4 Press ▼ several times to select [Print Adjust], and then press «OK». 

5 Check that [Print Position Adjust] is selected, and then press «OK». 

6 Press ▲ or ▼ to select the tray to correct, and then press «OK». 

7 Press ▲ or ▼ to select the item to correct. 

8 Press «OK». 

9 Press ▲ or ▼ to select the correction volume, and press «OK». Check that [*] is displayed to 

the left of the selected setting. 

10 Press «CANCEL» to return to the standby screen. 
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Printing with security enhanced 

Printing with print data encrypted 
In order to protect its content against being read by a third party or printed to other machines before the print 
data reaches this machine, the print data is encrypted with the printer key of the destination machine. 
Unauthorized access to confidential information can be prevented. 

 
 The printer key of the destination machine is automatically obtained when the printer is installed or just before 

printing (for Windows only). 
 If the printer key is not obtained automatically, follow the warning screen in the printer driver to obtain the printer key 

or input it manually. 
 If it is encrypted with the printer key of any other machines than the destination machine, the print data will not be 

printed with "Failed to decrypt incoming data" displayed on the operator panel of the machine. In this case, follow 
"Updating the printer key for encrypting print jobs(P.189)" to update the printer key of the destination machine and 
print it again. 

 With the following functions, the print data is sent to a different printer from the destination machine, so the print data 
cannot be encrypted before printing. 
- Auto Forwarding and Broadcast Printing of the OKI LPR utility 
- Printer Pooling for Windows 

 

For the Windows PCL printer driver 

1  Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Select [Encrypt print jobs] in [Item], and set it to [On] in [Settings]. 

7 Click [OK]. 

8  Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 
 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Check [Encrypt print jobs], and click [OK]. 

7  Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 
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For the macOS printer driver 

 
 If you attempt to print without saving the printer key in the printer driver and without opening the print settings screen, 

the printing cannot be done with [Failed to decrypt incoming data] displayed on the operator panel of this machine. In 
this case, retrieve the printer key as follows and print it again. 
To retrieve by adding the printer again 
 Delete the printer in [System Settings] - [Printers & Scanners], check the connection with the printer, and add the 
printer again. 
To input the printer key manually 
 Input the printer key by following the steps in [Procedure for manually setting the printer key] displayed in the 
[Printer Options] - [Print Job Encryption] screen. 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printer Options] - [Print Job Encryption]. 

4 Check [Encrypt print jobs]. 

5  Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

For the Linux/ChromeOS printer driver (PPD file) 
For connection to this machine, select IPPS (Internet Printing Protocol Secure) before printing. 
IPPS is a protocol for providing secure printing services to networked printers, and it uses TLS to encrypt 
communications and ensure the safety of print data and control information. 
If IPPS is not selected or IPPS is not available, do not print personal or confidential documents as the security 
cannot be ensured. 
 

For the Linux printer driver (PPD file) 

1 Open "http://localhost:631" in your web browser. 

2 Click [Add Printer] on the [Administration] tab. 

3 Select [Other Network Printers] - [Internet Printing Protocol (IPPS)]. 

4 Input "https://this machine’s IP address/ipp" in [Connection], and then click [Continue]. 

5 Input an arbitrary printer name in [Name], and then click [Continue]. 

6 Click [Browse], and specify the destination of the PPD file. 

7 Click [Add Printer]. 
 

For the ChromeOS printer driver (PPD file) 

1 Open the Settings menu from the menu bar at the lower right corner of the screen. 

2 Select [Device] - [Print] - [Other available printers] - [Add printer manually] from the left menu. 

3  Input the following: 
・ Name: Input an arbitrary printer name 

・ Address: Input the IP address of this machine 

・ Protocol: Select [Internet Printing Protocol (IPPS)] or [Hypertext Transfer Protocol Secure (HTTPS)] 
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from the list 

4 Click [Add]. 

5  If it a PPD file is required, input the following:  
・Manufacturer: Select [Oki] from the list 

・Model: Select a PPD file from the list 

6 Click [Add]. 
 

Updating the printer key for encrypting print jobs 

For the Windows PCL printer driver 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the icon of [OKI *** PCL] (where *** is your model name), and then select 

[Printing Preferences]. 

3 Select the [Job Options] tab. 

4 Click [Advanced]. 

5 Click [Encrypt print jobs] in [Item], and click [Options]. 

6 Click [Retrieve from printer] or [Manual input], and then follow the on-screen instructions to 

update the printer key. 

7 Click [OK]. 

8 Click [OK]. 

9 Click [OK] to close the [Printing Preferences] screen. 

 
For the Windows PS printer driver 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the icon of [OKI *** PS] (where *** is your model name), and then select [Printing 

Preferences]. 

3 Select the [Job Options] tab. 

4 Click [Advanced]. 

5 Click [Encrypt print jobs] - [Options]. 

6 Click [Retrieve from printer] or [Manual input], and then follow the on-screen instructions to 

update the printer key. 

7 Click [OK]. 

8 Click [OK]. 

9 Click [OK] to close the [Printing Preferences] screen. 
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For the macOS printer driver 
To manually update the printer key, follow the procedure below. 

 
 To retrieve the printer key automatically from the printer, delete the printer in [System Preferences] - [Printers & 

Scanners], check the connection with the printer, and add the printer again. 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printer Options] - [Print Job Encryption]. 

4 Follow the on-screen instructions to input the printer key in [The printer key for encrypting the 

print job]. 

5 Click [OK]. 

Printing with print data encrypted and password set (Private Print) 
When printing private jobs, to prevent others from seeing the printing results of personal and confidential 
documents, the print data is encrypted and saved with a password in the machine's memory, and it is 
authenticated and printed from the operator panel. 
Because the print data is sent encryptedly, unauthorized access to confidential information can be prevented. 

 
 This function is not available to the macOS PCL printer driver. 
 If the print data cannot be stored due to insufficient capacity of the memory, a message is displayed indicating that 

the file system is full and the printing will not be performed. 
 When this machine is shared over a network via a print server, this function cannot be used in conjunction with the 

poster or booklet printing in the Windows PCL printer driver. 
 To use this function, uncheck [Job Spool]. 

 Printing data stored in this machine(P.183) 

 

Setting encryption/password on your PC and sending it to this 
machine 
For the Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select [Job Type] - [Private Print]. 

6 Input any password in [Password] of [Job Type Option]. 

7 Click [OK]. 

8 Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 
Only the print data with a password set for encryption is sent to this machine, but without printing. 
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For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Select the [Job Options] tab. 

5 Select [Job Type] - [Private Print]. 

6 Input the password in [Password] of [Job Type Option]. 

7 Click [OK]. 

8 Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 
Only the print data with a password set for encryption is sent to this machine, but without printing. 

 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printer Options] - [Secure Print]. 

4 Select [Job Type] - [Private Print]. 

5 Input the password in [Job Password]. 

6 Specify other settings as necessary, and click [Print]. 
Only the print data with a password set for encryption is sent to this machine, but without printing. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

Printing a document with encryption/password set from this machine 
You can print the encrypted print data with a password saved in the machine's memory. 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Print], and then press 

«OK». 

3 Press ▼ to select [Private Print], and then press «OK». 

4 When the user list appears, select the user name of your PC and then press «OK». 

5 Input the password set on the PC, and press «OK». 

6 When a list of private jobs appears, press ▲ or ▼ to select the data to print and then press 

«OK». 

7 Check that [Execute] is selected, and then press «OK». 
Select [Delete] and then press «OK» to delete the specified print data. 
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 The print data saved in the memory is automatically deleted when the print data has been printed or has not 

been printed after the specified retention period. The factory default setting is 2 hours. 
To change the retention period, select [Menus] - [Admin Setup] - [Private Print Setup] - [Keep job for]. 

 If an error occurs sending data or it is detected that the print data has changed since it was sent from the PC, 
the print data will be deleted automatically. 

 
 When [Menus] - [Admin Setup] - [Others Setup] - [Security Setup] - [Access Control] is set to [Enable] on this 

machine, if [Menus] - [Admin Setup] - [Private Print Setup] - [Verify job password] is set to [Off], you can skip 
inputting the password. 

 You can skip inputting the password by unchecking the following items in the printer driver. 
For the Windows PCL printer driver: [Verify Password for Private Print] of the [Device Options] tab 
For the Windows PS printer driver: [Verify Password for Private Print] of the [Device Setup] tab 
For macOS: [Verify Password for Private Print] of the [Options] tab of [Options and Supplies] after this machine is 
selected from [System Preferences] - [Printers & Scanners] in the Apple menu 

 You cannot print private jobs in the following case if you skip inputting the password. 
When [Menus] - [Admin Setup] - [Others Setup] - [Security Setup] - [Access Control] is set to [Disable] on this 
machine 
When [Menus] - [Admin Setup] - [Others Setup] - [Security Setup] - [Access Control] is set to [Enable] on this 
machine and [Menus] - [Admin Setup] - [Private Print Setup] - [Verify job password] is set to [On] 
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Canceling the printing 

To cancel the data being printed or ready to print, press «CANCEL» on the operator panel for a short time (2 
seconds or less). 

 
 You can change how long the button is pressed from [Menus] - [Admin Setup] - [Others Setup] - [Job Cancel Setup] - 

[Cancel Button Behavior] of the menu items. 

 
If you press «CANCEL», the following screen will be displayed. 

 

To cancel the printing, select [Yes] and press «OK». 
To continue the printing, select [No] and press «OK». 
If no operation is done within 3 minutes while this screen is displayed, the screen display will disappear and 
printing will continue. 
 

Canceling the printing from the PC 
Cancel the printing from your PC if you accidentally send a large amount of data from your PC to the printer. 
 

For Windows 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the printer’s icon, and select [See what's printing]. 

3 Select the name of the file under printing that you want to cancel. 

4 Press the «Delete» key on the keyboard. 

5 Check the operator panel of this machine. 
If "Processing" or "Data Present" is displayed, cancel the printing from this machine’s operator panel. 

 

For macOS 

1 Select [System Preferences] from the Apple menu. 

2 Click [Printers & Scanners]. 

3 Click the icon of the printer. 

4 Click [Open the Print Queue]. 

5 Select the name of the file under printing that you want to cancel. 

6 Click [x]. 

7 Check the operator panel of this machine. 
If "Processing" or "Data Present" is displayed, cancel the printing from this machine’s operator panel. 
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Administrator Password 

The administrator password is used to change the settings of the machine. 
We recommend that you change the administrator password to protect your personal information. 
 

Checking the factory default admin password 
The factory default admin password can be found on the password label attached on the inside of the 
machine. 

1 Place your finger in the front recess, and pull to open the MP tray towards you. 

 

2 Check the password label attached on the inside of this machine. 

 

Inputting the factory default admin password 
This section explains the procedure assuming that the factory default admin password is "GAhtfPANe5". 

 Checking the factory default admin password(P.195) 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [Admin Setup], and press «OK». 
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4 Press ▲ or ▼ several times until "G" is displayed, and then press «OK». 
The entered digit is displayed in "*" and the cursor moves to the next position. 

 
 When you press the «HELP» button, "*" will change to the text you entered. 

 

5 Press ▲ or ▼ several times until "A" is displayed, and then press «OK». 

 

6 Input the remaining characters by the same procedure. 

7 Press «OK» again to complete inputting the admin password and display [Admin Setup]. 

 

Changing the admin password 

 
 The password policy may differ from region to region. 

 
The admin password consists of either 10 to 32 characters or 1 to 32 characters depending on the password 
policy. 
The factory default setting of the password policy is as follows. [Password Policy] can be changed in [Admin 
Setup]. 
[Minimum Length]: 10 characters or 1 character 
[Contain upper-case letters]: [On] or [Off] 
[Contain lower-case letters]: [On] or [Off] 
[Contain symbols]: [Off] 
[Contain digits]: [Off] 
 
The following characters can be used for the admin password. 
 Upper-case letters 
 Lower-case letters 
 Digits 
 Symbols: [Space] ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ ¥ ] ^ _ ` { | } ~ 

 

 
 Be sure to write down the password you set just in case you forget. 
 If you forget the changed password, you cannot change [Admin Setup] or [Boot Menu]. 
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 To reset the admin password, the charged service by maintenance staff may be necessary. 

This section explains the procedure to change the password assuming that the factory default admin 
password is "GAhtfPANe5". 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

 

4 Input the factory default admin password. 
 Inputting the factory default admin password(P.195) 

 

5 Press ▲ to select [Change Password], and then press «OK». 

 

6 When "Please be careful not to forget the new admin password. It will be required for changing 

settings. Press «OK»." is displayed, press «OK». 

7 When [Password Policy] is displayed, press «OK». 

 

8 Enter a new password and press «OK». 
 Inputting text(P.93) 
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9 Press «OK» again to display the [Verify Password] screen. 

 

10 Input the password again, and press «OK». 

 

11 "Password Changed" is displayed. 

 

12 The screen will return to [Admin Setup] in 3 seconds. 
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Changing settings of Admin Setup 

This section explains the procedure of changing settings of this machine as an administrator. 
 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

5 Press ▲ or ▼ to select the menu for which you want to change the settings, and then press 

«OK». 

6 Press ▲ or ▼ to change the settings. 

7 Press «OK». 

8 Press «CANCEL» to return to the standby screen. 
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Managing the machine from the web page 

You can manage the machine by accessing the web page of the machine from a web browser on your PC or 
mobile device. What you can do with the web page is as follows. 
 Displaying the state of this machine 
 Setting up the tray, network, default settings of each function, and this machine 
 Displaying the print data list 
 Printing PDF files without using the printer driver 
 Links to frequently used web pages 

 
 To change settings of this machine from the web page, it is necessary to log in as an administrator. 

 

Opening the web page 

 
 Please enable Cookies and JavaScript in the security setup of your web browser. 

This section takes the following environment for example. 
 Name of this machine: B433 
 IP address of this machine: 192.168.0.2 

 

1 Start the web browser. 

2 Input the URL "https://(this machine's IP address)" in the address bar, and then press the 

«Enter» key. 
The IP address of this machine is available on the printed menu map. 

 Printing the menu map (configuration)(P.89) 

 

 
 If the IP address includes values of 1 or 2 digits, do not add "0" before such values. Otherwise, communication 

may fail. 
 Correct: https://***.168.0.2/ 
 Wrong: https:/***.168.000.002/ 

*** refers to any digits. 
 By default, when you are opening the printer's web page, use HTTPS instead of HTTP. 
 By default, when you are opening the printer's web page, a warning that it may not be a legitimate server will be 

displayed in your web browser. Set up the certificate appropriately, or temporarily ignore the warning. 
 If you cannot access the machine via HTTPS due to an expired certificate or a corrupted certificate, set [HTTPS 

Redirection (Web)] to [Disable] from the operator panel, access the web page via HTTP, and reset the HTTPS 
settings. 

 This machine does not support TLS 1.1 or lower. If the web browser you are using only supports TLS 1.1 or 
lower, use a web browser that supports TLS 1.2 or higher, or after understanding the security risks, set [HTTPS 
Redirection (Web)] to [Disable] from the operator panel and access the web page via HTTP. 
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Logging in as an administrator 
To change settings of this machine from the web page, it is necessary to log in as an administrator. 

1 Click [Login]. 

 

2 Input "admin" in [User Name] and the admin password of this machine in [Password], and then 

click [Sign In]. 
 Administrator Password(P.195) 

 
 When access control is enabled, you can log in as a local user with administrator privileges (with .AdminRole 

assigned). 

 

3 The following screen is displayed. 
 

 

Changing the admin password (Web page) 
You can change the admin password of this machine from the web page. 
The admin password specified on the web page is used to log into this machine or to change settings from the 
operator panel or web page. 
The machine comes with the setting function of password policy. 

 
 The password policy may differ from region to region. 

The factory default setting is a minimum length of 10 characters containing at least one upper-case letter and 
one lower-case letter, or a minimum length of 1 character. 
Please set a string as the administrator password in accordance with the password policy. 
The following characters can be used for the admin password. 
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 Upper-case letters 
 Lower-case letters 
 Digits 
 Symbols: [Space] ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ ¥ ] ^ _ ` { | } ~ 

 
 Be sure to write down the password you set just in case you forget. 
 If you forget the admin password, you cannot change [Admin Setup] or [Boot Menu]. 
 To reset the admin password, the charged service by maintenance staff may be necessary. 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Printer Settings]. 

4 Click [Menu] on the upper right corner, and then select [Management] - [Admin Password]. 

5 Input a new password in [New Admin Password]. 

6 Input the new password again in [New Admin Password(Verify)]. 
The password you input is not displayed. Write down your password and keep it in a safe place. 

7 Click [Apply]. 
 
  It is not necessary to restart the machine. The next time you log in as an administrator, use the new password. 

Checking/Changing the state of this machine 

 
 Please enable Cookies and JavaScript in the security setup of your web browser. 
 To change settings of this machine from the web page, it is necessary to log in as an administrator. 

 Logging in as an administrator(P.201) 
 About network setup 

 Connecting via a wired LAN(P.37) 
 Connection form via a wireless LAN(P.45) 
 Connecting via an access point (Infrastructure)(P.46) 
 Connecting directly with this machine (Wi-Fi Direct)(P.58) 

 
This section takes the following environment for example. 
 Name of this machine: B433 
 IP address of this machine: 192.168.0.2 

 

Checking the state of this machine 
1 Open the web page of this machine. 

 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 
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3 The following screen is displayed. 
You can check the print job, system information, supplies life, counter, print statistics and alert 
information of this machine. 
 

 

 

Changing settings of this machine 
You can change settings of this machine from the web page. 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Change the settings, and click [Apply]. 
You can change settings of this machine from the following tabs. 
 Printer Settings 
 Network Setup 
 Links 

Saving configurations 
The settings of this machine and the usage of consumables and maintenance parts can be saved as a CSV 
file. 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Click [Menu] on the upper right corner, and then select [Display and Save Printer Information] - 

[Export MenuMap]. 

3 Click [Export], and save it with a name. 

Communication encryption (SSL/TLS) 
You can encrypt the communication between your PC or mobile device and this machine. The communication 
is encrypted with SSL/TLS in the following cases. 
A certificate is pre-installed on this machine to enable the communication using HTTPS. 
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Registering a certificate 
You can use a certificate when sending data to this machine connected to a network. 
The following two types of certificates can be registered. 
 Self-signed certificate 

This certificate is issued by this machine. 
 Certificate issued by certificate authority 

This certificate is signed and issued by an external certificate authority for CSR (Certificate Signing 
Request) created by this machine. 

 
 Before registering a certificate, be sure to delete the certificate already registered in this machine. 
 If an IP address is set in [Common Name] of the certificate, the certificate will be invalidated when the machine's IP 

address is changed after the certificate is registered. Please register the certificate again. 

 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click [Menu] on the upper right corner, select [Security] - [Communication Encryption (SSL/TLS 

Server Certificate)], and click [Delete Certificate]. 

5 Select [Delete] to delete the certificate that is already registered. 
 
 If the certificate has been deleted, proceed to Step 6. 

6 Select the certificate to be registered in [How to prepare the server certificate to be used]. 
 For a self-signed certificate 

Select [Create a self-signed certificate], input the required items according to the on-screen 
instructions, and click [Create & Import]. 

 To obtain a certificate issued by a certificate authority 
Select [Obtain a certificate issued by a certificate authority], input the required items according to the 
on-screen instructions, and click [Create & Download] to create a CSR, export it and send the CSR 
to the certificate authority, obtain a certificate from the certificate authority, and install it. 

 For a certificate issued by an external certificate authority 
Select [Import the certificate and private key you already have], input the required items according to 
the on-screen instructions, and click [Import]. 

 
 You can import a certificate in PKCS#12 format. 

7 Select [Enable] for the protocol you want to apply the encryption to. 

8 Click [Apply]. 
 

Exporting a certificate 
Depending on the SSL/TLS communication function, your PC or mobile device may require to trust the 
machine's certificate. 
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To trust the machine's certificate, export the machine's certificate and import it into the trusted certificate store 
of the PC or mobile device. 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Security] - [Communication 

Encryption (SSL/TLS Server Certificate)]. 

5 Select [Export Certificate] to export the certificate. 
 
  The certificate is exported in the PEM format. 

Disabling HTTP 
If HTTPS is enabled, you can disable it for better security. 
If HTTP is disabled, the following limitations apply. 
 WSDPrint (Web Service Device Print) will not be available. 
 Since [Role management] of the Configuration Tool is not available, restrict access to this machine from 

the web page. 
 The web page of this machine cannot be opened with [Web Setting] of Network Extension and OKI LPR 

utility. To open the web page of this machine, input "https://<this machine's IP address>" directly from the 
web browser. 

 For macOS, to add this machine by selecting [IP] in [Add Printer] with the protocol [IPP (Internet Printing 
Protocol)], specify "this machine's IP address + port number (443)" in [Address]. (Example: 
192.168.1.1:443) Printing is not possible if only the IP address is specified. 
Also, if "this machine's IP address + port number (443)" is specified but the device information cannot be 
obtained when a printer is added, set the device information on the [Options] tab. 

 If you changed [Search Protocol] on the device search screen of Mobile Print (Android) to [WSD], you will 
not be able to search for devices. Search by setting it to [SNMP]. 
Also, if you changed [Print Protocol] on the device search screen to [IPP], you will not be able to print. Set 
it to [RAW] before printing. 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Protocol] - [Protocol ON/OFF] 

- [HTTP]. 

5 Select [Disable], and then click [Apply]. 

 
 If you are trying to disable HTTP when HTTPS is disabled, [HTTP and HTTPS/IPPS cannot be disabled at the same 

time] will be displayed. Please enable HTTPS and try again. 
If the server certificate is deleted, HTTPS will be automatically disabled. To avoid disabling HTTP and HTTPS at the 
same time, the certificate cannot be deleted while HTTP is disabled. If you are trying to delete the certificate, [The 
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certificate cannot be deleted while HTTP is disabled.] will be displayed. 

Using IPP 
Add this machine as an IPP printer in a PC. 
 

For Windows 

1 Open [Devices and Printers], and select [Add Printer]. 
 How to open [Devices and Printers](P.141) 

2 In the [Add Printer] wizard, select [The printer that I want isn’t listed]. 

3 Select [Select a shared printer by name]. 

4 Input "https://(IP address of this machine)/ipp" or "https://(IP address of this machine)/ipp/lp", 

and click [Next]. 

5 Click [Have Disk]. 

6 Prepare the driver software. 
Double-click on the driver software file downloaded from our website to unzip it, or insert the included 
DVD into the PC. 

7 Input the following values in [Copy manufacturer's files from], and click [Browse]. 
To install the PCL printer driver: "D:¥Drivers¥_PCL" 
To install the PS printer driver: "D:¥Drivers¥_PS" 

 
 The above values are examples when the included DVD is used and the DVD drive is set to the D drive. 
 When using driver software downloaded from our website, specify the folder unzipped in Step 6. 

8 Select an INF file, and click [Open]. 

9 Click [OK]. 

10 Select a template, and click [OK]. 

11 Click [Next]. 

12 Click [Completed]. 

13 When the installation has completed, print a test page. 
 

For macOS 
1 Install the printer driver by opening the driver software file downloaded from our website, or 

inserting the included DVD into the PC. 
 Installing software on your PC(P.63) 

2 Select [System Preferences] from the Apple menu. 

3 Click [Printers & Scanners]. 

4 Click [Add Printer, Scanner or Fax]. 

5 Click the [IP] tab. 

6 Select [IPP (Internet Printing Protocol)] in [Protocol]. 

7 Input the IP address of this machine in [Address]. 
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8 Input "ipp" in [Cue]. 

9 Click [Add]. 

10 Click [Continue]. 

11 Check if this machine has been registered in [Printers & Scanners]. 

Communication encryption (IPSec) 
You can encrypt the communication between your PC or mobile device and this machine. 
Encrypt the communication with IPSec. When IPSec is enabled, all applications are encrypted using IPSec. 
You can specify 50 hosts per IP address. Any access to this machine from an unregistered host will be 
denied. Any attempt to access an unregistered host will be invalidated. 
Set up your PC or mobile device after setting up this machine in advance. 

 
  You need to prepare a pre-shared key beforehand. 

 
  When IPSec is enabled, any communication with the host not specified in this step will be denied. 
 IPSec communication is done when IPSec is set for this machine and the host. If IPSec is not set on the host, IPSec 

communication will not be done. 
 Be sure to make a note of the values you specify in this step. They will be required to configure IPSec settings on a 

PC or mobile device. 

 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, select [Security] - [IPSec], and then select 

[Enable] on the displayed screen. 

5 Configure the settings following the on-screen instructions. 
 
  For the "Phase 2 Proposal" setting, [AH] or [ESP] must be enabled. 
 [AH] and [ESP] cannot be used simultaneously. 

6 Click [Apply]. 
 
 If IPSec cannot be set up due to the inconsistency of specified parameters, the web page cannot be accessed. 

In this case, disable IPSec or initialize network settings from the operator panel of this machine. 

7 Set IPSec on your PC or mobile device. For the setting method, please consult your network 

administrator. 

Using the access control function (IP filter) with the IP address 
You can use the IP Address to control the access to this machine. You can set whether or not to authorize 
setup or printing from the specified IP address. IP filtering is disabled by default. 
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 Be sure to specify the correct IP address. If you specify an incorrect IP address, you will not be able to access the 

machine using the IP protocol. 
 When IP filtering is enabled, any access to the host not specified in this setting will be denied. 

 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, select [Security] - [IP Filtering], and then select 

[Enable] on the displayed screen. 

5 Configure the settings following the on-screen instructions. 
 
 If nothing is registered in [Administrator's IP Address setting], access to this machine may be disabled 

depending on the specified IP address range. 
 If you are using a proxy server, [Your Current Local Host/Proxy IP Address] may not match the IP address of 

the current host. 

6 Click [Apply]. 

 
 IP filtering is applicable only to IPv4. 

Using the access control function with the MAC address 
You can use the MAC Address to control the access to this machine. You can allow or deny the access from 
the specified MAC Address. 

 
 Be sure to specify the correct MAC address. If you specify an incorrect MAC address, you will not be able to access 

the machine using the network. 

 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, select [Security] - [MAC Address Filtering], and 

then select [Enable] on the displayed screen. 

5 Configure the settings following the on-screen instructions. 
 
 If nothing is registered in [Administrator's MAC Address setting], access to this machine may be disabled 

depending on the specified MAC address range. 
 If you are using a proxy server, [Your Current Local Host/Proxy MAC Address] may not match the MAC address 

of the current host. 

6 Click [Apply]. 



Management of this machine 

- 209 - 

 
 You cannot specify the access control individually for each address. 

Notifying errors via e-mail 
Errors of consumables or maintenance parts are notified via e-mail. You can also set the timing of notification. 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Printer management] - [Email 

Alert]. 

5 Select [Enable] on the displayed screen. 

6 Set the mail address allocated to this machine in [Device E-mail Address]. 

7 Input the e-mail server name or the address of e-mail server in [SMTP Server]. 

8 Set appropriate values for other setting items if necessary. 

9 Input the e-mail address to receive notifications in [Notification Email Address]. 

10 Click [Settings] for the email address you input. 
If you want to apply the notification condition to another address, select the copy source, and then click 
[Copy]. 

11 Configure the settings following the on-screen instructions. 
 
 When you select [Upon occurrence of an event], an error is notified just once. 
 When you select [Notify Periodically], an error is notified periodically until it is cleared. 

12 Click [Apply]. 

 
 If no notification target error occurs, the notification e-mail will not be sent. 

Using SNMPv3 
By using the SNMP manager that is compatible with SNMPv3, the management of this machine can be 
encrypted with SNMP. 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Protocol] - [SNMP]. 

5 Configure the settings following the on-screen instructions. 
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6 Click [Apply]. 

 
 You can use a commercially-available SNMP manager to verify and change the settings of this machine. For the MIB 

of this machine, refer to the supplied DVD, and check the MIB definition file in [Misc] - the [MIB Files] folder. 

Using IEEE802.1X (Wired LAN) 
This machine is compatible with IEEE802.1X authentication. IEEE802.1X authentication is possible after 
IEEE802.1X authentication on the web page of this machine is enabled and the authentication switch is 
connected. 

 
 This machine does not support TLS 1.1 or lower. If your server only supports TLS 1.1 or lower, connection will be 

impossible. Please double-check the environment. 

 

Setting with EAP-TLS 
This section describes how to set up EAP-TLS, one of the IEEE802.1X authentication. 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Security] - [IEEE802.1X 

Authentication]. 

5 Select [Enable] in [IEEE802.1X Authentication]. 

6 Select [EAP-TLS] in [EAP Type]. 

7 Input the user name in [EAP User]. 

8 Select [Do Not Use] in [Use server certificate (SSL/TLS certificate) in EAP authentication]. 

9 Input the password in [Import of Client Certificate]. 

10 Click [Import of Client Certificate], select the certificate file, and click [OPEN]. 
Only PKCS#12 files can be imported. 

11 Select [Authenticate Server] in [Server Authentication Settings], and then click [Import] in 

[Import of CA Certificate]. 

12 Select the CA certificate file, and click [OPEN]. 
Specify the CA certificate used for RADIUS server authentication. PEM, DER and PKCS#7 files can be 
imported. 

13 Click [Apply]. 

14 When the machine is online, power off the machine. 

15 Remove the LAN cable from the machine. 

16 Connect the LAN cable to the network interface connector of this machine. 

17 Connect the other end of the LAN cable to the authentication port of the authentication switch. 
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18 Power on this machine. 

19 Set the IP address of this machine or the like. 
 

Setting with PEAP 
This section describes how to set up PEAP, one of the IEEE802.1X authentication. 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Security] - [IEEE802.1X 

Authentication]. 

5 Select [Enable] in [IEEE802.1X Authentication]. 

6 Select [PEAP] in [EAP Type]. 

7 Input the user name in [EAP User]. 

8 Input the password in [EAP Password]. 

9 Select [Server Authentication Implementation] - [Authenticate Server]. 

10 Click [Import of CA Certificate] - [Import]. 

11 Select the CA certificate file, and click [OPEN]. 
Specify the CA certificate used for RADIUS server authentication. PEM, DER and PKCS#7 files can be 
imported. 

12 Click [Apply]. 

13 When the machine is online, power off the machine. 

14 Remove the LAN cable from the machine. 

15 Connect the LAN cable to the network interface connector of this machine. 

16 Connect the other end of the LAN cable to the authentication port of the authentication switch. 

17 Power on this machine. 

18 Set the IP address of this machine or the like. 

Setting IEEE802.1X (Wireless LAN) 
You can set IEEE802.1X authentication with a wireless LAN. First, access the web page of this machine via a 
wired LAN to set IEEE802.1X authentication, and then set the wireless connection on the web page. 

 
 This machine does not support TLS 1.1 or lower. If your server only supports TLS 1.1 or lower, connection will be 

impossible. Please double-check the environment. 
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Setting with EAP-TLS 
1 Open the web page of this machine. 

 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Security] - [IEEE802.1X 

Authentication]. 

5 Select [Disable] in [IEEE802.1X Authentication]. 

6 Select [EAP-TLS] in [EAP Type]. 

7 Input the user name in [EAP User]. 

8 Select [Do Not Use] in [Use server certificate (SSL/TLS certificate) in EAP authentication]. 
 
 If you select [Use], the certificate must be preset in the [Communication Encryption (SSL/TLS Server 

Certificate)] menu. 
 Communication encryption (SSL/TLS)(P.203) 

9 Input the password in [Import of Client Certificate]. 

10 Click [Import of Client Certificate], select the certificate file, and click [OPEN]. 
Only PKCS#12 files can be imported. 

11 Select [Server Authentication Implementation] - [Authenticate Server]. 
When [Not Authenticate Server] is selected, go to Step 14. 
When using WPA2-EAP or WPA3-EAP, it is required to select [Authenticate Server]. 

12 Click [Import of CA Certificate] - [Import]. 

13  Select the CA certificate file, and click [OPEN]. 
 
 Specify the CA certificate used for RADIUS server authentication. PEM, DER and PKCS#7 files can be 

imported. 

14 Click [Apply]. 

15 When this machine is online, go to "Connecting to a wireless LAN (WPA3-EAP)(P.213)". 
 

Setting with PEAP 
1 Open the web page of this machine. 

 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Security] - [IEEE802.1X 

Authentication]. 

5 Select [Disable] in [IEEE802.1X Authentication]. 

6 Select [PEAP] in [EAP Type]. 
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7 Input the user name in [EAP User]. 

8 Input the password in [EAP Password]. 

9 Select [Server Authentication Implementation] - [Authenticate Server]. 
When [Not Authenticate Server] is selected, go to Step 12. 
When using WPA2-EAP or WPA3-EAP, it is required to select [Authenticate Server]. 

10 Click [Import of CA Certificate] - [Import]. 

11 Select the CA certificate file, and click [OPEN]. 
 
 Specify the CA certificate used for RADIUS server authentication. PEM, DER and PKCS#7 files can be 

imported. 

12 Click [Apply]. 

13 When this machine is online, go to "Connecting to a wireless LAN (WPA3-EAP)(P.213)". 

Connecting to a wireless LAN (WPA3-EAP) 
This machine supports the wireless LAN security method WPA/WPA2-EAP and WPA3-EAP. 
Before setting WPA/WPA2-EAP or WPA3-EAP as the wireless LAN security method, it is necessary to set it 
from the [IEEE802.1X Authentication] menu of the web page with a wired network connection. 
Refer to "Setting IEEE802.1X (Wireless LAN)(P.211)". 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Network Connection] - 

[Extended Network]. 

5 Select [Wireless LAN] in [Extended Network]. 
If [Wireless LAN] has already been set, proceed to Step 7. 

 

 
 The factory default setting is [Disable]. 

6 Click [Apply] to restart the machine. During the restart, the web page will display the 

reconnecting screen. When this machine has restarted, the setting screen of [Extended 

Network] will be displayed again. 

7 Select [Wireless(Infrastructure)] in [Wireless LAN]. 

8 Select [Manual Setup] in [Wireless Network Selection]. 

9 In the [SSID] field, input the SSID of the access point you want to connect to. 

10 In the [Security] field, select the security protocol ([WPA/WPA2-EAP] or [WPA3-EAP]) of the 
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access point. 

11 Click [Connect] to apply the settings. It may take up to 1 minute to connect to the wireless 

access point. If the connection fails, reset the wireless settings from the operator panel, or 

switch to wired LAN from the operator panel and reset the wireless settings from the web page. 

Setting the LDAP server 

 
 Consult your network administrator for the LDAP server and encryption setup. 

 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Protocol] - [LDAP Server 

Setting]. 

5 Input the FQDN or IP address of the LDAP server in [LDAP Server]. 
 
  When [Digest-MD5] or [Secure Protocol] is selected in Step 9, please input the FQDN instead of the IP 

address. An FQDN is a combination of the host name and domain name. (Example of FQDN: 
Server1.domain.local) 

6 Input the port number of the LDAP server in [Port Number]. 

7 In [Timeout], specify the timeout value to wait for the search result. 

8 Specify the Base DN to access the LDAP server in [DN (Distinguished Name)]. 

9 Select the required authentication method in [Authentication] - [Confirmation method]. 
[Anonymous]: Select it when you want to access the LDAP server using anonymous authentication. 
[Simple]: Select it when you want to access the LDAP server using simple authentication. 
[Digest-MD5]: Select it when you want to access the LDAP server using Digest-MD5 authentication. 
[Secure Protocol]: Select it when you want to access the LDAP server using Secure Protocol (Kerberos) 
authentication. 

 
 If [Anonymous] is selected, authentication will always be anonymous, even when the LDAP server is used for 

LDAP name authentication. If the LDAP server is used for LDAP name authentication, select any authentication 
method other than [Anonymous]. 

 
 If [Digest-MD5] is selected, it is required to set the DNS server. 
 If [Secure Protocol] is selected, it is required to set the SNTP server, DNS server and secure protocol server. 

10 If any option other than [Anonymous] is selected in Step 9, specify the user ID and password to 

login to the LDAP server. 

11 Select an encryption method in [Encryption]. 
[None]: No encryption will be done. 
[LDAPS]: The encryption will be done with the LDAPS method. 
[STARTTLS]: The encryption will be done with the StartTLS method. 
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 This machine does not support TLS 1.1 or lower. If your server only supports TLS 1.1 or lower, please double-

check the environment or select [None] with understanding of security risks. 

12 Click [Apply]. 

Setting e-mail receiving (Web page) 
Set the protocol (POP3, SMTP, etc.) for this machine to receive e-mails. 

 
 Consult your network administrator about the mail server. 

 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Network Setup]. 

4 Click the Menu button on the upper right corner, and then select [Protocol] - [E-mail Printing]. 

5 Select [POP3] or [SMTP] in [Use Protocol] according to your environment. 

6 Configure the settings following the on-screen instructions. 
 
 This machine does not support TLS 1.1 or lower. If your server only supports TLS 1.1 or lower, please double-

check the environment or select [None ] with understanding of security risks. 

7 Click [Apply]. 

Setting the Power Save Time (Web page) 
Set the time that will elapse before the power save mode is entered. 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Printer Settings]. 

4 Click the Menu button on the upper right corner, and then select [Management] - [Power Setup]. 

5 Select the transition time in [Power Save Time], and click [Apply]. 

Setting the sleep time (Web page) 
Set the time that will elapse before the sleep mode is entered. 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 
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3 Select [Printer Settings]. 

4 Click the Menu button on the upper right corner, and then select [Management] - [Power Setup]. 

5 Select the transition time in [Sleep Time], and click [Apply]. 

Setting "Auto Power Off" (Web page) 
Set the Auto Power Off function. 
 

Enabling Auto Power Off 
1 Open the web page of this machine. 

 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Printer Settings]. 

4 Click the Menu button on the upper right corner, and then select [Management] - [Power Setup]. 

5 Select [Enable] in [Auto Power Off]. 

6 Select the transition time in [Auto Power Off Time], and click [Apply]. 

Setting actions of the power save mode (Web page) 
Set actions of the power save mode. 
Mode1: Set it to the power save mode. The power consumption is lower than that in Mode 2. 
Mode2: Set it to the low temperature standby mode. The printing startup is faster than that in Mode 1. 

 
 The factory default setting is [Mode1]. 
 When the setting is changed, the machine will restart automatically. 

 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Printer Settings]. 

4 Click the Menu button on the upper right corner. Then, select [Management] - [Power Setup]. 

5 Select the action mode in [Power Save Setting], and click [Apply]. 

Copying the setup information of this machine to other devices 

Exporting settings of this machine 
1 Open the web page of this machine. 

 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 
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3 Select [Printer Settings]. 

4 Click the Menu button on the upper right corner, and then select [Configuration Management] - 

[Settings Export]. 

5 Select the settings to be copied. 

 

6 Click [Export]. 

7 Specify the storage location, name the file, and click [Save]. 
 
 The file may be saved without displaying the saving screen depending on the specific web browser. 

 

Importing settings of this machine 
1 Open the web page of the device to which you want to copy the settings. 

 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Printer Settings]. 

4 Click the Menu button on the upper right corner, and then select [Configuration Management] - 

[Settings Import]. 

5 Click [Select File], and select the copying file to export. 

6 Click [Import]. 

Printing PDF/JPEG files (Direct Print) 
With the application, you can print a PDF or JPEG file without opening it. 

 
 The compatible file formats are PDF (v1.7) and JPEG (JFIF 1.02). 

 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Select [Direct Print]. 

3 Select the PDF or JPEG file to print in [Step 1: Select a print file]. 

4 Set up the printing conditions by following the on-screen instructions in [Step 2: Set up printing 
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options]. 

5 Click [Print] in [Step 3: Start the printing]. 

Setting a link to the support page 
You can order consumables and set a URL for firmware update as you wish. 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Select [Links]. 

4 Scroll the screen until [Edit Links] is displayed, and then click [Edit Links]. 

5 Input the title and URL of each item. 

6 Click [Apply].  
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Setting items of the web page 

State 

 

 

Item Description 
◯: Items to 

display 
Admin User 

Print Job Job Lists Display a list of print data sent to this machine. You can 
also delete the print data during or before printing. 

◯  

Job Log Display the job log (or job history) saved in this machine. 
The job log is displayed when [Printer Settings] - 
[Management] - [Job Log] - [Save Job Log] is enabled. 

◯  

System 
Information 

Information Display the information of this machine. ◯ ◯ 
Version Information Display the version of firmware. ◯ ◯ 

Network Wireless(Infrastructure) Display the settings of Wireless(Infrastructure). ◯ ◯ 
Wireless(Wi-Fi Direct) Display the settings of Wireless(Wi-Fi Direct). ◯ ◯ 

Supplies Life Remaining Toner Display the remaining toner amount. ◯ ◯ 
Drum Life Remaining Display the remaining service life of the image drum. ◯ ◯ 
Fuser Life Remaining Display the remaining service life of the drum unit. ◯ ◯ 

Counter Print Counter Display the total number of printed pages for each tray. ◯ ◯ 
Paper Feed Roller Counter Display the number of sheets fed from each tray. ◯ ◯ 

Print 
Statistics 

Usage Report Display the Usage Report. ◯  

Alert 
Information 

Error Display errors that have occurred in this machine as 
"Alert Information". 

◯ ◯ 

Warning Display warnings that have occurred in this machine as 
"Alert Information". 

◯ ◯ 

Display and 
Save Printer 
Information 

Open Printer Information Display the information of this machine in a separate 
window. 

◯  

Export MenuMap You can save the printer's menu map. ◯ ◯ 
Export NFC Setting Log You can save the result of setting changes by NFC. 

* It is displayed only when the setting is changed by 
NFC. 

 
 Depending on the specific region, this machine may 

not come with the NFC function. 

◯ ◯ 

Export Access Log You can save the access log data. ◯  

Print Job 
Encryption 

Printer Key Display the printer key used for job encryption in the 
printer driver. 

◯ ◯ 
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Printer Settings 

 

 

Item Description 
◯: Items to 

display 
Admin User 

Paper Paper Tray Setup You can view or set the paper size, custom paper, etc. of 
each tray. 
When a printer driver is used, the setup in the printer 
driver takes priority over this setting value. 
Only the administrator can configure the settings. 

◯ ◯ 

Paper Input Options Set the paper-related options, tray switching and priority. ◯  

Duplex Last Page Set whether to print on both sides when the last page is 
single-sided. 

◯  

Management Identification You can view or set the information to identify this 
machine. 
Only the administrator can configure the settings. 

◯ ◯ 

Panel Setup Set the items to be displayed on the screen. ◯ ◯ 
Time Setup Set the time-related items. ◯  

Power Setup You can set Power Save, Sleep, Sleep After Printing and 
Auto Power Off. 

◯  

Buzzer Setup You can adjust the volume of the buzzer when an error 
occurs, when the printing has completed, and when 
AirPrint is checked. 

◯  

System Adjust Set general items related to the system. ◯  

Admin Password You can set the admin password. ◯  

Near Life Setup Set whether or not to display a message when the 
supplies or maintenance parts are approaching the end 
of service life. 

◯  

USB Setup Set the USB-related information. ◯  

Job Cancel Setup You can set the actions when «CANCEL» is pressed. ◯  

Font output mode setting Set the information related to the font output mode. ◯  

Private Print Setup Set how private jobs will be handled in the device. ◯  

Flash Memory Setup It is used to initialize the flash memory and format a 
partition. 

◯  

Job Log Setup You can set whether or not to save the job log. It is also 
used to clear the saved job logs. 

◯  

Access Log Setup You can set whether or not to save the access log. ◯  

Security Account Lockout You can enable/disable the lockout control when 
authentication fails. 

◯  
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Item Description 
◯: Items to 

display 
Admin User 

 Password Policy You can configure policies for the admin password, 
general user password, default user password for IPP 
Basic Authentication, SNMPv3 authentication 
passphrase, and SNMPv3 encryption passphrase. 

◯  

User 
Management 

Access Control Setup You can set the access control function. ◯  

User 
Management 

User List You can register/delete a user to use this machine. 
A maximum of 5,000 users can be registered. 

◯  

Role List You can manage the role assigned to the user. 
Up to 100 roles can be registered. 

◯  

Group List You can manage users registered in this machine in 
group. 
Up to 1,000 groups can be registered. 

◯  

LDAP Authentication You can set the user information, PIN, etc. required to 
use LDAP authentication. 

◯  

Role Assignment Rules for 
LDAP Authentication 

You can define the regulations on assigning roles to 
users when using LDAP authentication. 

◯  

Print Statistics Configure settings rated to the Print Statistics function. 
Print Statistics Login is required. 

◯ ◯ 

User Counter Display the Usage Report of each user. 
It is displayed when [Printer Settings] - [Management] - 
[Job Log] - [Save Job Log] is enabled. 

◯  

Usage Report Export Export the Usage Report of each user to a CSV file. 
It is displayed when [Printer Settings] - [Management] - 
[Job Log] - [Save Job Log] is enabled. 

◯  

Print Print Setup You can set the number of copies, etc. When a printer 
driver is used, the setup in the printer driver takes priority 
over this setting value. 

◯  

Print From USB Memory 
Setup 

You can set items related to the Print From USB Memory 
function. 

◯  

Printing behavior You can set items related to printing behavior such as 
Toner Save and Manual Timeout. 

◯  

Error behavior You can set the items related to actions when an error 
like a paper jam has occurred. 

◯  

Print Adjustment You can set items related to print adjustment such as 
High Humid Mode and Drum Cleaning. 

◯  

Print Position Adjust You can adjust the print position such as X Adjust, Y 
Adjust, Duplex X Adjust and Duplex Y Adjust. 

◯  

Hex Dump Convert the data received from the host PC to 
hexadecimal format and print it. 

◯  

Configuratio
n 
Management 

Settings Export File and save the settings of this machine to a PC. ◯  

Settings Import Transmit settings of this machine which are saved and 
filed to the PC. 

◯  

Erase Privacy Data Erase the following data set in this machine. 
 Admin password, values set in various menus 
 Various records 
 Access control and user information registered to 

the device 

◯  

Reset Settings Reset the menu settings changed by the user to the 
factory default settings. 

◯  
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Item Description 
◯: Items to 

display 
Admin User 

Printer 
Language 
Setup 

PS Setup You can set the PS-related information. ◯  

PCL Setup You can set the PCL-related information. ◯  

SIDM Setup Set the SIDM-related information. ◯  

IBM PPR Setup You can set the IBM 5577-related information. ◯  

EPSON FX Setup You can set the ESC/P-related information. ◯  

Network Setup 

 

 

Item Description 
◯: Items to 

display 
Admin User 

Network 
Connection 

Wired(LAN1) You can view and set the connection information of the 
supplied wired LAN module. 
You can disable the Energy Efficient Ethernet (EEE) 
function of the wired network (LAN1) by setting [Energy 
Efficient Ethernet] included in this item to [Disable]. 
Only the administrator can configure the settings. 

◯ ◯ 

Extended 
Network 

Disable View and set the network module to be added in addition 
to the wired LAN (LAN1) module. 
Specify Disable, Wireless LAN, or Wired(LAN2). 
Only the administrator can configure the settings. 

◯ ◯ 

Wired(LAN2) You can view and set the connection information of the 
extended wired LAN module. 
It is displayed when the Wired LAN module is installed 
and [Extended Network] is set to [Wired(LAN2)]. 
Only the administrator can configure the settings. 

◯ ◯ 

Wireless 
LAN 

You can view and check the connection information of 
the optional wireless LAN module. 
It is displayed when the wireless LAN module is installed 
and [Extended Network] is set to [Wireless LAN]. 
Only the administrator can configure the settings. 

◯ ◯ 

Default Gateway Settings Specify the network connection method for segment-
based communication. 
It is displayed when [Extended Network] is set to 
[Wired(LAN2)] or [Wireless LAN]. 

◯  

Other TCP/IP Settings You can view and set other TCP/IP information such as 
the DNS server and the WINS server. 
Only the administrator can configure the settings. 

◯ ◯ 

AirPrint You can set the AirPrint-related items. ◯  



Management of this machine 

- 223 - 

Item Description 
◯: Items to 

display 
Admin User 

 Network Scale This setting is to operate more efficiently on the network. 
When a hub with a spanning tree function is used, this 
function is effective when the PC and this machine are 
connected on a one-to-one basis with a crossover cable. 

◯  

Printer 
management 

Email Alert You can set the function to receive notifications by email 
when an error has occurred in this machine. 

◯  

Protocol NetBIOS over TCP/IP You can view and set the information related to NetBIOS 
over TCP/IP. 
If you are using NetBIOS to list computer names on a 
Windows network, you can set this item to display 
printers in the computer name list. 
Only the administrator can configure the settings. 

◯ ◯ 

IPP You can view and set the IPP-related information. 
The IPP protocol (Port number: 443, 631) can be used 
for printing. 
Only the administrator can configure the settings. 

◯ ◯ 

Windows Rally You can set the information related to Windows Rally. ◯  

Mopria You can set the information related to Mopria Print 
Service. 
Mopria Print Service allows you to print from Mopria™ 
compatible clients without using a printer driver. 
When the setting is changed, the machine will restart 
automatically (Depending on the settings of other menus, 
the machine may not restart). 
Only the administrator can configure the settings. 

◯  

IPP Everywhere You can set the information related to IPP Everywhere. 
IPP Everywhere allows you to print from IPP 
Everywhere™ compatible clients without using a printer 
driver. 
When the setting is changed, the machine will restart 
automatically (Depending on the settings of other menus, 
the machine may not restart). 
Only the administrator can configure the settings. 

◯  

E-mail Printing You can set the information required to receive e-mails. 
You can print PDF, JPEG, or TIFF files attached to 
emails received by this machine. 

◯  

LDAP Server Setting You can set the information related to the LDAP server. ◯  

SNMP You can view and set the SNMP-related information. 
This is a protocol for monitoring/managing network 
devices via the network. From the SNMP Manager 
software, you can use the information acquisition 
command to retrieve information about the printer and 
control the printer. 
Only the administrator can configure the settings. 

◯ ◯ 

Protocol ON/OFF Stops network protocols and network services that you 
do not use. 

◯ ◯ 

Security IP Filtering You can restrict access by TCP/IP. You can control 
access from outside the company. 
However, this function requires knowledge about the IP 
address. This machine may be denied from access to 
network due to serious problems depending on settings. 

◯  
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Item Description 
◯: Items to 

display 
Admin User 

 MAC Address Filtering You can restrict access by the MAC address. You can 
control access from outside the company. However, this 
function requires knowledge about the MAC address. 
This machine may be denied from access to network due 
to serious problems depending on settings. 

◯  

IPSec You can set the encryption and tampering of 
communication between this machine and your PC 
(client). 

◯  

IEEE802.1X Authentication You can set the information related to IEEE802.1X/EAP. ◯  

Secure Protocol Server 
Setting 

You can set the information related to the secure 
protocol server. 

◯  

Proxy You can set the information related to the proxy. ◯  

PJL Security You can set whether to receive unencrypted data. ◯  

WebPage Authentication 
Method 

You can set the WebPage authentication method. ◯  

Communication Encryption 
(SSL/TLS Server 
Certificate) 

You can encrypt communication between this machine 
and your PC (client). 

◯  

Maintenance Reset Network Card Reset the network card. The web page will not be 
displayed even if you access from the web browser until 
the resetting has completed. 

◯  

Restore Network Card to 
Factory Defaults 

Restore the network card to its factory default settings. 
The IP address will be reset to the initial state, and the 
information set manually will be lost. In that case, it is 
required to redo the printer's network settings to access 
the web page again. 

◯  

Direct Print 

 

 

Item Description 
◯: Items to 

display 
Admin User 

Direct Print Web Printing You can print any PDF/JPEG file you specified. ◯ ◯ 
E-mail Printing Set the e-mail reception. You can print a PDF, JPEG or 

TIFF file attached to an e-mail. 
* Please configure the e-mail reception settings in 
advance. 

◯  
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Links 

 

 

Item Description 
◯: Items to 

display 
Admin User 

Links Support Links Display the links set by the manufacturer. ◯ ◯ 
Other Links Display the links set by the administrator. ◯ ◯ 
Edit Links You can set the URL to be displayed in the links. You 

can register 5 support links and 5 other links. Input the 
URL that contains "https://". 

◯  
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User restriction (Access control) 

Access control is a function that a user authenticated by this machine can only perform permitted operations. 
Before using this machine, user authentication is required. The information required for user authentication 
refer to a user name and its password, or a PIN (Personal Identification Number). 
To enable the access control function, the administrator shall do the following on the web page of this 
machine. 
 
1. Registering a role(P.226) Register a role to set which operations are permitted or prohibited. 
2. Registering a user(P.227) If you use the local authentication method for user authentication, register 

users and groups. 

 
 User registration can also be performed using the Configuration Tool. 
 Registering the user name and password(P.259) 

 

3. Registering a group(P.228) 

4. Setting the authentication 
server(P.229) 

If you use server authentication for user authentication, configure server 
authentication settings. 

5. Enabling access control(P.230) Enable access control. 

 
 If you have been authenticated but cannot operate, check with the administrator if the operation is permitted. 

 
Printing from a PC(P.128) 

1. Registering a role 
Register a role to assign to the user. For example, create an organizational unit name or job title role, and set 
and register the allowed operations (like printing) for each role. 
A maximum of 100 roles can be registered. You can also assign multiple roles to a single user. 
You can set to permit/prohibit the following operations for a role. 
 Printing from a PC 

 
By default, two types of roles are registered. 
 .AdminRole: 

The role of the device administrator. It can be assigned to general users. A user with [.AdminRole] 
assigned can act as a device administrator and perform [Administrator Login] on the web page. 
(However, the condition is that access control is enabled and it is a local user.) 
[.AdminRole] cannot be deleted or edited. 

 .DefaultRole: 
This is the role to be assigned if no role is specified when a user is registered. 
[.DefaultRole] cannot be deleted, but the access rights can be edited. 

 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Click [Printer Settings]. 

4 Click the Menu button on the upper right corner, and then select [User Management] - [User 
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Management]. 

5 Click [Role]. 

6 When the Role Information screen is displayed, input the required information. 
 Role Name: Input any role name. The same [Role Name] cannot be registered. Also, [Role Name] 

cannot be omitted. 
 Role Description: Input a description for the role. 
 Permission: Set permission/prohibition/forced prohibition of each operation in this role. Setting forced 

prohibition will prohibit operations permitted by other roles. 
 Local User List: Add or delete a local user to which this role is assigned. 
 Kerberos User List: Add a Kerberos user to whom this role applies. 

 

7 Click [Submit]. 
You can copy registered roles and add new roles based on the copied configuration. 
When you click [Copy] below the role name, the role information screen will be displayed, so change and 
register the required items. 

2. Registering a user 
When performing user authentication using the local confirmation method, register the user on this machine 
from the web browser. A maximum of 5,000 users can be registered. 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Click [Printer Settings]. 

4 Click the Menu button on the upper right corner, and then select [User Management] - [User 

Management]. 

5 Click [User]. 

6 Set the type of user. 
 Local User: Register user information in this machine. 
 LDAP User: A user registered in the LDAP server. 

LDAP server authentication setting is required. LDAP user cannot be registered. 
Only browse is possible. You can check the users who used this machine. 

 Kerberos User: A user registered in the Kerberos server. 



Management of this machine 

- 228 - 

Kerberos server authentication setting is required. Kerberos user cannot be registered. Only browse 
is possible. 
You can check the list of users who used this machine. You can also assign a role to a Kerberos 
user. 

 

7 When the User Information Settings screen is displayed, input the required information. 
 User Name: Input the user name. The same [User Name] cannot be registered. Be sure to set it. 
 Password: Input the password. Be sure to set it. 
 Display Name: Input the display name. 
 E-mail Address: Input the user's e-mail address. 
 Language Code: Input the language code. When [Advanced] is selected, input the language code in 

a RFC1766-compliant format. (e.g. en-us) 
 PIN: Input the user's PIN. 
 Role: Set the user's role. [Role] can be assigned to multiple users. 
 Group: Set the group to which the user belongs. 

8 Click [Submit]. 
You can copy registered roles and add new users based on the copied settings. 
When you click [Copy] below the user name, the user information screen will be displayed. Then change 
and register the required items. 

3. Registering a group 
Users registered in this machine can be managed in a group. Up to 1,000 groups can be registered. Up to 
5,000 users can be registered in one group. 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Click [Printer Settings]. 

4 Click the Menu button on the upper right corner, and then select [User Management] - [User 

Management]. 

5 Click [Group]. 

6 When the Group Information screen is displayed, input the required information. 
 Group Name: Input any group name. Be sure to set it. 
 Group Description: Input a description for the group. 
 Local User List: Set the users you want to assign to this group. 
 Kerberos User List: Set the Kerberos users you want to assign to this group. 
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7 Click [Submit]. 
You can copy already registered groups and add new groups based on the copied settings. 
When you click [Copy] below the group name, the group information screen will be displayed, so change 
and register the required items. 

4. Setting the authentication server 
When performing user authentication using the server authentication method, set the server settings from the 
web browser. 
Here is an example of using an LDAP authentication server. 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Click [Printer Settings]. 

4 Click the Menu button on the upper right corner, and then select [User Management] - [LDAP 

Authentication]. 

5 Create user information based on the LDAP server information. 
Input the LDAP key from which each value is obtained. 
 Display name: Set the LDAP key to obtain the display name of user information. 
 E-mail address: Set the LDAP key to obtain the E-mail address of user information. 
 Language Code: Set the LDAP key to obtain the language code of user information. 
 Group: Set it to assign users to a group automatically. Set the LDAP key to obtain the assigned 

group name. When a group with a group name defined by the same text string as the acquired text 
exists in this machine, each group is assigned. When it does not exist, a group with the group name 
of acquired text string is automatically created and assigned. 

 PIN: Set the LDAP key to acquire the PIN to use for PIN authentication. If you do not use PIN 
authentication, no need to input anything. 

 User Name: Set the LDAP key of the user name registered in the LDAP server. 
The factory default user name is "sAMAccountName" for the LDAP key of a Windows server. 
Users using a Windows server do not need to change this setting. 

 Cache authentication information: Set whether authentication information is temporarily stored in this 
machine. The factory default setting is [Disable] (Do not save temporarily). When [Enable] is set, 
user authentication can be performed even when communication with the LDAP authentication 
server is not available due to a communication breakdown, etc., so this machine can be used 
continuously. 

 Cache confirmation information validity period: It appear when [Cache authentication information] is 
set to [Enable]. Set the validity period of the temporarily saved authentication information in this 
machine on a daily basis. The setting range is 1 to 2000 days. After the set number of days, 
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authentication with temporarily stored information will not be available any more. 

 

6 Click [Apply]. 

7 Scroll the screen until [Role Assignment Regulations] is displayed, and define the regulations 

for automatically assigning roles to LDAP users. 

8 When the Role Assignment screen is displayed, input the LDAP key, the LDAP value and the 

applicable role. 
When the LDAP value which is registered in the role assignment regulations of the user, and the LDAP 
value defined by the regulations are identified at the time of authentication, apply the role which is defined 
by each role assignment regulation to each user. 
When a single user matches multiple role assignment regulations, all the roles which match those 
regulations are applied to the user. 

 

9 Click [Submit]. 

5. Enabling access control 
After registering users and configuring the authentication server, enable access control. 
 

1 Open the web page of this machine. 
 Opening the web page(P.200) 

2 Log in as an administrator. 
 Logging in as an administrator(P.201) 

3 Click [Printer Settings]. 

4 Click the Menu button on the upper right corner, and then select [User Management] - [Access 

Control Setup]. 
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5 Select [Enable] in [Access Control]. 

 

6 Configure access control settings according to your environment. 
 Set Guest Permissions: The screen for setting the permissions for guest authentication is displayed. 

By default, guest access rights are granted for all operations. You can define guest permissions 
according to your security policy. 

 Guest user use: Guest is a user assigned to those who are not successful with user authentication 
when the access control is enabled. 
This setting is used to enable or disable the use of this machine by guest. 
When [Disable] is set, you can limit the use of this machine by users who failed the user 
authentication. Specifically, you can disable printing by users who failed the user authentication and 
the operation of the operator panel. 
When [Enable] is set, you can allow users who failed the user authentication to use this machine 
within the range of guest permissions. The definition of guest permissions can be set in the guest 
permission settings. 
[Guest] is displayed as the confirmation method on the Login screen. 

 If you want to discard print data that cannot be authenticated, set [Guest user use] to [Disable], or 
set [Set Guest Permissions] to prohibit the printing permission of the guest. 

 Confirmation method: Enable/Disable each authentication method. 
A user can select the authentication method within the range granted by the administrator at the time 
of authentication. 
If an unnecessary authentication method is disabled in this setting, the disabled authentication 
method will not be displayed in the user options. 

 Default authentication method: Define the focused authentication method as default when the user 
calls the authentication screen from the operator panel. 

7 Set the actions of Direct Print according to your environment. 
 E-mail Printing: Set it to [Enable] or [Disable]. When [Enable] is set, the attached file received by the 

E-mail Printing function will be printed. 
When [Disable] is set, the attached file received by the E-mail Printing function will not be printed. 

8 Click [Apply]. 
 

 
 When [Access Control] and [Lockout Function] are set to [Enable] and [IPP Authentication] is set to [Basic], the 

lockout times of this machine may be fewer than the lockout times set when the machine is logged in from an IPP-
based application. 
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Using the machine 
When access control is enabled, the home screen of this machine changes to the login screen, and user 
authentication is required. 
This section explains the login method to this machine by authenticating a user name and password. 
 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

3 Press ▲ or ▼ to select [User Account Info], and then press «OK». 

4 Input your own user name, and then press «OK». 

5 Press ▲ or ▼ to input your password, and then press «OK». 

6 Login is complete when "Ready To Print (logged in)" is displayed. The home screen is 

displayed. 

 
 You will be automatically logged out after a certain period of time without operating the panel. 

Printing from a PC 
If access control is enabled, when printing from a PC, you need to input user information in the printer driver. 

For Windows 
In this example, Notepad is used to print from the PCL driver. 

1 Select [Print] from the [File] menu. 

2 Select [OKI *** PCL] (where *** is your model name) from [Printer], and click [More settings]. 

3 Select the [Extend] tab. 

4 Click [User Authentication]. 

 

5 Set [User name] and [Password] of the user as user authentication information, and 

[Authentication Type] to specify the authentication destination and authentication mode of the 

user. 
 
 [Password], [Authentication Type], and [Use User Authentication] may not be displayed in the screen depending 

on the setting of [User Authentication Options...] in the [Device Options] tab. 

6 Check [Use User Authentication] if it is displayed. 
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 Uncheck [Use User Authentication] if the PIN of the job accounting client is used as user authentication 

information. 

7 Input the user name and password. 
The user name may be fixed as login name depending on the setting of [User Authentication Options...] 
of the [Device Options] tab. 
Check [Use logon name as user name] to use the Windows login name as the user name. 

8 If [Authentication Type] is displayed, select the user's authentication destination and 

authentication mode from the list. 
 Auto: Follow the method for logging into Windows. Authentication will be made by [Server LDAP] 

when you are logged into a domain or by [Device Local] when you are logged into a local PC. 
 Device Local: Authentication is made by the user information in this machine. 
 Server LDAP: Authentication is made by using LDAP in the user information of the server. 
 Server Kerberos: Authentication is made by using Kerberos in the user information of the server. 

 
 The default authentication type can be set in [User Authentication Options...] of the [Device Options] tab. 

9 Click [OK]. 

10 Specify other settings as necessary, and click [OK]. 

11 Click [Print] in the [Print] screen. 
 

Setting details of user authentication 
Set the user authentication details of the printer driver from the [Device Options] tab or [Device Settings] tab of 
printer properties. 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the icon of your model and select [Printer Properties]. 

3 For the Windows PCL printer driver, select the [Device Options] tab, and click [User 

Authentication Options...]. For the Windows PS printer driver, select the [Device Settings] tab, 

and expand [Installable Options]. 

4 Set the details of user authentication. 
 Set User Authentication Options for each user: Display [Use User Authentication] on the User 

Authentication Options screen so that you can set whether or not to use user authentication. 

 
 When [Set User Authentication Options for each user] is unchecked, user authentication will be used, and 

authentication type will follow the method for logging into Windows. Authentication will be made by [Server 
LDAP] when you are logged into a domain or by [Device Local] when you are logged into a local PC. 

 To use a PIN in the pop-up mode of the job accounting client as user authentication information, check 
[Set User Authentication Options for each user]. 

 Input user authentication information when printing: Pop up User Authentication Options for each 
print job. Use this option to specify an actual user for each print job in an environment where multiple 
users use the same login account on the same PC. 
This cannot be set if [Set User Authentication Options for each user] is checked. 

 Authentication Type: Set the authentication type in User Authentication Options. 
 Default Authentication Type: Specify the default authentication type if the authentication type cannot 
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be set. 

5 For the Windows PCL printer driver, click [OK]. 

6 Click [OK]. 
 

For macOS 
Here is an example with Text Edit. 

1 Select [Print] from the [File] menu. 

2 Select the printer driver of this machine. 

3 Select [Printer Options] - [User Authentication]. 

4 Check [Use User Authentication]. 

 

 
 Uncheck [Use User Authentication] if the PIN of the job accounting client is used as user authentication 

information. 

5 Input [User name] and [Password]. 
Check [Use logon name as user name] to use the login name as the user name. 

6 If [Authentication Type] is displayed, select the user's authentication destination and 

authentication mode from the list. 
 Auto: Follow the method for logging into macOS. Authentication will be made by [Server LDAP] 

when you are logged into a domain or by [Device Local] when you are not logged into a domain. 
 Device Local: Authentication is made by the user information in this machine. 
 Server LDAP: Authentication is made by using LDAP in the user information of the server. 
 Server Kerberos: Authentication is made by using Kerberos in the user information of the server. 

7 Make settings required for printing. 

8 Click [Print]. 
 

When using authentication type 

1 Select [System Preferences] from the Apple menu. 

2 Click [Printers & Scanners]. 

3 Select this machine, and click [Options and Supplies]. 

4 Set [Use User Authentication] to On in the [Options] tab. 

5 Specify the default authentication type, and click [OK]. 
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Initializing the settings 

This section explains how to initialize the memory and the settings of this machine. 
When you forget the admin password, the settings cannot be initialized. 
 

Initializing network settings 
The network settings will return to factory defaults after initialization. 

 
 With this operation, all network settings will be initialized. 

 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

5 Check that [Network Setup] is selected, and press «OK». 

6 Check that [General Setup] is selected, and press «OK». 

7 Press ▲ to select [Network Factory Defaults], and then press «OK». 

8 Check that [Execute] is selected, and press «OK». 

9 The display will return to the standby screen. 

Initializing the flash memory 

 
 Once the flash memory is initialized, the following data will be deleted. 

 Data saved by [Shared Print] or [Private Print] 
 Form data 

 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

5 Press ▲ or ▼ several times to select [Others Setup], and then press «OK». 

6 Press ▼ to select [Flash Memory Setup], and then press «OK». 

7 Select [Initialize], and then press «OK». 

8 Press ▼ to select the partition you want to initialize, and then press «OK». 
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9 When [Are you sure?] is displayed, select [Yes] and press «OK». 
To cancel the initialization, select [No] instead. 

10 When [Execute Now?] is displayed, select [Yes] and press «OK». 
 
 If you select [No], the display will return to [Flash Memory Setup], but the initialization will not be canceled. 

Initialization will be done upon the next power on. 

11 Press the power button to power off the machine, and then power it back on. 

Initializing settings of this machine 
You can restore settings of this machine to the factory default settings. 

 
 Initialization of settings of this machine will return the following data to the default factory settings. 

 [Menus] settings 
 [Admin Setup] settings 
 [Calibration] settings 

 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

5 Press ▲ several times to select [Settings], and then press «OK». 

6 Check that [Reset Settings] is selected, and press «OK». 

7 Check that [Execute] is selected, and press «OK». 
This machine restarts and its settings will be initialized. 
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Moving/Transporting this machine 

Moving this machine 

1 Press the power button to power off this machine. 

2 Remove all cables. 
 Power cord 
 LAN cable/USB cable 

3 Remove the paper from the paper cassette. 

4 If the optional expansion tray unit is installed, use a flat-head screwdriver to remove the parts 

connecting this machine and the expansion tray unit, and separate this machine and the 

expansion tray unit. 

5 Lift the optional expansion tray unit out of this machine, and move it to the destination. 
If the optional dedicated caster stand is installed, unlock the casters (x 2) before moving the machine. 

Transporting this machine 

 Burns may be caused.  

Do not touch the fuser unit because it is hot. 

A flat-head screwdriver is required to install the expansion tray unit. 
A Phillips screwdriver and a flat-head screwdriver are required to install the dedicated caster stand. 

 
 Please use the packing case and cushioning material which came with the product. 

 

1 Press the power button to power off this machine. 

2 Remove all cables. 
 Power cord 
 LAN cable/USB cable 

3 Remove the paper from the paper cassette.  
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4 If the optional expansion tray unit is installed, use a flat-head screwdriver to remove the parts (x 

2) that connect this machine and the expansion tray unit. 
 
 Do not remove the parts that connect the expansion tray units to each other. 
 Do not lose the removed connecting parts. 

 

5 Lift the machine and remove it from the expansion tray unit. 
 
 Pack and ship this machine and the expansion tray unit separately. 

 

6 Attach the cushioning material to this machine and put them together in the packing case. 

7 If you have multiple expansion tray units, use a flat-head screwdriver to remove all connecting 

parts and pack them together with each connected part. 
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8 If the caster stand is installed, use a Phillips-head screwdriver to remove the metal fixtures (x 2) 

that fix the caster stand and the expansion tray unit. 

 

9 Use a flat-head screwdriver to turn the positioning pins (x 2) in the arrow direction to remove 

them from the caster stand. 

 

10 Pinch the protrusion of the anti-tip foot b through the hole on the caster stand and push it out to 

remove the anti-tip foot b. Follow the same procedure to remove the remaining anti-tip feet b. 

 

11 Remove the anti-tip foot a from the caster stand. 

 

12 Put the caster stand in the packing box. At the same time, put the metal fixtures (x 2) of the 

caster stand, positioning pins (x 2), anti-tip feet b (x 3), and anti-tip foot a that were removed in 



Management of this machine 

- 240 - 

Steps 9 to 11 in the packing box. 
 
 Do not lose the removed connecting parts. 
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Disposal 

To dispose of this machine, it is recommended to erase the information registered or saved in this machine. 
The following items are included in the information saved in this machine. 
 Admin Password 
 Various menu settings 
 Private print data 
 Various records 
 Data of access control and user management (local user, external user cache [LDAP, Kerberos]) 

You can erase the information by the following procedure. 
 

1 Check that "Ready To Print" appears on the display. 
 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▼ on the operator panel to select [Menus], and then press «OK». 

3 Press ▼ several times to select [Admin Setup], and press «OK». 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

5 Press ▼ several times to select [Others Setup], and then press «OK». 

6 Press ▼ several times to select [Erase Privacy Data], and press «OK». 

7 When "Execute" is displayed, press «OK». 

8 When "Are you sure?" is displayed, select [Yes] and then press «OK». 
 
 Once the action is executed, the erased data cannot be restored. To cancel the erasing, select [No]. 

9 When "Would you like really?" is displayed, select [Yes(No Report print)] or [Yes(Report print)] 

and then press «OK». 
Restart the machine to erase the data. The result of [Erase Privacy Data] appears on the display. If 
[Yes(Report print)] was selected, a report of the results of [Erase Privacy Data] is printed. 

 

How to dispose of the used machine 
 For corporate customers, we accept collection and recycling of the used machine at your expense. 

Please refer to the support page of our website. 
 For individual customers, please consult your local government. 
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Useful software 
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Useful software 

- 243 - 

Software list 

This section describes the software that can be used with this machine. Please refer to each topic for how to 
use the software. 
 

Windows software 

 
 Software cannot be installed on an OS that is not listed in the operating environment. 

Operating environment 
 Windows 11 
 Windows 10 
 Windows Server 2025 
 Windows Server 2022 
 Windows Server 2019 
 Windows Server 2016 

Item Description Reference 
Monitoring Tool It is a tool to monitor the firmware version of the machine, 

software version and the service life of maintenance parts. 
 Monitoring Tool 

(Windows)(P.247) 
 

PS Gamma Adjuster Utility You can adjust the halftone density when printing from a 
PC. You can adjust the image density of photos or the like. 

 PS Gamma 
Adjuster(P.253) 

 

Configuration Tool  You can configure the access control settings for this 
machine. You can also register or delete form data. 

 Configuration 
Tool(P.255) 

 

OKI LPR Utility You can check the status of this machine connected to the 
network from your PC. You can also transfer print data to 
another machine. 

 OKI LPR utility(P.264) 
 

Print Job Accounting Client You can set a user ID (PIN) in the printer driver to use the 
job accounting function or access control function of this 
machine. 

 Print Job Accounting 
Client(P.268) 

 

Network Status Monitor You can check the status of this machine connected to the 
network from your PC. You can also be notified when 
printing is complete. 

 Network Status 
Monitor(P.271) 

 
 

Printer Supply Manager You can monitor the usage status of consumables and 
maintenance parts of the printer and keep the administrator 
notified. 

 Printer Supply 
Manager(P.273) 

 

smart PrintSuperVision This software is used to manage networked machines. You 
can check the usage status of the machine and impose 
restrictions on its operation. 

For details, please refer to 
the "smart 
PrintSuperVisionUser's 
Manual" on our website. 

Driver Installer Generator This software is used to create printer driver installers. By 
creating an installer that fits your environment, you can 
save the trouble of installing a printer driver. 

For details, please refer to 
the "Driver Installer 
GeneratorUser's Manual" on 
our website. 
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macOS software 

Operating environment 
 macOS 15 - 12 

 
Item Description Reference 

PS Gamma Adjuster Utility You can adjust the halftone density when printing from a 
PC. You can adjust the image density of photos or the 
like.    

 PS Gamma 
Adjuster(P.253) 

 

Print Job Accounting Client You can set a user ID (PIN) in the printer driver to use the 
job accounting function or access control function of this 
machine. 

 Print Job Accounting 
Client(P.268) 

 

Applications for mobile devices 
Item Description Reference 

Mobile Print You can print web pages or photos with an OKI LED printer 
or LED MFP connected to a network via a wireless LAN 
from your smartphone, tablet or other mobile devices. (For 
Android/iOS)  

 Printing with Mobile 
Print(P.278) 

 

NFC Setting Tool You can restore the default settings of this machine from a 
smartphone by using the NFC function even when this 
machine is powered off. (For Android only) 

 
 Depending on the specific region, this machine may 

not come with the NFC function. 

For details, please refer to 
the "Online Manual" on our 
website. 

Print Plugin You can print with OKI's printers by connecting them to Wi-
Fi and clicking the print button in the menu of each 
application on your Android device. 

 Printing with Print 
Plugin(P.291) 

 



Useful software 

- 245 - 

Installing software 

You can down your desired software if any from our website and install it on your PC. 
If your PC comes with a DVD drive, you can install the software from the included DVD. 

For Windows 
 Install your desired software by selecting it from the "Software Package for Windows" downloaded from our 
website or the included DVD. 
Connect this machine to a PC with a network or USB cable, and start the installation. 

 
 Check the status of this machine before installation. 

 The power is turned on. 
 For connection with a network, the machine is connected to a network with a network cable and the IP address 

and other settings of the machine have been configured. 

 

1 Open the "Software Package for Windows" downloaded from our website, or insert the included 

DVD into the PC. 
 
 When using the included DVD, click [Run Setup.exe] when the [DVD drive] screen is displayed. 

 

 
 When the [User Account Control] screen is displayed, click [Yes]. 

2 Choose a language from the pull-down menu of language selection in the [Welcome] screen. 

3 Read the software license agreement, and click [Accept]. 

4 Read the environmental advice, and click [Next]. 

5 Click either [Network Connection] or [USB Connection] depending on the connection method 

between the PC and this machine. 

6 Select the model name of this machine, and click [Next]. 
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7 Click [Individual Install]. 

 

8 Click the printer driver or software you want to install. 
 
 The procedure below may vary with the selected software. 

This is an example of installing the Configuration Tool. 

9 Click [Next] to start the installation. 
The installation starts. 

10 When the installation is complete, click [Finish]. 

For macOS 
Copy it to any location using drag-and-drop. You can also boot directly from the mounted drive. 
 

1 Download the "Software Package for Mac” from our website and open that file. To use the 

included DVD, insert the DVD to the PC. 

2 Double-click on [OKI] - the [Utility] folder. 

3 Copy the folder of the software to be installed to any location you want using drag-and-drop. 
 
 Double-click on the software icon in the folder to launch it. 

For mobile devices 
 Mobile Print is now available on App Store and Google Play. 

 
 The Android version can also be downloaded from our website. 

 
 The NFC Setting Tool can be downloaded from our website. 

For details, please refer to the "Online Manual" on our website. 

 
 Depending on the specific region, this machine may not come with the NFC function. 

 
 Print Plugin is now available on our website and Google Play. 
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Monitoring Tool (Windows) 

You can use the Monitoring Tool to update the firmware and software of the printer. 
The Monitoring Tool is available only for Windows. 
To learn how to install the Monitoring Tool, please refer to "Installing software(P.245)". 

 
 You can also automatically manage the printer's firmware updates. 

When using the automatic management function, use the same Windows login user when installing the Monitoring 
Tool and when using the Monitoring Tool. 

Changing settings of Monitoring Tool 
 

Registering the printer 
Register the printer to be monitored with the Monitoring Tool. 
 

1 Select [Start] - [All] - [OKI] - [Monitoring Tool] to start the Monitoring Tool. 

2 Select [Register printer] from the [Settings] menu. 

 

3 Select the printer to be registered from the printer list, and click [Register]. 

 

4 Input the admin password of the printer, and click [OK]. 
 Administrator Password(P.195) 
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 If an admin password authentication error is displayed, the admin password you input may be incorrect. Input 

the correct admin password again. 

 

5 Click [Close]. 

 

6 Check that the registered printer is displayed. 

 

Updating the printer software 
Monitoring Tool checks for software updates periodically. When an update is available for the software, follow 
the on-screen instructions to update the software. 
 

1 When an update is available for software, [Update Recommended] is displayed in the [Status] 

field. 
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2 Click [Update] on the line where [Update Recommended] is displayed. 

3 Click [Agree] on the license agreement screen. 

4 Follow the on-screen instructions to install it. 
 
 The screen may vary with the software. 

5 When the installation is complete, click [Finish]. 

6 Check that [The latest software] is displayed in the [Status] field. 

 

7 Select [Exit] from the [File] menu. 

Updating the printer’s firmware 
Monitoring Tool checks the status of this machine periodically. When a firmware update is available for this 
machine, follow the on-screen instructions to update the firmware. 
 

1 When a firmware update is available for this machine, [Update Recommended] is displayed in 

the update field. 

 

2 Check the name of this machine, and click [Update firmware]. 

3 On the [Administrator password authentication] screen, input the admin password of this 

machine, and click [OK]. 
 Administrator Password(P.195) 

 

4 The latest firmware is downloaded from our website, and the printer firmware is updated. 
 
 Do not power off the printer while updating the firmware 
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5 When [Completed] is displayed and "Success" is displayed in the [Status] field, the firmware 

update is completed. 
 
 If failed, an error message will be displayed in the [Status] field. Click [Details] on the right side of the message 

to display the error correction method. 

6 Select [Exit] from the [File] menu. 

Changing settings of Monitoring Tool 

1 Select [Start] - [All] - [OKI] - [Monitoring Tool] to start the Monitoring Tool. 

2 Select [Environment Settings] from the [Settings] menu. 

 

3 Set the values in each tab, and click [Apply]. 
 [Printer Communication] tab 

 
Item Description 

Printer search timeout (s) Set the time for searching for the printer. 
Printer communication timeout 
(s) 

Set the time limit for the timeout error of connection to the printer. 

Network search range Specify the range for searching for the printer. 
SNMP community name Set the SNMP community name. 
Restore default Restore all the settings to the default values. 
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 [Server Communication] tab 

 
Item Description 

Communication timeout (s) Set the timeout time for communication with our website. 
Communication retries (times) Set the number of retries when an error has occurred to communication with 

our website. 
Communication retry interval(s) Sets the interval for retrying communication with the website. 
Restore default Restore all the settings to the default values. 

 [Firmware Update] tab 

 
Item Description 

Update timeout (m) Set the timeout limit for the firmware update. 
Restore default Restore all the settings to the default values. 

Deleting the printer 
Delete a printer registered with the Monitoring Tool. 
 

1 Select [Start] - [All] - [OKI] - [Monitoring Tool] to start the Monitoring Tool. 

2 Select [Delete printer] from the [Settings] menu. 
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3 Check the printer to be deleted, and click [Delete]. 

 

Troubleshooting (Monitoring Tool) 

 
 Please check the following explanation and the "FAQ" on our website. 
 If the problem persists, contact your dealer. 
 For problems arising from the application, contact the application development company. 

 

When firmware update has failed 
Cause Solution 

The connection with the server has failed. Check your Internet connection environment. 
The admin password that you input is incorrect. Check the admin password. 
The printer is powered off. Power on the printer, enter the standby mode, and run the 

update again. 
The printer is not connected. Connect the printer. 
The printer is being used. Update the firmware after the printer has stopped. 
An error occurred in the printer (No toner, paper jam, etc.). Update the firmware after the error has been cleared. 
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PS Gamma Adjuster 

You can adjust the halftone density of this machine. Make adjustments if an image like a photo is too dark. 

 
 For Windows, the [Custom Gamma Adjustment] menu or its content may not be displayed on the [Job Options] tab of 

the printer driver after a name is registered in [Gamma Curve Name]. In such a case, restart your PC. 
 Using the Gamma Adjuster may slow down the printing. To prioritize the speed, for Windows, uncheck [Custom 

Gamma Adjustment] in the [Job Options] tab of the printer driver. For macOS, select [Not specified] in [Printer 
Options] - [Print Options] - [Custom Gamma Adjustment]. 

 Applications that have been started before registering [Gamma Curve Name] must be restarted before printing. 
 Some applications allow you to specify dot gain correction and gamma adjustment when printing or include this 

setting in an EPS file. To use the functions provided by an application, for Windows, uncheck [Custom Gamma 
Adjustment] in the [Job Options] tab of the printer driver. For macOS, select [Not specified] in [Printer Options] - [Print 
Options] - [Custom Gamma Adjustment]. 

 For Windows, the model name is displayed in the "Select Printer" list of the PS Gamma Adjuster Utility. If multiple 
identical models exist in [Devices and Printers], the registered [Gamma Curve Name] is valid for all identical models. 

 

Registering a gamma curve name 

For the Windows PS printer driver 

1 Click [Start], and then select [All] - [OKI] - [PS Gamma Adjuster]. 

2 When the [User Account Control] screen is displayed, click [Yes]. 

3 Select [OKI *** PS] (where *** is your model name) from [Select Printer]. 

4 Click [New]. 

5 Adjust the halftone. 
Adjust the halftone by editing the graph or inputting the gamma value and tone density in the text box. 

6 Input the setting name in [Gamma Curve Name], and click [OK]. 

7 Click [Add]. 

8 Click [Apply]. 

9 Click [OK]. 

10 Click [Exit] to close the PS Gamma Adjuster Utility. 
 

For the macOS PS printer driver 

1 Start the PS Gamma Adjuster Utility. 

2 Click [Edit Gamma Curve]. 

3 Adjust the halftone. 
Adjust the halftone by editing the graph or inputting the gamma value and tone density in the text box. 

4 Input the setting name in [Gamma Curve Name], and click [Save]. 

5 Click [Select PPD File]. 

6 Select a PPD file, and click [Open]. 

7 Select the gamma adjuster you created, and click [Add]. 

8 Click [Save]. 
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9 Select [Printers & Scanners] from [System Preferences]. 

10 Delete the registered device to which the adjustment has been set, and then register it again. 

 
 Do not click the [Config] button displayed while adding the printer. 
 If a dialog box for selecting a printer option is displayed while adding a printer, click [Cancel] and then add the printer 

again. 

Printing with registered halftone 

For the Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [More settings]. 

4 Check [Custom Gamma Adjustment] in the [Job Options] tab. 

5 Select the registered Gamma curve name. 

6 Specify other menus as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
 

For the macOS PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printer Options] - [Print Options]. 

4 Select the registered Gamma curve name from [Custom Gamma Adjustment]. 

5 Specify other settings as necessary, and click [Print]. 
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Configuration Tool 

The Configuration Tool allows you to manage multiple machines and change their settings. 
 

Registering this machine 
Register this machine with the Configuration Tool when installing it for the first time. 
 

1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select [Register Device] from the [Tools] menu. 

 

3 When registrable devices are displayed, select this machine, and click [Register]. 

4 Click [Yes] on the confirmation screen. 

Starting the Configuration Tool 

1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

 

Checking the state of this machine 
You can check the state and information of this machine. 
 

1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [Device Info] tab. 

 
 When this machine is connected to a network, [Device Status] is displayed. 
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 To update the information, click [Update Device Information]. 

Displaying print completion on the PC 

 
 The time and time zone of this machine must be consistent with your PC. 

 

Basic settings 
1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select [Alert Info] from the [Plug-in] menu. 

 

3 Select [Setup]. 

 

4 Change the settings as necessary. 

5 Click [Update]. 
 

Device Settings 
1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select [Alert Info] from the [Plug-in] menu. 

3 Select [Setting devices]. 
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4 Click [Update device]. 

 

5 Click the device name you want to set. 

6 Change the settings as necessary, and click [OK]. 
 

Filter Settings 
You can set alert conditions to be displayed when an e-mail is received during printing. 

1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select [Alert Info] from the [Plug-in] menu. 

3 Select [Filter settings]. 

4 Change the settings as necessary. 

 

5 Click [OK]. 

 
 Up to 100 senders can be registered as e-mail senders. 

 

Checking logs 
From the event log, you can check whether there are any records for this registered machine. 

1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select [Alert Info] from the [Plug-in] menu. 

3 Select [Display log]. 
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4 Select [Devices displaying log]. 

 

 
 You can check the total number of recorded events in [Table of number of logs]. 
 You can check the details of recorded logs in [Log details]. 

Registering forms (form overlay) 
You can register a logo, etc., as a form file in this machine for overlay printing. This section explains how to 
register a form file. 

 Printing overlaid text or logos (overlay printing)(P.162) 

 
 This explanation is applicable to the Windows PS printer driver. (The printer’s administrator privileges are required.) 
 To use the Windows PCL printer driver, see "Printing overlaid text or logos (overlay printing)(P.162)". 

 

Creating a form file 
1 Open [Devices and Printers]. 

 How to open [Devices and Printers](P.141) 

2 Right-click on the [OKI *** PS] icon (where *** is your model name) and select [Printer 

Properties]. 

3 Select the [Port] tab, check [FILE:] from [Printing Port], and click [Apply]. 

4 Open the file to be created as a form. 

5 Select [Print] from the [File] menu. 

6 Click [Advanced], and then click [Overlays] on the [Job Options] tab. 

7 Select [Create Form] from the pull-down menu, and click [OK]. 

8 Printing starts. 

9 When the screen for saving the file name is displayed, input a file name with an extension of 

".prn", and then click [Save]. 
Example: C:¥temp¥form.prn 

 
 Files with any other extensions than ".prn" cannot be registered as forms. 

10 When "Failed to encrypt print job" is displayed, select [Print without encryption], and then click 

[Enter]. 

11 Select the original port from [Printing Port] on the [Port] tab, and click [OK]. 
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Registering a form with this machine using Configuration Tool 
1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select [Storage Manager] from the [Plug-in] menu. 

3 Click the [New Project] icon. 

4 Click the [Add File to Project] icon, and select the created form file. 
The form will be added to the project. 

5 Click the form file. 

6 Select this machine in the window at the bottom of the Storage Manager plug-in screen. 
 
 When this machine is not registered with the Configuration Tool, see "Registering this machine(P.255)" to 

register it. 

7 Click the [Send project files to printer] icon. 

8 Click [OK]. 

Checking free space of memory/hard disk 

1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select [Storage Manager] from the [Plug-in] menu. 

3 Click the device name on the device selection area. 
The display shows the storage, volume name, size, free space, location name, usage, status, file name, 
size, comments, etc. by communicating with the device. 

Registering the user name and password 
You can use the user name and password to restrict access to this machine. 
The changed settings are reflected in this machine when the [Save to Device] icon is clicked. 
Since HTTPS is used for the communication with this machine, it is necessary to import the certificate of this 
machine to the computer for correct operation. 
 

Importing a certificate 
1 Open [Control Panel], and click [View network status and tasks]. 

2 Click [Internet Options], then click the [Content] tab - [Certificate]. 

3 Click on the [Trusted Root Certification Authorities] tab, and then click [Import]. 

4 Pay attention to the following points, follow the wizard that appears, and import the certificate. 
・ Select the certificate file to import from the file exported from this machine. 

・ Check that [Place all certificates in the following store] is selected and [Trusted Root Certification 

Authorities] is set for the certificate store. 
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5 If the warning screen appears, click [Yes]; and then click [OK] on the screen indicating that 

importing was successful. 

Creating a new user 
1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [User Setting] tab. 

4 Click [Role management]. 

5 Input the admin password, and click [OK]. 
 Administrator Password(P.195) 

6 Click [User Name/Group]. 

7 Click the [New(User)] icon. 

8 Input the user name and password. 
Set other necessary information. 
Name: Input the display name. 
E-mail Address: Input the user's e-mail address. 
Language Code: Input the language code. 
PIN: Input the user's PIN. 
Role: Set the user's role. 
Group: Set the group to which the user belongs. 

 
 You can input the PIN as a user setting option. 
 "admin" cannot be registered as a new user name. 

9 Click [OK]. 

10 Click the [Save to Device] icon. 
 

Changing user settings 
1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [User Setting] tab. 

4 Click [Role management]. 
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5 Input the admin password, and click [OK]. 
 Administrator Password(P.195) 

6 Click [User Name/Group]. 

7 Select the user name to be changed. 

8 Change the settings as necessary, and click [OK]. 

9 Click the [Save to Device] icon. 
 

Deleting a user 
1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [User Setting] tab. 

4 Click [Role management]. 

5 Input the admin password, and click [OK]. 
 Administrator Password(P.195) 

6 Click [User Name/Group]. 

7 Select the check box of the user to be deleted. 

8 Click the [Delete] icon. 

9 Click [Yes] on the confirmation screen. 

10 Click the [Save to Device] icon. 

Deleting this machine 
You can unregister this machine. 
 

1 Click [Start], and select [All] - [OKI] - [Configuration Tool]. 

2 Right-click on this machine from [Registered Device Table]. 

3 Select [Remove device]. 

4 Click [Yes] on the confirmation screen.  
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Name and function of each screen 

[Device Info] tab 
Display the information related to this machine. 

 

 

[User Setting] tab 
 
Set the user, role and so on. 

 
No. Item Description 

1 Role management Register users and roles, and edit the user and role information. 

 

[Alert Info] plug-in 
Detect and notify the event like the end of printing. 

 
No. Item Description 

2 Basic settings Set the notification method, detection interval, etc. 

3 Setting devices Set the type and presence of the event notified by each machine. 

4 Filter settings Set filter conditions for pop-up notifications. 

5 Display log Display detected notification information. 
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[Storage Manager] plug-in 
Register and edit files to be downloaded to the machine. 

 

Icon description 
Icon Icon name Description 

 
Create New Project Create a new project. 

 
Add File to Project Add files to a project. 

 
Send Project Send a project to this machine. 

 
Save to Device Save the settings to this machine. 

 
New (User) Create a new user. 

 
Delete Delete a user. 
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OKI LPR utility 

With the OKI LPR utility, you can print via a network, manage print jobs, or check the state of this machine. 
To use the OKI LPR utility, TCP/IP must be enabled. 

 
 The OKI LPR utility cannot be used for shared printers. Please use the standard TCP/IP port. 

 

Starting the OKI LPR utility 

1 Click [Start], and then select [All] - [OKI] - [OKI LPR Utility]. 

Registering this machine with the OKI LPR utility 
Add this machine to the OKI LPR utility. 

 
 Administrator privileges are required. 
 If this machine cannot be added, exit the OKI LPR utility temporarily, right-click on [Start] - [All] - [OKI] - [OKI LPR 

Utility], and select [More] - [Running As Administrator] to restart the utility. 

 
 You cannot set a device that is already registered in the OKI LPR utility. To change the port, select [Confirm 

Connections] from [Remote Print]. 

 

1 Start the OKI LPR utility. 

2 Select [Add Printer] from the [Remote Print] menu. 
When [User Account Control] screen is displayed, click [Yes]. 

3 Select [Printer Name]. 
Networked printers and printers connected to the LPR port will not be displayed. 

4 Input [IP Address]. Or, click [Discovery], select the model name to be registered from 

[Discovered Printer], and click [OK]. 

5 If necessary, input the information to identify this machine in [Comment]. 

6 Click [OK]. 
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Checking the state of the registered machine 

1 Start the OKI LPR utility. 

2 Select this machine. 

3 Select [Printer Status] from the [Remote Print] menu. 

Transferring print data to the registered device 
This section explains how to transfer the specified print data to a registered device using the OKI LPR utility. 
This section also explains how to transfer the print data to another device when a problem occurs to the 
destination device. 

 
 Print data can be transferred only to devices with the same model name as your device. 
 Before transferring print data, a device must be added. 
 If you encrypt it before printing, the print data will not be printed correctly on other devices. 

 

Transferring the selected print data 
1 Start the OKI LPR utility. 

2 Select [Job Status] from the [Remote Print] menu. 

3 Select the print data to be transferred, and select [Redirect] from [Job] menu. 

4 Select the destination device, and click [OK]. 
 

Automatically transferring print data 
When this machine cannot print since it is busy, offline, out of paper, etc., you can set the print data to be 
automatically transferred to another OKI machine. 

 
 Administrator privileges are required. 

1 Start the OKI LPR utility. 

2 Select the machine to set. 

3 Select [Confirm Connections] from the [Remote Print] menu. 

4 Click [Advanced]. 

5 Check [Automatic Job Redirect Used]. 

6 To transfer the print data only when an error occurs, check [Redirect only at the time of an 

error]. 

7 Click [Add]. 

8 Input the IP address of the destination device, and click [OK]. 

9 Click [OK]. 
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Printing the same document from multiple registered devices 
You can print from multiple devices with a single order. 

 
 Administrator privileges are required. 
 If you encrypt it before printing, the print data will not be printed correctly on other devices. 

 

1 Start the OKI LPR utility. 

2 Select the machine to set. 

3 Select [Confirm Connections] from the [Remote Print] menu. 

4 Click [Detail Setup]. 

5 Check [Print to more than one printer at a time]. 

6 Click [Options]. 

7 Click [Add]. 

8 Input the IP address of the devices to print at the same time, and click [OK]. 

9 Click [OK]. 

Opening the web page of a registered device 
You can open the web page of this machine from the OKI LPR utility. 
 

1 Start the OKI LPR utility. 

2 Select this machine. 

3 Select [Web Setting] from the [Remote Print] menu. 

 
 When the web port number is changed, the web page cannot be opened. 

For details, see "Setting the port number of the web page for the registered device(P.267)". 

Automatically following the IP address of the registered device 
You can set to maintain the connection to the original device even if the IP address of this machine is 
changed. 

 
 Administrator privileges are required. 

 
 The IP address may be changed when the IP address is dynamically allocated by DHCP, or when the network 

administrator has manually changed the IP address of this machine. 

1 Start the OKI LPR utility. 

2 Select [Setup] from the [Option] menu. 

3 Check [Auto Reconnect], and click [OK]. 
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Setting the port number of the web page for the registered device 

1 Start the OKI LPR utility. 

2 Select this machine. 

3 Select [Confirm Connections] from the [Remote Print] menu. 

4 Click [Detail Setup]. 

5 Input the port number of web page in [Port Numbers]. 

6 Click [OK]. 

Sending files to this machine registered with the OKI LPR utility 
If this machine is connected to the network and registered with the OKI LPR utility, you can download the print 
data. 
 

1 Start the OKI LPR utility. 

2 Select the download destination device. 

3 Select [Download] from [Remote Print]. 

4 Select the file and click [Open]. 
The file is sent to this machine. 

Deleting unnecessary print data 
You can use the OKI LPR utility to delete unnecessary print data. 
 

1 Start the OKI LPR utility. 

2 Select this machine. 

3 Select [Job Status] from the [Remote Print] menu. 

4 Select the print data to be deleted. 

5 Select [Delete Job] from the [Job] menu. 

Uninstalling OKI LPR utility 

 
 Administrator privileges are required. 

 

1 Make sure the OKI LPR utility is closed. 

2 Click [Start], and then select [All] - [OKI] - [Uninstall OKI LPR Utility]. 

3 When [User Account Control] screen is displayed, click [Yes]. 

4 Click [Yes] on the confirmation screen. 
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Print Job Accounting Client 

The Print Job Accounting Client is a program for setting the user information in the printer driver so as to use 
the job accounting function and the access control function of this machine. 
 

For Windows 
You can set the user name and user ID (PIN) in the printer driver. 

 
 Since the job account mode will be disabled after the printer driver is updated or reinstalled, please reset the job 

account mode. However, when all printer drivers are set to the same mode, it is not necessary to reset the mode. 

 

Setting the user name and user ID 
You can set the user name and user ID using "Properties" in the printer driver. 

 

 

1 Click [Start], and then select [All] - [OKI] - [Change Job Accounting Mode]. 

2 From the list of printer drivers, select the printer driver you want to set. 
To set all printer drivers to the same mode, check [Set the same mode for all drivers]. 

3 Select [Tab], and click [Change]. 
A window is displayed. 

4 Click [OK]. 

5 Select [Close] from the [File] menu. 

6 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

7 Right-click on the printer icon, and select [Printer Properties]. 

8 Select the [Job Accounting] tab, input the user name and user ID, and click [OK]. 
 

Setting the pop-up mode 
With this feature, each time you start printing, you need to enter a user name and a user ID. 

1 Click [Start], and then select [All] - [OKI] - [Change Job Accounting Mode]. 

2 From the list of printer drivers, select the printer driver you want to set. 
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3 Select [Popup], and click [Change]. 
A window is displayed. 

4 Click [OK]. 

5 Select [Close] from the [File] menu. 
 

Setting the user ID for each user in the hide mode 
The system administrator creates beforehand the ID file that describes the user ID and user name 
corresponding to the login user name for Windows. Since users are identified by this software, you do not 
have to enter a user name or ID when printing. 
Please use the Hide mode with shared printers. 

1 Create an ID file with the Notepad or spreadsheet software. 
 
 ID files are listed in the following order. 

Login user name (the user name input when logging into Windows), user ID (the user ID corresponding to the 
login user name), and the user name 

 The user name can be omitted. When omitted, the user name will follow the login user name. 
 Separate each item with a comma. 
 For the spreadsheet software, input one login user name, one user ID, and one user name on each line. 

2 Save the file in "CSV" format. 

3 Click [Start], and then select [All] - [OKI] - [Change Job Accounting Mode]. 

4 From the list of printer drivers, select the printer driver you want to set. 
To set all printer drivers to the same mode, check [Set the same mode for all drivers]. 

 
 When using a shared printer, do not use the function to set all printer drivers to the same mode. The account 

information is not output when you are printing from a shared printer client. 

5 Select [Hide], and click [Change]. 

6 Click [OK]. 

7 Select [Import ID file] from the [Hide Mode] menu. 

8 Specify the ID file created in Step 1, and click [Open]. 

9 Uncheck [Set fixed Job Account ID for all users] from the [Hide Mode] menu. 

10 Select [Close] from the [File] menu. 

For macOS 
You can set the user name and user ID in the printer driver. 
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Registering the user ID 
1 Start the Print Job Accounting Client. 

2 Click [New]. 

3 Input your macOS login name, new user name and new user ID, and then click [Save]. 

4 Click [Save]. 

5 Exit the Print Job Accounting Client. 
 

Registering multiple users simultaneously 
You can register multiple user IDs and user names simultaneously using a CSV file. 

 
 The following procedure uses TextEdit as an example. 

1 Start the TextEdit. 

2 Input the login name, user ID and user name in order, separated by commas. 

3 Save the file in CSV format. 

4 Start the Print Job Accounting Client. 

5 Select [Import] from the [File] menu. 

6 Select the CSV file created in Step 3 and click [Open]. 

7 Click [Save]. 

8 Exit the Print Job Accounting Client. 
 

Changing the user ID and user name 
1 Start the Print Job Accounting Client. 

2 Select the user to be changed, and click [Edit]. 

3 Input the new user ID and user name, and then click [Save]. 

4 Click [Save]. 

5 Exit the Print Job Accounting Client. 
 

Deleting the user ID and user name 
1 Start the Print Job Accounting Client. 

2 Select the user to be deleted, and click [Delete]. 

3 Click [Save]. 

4 Exit the Print Job Accounting Client. 
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Network Status Monitor 

With the Network Status Monitor, you can check the status of the networked machine and the completion of 
printing. 
To use it, TCP/IP must be enabled. 
 

Starting the Network Status Monitor 

1 Select [Start] - [All] - [OKI] - [Network Status Monitor] to start the Network Status Monitor. 

2 Click [Discovery]. 

3 From the list of found printers, select the printer whose status you want to check, and then click 

[OK]. 

 
 If [AutoStart] is checked in the display menu, when you start your computer and log in, the Network Status Monitor 

will automatically start and reconnect to the machine you were connected to when you last logged out. 

Checking the state of this machine 
You can check the state of this machine from your PC. 

1 Start the Network Status Monitor. 
 Starting the Network Status Monitor(P.271) 

The status of the machine is displayed in the Network Status Monitor window and in the notification tray 
icon of Windows. 
Display example of the Network Status Monitor window 

 

Status illustration and notification icon 
State Illustration in the window Notification icon 

Normal 

 

 

Warning 

 

 

Error 

 

 

Not connected 
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Displaying print completion on the PC 

 
 The time and time zone of this machine must be consistent with your PC. 

1  Start the Network Status Monitor. 

2 Click [Display] - [Pop-up] - [Printing Completed], and then click [All Jobs] or [Jobs sent from my 

own PC] to make it checked. 

3 Print a job from a PC to this machine. 

4 When printing is complete, a completion message is displayed. 
 
 The printing completion message is displayed for 5 seconds and then disappears automatically. 
 It does not distinguish whether the printing was completed successfully or due to cancellation. 
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Printer Supply Manager 

You can monitor the usage status of consumables and maintenance parts of the printer and keep the 
administrator notified. 
Printer Supply Manager is available only for Windows. 
To use the notification feature, you need to exit the Printer Supply Manager screen. After completing the 
settings described in this section, be sure to exit the screen. 
 

Installing 

1 Unzip the .zip file downloaded from our website. 

2 Run the setup.exe located in the unzipped folder. 

3 Follow the installation screen displayed to proceed with the installation. 

Registering the printer 

1 Click [Start] - [All] - [OKI] - [Printer Supply Manager] to start the Printer Supply Manager. 

2 Click [Register printer] from the [Settings] menu. 

 

3 Click [Discover Devices]. 
 

 

4 Select the discovered printer, and click [Add Selected Printers]. 
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Setting the notified party for notifications about 
consumables/maintenance parts 
 

1 Click [Environmental Settings] from the [Settings] menu. 

 

2 Select the notified party from the [Notifications To] on the [Notification Settings] tab, and click 

[OK]. 
・ Email address: Device data will be sent to the email address entered in [Mail Settings]. 

・ smart PrintSuperVision: Device data will be sent to smart PrintSuperVision, an integrated 

management tool. 
・ PC (Popup): Device data will be displayed in a popup format on the PC. 

 

Setting the notified party for notifications about 
consumables/maintenance parts (E-mail Address) 

1 Click [Mail Settings] from [Notifications To] on the [Notification Settings] tab. 

2 Input each item and click [OK]. 
・ Destination Email Address: Email address to be notified 

・ Originating Email Address: Email address of the sender displayed in the notification email 

・ Display Name: E-mail sender ID displayed in the notification email 

・ Server Name: Server name or IP address of the SMTP server 

・ Port Number: Port number used for communication with the SMTP server 

・ Authentication Method: Authentication method when connecting to the SMTP server 

・ User Name: User name of the SMTP server 

・ Password: Password of the SMTP server 

・ Encrypt Communication: Encrypting the communication with the SMTP server  



Useful software 

- 275 - 

 
 Consult your network administrator for any questions regarding the SMTP server settings. 

 

3 Click [OK] on the [Notification Settings] tab. 

Periodical notification of the usage status of consumables/maintenance 
parts 
You can set periodical notifications at specific time intervals. 
This setting operates regardless of the usage of consumables and maintenance parts, so it can keep you 
notified of the usage status of consumables and maintenance parts periodically. 

1 Click [Environmental Settings] from the [Settings] menu. 

2 Select your desired notification setting from [Notification Settings] - [Notify Periodically], and 

click [OK]. 

 

3 Click [x] in the upper right corner of the screen to exit the Printer Supply Manager. 

Notification based on the usage status of consumables/maintenance 
parts 
You can set notifications based on the usage status of consumables and maintenance items. 
This setting only operates when the usage status of consumables and maintenance parts meets the specified 
conditions, so it can keep you notified of the specified usage status of consumables and maintenance parts. 

1 Click [Printer Management Settings] from the [Settings] menu. 

 

2 Input any name for the management setting. 
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3 Set the conditions for notifications in [Management Settings of Supplies Notification]. 
Example) If you want to be notified when the toner level drops below 30%, set it up as follows. 
 

 

4 Click [Add] to save the settings, and then click [OK]. 
To change the conditions for notifications you have set, change the settings, click [Change], and then 
click [OK]. 

 
 Click [Add] or [Change] to apply the settings. 

5 Double-click on the cell of the [Management Settings] for the printer to be notified, and input the 

management setting name added in Step 3. 
In addition to [Management Settings], you can also change the name of [Identification]. 
Since this is the information that identifies the printer upon notification, it is recommended to input/change 
it as necessary. 

 

6 Click [x] in the upper right corner of the screen to exit the Printer Supply Manager. 
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Printing from a mobile device 
 

Printing with Mobile Print ........................................................................ 278 

Printing with AirPrint ............................................................................... 281 

Printing with Mopria Print Service .......................................................... 285 

Printing with IPP Everywhere ................................................................. 288 

Printing with Print Plugin ........................................................................ 291 
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Printing with Mobile Print 

Mobile Print is an application that allows you to print photos, images, etc. stored on your smartphone, tablet or 
other mobile devices, web pages displayed on the web browser, and photos taken with the built-in camera 
directly onto an OKI printer or MFP from your smartphone, tablet or other mobile devices. 
Mobile Print is now available on App Store and Google Play. 

 
 The Android version can also be downloaded from our website. 

For details on the procedure, please refer to the "Mobile Print WebManual" on our website. 
 

Printing by connecting to an access point 

1 Connect the mobile device to the same network as this machine. 
You can connect it to the wireless LAN access point in the same network as this machine, or directly to 
this machine via Wireless(Wi-Fi Direct). 

 Connection form via a wireless LAN(P.45) 
 Connecting via an access point (Infrastructure)(P.46) 
 Connecting directly with this machine (Wi-Fi Direct)(P.58) 

2 Register this machine in the app and set it as the output destination. 
If it has already been registered, only the destination is set. 

3 Select the target you want to print. 

4 Tap [Print]. 

Printing with the NFC function 

 
 Depending on the specific region, this machine may not come with the NFC function. 

If your mobile device supports the NFC function, you can print using the NFC function of this machine. 
To print using the NFC function, it is necessary to set [Wireless(Wi-Fi Direct)] to [Enable] for this machine. 

 
 [Wireless LAN (Wi-Fi Direct)] cannot be used simultaneously with [Wireless LAN (Infrastructure)]. 

 

Enabling Wireless LAN (Wi-Fi Direct) 
1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «OK» to restore. 

2 Press the scroll button ▲ or ▼ on the operator panel several times to select [Wireless Setting], 

and press «OK». 

3 Check that [Wireless(Wi-Fi Direct) Setting] is selected, and press «OK». 

4 Press ▲ or ▼ to input the admin password, and press «OK». 
 Administrator Password(P.195) 

5 Select [Wireless(Wi-Fi Direct)], and press «OK». 
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6 Select [Enable], and then press «OK». 

7 Press «CANCEL» to return to the standby screen. 
 

Printing with this machine registered with the app 
1 Enable the NFC function of your mobile device, and enable Wi-Fi. 

2 Bring the NFC antenna of the mobile device close to the NFC mark on this machine. 
This machine is registered to the mobile device application. If it has already been registered, only the 
destination is set. 

 
 For iOS, it is necessary to display the NFC reading screen on the application in advance. 

3 Select the target you want to print. 

4 Tap [Print]. 

 
 As the position of the NFC antenna differs for each mobile device, please refer to the manual of your mobile device 

for further details. 
 If the printing has failed, check the Wi-Fi settings of your mobile device, and register this machine with the application 

again. 

Troubleshooting for Mobile Print 

 
 It may take two or three minutes for this machine to join a network after it is turned on. Make sure that the machine is 

connected to the network before attempting to print. 

 

Cannot register this machine using the NFC function 

 
 Depending on the specific region, this machine may not come with the NFC function. 

 
Cause Solution Reference 

Is the wireless setting of this 
machine set to Wi-Fi Direct? 

Enable Wi-Fi Direct.  Printing with Mobile 
Print(P.278) 

 

Is the NFC setting of this 
machine set to [Enable]? 

Check the status of [Menus] - [Admin Setup] - [Others 
Setup] - [NFC Setup] on this machine. If [Disable] is 
displayed, the NFC function is not available. Set it to 
[Enable]. 

- 

Is the wireless setting of the 
mobile device enabled? 

Enable the wireless setting on your mobile device. - 

 

Unable to print 
Cause Solution Reference 

Is the power supply of this 
machine turned on? 

Turn on the power supply of this machine. 
If the power supply is on, turn it off and then back on, and 
then check if the problem is resolved. 

 Turning the power 
on(P.73) 

 Turning the power 
off(P.73) 
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Cause Solution Reference 
When you are printing with 
the NFC function, are this 
machine and the mobile 
device set to communicate 
via Wi-Fi Direct? 

Enable Wi-Fi Direct of this machine. 
Enable Wi-Fi on the mobile device and set the connection 
destination to this machine. 

 Printing with Mobile 
Print(P.278) 

 

Is there any paper? Check that the out-of-paper message is not displayed.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 

 

Is there any toner? Check that the out-of-toner message is not displayed.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 

 

Is any error displayed? Check the error message.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 
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Printing with AirPrint 

With AirPrint, you can print without installing a printer driver. 
This section gives an overview of AirPrint and describes its basic settings. 
 

About AirPrint 
AirPrint is a function that allows you to easily print from macOS or iOS. Mobile devices and Mac computers 
automatically detect this machine. 
With AirPrint, you can easily print photos, emails, web pages, and anything else that appears on your screen 
with just two or three taps on the screen. 
To use this function, you need to connect this machine to a mobile device or Mac computer with a wired LAN, 
wireless LAN or USB cable. 
For details about AirPrint, please visit the Apple website. 
 

1. Setting AirPrint 

1 Connect this machine to the same network as the mobile device. 
Connect this machine and the mobile device via a wireless LAN access point or directly with a wireless 
LAN (Wi-Fi Direct). 
Connect this machine and the access point via [Wireless LAN (Infrastructure)] or [Wired LAN]. 
To connect via [Wireless LAN (Infrastructure)], please set [Wireless LAN (Infrastructure)] in advance. 

 Connection form via a wireless LAN(P.45) 
 Connecting via an access point (Infrastructure)(P.46) 

 

To connect via a wired LAN, connect this machine and the access point with a LAN cable. 
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To connect via [Wireless LAN (Wi-Fi Direct)], please set [Wireless LAN (Wi-Fi Direct)] in advance. 
 Connection form via a wireless LAN(P.45) 
 Connecting directly with this machine (Wi-Fi Direct)(P.58) 

 

2 To use it from a Mac, connect this machine with the Mac. 

3 To print with AirPrint, make settings from the mobile device. 
Go to "3. Printing with AirPrint(P.282)". 

2. Registering this machine on Mac 
When using AirPrint for the first time, register this machine on your Mac. 
 

1 Turn on the power of this machine and the PC. 

2 Connect this machine and the PC via a wireless or wired LAN. 

3 Select [System Preferences] from the Apple menu. 

4 Click [Printers & Scanners]. 

5 Click [Add Printer, Scanner or Fax]. 

6 Select the model name of this machine, and click [Add]. 

7 Make sure that the model name of this machine is displayed in [Printer] and that [(your model 

name)-AirPrint] is displayed in [Type]. 

8 Close [Printers & Scanners]. 

3. Printing with AirPrint 
To AirPrint from a Mac, register this machine on the Mac in advance. 

 2. Registering this machine on Mac(P.282) 

 

Printing from an iOS device 

1 Open the file to be printed. 

2 Tap (Operation). 

3 Tap (Print). 
The model name of the previously used printer on the same network is displayed. 

 
 When printing for the first time or when a model name other than this machine is displayed, select this machine 

in Step 4. 

4 Tap [Printer], and select the model of this machine. 

5 Set the required items. 
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6 Tap [Print]. 
 

Printing from Mac 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the model name of this machine from [Printer]. 

4 Set the required items. 

5 Click [Print]. 

Troubleshooting for AirPrint 

 
 It may take two or three minutes for this machine to join a network after it is turned on. Make sure that the machine is 

connected to the network before attempting to print. 
 If you are using macOS or iOS, please update the software to the latest version before printing. 

 

"No AirPrint Printers Found" is displayed on the iOS device 
Cause Solution Reference 

Is the power supply of this 
machine turned on? 

Turn on the power supply of this machine. 
If the power supply is on, turn it off and then back on, and 
then check if the problem is resolved. 

 Turning the power 
on(P.73) 

 Turning the power 
off(P.73) 

 

Is this machine connected to 
the same network as the iOS 
device?  

Check if this machine is displayed on the iOS print screen. 
If this machine is not displayed, check the IP address. 

- 

 

Unable to print 
Cause Solution Reference 

Is the power supply of this 
machine turned on? 

Turn on the power supply of this machine. 
If the power supply is on, turn it off and then back on, and 
then check if the problem is resolved. 

 Turning the power 
on(P.73) 

 Turning the power 
off(P.73) 

 

Is this machine connected to 
the same network as the iOS 
device? 

 Check if this machine is displayed on the iOS print screen. 
If this machine is not displayed, check the IP address. 

- 

Is the latest firmware 
installed? 

Make sure that the firmware of this machine and the 
software of macOS and iOS are of the latest versions. 
If they are not of the latest versions, please update them to 
the latest versions from our website or Apple's website. 

- 

Is there any paper? Check that the out-of-paper message is not displayed.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 

 

Is there any toner? Check that the out-of-toner message is not displayed.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 
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Cause Solution Reference 
Is AirPrint set to [Enable]? Press the scroll button on the operator panel several times 

to check the status of [AirPrint]. If [Disable] is displayed, 
AirPrint cannot be used. 

- 

Is any error displayed? Check the error message.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 

 

Is the lockout function 
enabled? 

When [Access Control] and [Lockout Function] are set to 
[Enable] and [IPP Authentication] is set to [Basic], the 
lockout times of this machine may be fewer than the 
lockout times set when the machine is logged in from an 
IPP-based application. 

 Preventing disclosure of 
confidential information 
in the operation of this 
machine(P.417) 
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Printing with Mopria Print Service 

With Mopria Print Service, you can print from Android or Windows to a Mopria™ certified printer. 
This section gives an overview of Mopria Print Service and describes its basic settings. 
 

About Mopria Print Service 
Mopria Print Service is an application that allows you to print to Mopria™ certified multifunction printers from 
many manufacturers. It is not required to install a printer driver. Mopria Print Service is now available on 
Google Play. Visit https://www.mopria.org for details. 
 

1. Setting Mopria Print Service 

1 Connect this machine to the same network as the mobile device. 
Connect this machine and the mobile device via a wireless LAN access point or directly with [Wireless 
LAN (Wi-Fi Direct)]. 
Connect this machine and the access point via [Wireless LAN (Infrastructure)] or [Wired LAN]. 
To connect via [Wireless LAN (Infrastructure)], please set [Wireless LAN (Infrastructure)] in advance. 

 Connection form via a wireless LAN(P.45) 
 Connecting via an access point (Infrastructure)(P.46) 

 

To connect via a wired LAN, connect this machine and the access point with a LAN cable. 

 

To connect via a Wireless LAN (Wi-Fi Direct), please set the Wireless LAN (Wi-Fi Direct) in advance. 
 Connection form via a wireless LAN(P.45) 
 Connecting directly with this machine (Wi-Fi Direct)(P.58) 

 

2 To use from a Windows, connect this machine to the Windows. 

3 To print using the Mopria Print Service, configure the settings from the mobile device. 
Go to "3. Printing with Mopria Print Service(P.286)". 

https://www.mopria.org/
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2. Registering this machine with a Windows 
When using the Mopria Print Service for the first time, register this machine in Windows. 
 

1 Turn on the power of this machine and the PC. 

2 Connect this machine and the PC via a wireless or wired LAN. 

3 Open [Start] - [All] - [Settings]. 

4 Click [Printers & Scanners] from [Bluetooth & devices]. 

5 Click [Add device]. 

6 Select the model name of this machine, and click [Add device]. 

7 Check that the model name of this machine is displayed in [Printers & Scanners]. 

8 Close [Settings]. 

3. Printing with Mopria Print Service 
To use Mopria Print Service from a Windows, register this machine on the Windows in advance. 

 2. Registering this machine with a Windows(P.286) 

 

Printing from Android 

1 Open the file to be printed. 
2 Tap [︙]. 

3 Tap [Print]. 

4 The model name of the previously used printer on the same network is displayed. 
 When printing for the first time or when a model name other than this machine is displayed, select this 
machine in Step 5. 

5 Select the model of this machine. 

6 Set the required items. 

7 Tap [Print]. 
 

Printing from Windows 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Print]. 

4 Select the model of this machine. 

5 Set the required items. 

6 Click [Print]. 
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Troubleshooting for Mopria Print Service 

 
  It may take two or three minutes for this machine to join a network after it is turned on. Make sure that the machine 

is connected to the network before attempting to print. 
  For Android, please update the software to the latest version before printing. 

 

When "No Mopria Printer Found" is displayed on an Android or Windows 
Cause Solution Reference 

Is the power supply of this 
machine turned on? 

Turn on the power supply of this machine. 
If the power supply is on, turn it off and then back on, and 
then check if the problem is resolved. 

 Turning the power 
on(P.73) 

 Turning the power 
off(P.73) 

 

Is the machine connected to 
the same network as the 
Android device? 

Check if this machine is displayed on the Android print 
screen. 
If this machine is not displayed, check the IP address. 
If the network is not connected to the Internet, select [Yes] 
in [Do you wish to stay connected?] on the notification 
screen of the Android device. 

- 

Is the latest firmware 
installed? 

Check that the firmware of this machine or the Android 
software is of the latest versions. 
If it is not of the latest version, update it to the latest 
versions. 

- 

Is there any paper? Check that the out-of-paper message is not displayed.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 

 

Is there any toner? Check that the out-of-toner message is not displayed.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 

 

Is Mopria set to [Enable]? Check the status of [Network Setup] - [Mopria] from the 
web page of this machine. If [Disable] is displayed, Mopria 
is not available. 

 Managing the machine 
from the web 
page(P.200) 

 

Is any error displayed? Check the error message.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 

 

Is the Android’s print service 
set to [Enable]? 

Check the status of [Default Print Service] or [Mopria Print 
Service] from the Android’s print service. 
If [Disable] is displayed, Mopria is not available. 

- 

Is the lockout function 
enabled? 

When [Access Control] and [Lockout Function] are set to 
[Enable] and [IPP Authentication] is set to [Basic], the 
lockout times of this machine may be fewer than the 
lockout times set when the machine is logged in from an 
IPP-based application. 

 Preventing disclosure of 
confidential information 
in the operation of this 
machine(P.417) 
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Printing with IPP Everywhere 

IPP Everywhere allows you to print from Linux or Chromebook to IPP Everywhere™ compatible printers. 
This section describes basic settings of IPP Everywhere. 
 

1. Setting IPP Everywhere 

1 Connect this machine to the same network as the mobile device. 
Connect this machine and the mobile device via a wireless LAN access point or directly with [Wireless 
LAN (Wi-Fi Direct)]. 
Connect this machine and the access point via [Wireless LAN (Infrastructure)] or [Wired LAN]. 
To connect via [Wireless LAN (Infrastructure)], please set [Wireless LAN (Infrastructure)] in advance. 

 Connection form via a wireless LAN(P.45) 
 Connecting via an access point (Infrastructure)(P.46) 

 

When connecting via a wired LAN, connect this machine to the access point with a LAN cable. 

 

To connect via a Wireless LAN (Wi-Fi Direct), please set the Wireless LAN (Wi-Fi Direct) in advance. 
 Connection form via a wireless LAN(P.45) 
 Connecting directly with this machine (Wi-Fi Direct)(P.58) 

 

2 To use it from Chromebook, connect this machine to Chromebook. 

3 To print with IPP Everywhere, configure the settings from the mobile device. 
Go to "3. Printing with IPP Everywhere(P.289)". 

2. Registering this machine with Chromebook 
When using IPP Everywhere for the first time, register this machine on your Chromebook. 
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1 Turn on the power of this machine and the PC. 

2 Connect this machine and the PC via a wireless or wired LAN. 

3 Open [Settings]. 

4 Click [Devices] from the left menu. 

5 Click [Print]. 

6 Select the model name of this machine, and click [Save]. 

7 Check that the model name of this machine is displayed in [Your saved printers]. 

8 Close [Settings]. 

3. Printing with IPP Everywhere 
To use IPP Everywhere from Chromebook, register this machine with your Chromebook in advance. 

 2. Registering this machine with Chromebook(P.288) 

You can print from Linux by following the same procedure. 
 

Printing from Chromebook 

1 Open the file to be printed. 
2 Click [︙]. 

3 Click [Print]. 

4 Select the model of this machine. 

5 Set the required items. 

6 Click [Print]. 

Troubleshooting for IPP Everywhere 

 
 It may take two or three minutes for this machine to join a network after it is turned on. Make sure that the machine is 

connected to the network before attempting to print. 
 For Linux or Chromebook, please update the software to the latest version before printing. 

 

"Printer not found" is displayed on Linux or Chromebook 
Cause Solution Reference 

Is the power supply of this 
machine turned on? 

Turn on the power supply of this machine. 
If the power supply is on, turn it off and then back on, and 
then check if the problem is resolved. 

 Turning the power 
on(P.73) 

 Turning the power 
off(P.73) 

 

Is the machine connected to 
the same network as the 
Linux or Chromebook 
device? 

Check if this machine is displayed on the print screen of 
Linux or Chromebook. 
If this machine is not displayed, check the IP address. 

- 

Is the latest firmware 
installed? 

Check that the firmware of this machine or the software of 
Linux or Chromebook is of the latest versions. 
If it is not of the latest version, update it to the latest 
versions. 

- 
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Cause Solution Reference 
Is there any paper? Check that the out-of-paper message is not displayed.  Error message 

list(P.350) 
 When an error 

message appears on 
the display(P.349) 

 

Is there any toner? Check that the out-of-toner message is not displayed.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 

 

Is IPP Everywhere set to 
[Enable]? 

Check the status of [Network Setup] - [IPP Everywhere] 
from the web page of this machine. If [Disable] is displayed, 
IPP Everywhere is not available. 

 Managing the machine 
from the web 
page(P.200) 

 

Is any error displayed? Check the error message.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 

 

If you are using Linux, is the 
CUPS service set to 
[Enable]? 

Check the status of the CUPS service installed on Linux. 
If the CUPS service is not installed, please install the latest 
version. 

- 

If you are using 
Chromebook, are this 
machine and your 
Chromebook connected to 
the Internet? 

Check that this machine and your Chromebook are both 
connected to the Internet. 
IPP Everywhere is not available if they are not connected to 
the Internet. 

Visit Chromebook's official 
websitefor details. 

Is the lockout function 
enabled? 

When [Access Control] and [Lockout Function] are set to 
[Enable] and [IPP Authentication] is set to [Basic], the 
lockout times of this machine may be fewer than the 
lockout times set when the machine is logged in from an 
IPP-based application. 

 Preventing disclosure of 
confidential information 
in the operation of this 
machine(P.417) 
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Printing with Print Plugin 

With Print Plugin, you can print to an OKI printer from an Android mobile device. 
Print Plugin is now available on our website or Google Play. 

 

 

Printing by connecting to an access point 

1 Connect the mobile device to the same network as this machine. 
You can connect it to the wireless LAN access point in the same network as this machine, or directly to 
this machine via [Wireless(Wi-Fi Direct)]. 

 Connection form via a wireless LAN(P.45) 
 Connecting via an access point (Infrastructure)(P.46) 
 Connecting directly with this machine (Wi-Fi Direct)(P.58) 

2 Open the file to be printed. 
3 Tap [︙] on the upper right corner of the screen. 

4 Tap [Print]. 

 

5 Tap the printer. 
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6 Select the printer you want to print to. 

 

7 Set the required items. 

8 Tap the [Printer] icon. 

 

Troubleshooting for Print Plugin 

 
 It may take two or three minutes for this machine to join a network after it is turned on. Make sure that the machine is 

connected to the network before attempting to print. 

 

Printer not found 
Cause Solution Reference 

Is the power supply of this 
machine turned on? 

Turn on the power supply of this machine. 
If the power supply is on, turn it off and then back on, and 
then check if the problem is resolved. 

 Turning the power 
on(P.73) 

 Turning the power 
off(P.73) 

 

Is the wireless setting of the 
mobile device enabled? 

Enable the wireless setting on your mobile device. - 

Is the Android’s print service 
set to [Enable]? 

Check the status of [Print Plugin] from the Android’s print 
service. 
If it is set to [Disable], change it to [Enable]. 

- 

Unable to print 
Cause Solution Reference 

Is there any paper? Check that the out-of-paper message is not displayed.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 
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Cause Solution Reference 
Is there any toner? Check that the out-of-toner message is not displayed.  Error message 

list(P.350) 
 When an error 

message appears on 
the display(P.349) 

 

Is any error displayed? Check the error message.  Error message 
list(P.350) 

 When an error 
message appears on 
the display(P.349) 
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Precautions for replacing consumables and maintenance 
parts 

Note the following points during the replacement. 
 

 

 
Do not throw the toner or toner cartridge in fire. Toner may fly off, thus causing burns. 

 
Do not store the toner cartridge in a place with fire. Doing so may cause a fire or burns. 

 
Do not clean up spilled toner using an electric vacuum cleaner. Otherwise, a fire may be caused due to sparks 
from the electrical contacts. Wipe off and remove the toner spilled on the floor using a wet cloth. 

 

 

 
There are high-temperature parts inside the machine. Do not touch the area with the "Caution: High 
Temperature" label. Doing so may cause burns. 

 
As the fuser unit may be hot, be cautious during operation and always hold the handle to lift it. When it is hot, 
wait until it cools down before any operation. 

 
Keep the toner cartridge out of the reach of children. If children swallow toner by mistake, immediately consult a 
physician. 

 
When toner is inhaled, gargle with a lot of water and move the person to a place with fresh air. Consult a 
physician as necessary. 

 
When toner gets contact with the skin of your hands etc., wash it off with soapy water. 

 
It toner gets into your eyes, immediately wash it off with a large quantity of water. Consult a physician as 
necessary. 

 
When toner is swallowed, exhale the toner. Consult a physician as necessary. 

 

When clearing a paper jam or replacing the toner cartridge, take care that your hands and clothes are not 
stained with toner. When clothes are stained with toner, wash them in cold water. Heating it like washing in hot 
water may dye the toner on clothes, and the stains may not be removed easily. 

 
Do not disassemble the image drum or toner cartridge. Doing so may scatter the toner, which may be inhaled 
by people or may stain clothes or hands. 

 
Store the used toner cartridge in a bag such that toner does not scatter. 

 
 Please use genuine OKI genuine consumables for optimum performance. 
 Failures caused by using non-genuine consumables may void the warranty or maintenance contract. (The use of 

non-genuine consumables will not necessarily cause failures, but please fully take notice of such usage.) 
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Service life and replacement cycle of consumables 

Toner cartridge 

Service life of the toner cartridge 
The number of printable pages of a toner cartridge is based on the condition that continuous printing is done 
on 1-sided A4 paper according to the data of "ISO/IEC 19752". The number of printable pages may vary with 
the actual printing conditions (*). 
* Printing conditions: content of printed documents, printer driver settings, user's operating environment, OS 
environment, operational adjustments during power ON/OFF or cover opening/closing, etc. 
To check the remaining toner amount, select [Menus] - [Configuration] - [Supplies Life] - [Toner] on the 
operator panel. 

Replacement cycle of the toner cartridge 
When the time for replacement is approaching or has arrived, the following message appears on the display. 

 
When the time for replacement is 

approaching → When the time for replacement has 
arrived 

Displayed message Toner Low. → The toner cartridge is empty. Replace the 
toner cartridge with a new one. 

Response to the 
message 

Prepare a new toner cartridge. → Replace the toner cartridge with a new one. 

State of this machine Printing is possible, but the remaining toner 
is low. 

→ The toner cartridge is empty. Printing stops. 

About 180 pages can be printed from when the time for replacement is approaching to when the time for 
replacement has arrived. (reference value for A4_ISO pattern_simplex printing) 

 
 Printing quality will decline after the toner cartridge stays unpacked for one year or longer. Therefore, prepare a new 

toner cartridge. 
 Please use genuine OKI genuine consumables for optimum performance. 
 Failures caused by using non-genuine consumables may void the warranty or maintenance contract. (The use of 

non-genuine consumables will not necessarily cause failures, but please fully take notice of such usage.) 
 Replace the toner cartridge immediately when a message indicating replacement of the toner cartridge is displayed 

and printing has stopped. 
If you repeatedly open and close the top cover so that you can continue printing temporarily, a failure may be caused 
or the print quality may be degraded. 
In addition, after a certain period of time, printing will be disabled even if you open and close the top cover. (The 
printable period of time varies with the usage condition.) 

 Replacing toner cartridges(P.298) 

Image drum 

Service life of the image drum 
The image drum can print approximately 30,000 sheets of A4-sized paper (for simplex printing), but the actual 
printable number of sheets may vary with the usage condition. 
The above number of printable pages is based on the condition that 3 sheets are printed at a time on 1-sided 
A4 paper (continuous printing). If one sheet is printed at a time, the yield may reduce to approximately half or 
less depending on the printing conditions (*). 
* Printing conditions: content of printed documents, printer driver settings, user's operating environment, OS 
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environment, operational adjustments during power ON/OFF or cover opening/closing, etc. 
To check the life of the image drum, select [Menus] - [Configuration] - [Supplies Life] - [Drum] on the operator 
panel. 

Replacement cycle of the image drum 
When the time for replacement is approaching or has arrived, the following message appears on the display. 

 
When the time for replacement is 

approaching → When the time for replacement has 
arrived 

Displayed message 
Image Drum Near Life. 

→ 
The image drum has reached the end of its 
service life. Replace the image drum with a 
new one. 

Response to the 
message 

Prepare a new image drum. 
→ 

Replace the image drum with a new one. 

State of this machine Printing is possible, but the image drum is 
approaching the end of its service life. → 

The image drum has reached the end of its 
service life. Printing stops. 

About 1,000 pages can be printed from when the time for replacement is approaching to when the time for 
replacement has arrived. (When printing under general usage conditions with factory default settings) 
 

 
 Printing quality will decline after the image drum stays unpacked for one year or longer. Therefore, prepare a new 

image drum. 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it uncovered 

for more than 5 minutes even under room lighting. 
 Please use genuine OKI genuine consumables for optimum performance. 
 Failures caused by using non-genuine consumables may void the warranty or maintenance contract. (The use of 

non-genuine consumables will not necessarily cause failures, but please fully take notice of such usage.) 
 Replace the image drum immediately when a message indicating replacement of the image drum is displayed and 

printing has stopped. 
If you repeatedly open and close the top cover so that you can continue printing temporarily, a failure may be caused 
or the print quality may be degraded. 
In addition, after a certain period of time, printing will be disabled even if you open and close the top cover. (The 
printable period of time varies with the usage condition.) 

 If [Menus] - [Admin Setup] - [Panel Setup] - [Near Life Status] is set to [Disable], a message indicating the time for 
replacement will not be displayed. 

 
 You can change the timing for displaying a message indicating the time for replacement of the image drum. The 

factory default setting is [1000]. 
This timing can be set from [Menus] - [Admin Setup] - [Others Setup] - [Near Life Setup] - [Drum Near Life Timing] on 
the operator panel. 
The setting range is from 500 to 5,000 (in increments of 500). 

 Replacing the image drum and the toner cartridge(P.305) 
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Replacing toner cartridges 

1 Prepare a new toner cartridge. 

2 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

3 Press the toner cartridge from the top, and then rotate the blue lever on the right side in the 

direction of the unlock mark until it stops. 

 

4 Lift the right side of the toner cartridge, and gently pull the toner cartridge out. 

 Burns may be caused.  

Never throw a used toner cartridge in fire. The toner inside may scatter or even explode, thus resulting in burns. 

 

5 Remove the new toner cartridge from its packaging bag, and shake it horizontally to even out 

the toner inside. 
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6 Remove the protective tape on the bottom while keeping the toner cartridge level. 

 

7 Hold the toner cartridge with the flat part facing up and the blue lever on the right side. 

 

8 Tilt the left side of the toner cartridge downward, insert the toner cartridge so that it is pressed 

against the protrusion on the image drum, and then lower its right side. 

 

9 Press the toner cartridge from the top, and then rotate the blue lever on the right side in the 

direction of the lock mark until it stops. 
 
 If the toner cartridge is not installed correctly, the toner cartridge lever will not rotate. 

 

10 Close the top cover (front). 

 

 
 Please recycle the used toner cartridge. 
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Replacing the image drum 

This section explains how to only replace the image drum with a new one, and continue using the existing 
toner cartridge. 
Refer to "Replacing the image drum and the toner cartridge(P.305)" if you want to replace both the image drum and 
toner cartridge with new ones. 

 
 If you attach the existing toner cartridge to a new image drum, the remaining amount of the toner cartridge may not 

be displayed correctly. In addition, "Toner low." or "Toner Empty. Waste Toner Full." may be displayed after the 
replacement. 

 Please use genuine OKI consumables for optimum performance. 
 Failures caused by using non-genuine consumables may void the warranty or maintenance contract. (The use of 

non-genuine consumables will not necessarily cause failures, but please fully take notice of such usage.) 

 

1 Prepare a new image drum. 

2 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

3 Press the blue part of the left side in the machine to open the top cover (whole). 
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4 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 

 

5 Remove the image drum. Remove the image drum together with the toner cartridge attached to 

it. 

 

6 Place the image drum and toner cartridge on a flat surface covered with newspaper or the like. 
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7 Remove the new image drum from its packaging bag, and then place it on a flat surface 

covered with newspaper or the like. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 

 

 

8 Take out the desiccant. 

 

9 Install the new image drum into the main unit. 
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10 Remove the toner cover attached to the new image drum. 
 
 Handle the toner cover with your both hands and be careful not to hit it on surrounding objects. The toner on the 

toner cover may scatter and stain your clothes. 

 

11 For the used image drum and toner cartridge removed in Steps 5-6, press them down from the 

top, and then rotate the blue lever on the right side of the toner cartridge in the direction of the 

unlock mark until it stops. 

 

12 While pressing down the image drum, remove the toner cartridge by lifting its right side. 

 

13 Tilt the left side of the toner cartridge downward, insert the toner cartridge so that it is pressed 

against the protrusion on the new image drum, and then lower its right side. 
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14 Press the toner cartridge from the top, and then rotate the blue lever on the right side in the 

direction of the lock mark until it stops. 
 
 If the toner cartridge is not installed correctly, the toner cartridge lever will not rotate. 

 

15 Close the top cover from the rear side. 

 

16 Close the top cover (front). 

 

 
 Please recycle the used image drum. 
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Replacing the image drum and the toner cartridge 

This section explains how to replace both the image drum and toner cartridge with new ones. 
Refer to "Replacing the image drum(P.300)" if you want to replace only the image drum with a new one but 
continue using the existing toner cartridge. 
 

1 Prepare a new image drum and a new toner cartridge. 

2 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

3 Press the blue part of the left side in the machine to open the top cover (whole). 

 

 

4 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 
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5 Remove the image drum. Remove it with the toner cartridge attached to the image drum. 
 
 Do not remove the toner cartridge from the image drum. 

 

6 Remove the new image drum from its packaging bag, and then place it on a flat surface 

covered with newspaper or the like. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 

 

 

 

7 Take out the desiccant. 
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8 Install the new image drum into the main unit. 

 

9 Remove the toner cover attached to the new image drum. 
 
 Handle the toner cover with your both hands and be careful not to hit it on surrounding objects. The toner on the 

toner cover may scatter and stain your clothes. 

 

10 Remove the new toner cartridge from its packaging bag, and shake it horizontally to even out 

the toner inside. 

 

11 Remove the protective tape on the bottom while keeping the toner cartridge level. 
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12 Hold the toner cartridge with the flat part facing up and the blue lever on the right side. 

 

13 Tilt the left side of the toner cartridge downward, insert the toner cartridge so that it is pressed 

against the protrusion on the image drum, and then lower its right side. 

 

14 Press the toner cartridge from the top, and then rotate the blue lever on the right side in the 

direction of the lock mark until it stops. 
 
 If the toner cartridge is not installed correctly, the toner cartridge lever will not rotate. 

 

15 Close the top cover from the rear side. 
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16 Close the top cover (front). 

 

 
 Please recycle the used image drum and toner cartridge. 
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Service life and replacement cycle of maintenance parts 

Maintenance kit 
The maintenance kit is a set of a fuser unit and a transfer roller. 

Service life of the maintenance kit 
The fuser unit and the transfer roller can print approximately 200,000 sheets of A4-sized paper (for simplex 
printing), but the actual printable number of sheets may vary with the usage condition. 
The above number is based on the general usage condition (three sheets at a time). If you print a single sheet 
at a time, the life may be reduced by half. 
A message appears indicating preparation for replacement when the end of life is approaching. 
To check the life of the fuser unit, select [Menus] - [User Setup] - [Information] - [Supplies Life] - [Fuser] on the 
operator panel. 
 
For Windows, when you are using the Monitoring Tool, the Monitoring Tool will pop up a message to notify 
you that it is time to replace the maintenance kit. 

 Monitoring Tool (Windows)(P.247) 

 

Replacement cycle of the maintenance kit 
When the time for replacement is approaching or has arrived, the following message appears on the display. 

 
When the time for replacement is 

approaching → When the time for replacement has 
arrived 

Displayed message Fuser Near Life. 
→ 

Fuser Life. Change Fuser. 

Response to the 
message 

Prepare a new fuser unit. 
→ 

Replace the fuser unit with a new one. 

State of this machine Printing is possible, but the fuser unit is 
approaching the end of its service life. → 

Printing is possible, but the print quality 
cannot be guaranteed. 

About 1,500 pages can be printed from when the time for replacement is approaching to when the time for 
replacement has arrived. (When printing under general usage conditions with factory default settings) 
 

 
 If [Menus] - [Admin Setup] - [Panel Setup] - [Near Life Status] is set to [Disable], a message indicating the time for 

replacement will not be displayed. 

 
 You can change the timing for displaying a message indicating the time for replacement of the fuser. The factory 

default setting is [1500]. 
This timing is set from [Menus] - [Admin Setup] - [Others Setup] - [Near Life Setup] - [Fuser Near Life Timing] on the 
operator panel. 
The setting range is from 500 to 5,000 (in increments of 500). 

 Replacing the maintenance kit(P.312) 
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Paper feed roller 
Replace the paper feed roller of each tray by referring to the following number of printable sheets. 
 Approx. 100,000 for Tray 1/2/3/4 
 Approx. 80,000 for the MP Tray 

The display does not show the replacement time of the paper feed roller or a message indicating that it is time 
to replace the paper feed roller. 
Check the roller usage of each tray in [Menus] - [Information] - [Paper Feed Roller Counter] on the operator 
panel, and replace the paper feed roller if it has reached the designed number of sheets. Or, replace the 
paper feed roller if paper jams occur frequently even after you have cleaned it. 
For Windows, you can check the replacement time from the usage status of each paper feed roller in the 
Monitoring Tool. However, the pop-up screen for the replacement time will not be displayed. 
The paper feed roller of Tray 1/2/3/4 differs in shape from that of the MP tray. Check the tray of which the 
paper feed roller is to be replaced, and prepare a new paper feed roller accordingly. 
 

 Replacing the paper feed roller (Tray 1)(P.319) 
 Replacing the paper feed roller (MP Tray)(P.329) 
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Replacing the maintenance kit 

The maintenance kit is a set of a fuser unit and a transfer roller. Follow the procedure below to replace the 
fuser unit and the transfer roller at the same time. 
 

1 Prepare a new maintenance kit and check that you have all the parts. 

 

Fuser unit 

 

Transfer roller 

2 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

3 Press the blue part of the left side in the machine to open the top cover (whole). 
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4 Unlock the fuser unit by rotating the blue lock lever on its both sides towards the back side until 

it reaches the unlock mark position. 

 

5 Remove the fuser unit from this machine by holding its central handle. 

 Burns may be caused.  

As the fuser unit may be hot, be cautious during operation and always hold the handle to lift it. When it is hot, wait 
until it cools down before any operation. 

 

6 Install the new fuser unit into this machine. 

 



Maintenance 

- 314 - 

7 Lock the fuser unit by rotating the blue lock lever on its both sides towards the front side until it 

reaches the lock mark position. 

 

8 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 

 

9 Remove the image drum. Remove the image drum together with the toner cartridge attached to 

it. 
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10 Place the removed image drum and toner cartridge on a flat surface and cover it with a piece of 

paper or the like to avoid direct light. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 

 

 

 

11 Unlock the transfer unit by rotating the blue handles on its both sides towards the front side. 
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12 Remove the transfer unit. 
 
 Do not wipe off any grease applied to the metal part inside the main unit. 

 

 

13 Remove the transfer roller by pressing the blue label on the lower left side of the transfer unit 

outwards. 
 
 Be careful not to touch the sponge section in the center. 

 

14 Take the new transfer roller out of its packing box. 

  



Maintenance 

- 317 - 

15 Install the transfer roller to the transfer unit with the blue handle of the transfer unit on the front 

side and the blue label of the transfer roller on the left side. 
 
 Be careful not to touch the sponge section in the center. 

 

16 Install the transfer unit into this machine. 
 

 

17 Lock the transfer unit by tilting its left and right blue levers toward the back. 
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18 Install the image drum together with the toner cartridge into this machine. 

 

19 Close the top cover from the rear side. 

 

20 Close the top cover (front). 

 

 
 Please recycle the used maintenance kit. 
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Replacing the paper feed roller (Tray 1) 

For the replacement cycle, please refer to "Paper feed roller(P.311)". 
This section takes for example the procedure of replacing the paper feed roller of Tray 1. You can replace the 
paper feed roller of Tray 2/3/4 by following the same procedure. 

 
 Please replace the paper feed roller with clean hands. If hand oil or hand cream gets on the rubber part, the paper 

feed function may deteriorate. 

 

1 Prepare a new feed roller assembly (for Tray 1) and check that you have all the parts. 

 

Paper feed roller (without gears) 

 

Paper feed roller (with gears) 

 

Separation roller 

 
Spring 

2 Press the power button to power off this machine. 

3 Pull out the lower paper cassette of Tray 1 until it stops, and then lift it slightly upward to remove 

it. 
 
 If you pull out the paper cassette with the power on, "Change settings?" may appear on the display. This 

message will disappear automatically in about 10 seconds after the paper cassette is returned to the main unit. 
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4 While pushing the claws of the front paper feed roller (without gears) outward (as shown in the 

following figure) in the evacuated paper cassette slot, slide the paper feed roller (without gears) 

to the left and remove it. 

 

5 For B433, open the black cover downward by pressing the claw on its left side, and remove the 

internal paper feed roller (with gears). 

 

For B513, press the tab, and remove the internal paper feed roller (with gears). 

 

6 Attach it to the machine from the right side of the new paper feed roller (with gears), and close 

the black cover until you hear a click. 
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7 Hold the new paper feed roller (without gears) with the blue claw on the left, insert it onto the 

front shaft, and push the paper feed roller in until you hear a click. 
 
 If it is hard to mount it, rotate the roller slightly left and right, and then mount it again. 

 

8 Remove the paper from the paper cassette. 

 

9 Open the roller cover by pressing the claws on its both sides, and remove the separation roller. 

 

10 Attach the spring to the new separation roller. 
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11 Align the spring (A) of the new separation roller with the tray, insert the shaft (B), and snap the 

notch (C) into the tray shaft. 

 

 

12 Check that the separation roller is properly installed. 

 

13 Close the roller cover. 

 

14 Load paper in the paper cassette. 
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15 Insert the paper cassette into the main unit from slightly above and install it back to its original 

position. 

 

16 Clear the paper feed roller counter of the replaced tray. 
On the operator panel, select [Menus] - [Admin Setup] - [Others Setup] - [Paper Feed Roller Counter 
Clear] - [Tray1 Clear] - [Execute] - [Yes], and then press «OK». 

 
 Please recycle the used paper feed roller. 
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Replacing the paper feed roller (Tray 2/3/4 (Optional)) 

For the replacement cycle, please refer to "Paper feed roller(P.311)". 
This section takes for example the procedure of replacing the paper feed roller of Tray 2. You can replace the 
paper feed roller of Tray 3/4 by following the same procedure. 

 
 Please replace the paper feed roller with clean hands. If hand oil or hand cream gets on the rubber part, the paper 

feed function may deteriorate. 

 

1 Prepare a new feed roller assembly (for Tray 2/3/4) and check that you have all the parts. 

 

Paper feed roller (without gears) 

 

Paper feed roller (with gears) 

 

Separation roller 

 
Spring 

2 Press the power button to power off this machine. 

3 Pull out the lower paper cassette of Tray 2 until it stops, and then lift it slightly upward to remove 

it. 
 
 If you pull out the paper cassette with the power on, "Change settings?" may appear on the display. This 

message will disappear automatically in 10 seconds after the paper cassette is returned to the main unit. 
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4 While pushing the claws of the front paper feed roller (without gears) outward (as shown in the 

following figure) in the evacuated paper cassette slot, slide the paper feed roller (without gears) 

to the left and remove it. 

 

5 While pushing the claws of the rear paper feed roller (with gears) outward (as shown in the 

following figure), slide the paper feed roller (with gears) to the left and remove it. 

 

6 Mount the new paper feed roller (with gears). Hold the paper feed roller (with gears) with the 

blue claw on the left, insert it onto the rear shaft, and push the paper feed roller in until you hear 

a click. 

 

7 Mount the new paper feed roller (without gears). Hold the paper feed roller (without gears) with 

the blue claw on the left, insert it onto the front shaft, and push the paper feed roller in until you 

hear a click. 
 
 If it is hard to mount it, rotate the roller slightly left and right, and then mount it again. 
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8 Remove the paper from the paper cassette. 

 

9 Open the roller cover by pressing the claws on its both sides, and remove the separation roller. 

 

10 Attach the spring to the new separation roller. 
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11 Align the spring (A) of the new separation roller with the tray, insert the shaft (B), and snap the 

notch (C) into the tray shaft. 
 
 Do not touch the rubber portion of the roller. 

 

12 Check that the separation roller is properly installed. 

 

13 Close the roller cover. 
 

 

14 Load paper in the paper cassette. 
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15 Insert the paper cassette into the main unit from slightly above and install it back to its original 

position. 

 

16 Clear the paper feed roller counter of the replaced tray. 
On the operator panel, select [Menus] - [Admin Setup] - [Others Setup] - [Paper Feed Roller Counter 
Clear] - [Name of the replaced tray Clear] - [Execute] - [Yes], and then press «OK». 

 
 Please recycle the used paper feed roller. 
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Replacing the paper feed roller (MP Tray) 

For the replacement cycle, please refer to "Paper feed roller(P.311)". 

 
 Please replace the paper feed roller with clean hands. If hand oil or hand cream gets on the rubber part, the paper 

feed function may deteriorate. 

 

1 Prepare a new feed roller assembly (for the MP tray) and check that you have all the parts. 

 

Paper feed roller (with gears) 

 

Paper feed roller (without gears) 

2 Press the power button to power off this machine. 

3 Place your finger in the front recess, and pull to open the MP tray towards you. 

 

4 While lifting the MP tray gently, swing the right arm outward to unlock the roller guide. 

 

5 Follow the same procedure to unlock the arm on the left side. 

6 Open the roller guide until it attaches to the main unit. 
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7 While holding the black cover down, grasp the left side of the upper paper feed roller (with 

gears), and pull the roller along a forward-right diagonal to remove it. 

 

8 Open the cover guide in the arrow direction. 

 

9 Remove the lower paper feed roller (without gears). 

 

10 Wipe the separation pad with a cloth slightly moistened with water. 
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11 Prepare a new paper feed roller (without gears). Install the slender shaft on the left side, and 

slide it rightward to lock the cover guide. 
 
 Do not touch the rubber portion of the roller. 

 

12 Prepare a new paper feed roller (with gears). With its gears on the right side, insert the paper 

feed roller (with gears) into the upper hole and push it in until you hear a click. 

 

13 While lifting the MP tray gently, swing the right arm outward to lock the roller guide. 

 

14 Follow the same procedure to lock the left arm. 

15 Close the MP tray. 
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16 Press the power button to power on this machine. 

17 Clear the counter of the paper feed roller on the MP tray. 
On the operator panel, select [Menus] - [Admin Setup] - [Others Setup] - [Paper Feed Roller Counter 
Clear] - [MP Tray Clear] - [Execute] - [Yes], and then press «OK». 

 
 Please recycle the used paper feed roller. 
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Cleaning the main unit and the parts 

Cleaning the LED head 
If there are black or white vertical stripes on the output paper, the image is faded or the text is blurred, clean 
the LED head. 

 
 Do not use methyl alcohol or thinner. Doing so may damage the LED head. 

1 Press the power button to power off this machine. 

2 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

3 Press the blue part of the left side in the machine to open the top cover (whole). 

 

 

4 Gently wipe the lens surface of the LED head with a soft tissue paper. 
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5 Close the top cover from the rear side. 

 

6 Close the top cover (front). 

 

Cleaning the surface of the main unit 

 
 Do not use benzene, paint thinner or alcohol as it may damage plastic parts and coating of this machine. 
 It is not necessary to lubricate the parts of this machine. Do not lubricate. 

 

1 Press the power button to power off this machine. 

2 Clean the surface of this machine with a cloth slightly moistened with water or a neutral 

detergent. 
 
  Only use water or a neutral washing agent. 

 

3 Wipe the surface of this machine with a soft dry cloth. 

Cleaning the paper feed roller (Tray 1/2/3/4) 
If paper jams occur frequently, clean the paper feed roller. Clean the separation roller of the paper cassette 
and the paper feed roller inside this machine. 

 
 If paper jams persist even after the paper feed roller is cleaned, it is recommended to replace the paper feed roller. 
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This section takes for example the procedure of cleaning the paper feed roller of Tray 1. Clean the paper feed 
roller of Tray 2/3/4 by following the same procedure. 
 

1 Pull out the lower paper cassette of Tray 1 until it stops, and then lift it slightly upward to remove 

it. 

 

2 Remove the paper from the paper cassette. 

 

3 Press the recess of the separation roller on the paper cassette, and wipe it with a cloth slightly 

moistened with water while rotating the separation roller. 

 

4 Load paper in the paper cassette. 
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5 Wipe the paper feed roller with a cloth slightly moistened with water while rotating the white 

gear inside this machine to the far side. Wipe the paper feed roller with a blue gear as well. 

 

6 Insert the paper cassette into the main unit from slightly above and install it back to its original 

position. 

 

Cleaning the paper feed roller (MP tray) 
If paper jams occur frequently, clean the paper feed roller and the separation pad. 

 
 If paper jams persist even after the paper feed roller and the separation pad are cleaned, it is recommended to 

replace the paper feed roller. 

 

1 Place your fingers in the front recess and pull to open the MP tray towards you. 

 

2 While lifting the MP tray gently, swing the right arm outward to unlock the roller guide. 
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3 Follow the same procedure to unlock the roller guide on the left side. 

4 Open the roller guide until it attaches to the main unit. 

 

5 Wipe the paper feed roller with a cloth slightly moistened with water while rotating it. 

 

6 Remove the paper feed roller (without gears), and wipe the separation pad with a cloth slightly 

moistened with water. 
 
 For the method of removing the paper feed roller, please refer to "Replacing the paper feed roller (MP 

Tray)(P.329)". 

 

7 While lifting the MP tray gently, press the right arm outward to lock the roller guide. 

 

8 Follow the same procedure to lock the roller guide on the left side. 
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9 Close the MP tray. 

 

 

Cleaning the light-shielding film 
When streaks appear on the printing result, clean the light-shielding film of the image drum to improve the 
printing. 
 

1 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

2 Press the blue part of the left side in the machine to open the top cover (whole). 
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3 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 

 

4 Remove the image drum. Remove the image drum together with the toner cartridge attached to 

it. 

 

5 Place the image drum and toner cartridge on a flat surface covered with newspaper or the like. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 
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6 Wipe the light-shielding film with soft tissue paper. 

 

7 Install the image drum together with the toner cartridge into this machine. 

 

8 Close the top cover from the rear side. 

 

9 Close the top cover (front). 
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Cleaning the resist roller 
When horizontal streaks appear on the printing result, clean the metal part of the resist roller to improve the 
printing. 
 

1 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

2 Press the blue part of the left side in the machine to open the top cover (whole). 

 

3 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 
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4 Remove the image drum. Remove the image drum together with the toner cartridge attached to 

it. 
 
 Do not touch the blue lever on the toner cartridge. If the lever is moved, the toner cartridge may come off, thus 

causing the toner to scatter. 

 

5 Place the toner cartridge and image drum on a flat surface covered with newspaper or the like, 

and cover them with a piece of paper to avoid direct light. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 

 

 

 

6 Wipe the metal part of the resist roller with a soft tissue paper while rotating the resist roller. 
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7 Install the toner cartridge and the image drum by holding the toner cartridge. 

 

8 Close the top cover from the rear side. 

 

9 Close the top cover (front). 
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Updating software 

You can update the printer driver and other software to the latest version. 
A PC connected to the Internet is required for the update. 
 

For Windows 
For Windows, use the Monitoring Tool. 

 Monitoring Tool (Windows)(P.247) 

For macOS 
For macOS, please refer to our official website. 



Maintenance 

- 345 - 

Deleting software 

This section explains how to delete a printer driver from your PC. 

 
 The specific method may differ for different printer drivers and versions of Windows or macOS. 

 

Uninstalling the Windows printer driver 

 
 To perform this procedure, you will have to login to the PC as a user with administrator privileges. 
 Restart the PC before uninstalling a printer driver. 

 

1 Open [Devices and Printers]. 
 How to open [Devices and Printers](P.141) 

2 Right-click on the icon of the printer to be deleted, and select [Remove device]. 

3 When a confirmation message is displayed, click [Yes]. 
 
 If a message indicating that the device is being used is displayed, restart the PC and repeat Steps 1 and 2. 

4 Select one of the icons displayed in [Printer], and click [Print server properties] in the menu bar. 

5 Select the [Drivers] tab. 

6 Click [Change Driver Settings] if displayed. 

7 Select the printer driver to be deleted, and click [Delete]. 

8 When a message asking whether to delete the printer driver only or both the printer driver and 

its package from the system, select [Remove driver and driver package], and click [OK]. 

9 When a confirmation message is displayed, click [Yes]. 

10 When the [Remove Driver Package] screen is displayed, click [Delete] - [OK]. 
 
 If deletion is rejected, restart the PC and repeat Steps 4 to 10. 

11 Click [Close] in the [Print server properties] screen. 

12 Restart the PC. 

Uninstalling the macOS printer driver 

 
 To perform this procedure, you will have to login to the PC as a user with administrator privileges. 

 

1 Select [System Preferences] from the Apple menu. 

2 Select [Printers & Scanners]. 

3 Select the device to be deleted, and click [Delete Printer]. 

4 When a confirmation message is displayed, click [Delete Printer]. 

5 Close the [Printers & Scanners] screen. 
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6 Open the driver software file downloaded from our website, or insert the included DVD into the 

PC. 

7 Double-click on [OKI] - [Drivers] - [PS] - [Uninstaller]. 

8 Confirm the model to be deleted displayed in the dialog box, and click [OK]. 

9 Follow the on-screen instructions to delete the printer driver. 

10 Once the deletion is complete, remove the mounted drive or the included DVD from your 

computer. 
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Firmware update 

You can update the printer firmware to the latest version. 
A PC connected to the Internet is required for the update. 
 

For Windows 
For Windows, use the Monitoring Tool. 

 Monitoring Tool (Windows)(P.247) 

For macOS 
For macOS, please refer to our official website. 
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When an error message appears on the display 

If a problem occurs to this machine, the ATTENTION lamp will light on or flash, and a message will appear on 
the display. 
Check the message on the display and take action based on the corresponding message. 
If [Press HELP For Details] appears at the bottom of the display, press «HELP» on the operator panel to show 
the solution. (If there is no indication, pressing «HELP» will not change the indication on the display.) 

 

1 On-screen message 

2 ATTENTION lamp 

3 «HELP» button 

 
Display when «HELP» is pressed 

 

1 Error code 

2 Scroll up 

3 Scroll down 

 

 Error message list(P.350) 
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Error message list 
Clear the error by referring to the description of the corresponding message. 
Meanings of symbols used in the error message are as follows. 
 Tray Name: One of the following: Tray 1, Tray 2, Tray 3, Tray 4 and MP Tray 
 Cover Name: Top cover or Rear cover 
 Code: The error code number of 1 to 3 digits. The displayed number changes with the specific error. 
 Pages: Number of pages to print 
 Paper Size: The size of paper 
 Media Type: The type of paper 
 Number: Number of all places where paper jams have occurred 

For "---", different messages are displayed depending on the state of this machine. 
When "Please see HELP for details" is displayed at the bottom of the display, if you press «HELP» on the 
operator panel, the error code and solution will be displayed. 

Message Error code Description 
Storage Error: 250 
To Storage 
format, press [OK] 
To shut down, press [Cancel] 

- While the machine is being initialized, storage to be formatted 
is detected. 
If «OK» is pressed, the machine will be restarted and restored 
after the storage is formatted. 

Detected an abnormality of internal 
database 
The data must be deleted 
After pressing [OK], the data will 
be deleted, and then reboot 

- An error is detected in the built-in database. 
Press «OK» to delete the database and restart this machine. 

Detected an abnormality of access 
log database 
The data must be deleted 
After pressing [OK], the data will 
be deleted, and then reboot 

- An error is detected in the built-in database that records the 
access log. 
Press «OK» to delete the database and restart this machine. 

Damage in settings detected 
Settings have been restored 
Settings may be damaged 
 
Press OK Button 

- A error in the setup information of this machine was detected 
due to an unexpected power interruption. 
A recovery process was executed, but some settings may have 
been reset. 
Check that the settings you just configured have been applied 
correctly. 

--- 
PU Flash Error 

- Firmware update has failed. 
Please update the firmware again. 
If the error persists, contact your dealer. 

Communication Error - An error has occurred in this machine. Restart this machine. 
If the error persists, contact your dealer. 

The program is being updated 
Do not turn off the power 
It takes about 5 minutes 
The machine will not be available 
until it is completed 

- FW Updating. 
If the power is turned off halfway, this machine may not be able 
to start. 
When update is completed, the machine restarts automatically. 

--- 
Toner Low. 

- The toner is low. Please prepare a new toner cartridge. 
After the message of replacement is displayed, please replace 
the toner cartridge with a new one. 

--- 
The optimal toner cartridge for this 
printer is not installed 

- The toner cartridge is not optimal for this machine. 
It is recommended to use the toner cartridge that is optimal for 
this machine. 
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Message Error code Description 
--- 
Image Drum Near Life. 

- The image drum is approaching its service life. 
Please prepare a new image drum. 
After the message of replacement is displayed, please replace 
the image drum with a new one. 

Install New Image Drum 
Image Drum Life 
Press HELP for details 

353 The image drum has reached the end of its service life. 
Please prepare a new image drum. To replace the image drum, 
please refer to "Replacing the image drum(P.300)" or 
"Replacing the image drum and the toner cartridge(P.305)". 

Install New Image Drum 
Image Drum Life 
Press HELP for details 

347 The image drum has reached the end of its service life. 
Please prepare a new image drum. To replace the image drum, 
please refer to "Replacing the image drum(P.300)" or 
"Replacing the image drum and the toner cartridge(P.305)". 

Install New Image Drum 
Image Drum Life 
Press HELP for details 

563 The image drum has reached the end of its service life. 
Please prepare a new image drum. To replace the image drum, 
please refer to "Replacing the image drum and the toner 
cartridge(P.305)". 

--- 
Fuser Near Life. 

- The fuser unit is approaching the end of its service life. 
Please prepare a new fuser unit. 
After the message of replacement is displayed, please replace 
the fuser unit with a new one. 

--- 
Fuser Life. Change Fuser. 

- The fuser unit has reached the end of its service life. 
Please replace the fuser unit with a new one. To replace the 
fuser unit, please refer to "Replacing the maintenance 
kit(P.312)". 

--- 
Toner Empty. 

- The toner cartridge is empty. 
Replace the toner cartridge with a new one. 

--- 
Install Toner. 

- The toner cartridge is empty. 
Replace the toner cartridge with a new one. 

--- 
Image Drum Life. 

- The image drum has reached the end of its service life. 
Replace the image drum with a new one. To replace the image 
drum, please refer to "Replacing the image drum and the toner 
cartridge(P.305)". 

--- 
Image Drum Life. nnn Pages Left. 

- The image drum has reached the end of its service life. 
The printing is impossible with the displayed number of sheets. 
Please replace the image drum with a new one as soon as 
possible. 
To replace the image drum, please refer to "Replacing the 
image drum and the toner cartridge(P.305)". 

--- 
Image Drum Life. Print Quality Not 
Guaranteed. 

- The image drum has reached the end of its service life. 
Print quality cannot be guaranteed. Please replace the image 
drum with a new one as soon as possible. To replace the 
image drum, please refer to "Replacing the image drum and 
the toner cartridge(P.305)". 

Install New Image Drum 
Image Drum Life 
Press HELP for details 

683 The image drum has reached the end of its service life. 
Printing cannot be continued. 
Please prepare a new image drum. To replace the image drum, 
please refer to "Replacing the image drum and the toner 
cartridge(P.305)". 

--- 
Tray Name Empty 

- There is no paper in the indicated tray. 
Please load paper. 

--- 
Tray Name Cassette Missing 

- The displayed tray is not properly installed. 
Please install the tray. 
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Message Error code Description 
--- 
Wait Timeout Is Disabled 

- Wait Timeout is set to [Off]. 
When the USB cable is connected, you may not be able to print 
from the network. 

--- 
No Communication With The 
SNTP Server 

- Failed to retrieve the time from the SNTP server. 
Press the scroll buttons on the operator panel several times to 
check that the setting of [SNTP Server] is correct in [Menus] - 
[Admin Setup] - [Time Setting]. 

--- 
Getting Target IP Failed. Check 
DHCP Settings 

- The DHCP server was not detected. 
Check that the DHCP server is connected to the same network 
of this machine. 

--- 
Error Postscript 
Press OK Button 

- An error has occurred to Postscript data. 
Please check the print result. 
If there is a problem with the print result, execute the print job 
again. 
The problem may be solved if you select [Optimize to reduce 
error] in [PostScript Output Options] of the PS printer driver. 

--- 
PDL Error Occurred 
Press OK Button 

- A PDL error has occurred. 
Press «OK» to clear the error display. 

--- 
NFC Unit Error. NFC Function Not 
Available 
Press OK Button 

- 
 
 Depending on the specific region, this machine may not 

come with the NFC function. 
An error has occurred to the NFC unit. 
NFC-specific functions are not available. 
Turn off this machine and then turn it back on. 
If the same error message is displayed, contact your dealer. 
You can hide this message by selecting [Disable] for [Menus] - 
[Admin Setup] - [Others Setup] - [NFC Setup]. 

--- 
Collate Fail:Too Many Pages 
Press OK Button 

- The memory is full with the collation data. 
Reduce the number of pages of the print data. 

--- 
Duplex Print Failed 
Press OK Button 

- Printed on one side because the paper setting is not applicable 
to duplex printing. 
To print on both sides, print it again from the tray with paper 
suitable for duplex printing. For paper settings applicable to 
duplex printing, please refer to "Applicable paper(P.74)". 

--- 
Print Restricted. Job Rejected 
Press OK Button 

- The print data from an user unauthorized to print was deleted. 
To print, contact the administrator of this machine. 

--- 
Expired saved files have been 
deleted 
Press OK Button 

- The private print document whose retention date has passed 
was deleted. 

--- 
E-mail receiving has been 
cancelled 
Press OK Button 

- The e-mail printing is canceled. 
Check the format and size of the file attached to the e-mail. 
Printing will be canceled in any of the following cases. 
・ The format is not PDF, JPEG, or TIFF 

・No file is attached 

・The size exceeds 8 MB 
--- 
File System Operation Failed 
Press OK Button 

- A file system error has occurred. 
Press «OK» on the operator panel to hide the message. 
If the same error occurs, contact your dealer. 
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Message Error code Description 
--- 
Invalid Print Data Received 
Press OK Button 

- Received data was deleted because it cannot be handled by 
the machine in one of the following cases: 
The data contains commands that are not supported by the 
machine 
・ The private print data is not complete 
Check the printer driver you are using, and then print it again. 

--- 
Job Log Database Error 
Contact The Device Administrator 
Press OK Button 

- A database access error has occurred to writing or reading of 
print data logs. 
Turn off this machine and then turn it back on. 
If the same error message is displayed, contact your dealer. 

--- 
IPv4 Address is Conflicted 
Change IPv4 Address 

- The IPv4 address conflicts with that of another machine. 
Please change the IPv4 address. 

--- 
Error PDF 
Press OK Button 

- Printing is not possible because an error has occurred to the 
PDF file you tried to print. 
Print it again by using the printer driver from the application. 

--- 
Invalid Password 
Press OK Button 

- Printing is not possible because the password set in the PDF 
file does not match the password you input. 
Please input the correct password. 

--- 
Password required to print 
Press OK Button 

- Printing restrictions have been imposed on the PDF file. Please 
input the password required to print. 

--- 
PDF Cache Write Error 
Press OK Button 

- Failed to cache the PDF file. 
Reduce the file size, split the PDF file and print it again. 

--- 
Decode error occurred 
Press OK Button 

- Printing has failed because there was a problem with the 
specified file for Direct Print or the file attached to the e-mail. 
Confirm the specified file. 

--- 
Can not read the file 
Press OK Button 

- An error occurred when the file is read from the USB memory. 
Re-insert the USB memory, and repeat the procedure from the 
beginning. 

--- 
Failed to decrypt incoming data 
Please update the "Printer's 
Encryption Key" in the printer 
driver 
Press OK Button 

- An error has occurred when the machine decrypts the incoming 
data. 
Input the "Printer’s Encryption Key" for encryption in the printer 
driver and print it again. 
For details, please refer to "Printing with print data 
encrypted(P.187)". 

--- 
The account is locked. Data 
Deleted 
Contact The Device Administrator 
Press OK Button 

- Since the user specified in the Print Secure Job is locked out, 
the print data was deleted without printing. 
Wait until the lockout is lifted, and then print it again. 

--- 
Received Data Type restricted 
Job rejected 
Press OK To Hide This Message 

- When [PJL Security Enhancement] is set to [Mode 1], the 
received job was rejected because unencrypted data 
containing confidential data was received over the network. 
Open the dedicated printer driver and utilities for this machine, 
and set [Print Data Encryption] to [On] in the printer driver 
settings. Alternatively, if necessary, temporarily set [PJL 
Security Enhancement] to [Off], and then either print the job 
again, or run the operation from your utilities. 
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Message Error code Description 
--- 
Job Type restricted 
Job rejected 
Press OK Button 

- The print data was canceled because only Private Print is 
enabled with restrictions. 
Select [Private Print] from [Job Type] in the printer driver. 
Refer to "Printing with print data encrypted and password set 
(Private Print)(P.190)". 

Install Paper 
Paper Size 
%MEDIA_SIZE_PANEL% 

- The print mode has been specified in which paper is loaded in 
the MP tray and fed one by one. 
Load proper paper in the MP tray, and press «OK» on the 
operator panel. 
If you are printing a multi-page document, the same massage 
appears each time after one page is printed. Press «OK» each 
time. 

Recovered from error nnn 
Print again if the printing result 
does not come as expected 
Press OK Button 

- An error has occurred inside this machine, and the machine 
has restarted. Check that the printing goes as expected, since 
the machine may have restarted during printing. 
Print it again if the printing does not work as expected. 

Change Paper in Tray Name 
Paper Size 
Media Type 
Press OK Button 
Press HELP for details 

660, 661, 662, 
663, 664 

The media type of the paper loaded in the displayed tray did 
not match that of the paper you are trying to print on. Check the 
paper settings of the application you are trying to print from and 
the paper tray setup, and match the media type of the paper. 
660: MP tray; 661: Tray 1; 662: Tray 2; 663: Tray 3; 664: Tray 
4 

Change Paper in Tray Name 
Paper Size 
Media Type 
Press OK Button 
Press HELP for details 

460, 461, 462, 
463, 464 

The paper size or both the paper size and media type of the 
paper loaded in the displayed tray did not match the settings of 
the paper you are trying to print on. Check the paper size 
settings of the application you are trying to print from and the 
paper size settings of the tray, and match the paper size 
settings. 
If the paper of the size can be loaded in either portrait or 
landscape, please note the orientation of the paper. 
If you print on the paper of a size different from the displayed 
paper size, a paper jam may occur. 
460: MP tray; 461: Tray 1; 462: Tray 2; 463: Tray 3; 464: Tray 
4 

Memory Overflow 
Press OK Button 
Press HELP for details 

420 The memory is insufficient. 
Print it again after lowering the printing quality in the printer 
driver. 

Insufficient memory 
If using multiple functions, finish 
the function being used before 
attempting another 
If the problem does not improve, 
reduce the resolution 
Press OK Button 

- The memory is insufficient. 
Print it again after lowering the printing quality in the printer 
driver. 

Error While Initializing Settings 
Press OK Button 

751 
 
 Depending on the specific region, this machine may not 

come with the NFC function. 
The initial value set with the NFC Setting Tool is not properly 
reflected in the device settings. You can check the reflection 
result from [Export NFC Setting Log] on the web page. 
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Message Error code Description 
Wireless startup failed 
Press OK Button 
Press HELP for details 

517 Restart this machine. 
If the problem still persists even after the reboot, power off this 
machine and check if the wireless LAN module is installed. 
If the wireless LAN module is not installed, set [Extended 
Network] to [Disable]. 
If the wireless LAN module is installed, check if the model 
name of the wireless LAN module is compatible with this 
machine. 
If the model name is incorrect, replace the wireless LAN 
module with the one suitable for this machine. 
If the model name is correct, consult your dealer. 

Wireless settings are incomplete 
Press OK Button 
Press HELP for details 

505 The wireless LAN settings are not correct. 
Please reset the wireless LAN from the beginning. Please refer 
to "Connection form via a wireless LAN(P.45)" for details. 
If the problem still persists, initialize the network settings and 
reset the wireless LAN settings. To initialize the network 
settings, please refer to "Initializing network settings(P.235)". 

Not connected to wireless access 
point 
Press OK Button 
Press HELP for details 

506 It is not connected to the wireless LAN access point. Or, the 
wireless communication may be poor. 
Check that the power of the wireless LAN access point is 
turned on. 
Check that the wireless LAN settings are correct. 
Refer to "Connection form via a wireless LAN(P.45)" or 
"Connecting via an access point (Infrastructure)(P.46)" for 
details. 

Wired(LAN2) startup failed 
Press OK Button 
Press HELP for details 

507 The wired LAN2 module is not installed properly. Or, the wired 
LAN2 module may be broken. 
Please reinstall the wired LAN2 module. Refer to "Installing the 
extended wired LAN module(P.37)" for details. 
If the error persists, contact your dealer. 

Can not connect to the wireless 
access point 
Timeout 
Press OK Button 
Press HELP for details 

526 Could not connect to the wireless LAN access point. Could not 
connect to the wireless access point within the specified time of 
WPS. 
Check that the wireless access point is turned on, and then run 
WPS again. 

Can not connect to the wireless 
access point 
Overlap 
Press OK Button 
Press HELP for details 

527 Could not connect to the wireless LAN access point. It is 
possible that you could not connect to the wireless access 
point because another handset is running WPS. Wait for a 
while and then run WPS again. 

Can not connect to the wireless 
access point 
The security selected is not 
supported by WPS 
Press OK Button 
Press HELP for details 

528 Could not connect to the wireless LAN access point. The 
wireless access point may not comply with the WPS standard. 
If you still cannot connect even after running WPS again, 
manually set and connect. 

Can not connect to the wireless 
access point 
Communication error 
Press OK Button 
Press HELP for details 

529 Could not connect to the wireless LAN access point. There 
may be something wrong with the wireless LAN module. 
If you still cannot connect even after restarting the machine and 
running WPS again, contact your dealer. 

Receiving Data Timeout 
Press OK Button 
Press HELP for details 

519 The data could not be received within the correct time. 
When the printing does not work as expected, set a longer time 
in [Menus] - [User Setup] - [System Adjust] - [Timeout Injob]. 
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Message Error code Description 
Firmware Update Error 
Please try again 
If network doesn't work, please try 
firmware update over USB 

- Firmware update has failed. 
Please update the firmware again. Please refer to "Firmware 
update(P.347)" for details. 

Rear Output Tray Open 
Duplex Not Available 
 
Press HELP for details 

581 The rear output tray is open. Close the rear output tray. 
For details of the rear output tray, please refer to "Rear output 
tray(P.88)". 

No Paper In Tray Name 
Load Paper of 
Paper Size 
Press HELP for details 

490, 491, 492, 
493, 494 

There is no paper in the indicated tray. 
Please load paper. 
490: MP tray; 491: Tray 1; 492: Tray 2; 493: Tray 3; 494: Tray 
4 

No cassette for Tray Name 
Reset it 
Press HELP for details 

430, 431, 432, 
433, 440, 441, 442 

The printing has stopped because the displayed paper cassette 
is not properly installed. 
Pull the paper cassette out, and insert it back. 
430, 440: Tray 1; 431, 441: Tray 2; 432, 442: Tray 3; 433: 
Tray4 

Install Toner 
Waste Toner Full 
Press HELP for details 

413 The toner cartridge is empty. 
You can continue using the machine for a while by opening and 
closing the top cover, but the image drum may be damaged. 
Therefore, please replace the toner cartridge with a new one 
promptly. To replace the toner cartridge, please refer to 
"Replacing toner cartridges(P.298)". 

The optimal toner cartridge for this 
printer is not installed 
Press HELP for details 

553, 557, 617, 623 The toner cartridge is not optimal for this machine. It is 
recommended to use the toner cartridge that is optimal for this 
machine. 

The toner cartridge is not installed 
Press HELP for details 

613 The toner cartridge is not installed. 
Install the toner cartridge. To install the toner cartridge, please 
refer to "Replacing toner cartridges(P.298)". 

Used or non-genuine 
consumables/maintenance parts 
are installed 
Refer to "Troubleshooting" in the 
User's Manual 
 

709 If you have installed an empty toner cartridge that was 
previously used in another machine, replace it with a new toner 
cartridge. 
You can use any consumables/maintenance parts, but the print 
quality may be lowered and the optimum performance may not 
be obtained. 
If the use of non-genuine consumables/maintenance parts 
causes damage to the product or results in your product not 
functioning to its full specification, such damage or effects on 
the product are not covered by warranty. 
When you understand the above points and use non-genuine 
consumables/maintenance parts, follow the procedure below. 

 Power off the main unit. 
 Power on this machine while pressing «CANCEL» on the 

operator panel. 
 When "Ready To Print" appears, release «CANCEL». 

The above operation will be recorded inside this machine. 
A toner sensor error has occurred 
Press HELP for details 

543 A toner sensor error has occurred. 
Rotate the blue lever on the right side of the toner cartridge 
towards the front until it stops, and then rotate the blue lever 
again all the way in until it stops. 
If the error persists, contact your dealer. 
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Message Error code Description 
Check Paper 
Reset Paper in Tray Name 
Press HELP for details 

400 Multiple sheets of paper are fed at a time from the displayed 
tray. Or, the paper of a size different from the paper size setting 
of the tray is fed. 
Remove the jammed paper. 
Remove the paper temporarily from the tray when multiple 
sheets of paper are fed at a time. Shuffle the paper well, 
horizontally align the edge of paper, and load the paper in the 
tray again. 
If there are still multiple sheets of paper fed at a time, it may be 
improved by reversing the surface and back of the paper and 
loading it again. 
Otherwise, check that the size of the paper to print on matches 
the paper size setting of the tray. 

Install New Image Drum 
Image Drum Life 
To Exceed the Life, Press OK 
Button 
Press HELP for details 

567 The image drum has reached the end of its service life. 
Replace the image drum with a new one. You can continue 
printing for a while by pressing «OK» on the operator panel, but 
the print quality is not guaranteed. 
To replace the image drum, please refer to "Replacing the 
image drum and the toner cartridge(P.305)". 

The toner cartridge is not installed 
properly 
Please reinstall the toner cartridge 
Press HELP for details 

547 The toner cartridge is not installed properly. 
Check that the protective tape on the toner cartridge has been 
peeled off. 
If the error persists, contact your dealer. 

The fuser unit is not installed 
properly 
Reinstall it 
Press HELP for details 

320 The fuser unit is not properly installed. Please reinstall the 
fuser unit. 
To install the fuser unit, please refer to "Replacing the 
maintenance kit(P.312)". 
If the error persists, contact your dealer. 

Close Cover Name 
Press HELP for details 

310, 311, 752 The indicated cover is open. Close the cover. 
310: Top Cover (Front); 311: Top Cover; 752: Top Cover 
(Rear) 

Paper jam occurred 
Paper jam in number place(s) 
Remove the paper 
Press ▼ to locate jam 
Press HELP for details 

632, 633, 634, 
638, 639 

A paper jam has occurred. 
Multiple sheets of paper remain inside this machine. When the 
scroll button on the operator panel is pressed, the lamp for the 
place where paper is jammed blinks. Remove all the paper 
from where the lamp blinks. 

Paper jam occurred 
Paper jam in number place(s) 
Remove the paper 
Press ▼ to locate jam 
Press HELP for details 

390, 391, 392, 
393, 394 

A paper jam has occurred in the paper feed path from the 
displayed tray. 
Remove the jammed paper. 
If no paper is jammed, feeding has failed. Reduce the number 
of paper loaded in the tray. Also, make sure that the paper 
stopper position matches the paper size. 
Cleaning the paper feed roller may improve the situation. 
390: MP tray; 391: Tray 1; 392: Tray 2; 363: Tray 3; 394: Tray 
4 

Paper jam occurred 
Paper jam in number place(s) 
Remove the paper 
Press ▼ to locate jam 
Press HELP for details 

372, 380, 381, 
382, 389 

A paper jam has occurred. 
Multiple sheets of paper remain inside this machine. When the 
scroll button on the operator panel is pressed, the lamp for the 
place where paper is jammed blinks. Remove all the paper 
from where the lamp blinks. 

The printing was stopped because 
the rear output tray was opened 
Remove the paper 
Press HELP for details 

409 The printing was stopped because the rear output tray was 
opened during printing. 
Close the rear output tray, open the top cover (front), and 
remove the paper. 
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Message Error code Description 
Language Change Failed 
Error num:Code 

- Failed to change the display language on the display. 
Restart this machine, and reset the language setting. 

Power off and wait for a while 
%FATAL1%:Condensing Error 
%FATAL1%:Thermal Error 

- Condensation has occurred inside this machine. 
Turn off the power, and then turn the power back on after a 
while. 
If the same error message is displayed, contact your dealer. 

Service call 
nnn:Error 

- An error has occurred inside this machine. 
Please contact your dealer. 

nnn:Error 
%FATAL1%:Error 

- An error has occurred inside this machine. 
Please contact your dealer. 

nnn:Error nnn 
%FATAL1%:Error 

- An error has occurred inside this machine. 
Please contact your dealer. 

nnn:Error 
Restart Printer 
Service Call 

- An error has occurred inside this machine. 
Please contact your dealer. 

nnn:Error nnn 
Restart Printer 
Service Call 

- An error has occurred inside this machine. 
Please contact your dealer. 

Power Off and Wait for a While 
%FATAL1%:Thermal Error 
Service Call 

- The temperature is high inside this machine. 
Turn off the power, and then turn the power back on after a 
while. 
If the same error message is displayed, contact your dealer. 
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When a paper jam occurs 

For the error code 372 

1 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

2 Press the blue part of the left side in the machine to open the top cover (whole). 

 

3 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 
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4 Take out the image drum. Remove the image drum together with the toner cartridge attached to 

it. 
 
 Do not touch the blue lever on the toner cartridge. If the lever is moved, the toner cartridge may come off, thus 

causing the toner to scatter. 

 

5 Place the removed image drum and toner cartridge on a flat surface and cover it with a piece of 

paper or the like to avoid direct light. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 

 

 

6 Lift the transparent guide, and slowly pull the paper upwards to remove it. 
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7 Return the transparent guide back to its original position. 

 

8 Unlock the transfer unit by rotating the blue handles on its both sides towards the front side. 

 

9 Remove the transfer roller unit. 
 
 Do not wipe off any grease applied to the metal part inside the main unit. 
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10 Unlock the fuser unit by rotating the blue lock lever on its both sides towards the back side until 

it reaches the unlock mark position. 

 

11 Remove the fuser unit from this machine by holding its central handle. 

 Burns may be caused.  

As the fuser unit may be hot, be cautious during operation and always hold the handle to lift it. When it is hot, wait 
until it cools down before any operation. 

 

12 Remove the paper if it is visible. 
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13 Install the transfer roller unit back into this machine. 

 

14 Lock the transfer unit by tilting its left and right blue levers toward the back. 

 

15 Install the fuser unit into this machine by holding its central handle. 
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16 Lock the fuser unit by rotating the blue lock lever on its both sides towards the front side until it 

reaches the lock mark position. 

 

17 Install the image drum together with the toner cartridge into this machine. 

 

18 Close the top cover from the rear side. 

 

19 Close the top cover (front). 
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For the error code 380 

1 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

2 Press the blue part of the left side in the machine to open the top cover (whole). 

 

3 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 
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4 Remove the image drum. Remove the image drum together with the toner cartridge attached to 

it. 
 
 Do not touch the blue lever on the toner cartridge. If the lever is moved, the toner cartridge may come off, thus 

causing the toner to scatter. 

 

5 Place the removed image drum and toner cartridge on a flat surface and cover it with a piece of 

paper or the like to avoid direct light. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 
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6 Lift the transparent guide. 

 

7 Slowly pull the paper upwards to remove it. 

 

8 Return the transparent guide back to its original position. 

 

 

9 Install the image drum together with the toner cartridge into this machine. 

 



Troubleshooting 

- 368 - 

10 Close the top cover from the rear side. 

 

11 Close the top cover (front). 

 

For the error code 381 or 382 

1 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

2 Press the blue part of the left side in the machine to open the top cover (whole). 
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3 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 

 

4 Remove the image drum. Remove the image drum together with the toner cartridge attached to 

it. 
 
 Do not touch the blue lever on the toner cartridge. If the lever is moved, the toner cartridge may come off, thus 

causing the toner to scatter. 
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5 Place the removed image drum and toner cartridge on a flat surface and cover it with a piece of 

paper or the like to avoid direct light. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 

 

 

 

6 Remove the paper if it is visible. 

 

7 Unlock the fuser unit by rotating the blue lock lever on its both sides towards the back side until 

it reaches the unlock mark position. 
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8 Remove the fuser unit from this machine by holding its central handle. 

 Burns may be caused.  

As the fuser unit may be hot, be cautious during operation and always hold the handle to lift it. When it is hot, wait 
until it cools down before any operation. 

 

9 If there is still paper stuck in the fuser unit, place the fuser unit on a flat surface, and pull out the 

paper towards the front while pressing the jam release lever on the top of the fuser unit. 
 
 Do not press the envelope lever (blue, small). Otherwise, poor fixing may be caused. 

 

10 Remove any paper left in the main unit of this machine. 
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11 Install the fuser unit into this machine. 

 

12 Lock the fuser unit by rotating the blue lock lever on its both sides towards the front side until it 

reaches the lock mark position. 

 

13 Install the image drum together with the toner cartridge into this machine. 

 

14 Close the top cover from the rear side. 
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15 Close the top cover (front). 

 

For the error code 389 

1 Open and close the top cover (front). 

 

2 Remove the jammed paper by following the error message displayed. 

For the error code 390 

 
 If the paper jam persists, it may help to clean or replace the feed roller or reduce the loaded number of sheets of 

paper. 

1 Remove the paper from the MP tray. 

 

 

2 Adjust the paper guide. 
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3 Load the paper with the print side facing up. 

 

 

4 Open and close the top cover (front). 
 
 The error will not be cleared without opening and closing the top cover (front). 

 

 

For the error code 391 

1 Pull out the lower paper cassette of Tray 1 until it stops, and then lift it slightly upward to remove 

it. 

 

2 Remove the jammed paper. 
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3 Insert the paper cassette into the main unit from slightly above and install it back to its original 

position. 
 
 If you return the paper cassette to the main unit by force, the paper stopper may shift. 

 

4 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

5 Press the blue part of the left side in the machine to open the top cover (whole). 
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6 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 

 

7 Remove the image drum. Remove the image drum together with the toner cartridge attached to 

it. 
 
 Do not touch the blue lever on the toner cartridge. If the lever is moved, the toner cartridge may come off, thus 

causing the toner to scatter. 
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8 Place the removed image drum and toner cartridge on a flat surface and cover it with a piece of 

paper or the like to avoid direct light. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 

 

 

 

9 Lift the transparent guide, and slowly pull the paper upwards to remove it. 
 

 

 

10 Return the transparent guide back to its original position. 
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11 Install the image drum together with the toner cartridge into this machine. 

 

12 Close the top cover from the rear side. 

 

13 Close the top cover (front). 

 

For the error code 392, 393 or 394 
This section takes the error code 392 for example indicating that a paper jam occurs when paper is feeding 
from Tray 2. 
Pull out the paper cassette of Tray 3 (for the error code 393) or Tray 4 (for 394), and remove the jammed 
paper. 

 
 If the same error occurs repeatedly even after the jammed paper is removed, please refer to "Troubleshooting for the 

paper(P.410)". 
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1 Pull out the lower paper cassette of Tray 2 until it stops, and then lift it slightly upward to remove 

it. 

 

2 Remove the jammed paper. 

 

3 Insert the paper cassette into the main unit from slightly above and install it back to its original 

position. 
 
 If you return the paper cassette to the main unit by force, the paper stopper may shift. 

 

4 Open and close the top cover (front). 
 
 The error will not be cleared without opening and closing the top cover (front). 
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For the error code 632, 633 or 634 
This section takes the error code 632 for example indicating that a paper jam occurs to Tray 2. 
Pull out the paper cassette of Tray 3 (for the error code 633) or Tray 4 (for 634), and remove the jammed 
paper. 
 

1 Pull out the lower paper cassette of Tray 2 until it stops, and then lift it slightly upward to remove 

it. 

 

2 Remove the jammed paper. 

 

3 Insert the paper cassette into the main unit from slightly above and install it back to its original 

position. 
 
 If you return the paper cassette to the main unit by force, the paper stopper may shift. 
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4 Open and close the top cover (front). 
 
 The error will not be cleared without opening and closing the top cover (front). 

 

For the error code 638 

1 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

2 Press the blue part of the left side in the machine to open the top cover (whole). 

 

3 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 
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4 Remove the image drum. Remove the image drum together with the toner cartridge attached to 

it. 
 
 Do not touch the blue lever on the toner cartridge. If the lever is moved, the toner cartridge may come off, thus 

causing the toner to scatter. 

 

5 Place the removed image drum and toner cartridge on a flat surface and cover it with a piece of 

paper or the like to avoid direct light. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 

 

 

 

6 Lift the transparent guide, and slowly pull the paper upwards to remove it. 
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7 Return the transparent guide back to its original position. 

 

8 Install the image drum together with the toner cartridge into this machine. 

 

9 Close the top cover from the rear side. 

 

10 Close the top cover (front). 
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For the error code 639 

1 Open the top cover (front). 
 
 Do not place any objects on the opened cover. 

 

2 Press the blue part of the left side in the machine to open the top cover (whole). 

 

3 Make sure that the blue lever on the right side of the toner cartridge is aligned with the lock 

mark. 
 
 Do not touch the blue lever. If the lever is moved, the toner cartridge may come off when the image drum is 

removed, thus causing the toner to scatter. 
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4 Remove the image drum. Remove the image drum together with the toner cartridge attached to 

it. 
 
 Do not touch the blue lever on the toner cartridge. If the lever is moved, the toner cartridge may come off, thus 

causing the toner to scatter. 

 

5 Place the removed image drum and toner cartridge on a flat surface and cover it with a piece of 

paper or the like to avoid direct light. 
 
 Handle with adequate care since (the green tube of) the image drum is very easy to be damaged. 
 Do not expose the image drum to direct sunlight or strong light (about 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
 Do not touch the gears on the bottom of the image drum. 
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6 Remove the paper if it is visible. 

 

7 Unlock the fuser unit by rotating the blue lock lever on its both sides towards the back side until 

it reaches the unlock mark position. 

 

8 Remove the fuser unit from this machine by holding its central handle. 

 Burns may be caused.  

As the fuser unit may be hot, be cautious during operation and always hold the handle to lift it. When it is hot, wait 
until it cools down before any operation. 
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9 Place the fuser unit on a flat surface, and pull out the paper towards the front while pressing the 

jam release lever on the top of the fuser unit. 
 
 Do not press the envelope lever (blue, small). Otherwise, poor fixing may be caused. 

 

10 Remove the paper left inside the machine if any. 
 

 

11 Install the fuser unit into this machine by holding its central handle. 
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12 Lock the fuser unit by rotating the blue lock lever on its both sides towards the front side until it 

reaches the lock mark position. 

 

13 Install the image drum together with the toner cartridge into this machine. 

 

14 Close the top cover from the rear side. 

 

15 Close the top cover (front). 
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Trouble with printing 

This section describes problems with printing from a PC. 

 
 If the problem is not solved using the following explanation, contact your dealer. 
 For problems arising from the application, contact the application development company. 

I cannot print 

For Windows/macOS 
Cause Solution Reference 

This machine powered is off. Please turn the power on.  Turning the 
power on(P.73) 

 

The LAN cable/USB cable is 
disconnected. 

Please check that the cable is correctly connected to this 
machine and the PC. 

 Connecting via a 
wired LAN(P.37) 

 Connecting via 
USB(P.62) 

 

There is a problem with the cable. Please replace the cable with a new one. - 
An error has occurred to this 
machine. 

Please check the error message displayed on the display. 
Or, press «HELP» on the operator panel to check and clear 
the error. 

 Error message 
list(P.350) 

 

The interface settings are disabled. Please check the interface settings you are using on the 
operator panel. 

 Connecting via a 
wired LAN(P.37) 

 Connection form 
via a wireless 
LAN(P.45) 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 

 

 

For Windows 
Cause Solution Reference 

This machine is not set as the 
default printer. 

Set this machine as the default printer. 
Open [Devices and Printers], right-click on the icon of the 
device name (*), and select [Set as Default Printer]. 
The asterisk (*) represents the type of printer driver. (e.g. 
PCL6/PS) 
 
Uncheck [Let Windows manage my default printer]. 

- 

The printout port of the printer 
driver is wrong. 

Please select the output port to which the LAN cable/USB 
cable is connected. 

- 
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Cause Solution Reference 
The printer is set offline on the PC. Open [Devices and Printers], right-click on the icon of the 

device name (*), and select [See what's printing]. When the 
icons are grouped, select the device name (*) from [See 
what's printing]. 
The asterisk (*) represents the type of printer driver. (e.g. 
PCL6/PS) 
In the displayed screen, select the [Printer] menu, and 
uncheck [Use Printer Offline]. 

- 

Troubleshooting for Wired LAN connection 

For Windows/macOS 
Cause Solution Reference 

A crossover cable is used. Use a straight cable. - 
There is a compatibility problem 
with the hub. 

Press the scroll buttons on the operator panel several times 
to select the proper connection from [Menus] - [Admin 
Setup] - [Network Setup] - [Wired(LAN1) Setup] - [Hub Link 
Setting]. 
See the Instruction Manual supplied with the hub. 

- 

The settings of wired LAN (LAN1) 
are not appropriate. 

Check the wired LAN (LAN1) settings.  Menus (Admin 
Setup)(P.112) 

 

The settings related to extended 
wired LAN (LAN2) are not 
appropriate. 

Check the wired LAN (LAN2) settings.  Menus (Admin 
Setup)(P.112) 

 

Both wired LAN (LAN1) and 
extended wired LAN (LAN2) are 
connected to the same network 
segment. 

Although this machine can use wired LAN (LAN1) and 
extended wired LAN (LAN2) at the same time, connecting 
wired LAN (LAN1) and extended wired LAN (LAN2) to the 
same subnet may cause unstable communication. To 
stabilize the communication, set the IP address of a 
different segment and connect it to a different network. 

 Menus (Admin 
Setup)(P.112) 

 

The settings of wired LAN are not 
appropriate. 

Only one of the following gateway addresses can be 
enabled: standard wired LAN (LAN1), extended wired LAN 
(LAN2) and wireless LAN. Select the standard wired LAN 
(LAN1) or extended wired LAN (LAN2) from [Menus] - 
[Admin Setup] - [Network Setup] - [General Setup] - 
[Enabling Default Gateway]. 

 Menus (Admin 
Setup)(P.112) 

 

Depending on the network device 
you are using, the connection may 
become unstable if Energy 
Efficient Ethernet (EEE) of the 
wired network (LAN1) of this 
machine is enabled. 

Check if the switching hub supports Energy Efficient 
Ethernet (EEE). 
If supported, change [Network Setup] - [Network 
Connection] - [Wired(LAN1) Setup] - [Energy Efficient 
Ethernet] to [Disable] from the web page of this machine 
and check if it improves. 

 Managing the 
machine from the 
web page(P.200) 

 

When the extended wired LAN 
(LAN2) is used, the wired LAN2 
module is not enabled. 
* LAN2 does not support some 
specifications. 

Set [Extended Network] to [Wired(LAN2)]. 
The extended wired LAN module and the wireless LAN 
module cannot be enabled at the same time. 

 1-2. Installing the 
extended wired 
LAN module (For 
wired 
LAN2)(P.37) 

 

 



Troubleshooting 

- 391 - 

For Windows 
Cause Solution Reference 

The IP address is incorrect.  Check that the IP address of this machine matches 
the one set on the PC. 

 Make sure the IP address does not overlap with that 
of other devices. 

 If [IP Address Set] is set to [Auto], the address may 
change dynamically. If the setting changes frequently, 
change [IP Address Set] of this machine to [Manual], 
and match the IP address of this machine with the one 
set on the PC. 

 Make sure the configured IP address, subnet mask 
and gateway address are all correct. 

 Make sure that the print port of the printer driver is 
correct. 

 For the OKI LPR utility, check the IP address settings 
with the OKI LPR utility. 

 Printing the menu 
map 
(configuration)(P.
89) 

 OKI LPR 
utility(P.264) 

 

The WSD port is in use. When the print port does not function well with [WSD], 
specify the IP address or short printer name of this machine 
in the standard TCP/IP port, and add the print port. 

- 

Troubleshooting for wireless LAN connection 

Unable to connect to wireless LAN 
For Windows/macOS 

Cause Solution Reference 
The wireless LAN module is not 
enabled. 

To connect to a wireless LAN, set [Extended Network] to 
[Wireless]. 
Wireless LAN and extended wired LAN (LAN2) cannot be 
used simultaneously. 

 Connection form 
via a wireless 
LAN(P.45) 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 

 

Proper settings are required for the 
connection. 

To connect via a wireless LAN access point or a wireless 
LAN router, set the wireless LAN (Infrastructure) 
accordingly. 
To connect a mobile device directly to this machine, set the 
wireless LAN (Wi-Fi Direct) accordingly. 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 
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Cause Solution Reference 
Network connection settings are 
incorrect. 

 Wireless LAN (Infrastructure) and wireless LAN (Wi-Fi 
Direct) cannot be enabled simultaneously. 

 To connect via a wireless LAN (Infrastructure), set 
[Wireless(Wi-Fi Direct)] to [Disable] and 
[Wireless(Infrastructure)] to [Enable]. 

 To connect via a wireless LAN (Wi-Fi Direct), set 
[Wireless(Infrastructure)] to [Disable] and 
[Wireless(Wi-Fi Direct)] to [Enable]. 

 Connection form 
via a wireless 
LAN(P.45) 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 

 

The settings of wireless LAN 
(Infrastructure) are incorrect. 

If you are connected via a wireless LAN (Infrastructure), 
check the infrastructure settings. 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 

The settings of wireless LAN (Wi-Fi 
Direct) are incorrect. 

To connect via a wireless LAN (Wi-Fi Direct), check the Wi-
Fi Direct settings. 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 

 

A timeout occurs during 
connection. 

Connect by specifying the wireless LAN access point you 
want to use from the wireless LAN access points detected 
by this machine. 

 4-1. Connecting 
by selecting a 
wireless LAN 
access 
point(P.50) 

 

 

For Windows 
Cause Solution Reference 

The IP address is incorrect.  Check that the IP address of this machine matches 
the one set on the PC. 

 Make sure the IP address does not overlap with that 
of another machine. 

 If [IP Address Set] is set to [Auto], the address may 
change dynamically. If the setting changes frequently, 
change [IP Address Set] of this machine to [Manual], 
and match the IP address of this machine with the one 
set on the PC. 

 Make sure the configured IP address, subnet mask 
and gateway address are all correct. 

 If you are using the OKI LPR utility, check the IP 
address settings in the OKI LPR utility. 

 Printing the menu 
map 
(configuration)(P.
89) 

 OKI LPR 
utility(P.264) 

 

The WSD port is in use. When the print port does not function well with [WSD], 
specify the IP address or short printer name of this machine 
in the Standard TCP/IP port, and add the print port. 

- 
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Unable to connect to wireless LAN (Infrastructure) 
First, print out the Network Information, and then check the following explanation while having a look at items 
numbered ① to ⑥ in the following figure in Wireless(Infrastructure) Information. 

Network Information can be printed from [Print Information] - [Network]. 

 

 

Unable to connect to the access point (State of ④ is not set to "Connected") 
Cause Solution Reference 

[Wireless] is not selected in the 
[Extended Network] settings. 

Select [Menus] - [Admin Setup] - [Network Setup] - 
[General Setup] - [Extended Network] - [Wireless]. 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 

The wireless LAN access point 
does not function properly. 

Check that the power of the wireless LAN access point is 
turned on and it functions properly. 

- 

[Wireless(Infrastructure)] is set to 
[Disable].* Above ① 

Set [Wireless(Infrastructure)] to [Enable]. 
* Wireless LAN (Infrastructure) and wireless LAN (Wi-Fi 
Direct) cannot be enabled simultaneously. 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 

[SSID] is incorrect. Or it is blank.* 
Above ② 

Check the SSID of the wireless LAN access point you want 
to connect is correct, and connect with the correct SSID. 
If it is blank, the settings for the wireless LAN connection of 
this machine are insufficient. Set [Wireless(Infrastructure) 
Setting]. 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 

The encryption key is incorrect. Check the encryption key of the wireless LAN access point 
you want to connect is correct, and set the correct 
encryption key. 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 

The setting of [Security] does not 
match the security of the wireless 
LAN access point.* Above ③ 

Check the security (encryption method) of the wireless LAN 
access point that you want to connect, and set it to keep 
consistent. 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 

 

Communication is not stable 
Cause Solution Reference 

The RSSI value is too small.* 
Above ⑥ 

The signal strength is insufficient. 
Put this machine in an unobstructed view position near the 
wireless LAN access point. (The recommended distance is 
30 m or less.) 
Do not place an electric appliance (especially microwave 
oven or digital cordless telephone) that emits weak 
electronic waves near this machine. 
It may be difficult to connect if there is a metal, aluminum 
sash or reinforced concrete wall between this machine and 
the wireless LAN access point. 

- 
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Cause Solution Reference 
The current frequency band is 
congested.* Above ⑤ 

[Band] displays the current frequency band to which this 
machine is connected. 
This machine is compatible with the 2.4 Ghz/5.0 GHz band. 
If the wireless LAN access point is compatible with the 2.4 
GHz/5.0 GHz band, try changing the connecting frequency 
band of the machine (or changing the SSID settings). 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 

 

Able to connect to the access point but unable to communicate 
Cause Solution Reference 

The IP address is in the same 
segment as the one on the wired 
side. 

Since the communication may be unstable if the wired LAN 
and wireless LAN are connected to the same subnet, 
please connect them to different subnets. 

- 

The setting of the enabled default 
gateway is wired LAN instead of 
wireless LAN. 

To communicate with a mobile device outside the segment 
via a wireless LAN, press the scroll buttons on the operator 
panel to select [Menus] - [Admin Setup] - [Network Setup] - 
[General Setup] - [Enabling Default Gateway], and then set 
it to [Wireless(Infrastructure)]. 
In that case, the wired LAN cannot communicate with a 
mobile device outside the segment. 
* You can check from [General Information] - [Enabling 
Default Gateway] in Network Information. 

 Connecting via 
an access point 
(Infrastructure)(P.
46) 

 

 

Unable to connect to a wireless LAN (Wi-Fi Direct) 
First, print out the Network Information, and then check the following explanation while having a look at items 
numbered ① to ④ in the following figure in Wireless (Wi-Fi Direct) Information. 

Network Information can be printed from [Print Information] - [Network]. 

 

 

The mobile device cannot connect 
Cause Solution Reference 

[Wireless] is not selected in the 
[Extended Network] settings. 

Select [Menus] - [Admin Setup] - [Network Setup] - 
[General Setup] - [Extended Network] - [Wireless]. 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 

 

[Wireless(Wi-Fi Direct)] is set to 
[Disable]. 
*Above ① 

Select [Enable] in [Wireless Setting] - [Wireless(Wi-Fi 
Direct) Setting] - [Wireless(Wi-Fi Direct)]. 
* Wireless LAN (Infrastructure) and wireless LAN (Wi-Fi 
Direct) cannot be enabled simultaneously. 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 

 

[SSID] is not consistent with the 
SSID selected by the wireless 
terminal. 
*Above ② 

Check that the SSID of this machine matches the SSID 
selected by the wireless terminal you want to connect. 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 

 

The setting of [Security] is not 
consistent with that of the wireless 
terminal. 
*Above ③ 

Check that the security of this machine matches the 
security set for the wireless terminal you want to connect. 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 
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Cause Solution Reference 
The encryption key is not 
consistent with that of the wireless 
terminal. 

Check that the encryption key of this machine matches the 
encryption key set for the wireless terminal you want to 
connect. 
You can check from [Wireless Setting] - [Wireless(Wi-Fi 
Direct) Setting] -[Manual Setup]. 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 

 

[Number Of Connected] is set to 
4.* Above ④ 

A maximum of 4 terminals can be connected to this 
machine via a wireless LAN (AP mode). Terminals 
exceeding the maximum number cannot be connected. 
Disconnect other terminals and try to connect again. 

 Connecting 
directly with this 
machine (Wi-Fi 
Direct)(P.58) 

 

Troubleshooting for USB connection 

USB does not connect 
Items to check Solution Reference 

Does the cable meet the 
specifications? 

Please use a USB 2.0 cable. 
The connector type on the main unit is Type B. 

- 

Are you using a USB hub, 
repeater, switch, or extension 
cable? 

If you are using a USB hub, repeater, switch or extension 
cable, disconnect it first. Connect the PC and the printer 
with a separate USB cable and check if the situation has 
improved. 
If it has improved, check the connection to and the power 
supply of the USB hub or any other similar intermediary 
device. 
If you are using an extension cable, please use a separate 
USB cable or insert a repeater in between. 

 Connecting via 
USB(P.62) 

 

Isn't the USB connection feature 
on the printer disabled? 

If [Menus] - [Admin Setup] - [USB Setup] - [USB] is set to 
[Disable], change the setting to [Enable]. 

 Security-related 
menu 
settings(P.418) 

 

Are the USB port and the printer 
name correct? 

If your PC comes with multiple USB ports, the printer name 
will be different for each USB port. Please select the printer 
name that matches the connection port, or reconnect it to 
the USB port that matches the printer name. 

- 

Is the printer driver properly 
installed? 

Please re-install the printer driver.  Installing 
software on your 
PC(P.63) 

 

Is there another printer driver 
installed that operates via USB 
connection? 

Delete any other printer drivers from the PC. - 
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Troubleshooting for printing results 

 
 Please check the following explanation and "FAQ" on your smartphone app or our website. 
 If the problem persists, contact your dealer. 

List of troubles with printing results 
Click the corresponding symptom to see the solution. 

 
Paper feed direction 

White streaks appear in the vertical direction(P.398) 

 
Paper feed direction 

Printing is faint in the vertical direction(P.398) 

 

Printing is light(P.399) 

 

White dots or lines appear(P.399) 

 

Condensation occurs on printed paper(P.400) 

 
Paper feed direction 

Streaks appear in the vertical direction(P.400) 

 
Paper feed direction 

Dots and horizontal streaks appear in the paper feeding direction 
periodically(P.400) 

 

White area is lightly stained(P.401) 
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Edges of text are blurred(P.401) 

 

When envelopes or coated paper is printed, the whole area is 
thinly stained(P.402) 

 

Toner comes off when rubbed(P.402) 

 

Specks appear on glossy paper(P.402) 

 

Point stains appear(P.403) 

 

Stains are printed(P.403) 

 

The entire paper is printed in black(P.403) 

 

Nothing is printed(P.404) 

 

White streaks occur(P.404) 

 

The peripheral area is dirty(P.404) 

 
Paper feed direction 

An afterimage printed on the front edge of the paper is 
printed(P.405) 
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Paper feed direction 

The density differs at two ends of the paper(P.405) 

White streaks appear in the vertical direction 

 
Cause Solution Reference 

The LED head is dirty. Clean the LED head.  Cleaning the LED 
head(P.333) 

 

The toner is low. When "Toner Low." or "Toner Empty. Replace with new 
Toner Cartridge." is displayed, replace the toner cartridge. 

 Replacing toner 
cartridges(P.298) 

 

The window film of the image drum 
is dirty. 

Wipe the window film with soft tissue paper.  Cleaning the 
light-shielding 
film(P.338) 

 

The image drum has not been 
installed correctly. 

Please install the image drum correctly.  Replacing the 
image drum and 
the toner 
cartridge(P.305) 

 

A foreign object is stuck in the 
image drum. 

Please replace the image drum.  Replacing the 
image drum and 
the toner 
cartridge(P.305) 

 

Printing is faint in the vertical direction 

 
Cause Solution Reference 

The LED head is dirty. Clean the LED head.  Cleaning the LED 
head(P.333) 

 

The toner is low. When "Toner Low." or "Toner Empty. Waste Toner Full." is 
displayed, replace the toner cartridge. 

 Replacing toner 
cartridges(P.298) 

 

The paper is not supported. Use the recommended paper.  Applicable 
paper(P.74) 
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Printing is light 

 
Cause Solution Reference 

The toner is low. When "Toner Low." or "Toner Empty. Waste Toner Full." is 
displayed, replace the toner cartridge. 

 Replacing toner 
cartridges(P.298) 

 

The print density may become 
lighter depending on the operating 
conditions. 

You can increase the print density by changing the settings 
of this machine as follows. 
Press the scroll buttons on the operator panel several times 
to select [Menus] - [User Setup] - [Print Adjust] - [Density 
Setting], and change the setting value to the plus side. 
If no effect is observed after [Density Setting] is adjusted, 
please change the settings of this machine as follows. 
Press the scroll buttons on the operator panel several times 
to select [Menus] - [User Setup] - [Print Adjust] - [Quiet 
Mode], and change the setting to [On]. 

 
 By changing [Density Setting] or [Quiet Mode] to 

increase the density, the toner consumption will 
increase. 

 Menus (User 
Setup)(P.107) 

 

The paper is moist. Use the paper stored at an appropriate temperature and 
humidity. 

 Storing 
paper(P.86) 

 

The paper is not supported. Use the recommended paper.  Applicable 
paper(P.74) 

 

The paper is not supported. 
The media weight is set 
incorrectly. 

Press the scroll buttons on the operator panel several times 
to select the paper tray you are using from [Menus] - [User 
Setup] - [Tray Configuration], and set an appropriate value 
for [Media Weight]. Or, change [Media Weight] to a thicker 
value than the present value. 

 Setting paper 
information on 
the operator 
panel(P.84) 

 

Recycled paper is used. Press the scroll buttons on the operator panel several times 
to select the paper tray you are using from [Menus] - [User 
Setup] - [Tray Configuration], and set a thicker value for 
[Media Weight]. 

 Setting paper 
information on 
the operator 
panel(P.84) 

 

It is used under an environment 
where combustion is emitted. 

Do not install this machine under an environment where 
combustion is emitted. If this machine is used under an 
environment where combustion is emitted indoors such as 
near an electric or gas stove, the image drum may be 
degraded. 

 Installation 
environment(P.18
) 

 

White dots or lines appear 

 
Cause Solution Reference 

Dry the paper as it is moist. Use the paper stored at an appropriate temperature and 
humidity. 

 Storing 
paper(P.86) 
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Condensation occurs on printed paper 

 
Cause Solution Reference 

The paper is moist. Use the paper stored at an appropriate temperature and 
humidity. 

 Storing 
paper(P.86) 

 

This machine is used in a place 
with high humidity or sudden 
changes in temperature and 
humidity. 

Use this machine in an environment with an appropriate 
temperature and humidity. 

 Installation 
environment(P.18
) 

 

The edge of the paper is wet. Press the scroll buttons on the operator panel several times 
to select [Menus] - [User Setup] - [Print Adjust] - [Moisture 
Control], and change the setting. This setting may delay the 
completion of printing the first page. 

- 

Streaks appear in the vertical direction 

 
Cause Solution Reference 

The LED head is dirty. Clean the LED head.  Cleaning the LED 
head(P.333) 

 

The toner is low. When "Toner Low." or "Toner Empty. Replace with new 
Toner Cartridge." is displayed, replace the toner cartridge. 

 Replacing toner 
cartridges(P.298) 

 

The image drum is scratched. Please replace the image drum.  Replacing the 
image drum and 
the toner 
cartridge(P.305) 

 

Paper guide is misaligned. Check the position of the paper guide in the paper cassette.  Loading 
paper(P.74) 

 

Dots and horizontal streaks appear in the paper feeding direction 
periodically 

 
Cause Solution Reference 

If dots or streaks of a specific color 
appear at intervals of about 94mm, 
the green tube of the image drum 
is scratched or dirty. 

Please replace the image drum.  Replacing the 
image drum and 
the toner 
cartridge(P.305) 
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Cause Solution Reference 
If dots or streaks appear at 
intervals of about 93 mm or about 
107 mm, the fuser unit is scratched 
or dirty. 

Replace the maintenance kit.  Replacing the 
maintenance 
kit(P.312) 

 

If the intervals are about 40 mm or 
58 mm, parts in the image drum 
are damaged. 

Please replace the image drum.  Replacing the 
image drum and 
the toner 
cartridge(P.305) 

 

If the intervals are about 38 mm, 
there are foreign objects in the 
image drum. 

Open and close the top cover and print again. 
If the problem persists, replace the image drum. 

 Replacing the 
image drum and 
the toner 
cartridge(P.305) 

 

If the intervals are about 47 mm, 
the resist roller is dirty. 

Open the top cover and wipe the resist roller with soft 
tissue paper. 

 Cleaning the 
resist 
roller(P.341) 

 

The image drum has been 
exposed to light. 

Install the image drum back to the printer, and leave the 
printer idle for a few hours. If the problem persists, replace 
the image drum. 

 Replacing the 
image drum and 
the toner 
cartridge(P.305) 

 

Dirt has deposited on the paper 
transfer path. 

Test print a few pages.  Printing the menu 
map 
(configuration)(P.
89) 

 

White area is lightly stained 

 
Cause Solution Reference 

Static electricity occurs to the 
paper. 

Use the paper stored at an appropriate temperature and 
humidity. 

 Storing 
paper(P.86) 

 

Thick paper is used. Use thinner paper.  Loading 
paper(P.74) 

 

The toner is low. When "Toner Low." or "Toner Empty. Replace with new 
Toner Cartridge." is displayed, replace the toner cartridge. 

 Replacing toner 
cartridges(P.298) 

 

Edges of text are blurred 

 
Cause Solution Reference 

The LED head is dirty. Clean the LED head.  Cleaning the LED 
head(P.333) 

 

The paper is not supported. Use the recommended paper.  Applicable 
paper(P.74) 

 

The paper is moist. Use the paper stored at an appropriate temperature and 
humidity. 

 Storing 
paper(P.86) 
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When envelopes or coated paper is printed, the whole area is thinly 
stained 

 
Cause Solution Reference 

When envelopes or coated paper 
is printed, toner may adhere to 
(cover) the whole area. 

This is not a malfunction. 
Do not use coated paper as much as possible. 

 Applicable 
paper(P.74) 

 Inapplicable 
paper(P.75) 

 

Toner comes off when rubbed 

 
Cause Solution Reference 

The media weight is set 
incorrectly. 

Press the scroll buttons on the operator panel several times 
to select the paper tray you are using from [Menus] - [User 
Setup] - [Tray Configuration], and set an appropriate value 
for [Media Weight]. Or, change [Media Weight] to a thicker 
value than the present value. 

 Setting paper 
information on 
the operator 
panel(P.84) 

 

Recycled paper is used. Press the scroll buttons on the operator panel several times 
to select the paper tray you are using from [Menus] - [User 
Setup] - [Tray Configuration], and set a thicker value for 
[Media Weight]. 

 Setting paper 
information on 
the operator 
panel(P.84) 

 

The envelope lever (blue, small) 
on the fuser unit is stuck. 

When printing on any other paper than envelopes, press 
the jam release lever (blue, large) on the top of the fuser 
unit, and return the paper envelope lever (blue, small) to its 
original position. 

 Printing on 
envelopes(P.142) 

 

Specks appear on glossy paper 

 
Cause Solution Reference 

The media weight is set 
incorrectly. 

Press the scroll buttons on the operator panel several times 
to select the paper tray you are using from [Menus] - [User 
Setup] - [Tray Configuration], and set an appropriate value 
for [Media Weight]. Or, change [Media Weight] to a thicker 
value than the present value. 

 Setting paper 
information on 
the operator 
panel(P.84) 
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Point stains appear 

 
Cause Solution Reference 

The paper is not supported. Use the recommended paper. 
If there is a lot of paper dust, load the paper after shuffling it 
well. 

 Applicable 
paper(P.74) 

 

If the intervals are approx. 94 mm, 
the green tube of the image drum 
is scratched or dirty. 

Replace the image drum with a new one if it is scratched.  Replacing the 
image drum and 
the toner 
cartridge(P.305) 

 

Stains are printed 

 
Cause Solution Reference 

The paper is moist. Use the paper stored at an appropriate temperature and 
humidity. 

 Storing 
paper(P.86) 

 

The paper is not supported. Use the recommended paper.  Applicable 
paper(P.74) 

 

The entire paper is printed in black 

 
Cause Solution Reference 

The machine may have broken 
down. 

Please contact your dealer. - 
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Nothing is printed 

 
Cause Solution Reference 

Multiple pages were fed at a time. Load the paper again after shuffling it well. 
Clean the paper feed roller. 

 Loading 
paper(P.74) 

 Cleaning the 
paper feed roller 
(Tray 
1/2/3/4)(P.334) 

 Cleaning the 
paper feed roller 
(MP tray)(P.336) 

 

The machine may have broken 
down. 

Print the configuration and check if the machine can print 
independently. 
If the configuration cannot be printed correctly, contact your 
dealer. 

 Printing the menu 
map 
(configuration)(P.
89) 

 

White streaks occur 

 
Cause Solution Reference 

The paper is moist. Use the paper stored at an appropriate temperature and 
humidity. 

 Storing 
paper(P.86) 

 

The paper is not supported. Use the recommended paper.  Applicable 
paper(P.74) 

 

The peripheral area is dirty 

 
Cause Solution Reference 

The size is not reduced by scale 
according to the paper size. 

Reduce the size by scale according to the paper size.  Enlarging/Reduci
ng to fit the 
specified paper 
size(P.157) 
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An afterimage printed on the front edge of the paper is printed 

 
Cause Solution Reference 

If N is about 94 mm and an 
afterimage is printed underneath, 
the media weight may not be set 
incorrectly. 

Press the scroll buttons on the operator panel several times 
to select the paper tray you are using from [Menus] - [User 
Setup] - [Tray Configuration], and set an appropriate value 
for [Media Weight]. Or, change [Media Weight] to a thicker 
value than the present value. 

 Setting paper 
information on 
the operator 
panel(P.84) 

 

If N is about 93 mm or at an 
interval of 107 mm and an 
afterimage is printed, the fuser unit 
may be scratched or dirty. 

Change the maintenance kit.  Replacing the 
maintenance 
kit(P.312) 

 

The density differs at two ends of the paper 

 
Cause Solution Reference 

After printing on narrow paper (i.e. 
width N in the figure) repeatedly, 
the machine printed on wide 
paper. 

If this occurs when you load the paper in landscape, try 
printing with the paper loaded in portrait. 

 Loading 
paper(P.74) 

 

You can reduce the occurrence of a difference in density by 
changing the settings of this machine as follows. 
Press the scroll buttons on the operator panel several times 
to select [Menus] - [User Setup] - [Print Adjust] - [Transfer 
Setting], and set the value to [-1]. 
It may take some time to improve the problem. If the 
problem does not improve even after the setting is 
changed, leave this machine idle for a while. 

 Menus (User 
Setup)(P.107) 
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Software troubleshooting 

 Monitoring Tool 
 Troubleshooting (Monitoring Tool)(P.252) 
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Troubleshooting for this machine and paper 

Troubleshooting for the machine 

 
 Please check the following explanation and "FAQ" on our website or your smartphone application. 
 If the problem persists, contact your dealer. 

Symptom Cause Solution Reference 
Nothing is displayed 
even after the power is 
turned on. 

The power cord is 
disconnected. 

Firmly insert the power cord. - 

There is a power 
failure. 

Check the power transmission status to the 
outlet. 

- 

It does not work. The power cord is not 
inserted firmly. 

Firmly insert the power cord. - 

The power is not 
turned on. 

Please turn the power on.  Turning the 
power on(P.73) 

 

The power was turned 
off by the Auto Power 
Off function. 

Please turn the power on. Or, disable the Auto 
Power Off function. 

 Turning off the 
power 
automatically 
(Auto Power 
Off)(P.100) 

 

This machine is 
frozen. 

Press and hold the power button for more than 
5 seconds to force a shutdown. 

- 

The top cover does 
not close. 
 
 

The toner cartridge is 
not installed properly. 

Install the toner cartridge properly.  Replacing toner 
cartridges(P.298) 

 

The blue lever on the 
toner cartridge is 
incorrectly positioned. 

Rotate the blue lever on the toner cartridge 
until it reaches the lock mark. 

 Replacing toner 
cartridges(P.298) 

 

The image drum is not 
installed properly. 

Install the image drum properly.  Replacing the 
image 
drum(P.300) 

 

The fuser unit is not 
installed properly. 

Install the fuser unit properly.  Replacing the 
maintenance 
kit(P.312) 

 

The error is not 
cleared even after the 
toner or drum is 
replaced. 

The replaced 
consumables are not 
correct. 

Check the error message on the display for the 
name of the consumables to be replaced. 
Replace the corresponding consumables. 

 Error message 
list(P.350) 

 Replacing toner 
cartridges(P.298) 

 

The toner cartridge is 
not installed properly. 

Check that the toner cartridge is installed 
firmly. 

The replaced 
consumables are not 
applicable to this 
machine. 

Use the consumables suitable for this machine. - 

"Used or non-genuine 
consumables/mainten
ance parts are 
installed. 
Check User's Manual 
"Trouble Shooting" to 
restore machine 
operation" appears on 
the display. 

Used toner cartridges 
or non-genuine 
consumables/mainten
ance parts are 
installed. 

Clear the error according to the description of 
Error Code 709 in the Error Message List. 

 Error message 
list(P.350) 

 

Printing process does 
not start. 

An error is displayed. Check the error code and follow the on-screen 
instructions. 

 Error message 
list(P.350) 
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Symptom Cause Solution Reference 
The LAN/USB cable is 
not plugged in. 

Firmly insert the LAN/USB cable.  Connecting via a 
wired LAN(P.37) 

 

There is a problem 
with the LAN/USB 
cable. 

Use another LAN/USB cable. - 

The LAN cable does 
not meet the 
specifications. 

Please use the cable of Ethernet 10BASE-
T/100BASE-TX/1000Base specifications. 

- 

The USB cable does 
not meet the 
specifications. 

Please use the USB cable enclosed with this 
machine. 

- 

There may be a 
problem with the print 
function. 

Press the scroll buttons on the operator panel 
to select [Menus] - [Print Information] - 
[Configuration], and print the configuration to 
check the printing performance. 

 Printing the menu 
map 
(configuration)(P.
89) 

 

The communication 
protocol is disabled. 

Press the scroll buttons on the operator panel 
to select [Menus] - [Admin Setup] - [Network 
Setup], and then enable the communication 
protocol in use. 

- 

The printer driver is 
not selected. 

Open [Devices and Printers]. Right-click on the 
icon of this machine, and select [Set as Default 
Printer]. 

 How to open 
[Devices and 
Printers](P.141) 

 

The output port of 
printer driver is 
incorrect. 

Specify the output port to connect the 
LAN/USB cable. 

- 

Nothing is displayed. This machine is in the 
sleep mode. 

Check that the POWER SAVE lamp is blinking, 
and then press «OK» to start this machine. 

- 

The print data is not 
sent. 

The LAN/USB cable is 
broken. 

Connect with a new cable. - 

The PC has timed out. Increase the length of timeout in port settings 
of the PC. 

- 

An abnormal sound is 
heard. 

This machine is tilted. Install it on a stable and flat surface. - 
Paper dust or foreign 
objects are left inside 
this machine. 

Check the inside of this machine and remove 
the object if any. 

- 

The top cover is open. Close the top cover. - 
A resonant sound is 
heard. 

While the temperature 
inside this machine is 
rising, printing is done 
on narrow or thick 
paper. 

This is not a fault with this machine. Use it as it 
is. 

- 

Printing is being 
performed from the 
expansion tray unit 
(optional). 

Printing does not start 
immediately. 

This machine is 
warming up for 
recovering from the 
power save mode or 
sleep mode. 

Extend the time that will elapse before the 
power save mode or sleep mode is entered by 
the following procedure. 
Press the scroll buttons on the operator panel 
to select [Power Save Time] or [Sleep Time] 
from [Menus] - [User Setup] - [System Adjust]. 

 Setting the power 
save 
function(P.98) 
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Symptom Cause Solution Reference 
Printing stops in 
between. 

The temperature is 
adjusted because the 
temperature inside this 
machine has risen due 
to long-time 
continuous printing. 

Please wait. 
The printing will automatically start again once 
the temperature of this machine returns 
appropriate. 

- 

The memory is 
insufficient. 

The memory of this 
machine is insufficient 
as the print data is too 
big. 

Print again after reducing the resolution in the 
printer driver. 

- 

All pages are not 
printed. 

The WSD port is used. Change the print destination port to the 
standard TCP/IP port. 

- 

Printing, printer search 
or setup is not 
available in the sleep 
mode. 

The NBT/WINS 
protocol is suppressed 
in the sleep mode. 

Press the scroll buttons on the operator panel 
to select [Specific] from [Menus] - [Admin 
Setup] - [USB Setup] - [Connected Host]. 

- 

Periodic email alerts 
are not notified in the 
sleep mode. 

Periodic email alerts 
notification is 
suppressed in the 
sleep mode. 

Press the scroll buttons on the operator panel 
to select [Specific] from [Menus] - [Admin 
Setup] - [USB Setup] - [Connected Host]. 

- 

The time and date 
settings of this 
machine may be 
shifted if acquired from 
the server. 

The time update 
function with the SNTP 
server is suppressed 
in the sleep mode. 

Press the scroll buttons on the operator panel 
to select [Specific] from [Menus] - [Admin 
Setup] - [USB Setup] - [Connected Host]. 

- 

Printing is slow. Printing is also 
performed on the PC 
side. 

Use a PC with a fast processing speed. - 

In the [Job Options] 
tab of the printer 
driver, [Fine 
(1200x1200dpi)] is 
selected. 

Select [Normal (600x600dpi)] in the [Advanced] 
or [Job Options] tab of the printer driver. 

- 

The print data is 
complicated. 

Select simple print data. - 

Narrow paper (less 
than 200 mm) is used. 

Press the scroll buttons on the operator panel 
to select [Menus] - [User Setup] - [Print Adjust] 
- [Narrow Paper Speed], and change the 
setting. 

- 

The temperature is 
adjusted because the 
temperature inside this 
machine has risen due 
to long-time 
continuous printing. 

Please wait. 
The printing will automatically resume once the 
temperature of this machine returns 
appropriate. 

- 

[Quiet Mode] is in use. Press the scroll buttons on the operator panel 
to select [Menus] - [User Setup] - [Print Adjust] 
- [Quiet Mode], and change the setting. 

- 

Display of the printer 
driver is abnormal. 

The printer driver may 
not work correctly. 

Delete and reinstall the printer driver.  Deleting 
software(P.345) 

 Installing 
software(P.245) 
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Symptom Cause Solution Reference 
The power turns off 
automatically. 

If this machine has not 
been used for a 
certain period of time 
(whose factory default 
setting is 4 hours*), the 
power will turn off 
automatically. This 
function is called Auto 
Power Off. 
*: Factory default 
settings may vary by 
region. 

Press the scroll buttons on the operator panel 
to select [Disable] in [Menus] - [Admin Setup] - 
[Power Setup] - [Auto Power Off]. 

 Turning off the 
power 
automatically 
(Auto Power 
Off)(P.100) 

 

The web page does 
not open. 

[Web] is set to 
[Disable] in the menu 
of this machine. 

Press the scroll buttons on the operator panel 
to select [Enable] in [Menus] - [Admin Setup] - 
[Network Setup] - [Setup] - [Web]. 

- 

The IP address is 
incorrect. 

Check the IP address of this machine and 
correct it if needed. 

 Printing the menu 
map 
(configuration)(P.
89) 

 

The LAN cable is 
disconnected. 

Check connection of the LAN cable.  1. Connecting the 
LAN cable(P.37) 

 

Troubleshooting for the paper 

 
 Please check the following explanation and "FAQ" on your smartphone app or our website. 
 If the problem persists, contact your dealer. 

Symptom Cause Solution Reference 
Paper jams occur 
frequently. 
Multiple sheets of 
paper are pulled in 
simultaneously. 
The paper is pulled in 
an inclined direction. 

This machine is tilted. Install it on a stable and flat surface. - 
The paper is either too 
thin or too thick. 

The paper is either too thin or too thick. Use 
the paper applicable to this machine. 

 Applicable 
paper(P.74) 

 

The paper is moist or 
charged with static 
electricity. 

Use the paper stored at an appropriate 
temperature and humidity. 

 Storing 
paper(P.86) 

 

The paper is wrinkled, 
folded or curled. 

Use the paper applicable to this machine. 
Straighten the paper if it is curled. 

 Applicable 
paper(P.74) 

 

The paper has had its 
reverse side printed. 

Already printed paper cannot be printed again 
from Tray 1/2/3/4. 
Print from the MP tray. 

- 

The paper is not 
aligned yet. 

Shuffle the paper well, and load the paper with 
the top, bottom, left and right aligned. 

 Loading 
paper(P.74) 

 

Load only one sheet of 
paper. 

Load multiple sheets of paper. - 

Additional paper is 
loaded in the paper 
cassette while the 
existing paper is kept 
as it is. 

Remove the existing paper in the tray, and load 
the paper again together with the new one with 
the top, bottom, left and right aligned. 

 Loading 
paper(P.74) 

 

The paper is not 
loaded straight. 

Fit the paper guide and paper stopper of the 
paper cassette of Tray 1/2/3/4 to the paper. 
Align the paper with the manual feeder guide of 
the MP tray. 

 Loading 
paper(P.74) 
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Symptom Cause Solution Reference 
Burrs (i.e. a thin ridge 
of roughness 
produced in cutting 
paper) occur on the 
edge of the paper. 

Load the paper again after shuffling it well. 
Load the paper again after turning it upside 
down. 

- 

The envelope is 
loaded in a wrong 
orientation. 

Load the envelope again correctly.  Loading 
paper(P.74) 

 

Envelopes are sticked 
together. 

Shuffle the envelopes well, or stack them one 
by one. 

- 

Paper jams occur 
frequently. 

Paper dust is attached 
to the paper feed 
roller. 

Clean the paper feed roller of the tray where 
the paper jam occurred. 

 Cleaning the 
paper feed roller 
(Tray 
1/2/3/4)(P.334) 

 Cleaning the 
paper feed roller 
(MP tray)(P.336) 

 

The paper feed roller 
has reached the end 
of its service life. 

As a guide, the paper feed roller reaches its 
service life after printing about 100,000 sheets 
for Tray 1/2/3/4 and about 80,000 sheets for 
the MP tray. Press the scroll buttons on the 
operator panel several times to select [Menus] 
- [Information] - [Paper Feed Roller Counter], 
check the roller usage of each tray, and 
replace the paper feed roller if its service life 
has reached. 

 
 

 Replacing the 
paper feed roller 
(Tray 
1/2/3/4)(P.319) 

 Replacing the 
paper feed roller 
(MP Tray)(P.329) 

 

For B513, paper jams 
occur frequently to 
feeding A5 paper in 
landscape. 

You have loaded 
paper with a weight of 
105 g/m2 or above. 

To print on A5-sized paper with a weight of 105 
g/ m2 or above, please load the paper in 
portrait. 

 Paper applicable 
to each tray(P.78) 

 

Disable [Media Check] 
in the printer driver, 
and then try printing 
again. 

To print on A5-sized paper in landscape, 
enable [Media Check] in the printer driver. 
Or, print on A5-sized paper in portrait. 

The paper jam with 
error codes 392, 393 
and 394 occurs 
repeatedly. 

The paper size set in 
the file to be printed is 
different from the 
paper size loaded in 
the expansion tray. 
Disable [Media Check] 
in the printer driver, 
and then try printing 
again. 

Remove the jammed paper. 
Cancel the printing. 
Load paper of the same size as the paper size 
set in the file to be printed into the expansion 
tray to be used, and then print. 

 For the error 
code 392, 393 or 
394(P.378) 

 Canceling the 
printing(P.193) 

 Loading paper in 
Tray 1 (for 
B433)(P.79) 

 

Paper cannot be fed. An incorrect setting is 
selected in [Paper 
Source] of the printer 
driver. 

Check the paper tray, and select the correct 
tray from [Paper Source] of the printer driver. 

- 

Manual feeding is 
specified in the printer 
driver. 

Disable [Feed paper individually] in the printer 
driver. 

 Printing one 
sheet at a time 
manually(P.156) 

 

Paper cannot be fed 
from Tray 2/3/4 

Tray 2/3/4 is not set up 
in the printer driver. 

Set up Tray 2/3/4 in the printer driver.  Setting the printer 
driver(P.67) 

 

Th machine is not 
restored even after the 
jammed paper is 
removed. 

- Open and close the top cover. - 
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Symptom Cause Solution Reference 
The paper gets curled 
. 
The paper is waved. 
The paper is wrinkled. 
 

The paper is moist or 
charged with static 
electricity. 

Use the paper immediately after unpacking.  Storing 
paper(P.86) 

 

Use the paper stored at an appropriate 
temperature and humidity. 
When you set paper in the printer tray, 
sometimes the issue can be resolved by 
reversing the front and back sides of the paper. 

Thin paper is used. Press the scroll buttons on the operator panel 
to select [Menus] - [User Setup] - [Tray 
Configuration] - [(Tray Name) Setup] - [Media 
Weight]. Then, change the current setting to a 
thinner value. 

 Setting paper 
information on 
the operator 
panel(P.84) 

 

Press the scroll buttons on the operator panel 
to select [Menus] - [User Setup] - [Print Adjust] 
- [High Humid Mode], and change the setting. 

- 

The front edge of 
paper curls and floats 
on the top cover. 

Thin paper is used. Remove the paper from the top cover each 
time you print one sheet. 

- 

The paper twines 
around the inside of 
the fuser. 

The media weight is 
set incorrectly. 

Press the scroll buttons on the operator panel 
to select [Menus] - [User Setup] - [Tray 
Configuration] - [(Tray Name) Setup] - [Media 
Weight], and set an appropriate value. 
Or, change [Media Weight] to a thicker value 
than the present one. 

 Setting paper 
information on 
the operator 
panel(P.84) 

 

Thin paper is used. Use thicker paper. - 
There is near-solid 
filling at the top edge 
of the paper. 

Try leaving a margin at the top edge of the 
paper. 
With duplex printing, try leaving a margin at the 
rear edge of the paper. 

- 

Corners of the paper 
are folded (the edge is 
folded). 

The paper is curled. 
The paper is waved. 

Use the paper stored at an appropriate 
temperature and humidity. 

 Storing 
paper(P.86) 

 

The envelope is 
wrinkled. 

The paper is moist. Use the paper stored at an appropriate 
temperature and humidity. 

 Storing 
paper(P.86) 

 

The paper settings are 
not correct. 

Press the scroll buttons on the operator panel 
to select [Envelope] in [Menus] - [User Setup] - 
[Tray Configuration] - [(Tray Name) Setup] - 
[Media Type]. 
Set [Media Type] to [Envelope] in the printer 
driver. 

 Printing on 
envelopes(P.142) 

 

The envelope lever 
(blue, small) on the 
fuser unit is raised. 

Please print by following the procedure in "If 
you are concerned about wrinkles" of "Printing 
on envelopes(P.142)". Once printing is 
complete, return the envelope lever (blue, 
small) to the original position. 

 Printing on 
envelopes(P.142) 

 

It applies to other 
cases than the above. 

Load the envelope with the flap facing the main 
unit. Next, from Print Setup, set the orientation 
to 180° reversion. 

 Screens and 
functions of the 
printer 
driver(P.131) 

 

Misalignment occurs 
when paper is output 
from the expansion 
tray unit. 

Misalignment occurs 
with each tray. 

Press the scroll buttons on the operator panel 
to select the tray to adjust in [Menus] - [User 
Setup] - [Print Adjust] - [Print Position Adjust], 
and correct the value of [X Adjust] (Landscape) 
or [Y Adjust] (Portrait). 

 Correcting the 
print position of 
the tray(P.186) 
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Symptom Cause Solution Reference 
The paper is 
automatically fed from 
another paper tray 
when the paper tray 
runs out of paper 
during printing. 

Tray Switch is set to 
Auto. 

Change the Auto Tray Switch setting in the 
printer driver. 
For the Windows PCL printer driver, uncheck 
[Setup] - [Paper Feed Options] - [Paper feed 
options] - [Auto Tray Change]. 
For the Windows PS printer driver, select 
[Layout] - [Advanced] - [Printer Features] - 
[Tray Switch] - [Off]. 
For macOS, go to [Paper Feed] - [All Pages 
From], and select the tray to be used. 

 Screens and 
functions of the 
printer 
driver(P.131) 

 

When a power failure occurs 
If a power failure occurs while the power is on, the power will not turn on automatically even after the power 
failure is recovered.  
If you want the power to turn on automatically after the power failure is recovered, select [Always On] or [Last 
State] in [Boot Menu] - [After AC power supply fails]. 

 Boot Menu(P.126) 

 
 The machine may not work properly if an uninterruptible. power supply (UPS) or inverter is used. Do not use any 

uninterruptible. power supply or inverter. 

 
With the factory default settings, when a power failure occurs, this machine acts as follows. 

State of this machine Action 
Receiving Reception is interrupted halfway. 
Printing a report Report printing is interrupted halfway. 
Standby Printing cannot be started. 
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Taking security measures 
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Preventing disclosure of documents 

Private Print 
For private printing, to prevent others from seeing the printing results of personal and confidential documents, 
the print jobs are encrypted and saved in the machine's memory, and they can be authenticated and printed 
only from the operator panel. 
In addition, because the print data is sent upon encryption from your PC, unauthorized access to confidential 
information can be prevented. 
Printing with print data encrypted and password set (Private Print)(P.190) 

Print Data Encryption 
In order to protect its content against being read by a third party or printed on other machines before the print 
data reaches this machine, the print data is encrypted. 
Because the print data is sent upon encryption, unauthorized access to confidential information can be 
prevented. 
 
For the printing procedure, please refer to "Printing with security enhanced(P.187)". 

Encrypting Network Communications 
By encrypting the communication between the machine and the computer or mobile device, it is difficult for a 
third party to read the content, thus preventing eavesdropping. 
Communication encryption (SSL/TLS)(P.203) 
Communication encryption (IPSec)(P.207) 
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Preventing unauthorized network access 

IP Filtering Setup 
You can use the IP Address to control the access to this machine. You can set whether or not to authorize 
setup or printing from the specified IP address. Controls access from outside the company. 
However, this function requires knowledge about the IP address. This machine may be denied from access to 
network due to serious problems depending on settings. 
Using the access control function (IP filter) with the IP address(P.207) 

MAC Filtering Setup 
You can use the MAC Address to control the access to this machine. You can allow or deny the access from 
the specified MAC Address. 
Controls access from outside the company. 
However, this function requires knowledge about the MAC address. This machine may be denied from access 
to network due to serious problems depending on settings. 
Using the access control function with the MAC address(P.208) 

IPSec Setup 
You can use IPSec to encrypt the communication between your PC or mobile device and this machine. 
When IPSec is enabled, all applications are encrypted using IPSec, thus ensuring a high level of security. 
Communication encryption (IPSec)(P.207) 

TLS Setup 
You can use TLS to encrypt the communication between your PC or mobile device and this machine. 
Communication encryption (SSL/TLS)(P.203) 

IEEE802.1X Settings 
IEEE802.1X authentication is required to connect to a wired or wireless LAN network. 
For network connection, the machine is authenticated to ensure that it is the correct user, and if it is the 
correct user, it can connect to the network. 
Using IEEE802.1X (Wired LAN)(P.210) 
Setting IEEE802.1X (Wireless LAN)(P.211) 

Access Log 
This machine records and stores the printer operations by the user and the contents and results of 
input/output with external machines. 
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Preventing disclosure of confidential information in the 
operation of this machine 

Password Policy 
The machine comes with the setting function of password policy. You can set the length and complexity of the 
admin password used for admin authentication and the password for personal authentication. 
By setting a password policy, you can avoid using a string that is easy to guess when creating a password, 
thus improving the level of security. 
The following settings are available for Password Policy. 

 
 The password policy may differ from region to region. 

 [Minimum Length]: Set the minimum length of the password. The factory default setting is 10 characters 
or 1 character. 

 [Use Uppercase]: Specify whether or not to include upper-case letters in the password. The factory 
default setting is [On] or [Off]. 

 [Use Lowercase]: Specify whether or not to include lower-case letters in the password. The factory 
default setting is [On] or [Off]. 

 [Use Symbol]: Specify whether or not to include symbols in the password. The factory default setting is 
[Off]. 

 [Use digit]: Specify whether or not to include digits in the password. The factory default setting is [Off]. 
 
 

Account Lockout 
With this function, you can temporarily lock a user account so that it is not available if authentication has failed 
for more than a certain number of times in a row. 
The purpose is to protect the machine from attacks (brute force attacks) that attempt to guess passwords and 
log in illegally. 
The following settings are available for Account Lockout. 
 [Lockout]: Enable/Disable the lockout function. The factory default setting is [Enable]. 
 [Lockout Condition]: Set the maximum number of authentication failures until lockout. The factory default 

setting is [5 times]. The value range is 1 - 10 times. 
 [Lockout Period]: Set the period of time until the account is unlocked. The factory default setting is [5 

minutes]. The value range is 1 - 60 minutes. 
There are two ways to unlock an account that has been locked out as follows. 
 Wait until the lockout period has elapsed 
 The machine’s administrator resets the password of the account 

 
 If you log in to the machine from an OS like Windows, or from an application that uses FTP, IPP, SNMPv3 or SMB, 

you may be locked out for fewer times than the number of times you set.  
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Admin password 
An administrator password has been set for this machine to prevent unexpected changes to the settings. 
We recommend that you change it once you start using this machine. 
Administrator Password(P.195) 

User Authentication/Access Control 
Access control is a function that a user authenticated by this machine can only perform permitted operations. 
Before a user operates this machine, personal authentication is required. The information required for 
personal authentication refers to either a user name and its password or a PIN (Personal Identification 
Number). 
To use the access control function, the administrator of this machine registers the user information, sets the 
authentication method, and enables access control. 
User restriction (Access control)(P.226) 

Initializing the settings 
This section explains how to initialize the memory and various settings of this machine. 
When you forget the admin password, the settings cannot be initialized. 
Initializing the settings(P.418) 
For items to be initialized, please refer to "Initialization specifications(P.428)". 

Erase Privacy Data 
Once Erase Privacy Data is executed, the machine will be restarted, the memory and all the settings will be 
initialized, and the registered data will be deleted. When initialization is complete, the execution result is 
displayed on the machine. 
If [Yes(Report print)] is selected during executing, the execution result will be printed. 
In addition, if Erase Privacy Data is executed from the web page, the execution result will not be displayed on 
the web page. If it is necessary to check the result, select [Yes(Report print)] during executing. 
For the procedure, please refer to "Disposal(P.241)". 
For the items to be initialized, please refer to "Initialization specifications(P.428)". 

MIB Get Control 
If it is set to [Enable], you can restrict some of the information that is retrieved using SNMP. 
If it is set to [Disable], you can retrieve all the information, including confidential data of MIB using SNMP. 
Please understand the security risks before setting it to [Disable]. 

Security-related menu settings 
The menu settings related to the security function of this machine are as follows. 

 
 For menu items that can be set on this machine, please refer to "Menu items(P.105)". 
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[Interface] 
Purpose Settings 

To prohibit wireless connections Select [Disable] in [Wireless Setting] - [Wireless(Infrastructure) Setting] - 
[Wireless(Infrastructure)]. 

To prohibit Wi-Fi Direct 
connections 

Select [Disable] in [Wireless Setting] - [Wireless(Wi-Fi Direct) Setting] - 
[Wireless(Wi-Fi Direct)]. 

To prohibit USB connections Select [Disable] in [Menus] - [Admin Setup] - [USB Setup] - [USB]. 
To prohibit the use of the USB 
memory 

Select [Disable] in [Menus] - [Admin Setup] - [USB Setup] - [USB Memory Interface]. 

[Authentication] 
Purpose Settings (Factory Defaults) 

To discard print data that cannot 
be authenticated 

In addition to user authentication/access control, you can prohibit the printing from 
users who cannot be authenticated by disabling or prohibiting guest user 
permissions for usage. 
Guest user permission settings 
・ Guest user permissions for usage: Enable/Disable (Enable) 

・ Guest user permissions for printing: Permit/Prohibit (Permit) 

・ Guest user permissions for printing from a USB memory: Permit/Prohibit (Permit) 
To continue operation with the 
printer's user 
authentication/access control 
enabled even after an error occurs 
to the communication with the 
authentication server 

By enabling the user information cache settings, you can continue operation with 
user authentication and access control enabled even after an error occurs to the 
communication between this machine and the authentication server. 
User information cache settings 
・ Cache authentication information: Enable/Disable (Disable) 

 
 This setting is enabled when external authentication is used that delegates 

user authentication to the authentication server. 
 This machine comes with a function to cache the user's authentication 

information for a certain period of time. When an error occurs, it automatically 
switches to user authentication with the cached authentication information, so 
that user authentication and access control can be continued. 

 The cache validity period can be specified in days, ranging from 1 day to 2000 
days. The factory default setting is 1 day. 

To specify rules for the admin 
password and the password used 
for personal authentication, thus 
keeping the machine safe 

Password policy 

 
 The password policy may differ from region to region. 

・ Minimum length: 1 - 32 (10 or 1) 

・ Contains at least one upper-case letter: OFF/ON (ON or OFF) 

・ Contains at least one lower-case letter: OFF/ON (ON or OFF) 

・ Contains at least one digit: OFF/ON (OFF) 

・ Contains at least one symbol: OFF/ON (OFF) 
To protect this machine from brute 
force attacks 

Account Lockout 
・ Lockout: Enable/Disable (Enable) 

・ Lockout Condition (Max. number of authentication failure times): 1 - 10 times (5 
times) 
・ Lockout Period (The period of time until the lockout is lifted automatically): 1 - 60 
min (5 min) 
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[Job] 
Purpose Settings (Factory Defaults) 

To prevent unattended printing Private Print Setup 
・ Verify job option: Enable/Disable (Disable) 
Specify whether to verify the print data before printing. If enabled, the printer prints 
after verifying that the print data has not been changed. The integrity of print data is 
guaranteed, but the time to start printing will be longer. 
・ Erase job option: No overwrite/Zero out once (No overwrite) 
Set the method for erasing the print data. You can specify that the data cannot be 
restored by overwriting after it is erased. If you overwrite, it will take longer to erase. 
・ Keep job for: 15 minutes - 7 days (2 hours) 
Set the retention period of the print data. After the print data is saved, if the print 
data is not printed after the set period, the print data is automatically deleted. 
・ Job Limitation: Enable all print formats/Enable private job printing only (Enable 
all print formats) 
Set whether to save restricted print data. When [Enable private job printing only] is 
selected, any print data other than private print will not be accepted. 
・ Verify job password: ON/OFF (OFF) 
Select whether to verify the job password when the access control is enabled. 
・ Job Auto Search: ON/OFF (ON) 
Select whether to perform job search while unlocking the panel when the access 
control is enabled. 

To prohibit using non-encrypted 
jobs 

PJL Enhance Security: Off/Mode 1 (Mode 1) 
Set the behavior of the machine when it receives an unencrypted job that contains 
confidential data over the network. 
[Mode 1] accepts and discards any unencrypted job that contains confidential data. 
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Handling of Personal Information 

When you log in to this product as an administrator, it is possible to set up the recording of the following 
personal information inside this machine. The recorded information will never be transferred to the server. 
If you do not log in as an administrator, you may not be able to fully utilize this product in some cases. 
 E-mail Address 
 Host Name 
 IP Address 
 PIN 
 User Name 
 Password 

 
The personal information is stored as follows. 

Item E-mail Address Host Name IP Address PIN User Name 
Password 

(*1) 
User List ○  × × ○ ○ ○ 
Shared Job/Private Job × ○ ○ × ○ × 
Job Log × ○ ○ × ○ × 
Access Log ○ × × ○ ○ ○ 
Email Alert ○ × × × × × 

*1: Since only the hash information of the password is recorded, the password is not possible to be leaked. 
 
Refer to the following part for the usage purpose and operation method of personal information. 

User List 
Usage purpose: It will be used for personal authentication of a user who wants to use this machine. 

Operation Authority Operation method 
Register Admin Register the information by using the web page, Configuration Tool or 

sPSV. 
Edit Admin Edit the information by using the web page, Configuration Tool or sPSV. 
Reference Admin Edit the information by using the web page, Configuration Tool or sPSV. 
Delete Admin Edit the information by using the web page, Configuration Tool or sPSV. 
Initialize Admin There is no function to initialize only the user list. With the Erase 

Privacy Data menu, all the data of the machine will be initialized. 

Shared Job/Private Job 
 Usage purpose: It is used to identify jobs for each user. 

Operation Authority Operation method 
Print Printing execution user Select either Shared Job or Private Job as the Job Type in 

the printer driver, and then print the job. 
Reference Shared Job: All users 

Private Job: Printing execution 
user/Admin 
 

Execute the Print menu for shared jobs or private jobs from 
the operator panel. 

Print Printing execution user Select a job displayed on the operator panel and print it. 
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Operation Authority Operation method 
Delete Shared Job: All users 

Private Job: Printing execution 
user/Admin 

For Shared Job, select a shared job on the operator panel 
and delete it. 
For Private Job, there are three operation methods as 
follows: 
 Select a private job on the operator panel and delete 

it. 
 After printing, the private job will be automatically 

deleted. 
 When its retention period has expired, the private job 

will be automatically deleted. 

Job Log 
Usage purpose: It is used to output the job history. 

Operation Authority Operation method 
Reference Admin There are two operation methods as follows: 

 It can be viewed from [State] - [Print Job] - [Job Log] on the web 
page. 

 It can be printed from [Menus] - [Admin Setup] - [Print Information] 
- [Job Log] on the operator panel. 

Delete Admin There are two operation methods as follows: 
 Execute [Erase Privacy Data] on the web page or operator panel. 
 Execute [Clear Job Log] on the web page or operator panel. 

Access Log 
Usage purpose: It is used to output the access history. 

Operation Authority Operation method 
Reference Admin On the web page, select [Export Access Log] and download a CSV file 

in zip format. Unzip the downloaded file and reference it. 
Delete Admin Execute [Erase Privacy Data] on the web page or operator panel. 
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Specifications 

Model Model Number 
B433 N22505B, N22505D B433dn 
B513 N22506B, N22506D B513dn 

General specifications 
Item B433 B513 

CPU Arm Processor (667MHz) 
Memory Built-in 512 MB 
Weight (with consumables) Approx. 14 kg Approx. 16 kg 
Dimensions (WxDxH) 387×364×245 mm 387×394×286 mm 
Power N22505B/N22506B: 220V - 240V AC +/-10% 

N22505D/N22506D: 110V AC +/-10% 
Power 
consumption 

Operating Max: 1,140W*/Average: 570W** 
* The value excluding the momentary peak value. 
** The average power consumption during operation. The average power 
consumption of 15-minute printing after one page is printed. 
*This is the value when all optional accessories are installed. It may vary with the 
operating environment. 

Standby Without options :47W or below 
With all options installed: 48W or less 

Sleep mode 0.6W or below* This is the default setting. It may vary with the specific settings and 
operating environment. 

Off 0.2W or below 
TEC value (Metrics specified in the 
Version 3.0 ENERGY STAR 
Product Specification for Imaging 
Equipment) 

0.41kWh (230V) 0.47kWh (230V) 

Operating and 
environmental 
conditions 

Operating Temperature: 10℃ - 32℃; Humidity: 20% - 80% RH 
Pause Temperature: 0℃ ~ 43℃; Humidity: 10% ~ 90% RH 

Interface USB 2.0 (Type B), Ethernet~1000BASE-T (Standard), Ethernet~100BASE-TX 
(Extended wired LAN, Recommended), IEEE802.11 a/b/g/n/ac (Wireless LAN, 
Optional) 

Display screen 1.82-inch monochrome graphic panel, 128 x 64 dots 
Compatible OS Windows 11/Windows 10 

Windows Server 2025/Windows Server 2022/Windows Server 2019/Windows 
Server 2016 
macOS 12~15 

Service life of the machine 7 years or 600,000 sheets 
* The service life of the machine may vary with the specific usage. 
* In order to maintain the paper-passing performance for 7 years, it may be 
necessary for maintenance personnel to replace the parts specified by our 
company. 

Storage environment Temperature: -10℃ - 43℃ 

Relative humidity: 10~90% (Max wet bulb temperature: 35℃) 

 

Printing section specifications 
Item B433 B513 

Printing method Dry electrode photo recording method using LED (light-emitting diodes) as the 
exposure light source 
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Item B433 B513 
Page description language Adobe PostScript 3, PDF (v1.7), PCL6 (XL3.0) emulation, PCL5c emulation, IBM 

ProPrinter, EPSON FX, EPSON LQ 
Resident fonts PCL: 91 typefaces (European languages) 

PS: 136 typefaces (European languages) 
Resolution 600 x 600 dpi, 1200 x 1200 dpi 
Printing colors Black 
Printing speed Simplex: 40 ppm 

Duplex: 20 ppm 
Simplex: 45 ppm 
Duplex: 20 ppm 

First page output time 
* From the start of receiving print data to the removal 

of the rear paper edge from the final exit roller 
・ When print data is sent within 30 seconds after 

the previous printing is completed 
・A4 size, paper type: plain; paper weight: light; 

simplex printing, paper feeding from Tray 1 
・ Ambient temperature: 22℃ - 25℃; Ambient 

humidity: 25% - 65% RH 

Approx. 4.5 sec Approx. 4.1 sec 

Paper Size Tray 1 A4, A5, A6, B5, B6, Letter, Legal 13, 
Legal 13.5, Legal 14, Executive, 
Statement, 8.5" SQ, Folio 

A4, A5, B5, Letter, Legal 13, Legal 13.5, 
Legal 14, Executive, 8.5" SQ, Folio, 

Expansion tray 
unit (optional) 

A4, A5, B5, Letter, Legal 13, Legal 13.5, Legal 14, Executive, 8.5" SQ, Folio 

MP Tray A4, A5, A6, B5, B6, B7, Letter, Legal 13, Legal 13.5, Legal 14, Executive, 
Statement, 8.5" SQ, Folio, 4" x 6", 5" x 7", Nagagata#3, Nagagata#4, Yougata#0, 
Yougata#4, Envelope C5, Envelope C6, Envelope DL, Envelope COM-9, Envelope 
COM-10, Envelope Monarch 

Duplex A4, B5, Letter, Legal 13, Legal 13.5, Legal 14, Executive, Folio 
Custom  Tray 1 

Width: 100 - 216 mm; Length: 148 - 356 
mm 

 Expansion tray unit 
Width: 148 - 216 mm; Length: 210 - 356 
mm 

 MPTray 
Width: 86 - 216 mm; Length: 127 - 1,321 
mm 

 2-Side 
Width: 182 - 216 mm; Length: 257 - 356 
mm 

 Tray1 
Width: 148 - 216 mm; Length: 210 - 356 
mm 

 Expansion tray unit 
Width: 148 - 216 mm; Length: 210 - 356 
mm 

 MPTray 
Width: 86 - 216 mm; Length: 127 - 1,321 
mm 

 2-Side 
Width: 182 - 216 mm; Length: 257 - 356 
mm 

Paper quality Plain (60 g/m2 - 256 g/m2), Recycled, Envelope, Label 
Paper feeding method Auto paper feeding from Tray 1, the MP tray, and the expansion tray unit (Optional) 

Manual paper feeding from the MP tray 
Feeding capacity  Tray1 

280 sheets (80 g/m2), with the total 
weight of 25 mm or less 

 MPTray 
110 sheets (80 g/m2), with the total 
weight of 10 mm or less; 10 envelopes 
(85 g/m2) 

 Expansion tray unit 
Plain: 580 sheets (80 g/m2 ), with the 
total weight of 53 mm or less 

 Tray1 
580 sheets (80 g/m2), with the total 
weight of 53 mm or less 

 MPTray 
110 sheets (80 g/m2), with the total 
weight of 10 mm or less; 10 envelopes 
(85 g/m2) 

 Expansion tray unit 
Plain: 580 sheets (80 g/m2 ), with the 
total weight of 53 mm or less 

Paper output method Output tray (Top cover), rear output tray 
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Item B433 B513 
Output capacity  Output tray (Top cover): 150 sheets of Plain paper (80 g/m2) 

 Rear Output Tray: 100 sheets of plain paper (80 g/m2) 
Assured printing range 4.23 mm or above from the paper edge (excluding special paper like envelopes) 
Printing accuracy  Standard-sized paper 

Writing position accuracy: ±2 mm; paper slant: ±1 mm/100 mm (except for duplex 

printing) 
Image stretch: ±1 mm/100 mm (except for duplex printing) 

Warm-up time  When powered on 
Approx. 18 sec 
(The time from when the power button is turned on to when [Ready To Print] appears on 
the display, when the ambient temperature is 22℃ - 25℃ and the ambient humidity is 

25% - 65% RH, and it works at the rated voltage.) 
 When restored from Sleep mode 

For plain paper: Approx. 12.0 seconds; For medium paper: Approx. 12.7 seconds 
(The time from the start of receiving print data to when [Adjusting Temp] disappears from 
the display, when the ambient temperature is 22℃ - 25℃ and the ambient humidity is 

25% - 65% RH, and it works at the rated voltage.) 
 When restored from the low-

temperature standby mode 
For plain paper: Approx. 10.9 seconds 
(The time from the start of receiving 
print data to the removal of the rear 
paper edge from the final exit roller 
when A4-sized paper is fed from Tray 1 
for simplex printing, when the ambient 
temperature is 22℃ - 25℃ and the 

ambient humidity is 25% - 65% RH, and 
it works at the rated voltage.) 

 When restored from the low-
temperature standby mode 
For plain paper: Approx. 11.0 seconds 
(The time from the start of receiving 
print data to the removal of the rear 
paper edge from the final exit roller 
when A4-sized paper is fed from Tray 1 
for simplex printing, when the ambient 
temperature is 22℃ - 25℃ and the 

ambient humidity is 25% - 65% RH, and 
it works at the rated voltage.) 

Printing quality assurance 
conditions 

 Operating range 
Temperature: 10℃; Humidity: 20% - 80% RH 

Temperature: 32℃; Humidity: 20% - 60% RH 

Humidity: 20% RH; Temperature: 10℃ - 32℃ 

Humidity: 80% RH; Temperature: 10℃ - 27℃ 

Consumables Toner cartridge, image drum 
Maintenance parts Maintenance kit (fuser, transfer roller), feed roller assembly 

Specifications of the expansion tray unit 
Item Expansion tray unit 

 
Weight Approx. 5.3 kg 
Dimensions (WxDxH) 387×405×139 mm 
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Network specifications 
Item B433 B513 

Protocol 
* The value in () is the factory default setting. 

TCP/IPv4 (Enable), TCP/IPv6 (Enable), NetBIOS over TCP (Enable), DHCP 
(Enable), DHCPv6 (Disable), HTTP (Enable. * However, you will be redirected to 
HTTPS.), HTTPS (Enable), DNS (Enable), DDNS (Disable), WINS (Disable), 
Bonjour (Enable), SMTP (Disable), SMTPS (Disable), POP3 (Disable), POP3S 
(Disable), SNMPv1 (Enable (ReadOnly)), SNMPv3 (Enable), SNTP (Disable), IPP 
(Disable), IPPS (Enable), WSD Print (Enable), LLTD (Disable), IEEE802.1X 
(Disable), LPR (Enable), Port9100 (Enable), Telnet (Disable), FTP (Disable), FTPS 
(Disable), IPSec (Disable), LDAP (Disable), LDAPS (Disable), Kerberos (Disable), 
AirPrint (Enable), Mopria (Enable), IPP Everywhere (Enable) 

Wireless LAN specifications 
Item B433 B513 

Wireless LAN standard IEEE802.11 a/b/g/n/ac (2.4 Ghz/5 GHz) 
Security Disable, WEP, WPA-PSK, WPA2-PSKcWPA-EAP, WPA2-EAP, WPA3-SAE, 

WPA3-EAP 

Access log specifications 
Item Description 

Log time The time at which the access occurred 
It follows the time display settings of this machine. 

User name  The user name for the current operation 
Operation info The item name of the operation target 
Access type The means by which the user accessed this machine 
Operation type The type of operation 
Before change  The value before change 
After change  The value after change 
Result  The result 

A maximum of 10,000 entries can be saved. 
Executing [Erase Privacy Data] will delete the data. 
When the maximum storage capacity is reached, the oldest 100 entries will be automatically deleted. 
For details about [Erase Privacy Data], please refer to "Disposal(P.241)". 

Job log specifications 
Item Description 

Time The time when printing starts 
Type It contains the scenario name. 
User Name The user name registered on this machine when access control is enabled 

The PC login name for PC printing only when access control is disabled 
* It may not be stored. 

Result The result of executing the job 
Result Detail The detail of the result of executing the job 

A maximum of 5,000 entries can be saved. 
Executing [Erase Privacy Data] or [Clear Job Log] will delete the data. 
When the maximum storage capacity is reached, the oldest 100 entries will be automatically deleted. 
For details about [Erase Privacy Data], please refer to "Disposal(P.241)". 
For details about [Clear Job Log], please refer to "Menus (Admin Setup)(P.112)". 
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Initialization specifications 

Item 
 

Description 

Operation (*1) 
Erase 

Privacy 
Data 

Reset 
Settings 

Initializin
g flash 

memory 

Initializin
g network 

setup 
Data 
registered 
in the 
machine 
 
 
 
 

Access Control Info 
 User restriction 

(Access 
control)(P.226) 

 

The user information, role 
information, and group information 
for access control 

●    

Form Data 
 Registering forms 

(form 
overlay)(P.258) 

 

The form data for form overlay 
printing 

●  ●  

Server Certificate 
 Communication 

encryption 
(SSL/TLS)(P.203) 

 

The server certificate for 
communication encryption 
(SSL/TLS) 

●    

Shared 
 Printing 

frequently used 
documents 
without using a 
PC(P.165) 

 

The shared job registered in the 
machine 

●  ●  

Private Print Job  
 Printing with print 

data encrypted 
and password set 
(Private 
Print)(P.190) 

 

The private print job registered in 
the machine 

●  ●  

Device 
Settings* 

- The settings configured in the 
Device Settings menu 

● ●  ● 

Password Admin Password 
 Administrator 

Password(P.195) 
 

The authentication password 
required to operate the Admin 
Setup menu 

〇 〇   

Print Statistics 
Password 

 Menus (Print 
Statistics)(P.121) 

 

The authentication password 
required to operate the Print 
Statistics menu 

** ** ** ** 

Log Print Statistics Log 
 Menus (Print 

Statistics)(P.121) 
 

A log that records the information 
that aggregates the amount of 
printing 

●    

Job Log Information 
 Menus (Admin 

Setup)(P.112) 
 

A log that records print data 
information 

●    

Error Log 
 Menus (Admin 

Setup)(P.112) 
 

A log that records the information 
of the error has occurred 

●    
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Item 
 

Description 

Operation (*1) 
Erase 

Privacy 
Data 

Reset 
Settings 

Initializin
g flash 

memory 

Initializin
g network 

setup 

 NFC Kitting Log 

 
 Depending on 

the specific 
region, this 
machine may not 
come with the 
NFC function. 

A log that records the information 
of executing the NFC kitting 
function 

●    

Access Log 
 Menus (Admin 

Setup)(P.112) 
 

A log that records the information 
about access to this machine 

●    

●: Indicates that when the operation is executed, it will be erased from this machine. 
●: Indicates that when the operation is executed, the factory default settings will be reset. 
* Device settings for security functions 
** The Print Statistics Password cannot be initialized. 
To change the Print Statistics password is changed, execute the password change from the Print Statistics 
menu. Make sure you don't forget the new password after change. 
*1 For details about [Erase Privacy Data], please refer to "Disposal(P.241)". 
For details about [Reset Settings], please refer to "Initializing settings of this machine(P.236)". 
For initialization of the flash memory, please refer to "Initializing the flash memory(P.235)". 
For initialization of the network setup, please refer to "Initializing network settings(P.235)". 

Regulatory wireless LAN statements 
  FCC Statement 
  IC Statement 
  Europe-CE Declaration of conformity. 

FCC statement 
FCC WARNING 
Changes or modifications not expressly approved by the party responsible for compliance could void the 
user's authority to operate the equipment. 
Note: This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that interference will not occur in 
a particular installation. If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
- Reorient or relocate the receiving antenna. 
- Increase the separation between the equipment and receiver. 
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
- Consult the dealer or an experienced radio/TV technician for help. 
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This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter. 

IC statement 
This device complies with Part 15 of FCC Rules and Industry Canada licence-exempt RSS standard(s). 
Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this 
device must accept any interference, including interference that may cause undesired operation of this device. 
Le présent appareil est conforme aux la partie 15 des règles de la FCC et CNR d'Ubdustrie Canada 
applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions 
suivantes : (1) I'appareil ne doit pas produire de brouillage, et (2) I'utilisateur de I'appareil doit accepter tout 
brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement. 
This Class [B] digital apparatus complies with Canadian ICES-003. 
Cet appareil numérique de la classe [B] est conforme à la norme NMB-003 du Canada. 

Caution (FCC/IC): 
5.15-5.25 GHz band is restricted to indoor operations only. 
La bande 5150-5250 MHz est restreints à une utilisation à l'intérieur. 
This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and 
meets the FCC radio frequency (RF) Exposure Guidelines and RSS-102 of the IC radio frequency (RF) 
Exposure rules. This equipment should be installed and operated keeping the radiator at least 20 cm or more 
away from person's body. 
Cet équipement est conforme aux limites d'exposition aux rayonnements énoncées pour un environnement 
non contrôlé et respecte les règles les radioélectriques (RF) de la FCC lignes directrices d'exposition et 
d'exposition aux fréquences radioélectriques (RF) CNR-102 de l'IC. Cet équipement doit être installé et utilisé 
en gardant une distance de 20 cm ou plus entre le dispositif rayonnant et le corps. 

Europe - CE Declaration of Conformity 

 

This equipment complies with the essential requirements of the European Union directive 2014/53/EU. 
The telecommunications functionality of this product may be used in the following EU and EFTA countries: 
Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, 
Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta, Netherlands, Norway, 
Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden, Switzerland, Turkey and United 
Kingdom. 
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Dimensions 

Plan view 

 

 B433 B513 

A 387 mm 

Side view 

 

 B433 B513 

B 820 mm 

C 214 mm 

D 364 mm 

E 242 mm 

F 245 mm 286 mm 

G 169 mm 209 mm 

H 228 mm 268 mm 

 

 B433 B513 

I 643 mm 

J 402 mm 

K 180 mm 

L 162 mm 

M 424 mm 465 mm 
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With optional accessories installed 

 

 B433 B513 

N 642 mm 

O 395 mm 

P 761 mm 802 mm 

Q 383 mm 424 mm 

R 138 mm 

S 138 mm 

T 138 mm 

U 102 mm 

V 443 mm 

W 644 mm 
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Contact us 

 Italia www.oki.com/it 

 Français www.oki.com/fr 

 Deutschland www.oki.com/de 

 United Kingdom www.oki.com/uk 

 Ireland www.oki.com/ie 

 España www.oki.com/es 

 Portuguesa www.oki.com/pt 

 Sverige www.oki.com/se 

 Danmark www.oki.com/dk 

 Norge www.oki.com/no 

 Suomi www.oki.com/fi 

 Nederland www.oki.com/nl 

 België/Belgique www.oki.com/be 

 Österreich www.oki.com/at 

 Schweiz/Suisse/Svizzera www.oki.com/ch 

 Polska www.oki.com/pl 

 Česká www.oki.com/cz 

 Slovenská www.oki.com/sk 

 Magyarország www.oki.com/hu 

 Россия www.oki.com/ru 

 Україна www.oki.com/ua 

 Türkiye'ye www.oki.com/tr 

 Serbia www.oki.com/rs 

 Croatia www.oki.com/hr 

 Greece www.oki.com/gr 

 Romania www.oki.com/ro 

 OKI Europe www.oki.com/eu 

 Singapore www.oki.com/sg/ 

 Malaysia www.oki.com/my/ 

 ประเทศไทย www.oki.com/th/printing/ 

 Australia www.oki.com/au/ 

 New Zealand www.oki.com/nz/ 

 中国 www.oki.com/cn/printing 

 대한민국 www.oki.com/kr/ 

 United States www.oki.com/us/ 

 Canada www.oki.com/ca/ 

 Brasil www.oki.com/br/printing 

 México www.oki.com/mx/ 

 Argentina www.oki.com/la/ 

 Colombia www.oki.com/la/ 

 Other countries www.oki.com/printing/ 

https://www.oki.com/it
https://www.oki.com/fr
https://www.oki.com/de
https://www.oki.com/uk
https://www.oki.com/ie
https://www.oki.com/es
https://www.oki.com/pt
https://www.oki.com/se
https://www.oki.com/dk
https://www.oki.com/no
https://www.oki.com/fi
https://www.oki.com/nl
https://www.oki.com/be
https://www.oki.com/at
https://www.oki.com/ch
https://www.oki.com/pl
https://www.oki.com/cz
https://www.oki.com/sk
https://www.oki.com/hu
https://www.oki.com/ru
https://www.oki.com/ua
https://www.oki.com/tr
https://www.oki.com/rs
https://www.oki.com/hr
https://www.oki.com/gr
https://www.oki.com/ro
https://www.oki.com/eu
https://www.oki.com/sg/
https://www.oki.com/my/
https://www.oki.com/th/printing/
https://www.oki.com/au/
https://www.oki.com/nz/
http://www.oki.com/cn/printing
http://www.oki.com/kr/
https://www.oki.com/us/
https://www.oki.com/ca/
https://www.oki.com/br/printing
https://www.oki.com/mx/
https://www.oki.com/la/
https://www.oki.com/la/
https://www.oki.com/printing/
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Menu tree 

X Dimension

Y Dimension

Media Type

Media Weight

X Dimension

Y Dimension

Media Type

Media Weight

Tray Usage

Tray1 Config Paper Size

Supplies Report

Error Log

User Setup Tray Configuration MPTray Config Paper Size

File List

PS Font List

PCL Font List

IBM PPR Font List

EPSON FX Font List

Usage Report

RAM

Flash Memory

Date and Time

Print Information Configuration

Network

Asset Number

Lot Number

Firmware Version

CU Version

PU Version

Panel Version

SSID

Security

Password

Number of connected

IPv4 Address

System Serial Number

Gateway Address

MAC Address

IPv6 Address (Local)

IPv6 Address (Stateless Address)

IPv6 Address (Stateful Address)

Wireless(Wi-Fi Direct) Information Wireless(Wi-Fi Direct)

State

Band

Channel

RSSI

IPv4 Address

Subnet Mask

IPv6 Address (Stateful Address)

Wireless(Infrastructure) Information Firmware Version

Wireless(Infrastructure) 

SSID

Security

IPv4 Address

Subnet Mask

Gateway Address

MAC Address

IPv6 Address (Local)

IPv6 Address (Stateless Address)

MAC Address

IPv6 Address (Local)

IPv6 Address (Stateless Address)

IPv6 Address (Stateful Address)

A4/Letter Impressions Count

Duplex Count

Wired(LAN2) Information Wired(LAN2)

Web Remote Version

Wired(LAN1) Information Wired(LAN1)

IPv4 Address

Subnet Mask

Gateway Address

General Information Extended Network

Enabling Default Gateway

Printer Name

Short Printer Name

NIC Program Version

MPTray

Tray1

Tray2

Tray3

Tray4

Paper Feed Roller Counter MPTray

Functions

Language Setup Select Language

Menus Information Tray Count

Supplies Life Toner

Drum

Fuser

Network Network Information

Tray1

Tray2

Tray3

Tray4
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Serial Number

Offline Receive

USB Memory Interface

Connected Host

DHCPv6

Hub Link Setting

USB Setup USB

Speed

Soft Reset

Wired(LAN2) Setup Wired(LAN2)

IP Address Set

IPv4 Address

Subnet Mask

Gateway Address

IPv4 Address

Subnet Mask

Gateway Address

DHCPv6
Gigabit Network

Hub Link Setting

WSD Print

Network Scale

Network Factory Defaults

Wired(LAN1) Setup Wired(LAN1)

IP Address Set

HTTP

HTTPS redirect (Web)

Telnet

FTP

IPSec

SNMP

Extended Network
You must input an administrator password. Enabling Default Gateway

TCP/IP

NetBIOS over TCP

Web

Narrow Paper Speed

Quiet Mode

Admin Setup Network Setup General Setup

Transfer Setting

SMR Setting

BG Setting

Density Setting

Drum Cleaning

High Humid Mode

Duplex Y Adjust

Tray4 X Adjust

Y Adjust

Duplex X Adjust

Duplex Y Adjust

Duplex X Adjust

Duplex Y Adjust

Tray3 X Adjust

Y Adjust

Duplex X Adjust

Y Adjust

Duplex X Adjust

Duplex Y Adjust

Tray2 X Adjust

Y Adjust

MPTray X Adjust

Y Adjust

Duplex X Adjust

Duplex Y Adjust

Tray1 X Adjust

Timeout Network

Jam Recovery

Error Report

Hex Dump

Print Adjust Print Position Adjust

Auto Power Off Time

Clearable Warning

Auto Continue

Manual Timeout

Timeout InJob

Timeout Local

Tray Sequence

Duplex Last Page

System Adjust Power Save Time

Sleep Time

Sleep After Printing

X Dimension

Y Dimension

Media Type

Media Weight

Paper Feed

Auto Tray Switch

X Dimension

Y Dimension

Media Type

Media Weight

Tray4 Config Paper Size

X Dimension

Y Dimension

Media Type

Media Weight

Tray3 Config Paper Size

Tray2 Config Paper Size
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Power Save Setting

Tray Setup Unit of Measurement

Default Paper Size

Setting method

SNTP Server (Primary)

SNTP Server (Secondary)

Time Setting

Power Setup Auto Power Off

Print Completion Buzzer Volume

Printer Identification Buzzer Volume

Time Setup Date Format

Time Zone

Daylight Saving

Near Life LED

Paper setup when paper exchange

Idle Display

Panel Contrast

Power Save LED Brightness

Buzzer Setup Error Volume

Erase job option 

Keep job for

Job Limitation

Verify job password

Job Auto Search

Panel Setup Near Life Status

Form Length

TOF Position

Left Margin

Fit to Letter

Text Height

Private Print Setup Verify job option

Letter O Style

Zero Character

Line Pitch

White Page Skip

CR Function

Line Length

Fit to Letter

Text Height

EPSON FX Setup Character Pitch

Character Set

Symbol Set

CR Function

LF Function

Line Length

Form Length

TOF Position

Left Margin

Character Set

Symbol Set

Letter O Style

Zero Character

Line Pitch

White Page Skip

SIDM Tray2 ID#

SIDM Tray3 ID#

SIDM Tray4 ID#

IBM PPR Setup Character Pitch

Font Condense

Tray4

SIDM Setup SIDM Manual ID#

SIDM MP Tray ID#

SIDM Tray1 ID#

SIDM Manual2 ID#

Pen Width Adjust

Tray ID# MPTray

Tray1

Tray2

Tray3

Symbol Set

A4 Print Width

White Page Skip

CR Function

LF Function

Print Margin

PDF Print Mode

PCL Setup Font Source

Font Number

Font Pitch

Font Height

PS Setup L1 Tray

Network Protocol

USB Protocol

PDF Paper Size

PDF Scaling Size

Resolution

Toner Save

Default Orientation

Edit Size

X Dimension

Y Dimension

Copies

Duplex

Binding

Media Check

A4/Letter Override

Edge to Edge

Print Setup Personality
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Power on this machine while pressing
«OK» on the operator panel.When [Boot
Menu] appears on the display, release your
finger and press «OK» again.
You must input an administrator password.

Menu Lockout

Panel Lockout

After  AC power supply fails

WEP Key

WPA Encryption Type

WPA Pre-shared Key

Execute

Wireless reconnection

Boot Menu Enter Password

WPS-PIN

Wireless Network Selection xxxxxx

Manual Setup SSID

Security

IPv4 Address

Subnet Mask

Gateway Address

DHCPv6

Automatic setup (WPS) WPS-PBC

Auto Approval Setting

Execute

Password Disclose Setting

Wireless(Infrastructure) Setting Wireless(Infrastructure) 

Network Setting IP Address Set

Manual Setup

Connection Setting SSID

Password

IPv4 Address

Fit

Shared Print

Private Print

Wireless Setting Wireless(Wi-Fi Direct) Setting Wireless(Wi-Fi Direct)

Print Setup

Print Setup Paper Feed

Copies

Duplex

Binding

UserAccount Info Change Password New Password Verify Password

Print Print From USB Memory Select Print File Print

Use Symbol

Use digit

Change Password New Password Verify Password

Calibration Fuser Temp Adjust

Lockout Condition

Lockout Period

Password Policy Minimum Length

Use Uppercase

Use Lowercase

You must input an administrator password. Maintenance Counter

Reset Main Counter

Reset Supplies Counter

Account Lockout Lockout

Verify Password

Print Information Job Log

AirPrint

Print Statistics Usage Report

LAN LED Setup

Power Off/On Log Record

Power Off/On Log Print

Settings Reset Settings

Change Password New Password

Display Timeout

Near Life Setup Drum Near Life Timing

Fuser Near Life Timing

Erase Privacy Data

NFC Setup

Font Setup Font Output Mode

Job Cancel Setup Cancel Button Behavior

Inquiry Display

Focus Position

Depending on the specific region, this machine may not come with the NFC function.

Password Policy Minimum Length

Use Uppercase

Use Lowercase

Use Symbol

Use digit

User Counter Report

PJL Enhance Security

Account Lockout Lockout

Lockout Condition

Lockout Period

Job Log Setup Save Job Log

Clear Job Log

Access Log Setup

Security Setup Access Control

MP Tray Clear

Tray1 Clear

Tray2 Clear

Tray3 Clear

Tray4 Clear

Flash Memory Setup Initialize

Others Setup Paper Feed Roller Counter Clear

You must input an administrator password.
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